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P R Z E W O D N I K  C Z Y T A N I A

Jak czytać ten podręcznik

Każdy wpis w podręczniku ma ten sam układ. Po lewej stronie znajdziesz ścieżki 
obsługi i szczegóły techniczne, a po prawej, w ciepłym panelu bocznym, zawsze proste 
wyjaśnienie. Małe ikony na początku wiersza zdradzają jednym spojrzeniem, jakiego 
rodzaju informacja teraz nastąpi.

C Z T E RY  I KO N Y

Gdzie to znajdę? Konkretna ścieżka kliknięć w aplikacji — pasek menu, sekcja 
Inspectora lub krok Trybu początkującego. Tutaj również znajdują się powiązane 
skróty klawiszowe. Ikona to pinezka mapy i pokazuje: tu w interfejsie użytkownika 
znajduje się dana funkcja.

Szczegóły. Wartości domyślne, zakresy wartości i ścieżki kodu. Spotkasz to 
przede wszystkim przy ustawieniach treningu, które nie są pozycją menu, lecz 
parametrami liczbowymi. Ikona pokazuje małą kartę specyfikacji.

Technicznie. Co funkcja robi wewnętrznie, jakie parametry mają wpływ, na co 
reaguje i jakie ma efekty uboczne. Dla czytelników, którzy chcą zrozumieć, co 
dzieje się w tle. Ikona to blok suwaków i symbolicznie reprezentuje pokrętła pod 
maską.

Prostymi słowami. Główne przesłanie wyrażone jasnymi słowami — bez żargo
nu, bez kodu. Przeczytaj tę sekcję najpierw, jeśli chcesz tylko szybko wiedzieć, 
do czego służy dana funkcja i kiedy jej potrzebujesz. Ikona to dymek dialogowy i 
oznacza „w skrócie„. Ta kolumna ma zawsze ciepły piaskowy odcień, aby oko od 
razu ją znalazło.

KO LO RY  R OZ DZ I A ŁÓW

Każdy rozdział ma własny kolor akcentu, który rozpoznasz po identyfikatorze (na 

przykład M1 ) na lewo od każdego tytułu wpisu oraz po małych ikonach przed nim. 
Przeglądając, od razu widzisz, w którym rozdziale aktualnie się znajdujesz.

1 Menu 2 Inspector 3 Ustawienia 4 Okna pomocnicze 6 Trening

7 Ustawienia wstępne 8 Eksporty 9 SfM 10 Tryb początkujący



W S K A Z Ó W K I  N AW I G A C J I

Szybki start. Jeśli interesuje cię tylko obsługa, przejdź bezpośrednio do Roz­
działu 10 — Tryb początkujący. To prowadzona wersja w czterech krokach i nie 
wymaga żadnej wcześniejszej wiedzy.

Głębsze wejście. Rozdział 2 — Inspector oraz Rozdział 7 — Ustawienia wstęp­
ne wyjaśniają elementy sterujące i predefiniowane profile jakości dostępne w 
Trybie eksperta.

Wyszukiwanie. Spis treści i wyszukiwanie pełnotekstowe PDF pomagają znaleźć 
konkretną funkcję. Nie musisz czytać podręcznika od początku do końca.



R A D I A N C E K I T

R O Z D Z I A Ł

Wprowadzenie — Co powinieneś 
wiedzieć

Czym jest RadianceKit?

RadianceKit to natywna aplikacja macOS, która z serii zwykłych zdjęć lub filmu tworzy 
interaktywną, „chodzalną„ rekonstrukcję 3D. Wejściem są na przykład od 50 do 500 
ujęć wykonanych wokół obiektu, przez pomieszczenie lub nad krajobrazem. Wyjściem 
jest tzw. scena Gaussian Splatting — model 3D, który możesz oglądać na Macu w czasie 
rzeczywistym z dowolnej perspektywy, który można eksportować i osadzać na stronach 
internetowych, a który w głównych aspektach wygląda fotorealistycznie.

Aplikacja działa całkowicie lokalnie na twoim Macu — żadne obrazy nie są przesyłane 
do chmury, nie jest wymagane logowanie, nie ma abonamentu. Intensywnie wykorzystu
je GPU twojego Maca z układem Apple Silicon (seria M): pełny trening może trwać od 
dwóch minut do kilku godzin w zależności od sceny i ustawienia wstępnego. Podczas 
obliczeń możesz normalnie dalej pracować na Macu; RadianceKit działa w tle i zgłosi 
się, gdy wynik będzie gotowy.

Istnieją dwa tryby obsługi: Tryb początkujący (Simple Mode) prowadzi cię w czterech 
krokach przez przepływ Import → Wybór ustawienia wstępnego → Trening → Eksport. 
Tryb eksperta (Expert Mode) otwiera duży Inspector ze wszystkimi pokrętłami, okno 
podglądu na żywo i wykresy diagnostyczne. Możesz w każdej chwili przełączać się 
między trybami; dane sceny pozostają zachowane.

Czym jest Gaussian Splatting?

Gaussian Splatting (często w skrócie 3DGS lub po prostu Splatting) to stosunkowo 
nowa metoda fotorealistycznej prezentacji 3D, zaprezentowana w 2023 roku w artykule 
z Graz i INRIA. Idea: zamiast modelować scenę jako klasyczną siatkę wielokątną (trójką
ty) lub jako siatkę wokseli, składa się ją z milionów małych, miękkich „chmurek„ 3D 
— każda pojedyncza chmurka to rozkład Gaussa 3D (stąd nazwa) z własną pozycją, 
rozmiarem, kształtem, kolorem i przezroczystością. Te chmurki są tak trenowane, aby z 
wszystkich kątów widzenia twoich zdjęć wejściowych razem dawały odpowiedni obraz.
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R A D I A N C E K I T Wprowadzenie — Co powinieneś wiedzieć

W praktyce oznacza to: Gaussian Splatting potrafi przedstawiać odbicia, blaski, miękkie 
liście, włosy lub zasłony tak, jak klasyczne modelowanie 3D nie może lub może tylko 
ogromnym kosztem. W zamian wynik nie jest edytowalnym modelem 3D w klasycznym 
sensie — nie możesz po prostu przesunąć pojedynczej ściany ani przestawić wazonu. 
To raczej zamrożone ujęcie przestrzeni, przez które możesz się swobodnie poruszać. 
Dla wielu zastosowań — wizualizacja architektoniczna, prezentacja produktu, wirtualne 
zwiedzanie, kryminalistyka, dziedzictwo kulturowe — to właśnie odpowiednia siła.

Aby z obrazów wejściowych powstała scena 3D, potrzebne są dwa kroki. Najpierw 
aplikacja oblicza za pomocą procedury zwanej Structure-from-Motion (SfM), gdzie 
znajdowała się twoja kamera przy każdym zdjęciu. Przy okazji powstaje zgrubna chmura 
punktów sceny. Następnie startuje właściwy trening Gaussian Splatting: wychodząc od 
tej zgrubnej chmury, miliony chmurek 3D są stopniowo rozprowadzane, powiększane, 
dopracowywane i korygowane w pozycji i kolorze, aż z wszystkich kątów widzenia wej
ściowych dadzą pasujący obraz.

Nie musisz wiedzieć o żadnym z tych elementów, aby korzystać z RadianceKit. Tryb po
czątkujący całkowicie ukrywa te kroki. Ale jeśli chcesz zrozumieć, co oznaczają liczby 
diagnostyczne w Trybie eksperta (iteracja, loss, gaussianów, SSIM …) lub dlaczego nie
które sceny stają się ładniejsze od innych, to w późniejszych rozdziałach podręcznika 
znajdziesz odpowiedzi.
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R A D I A N C E K I T Wprowadzenie — Co powinieneś wiedzieć

R O Z D Z I A Ł

Rozdział 1 — Pasek menu

Pasek menu RadianceKit grupuje wszystkie funkcje, które nie znajdują się bezpośrednio 
w oknie głównym lub Inspectorze. To przede wszystkim akcje działające na całą scenę 
(otwieranie, zapisywanie, nowy projekt), sterowanie treningiem (start, pauza, kontynu
acja), obsługa widoku (auto-rotacja, zrzut ekranu, kolor tła) oraz uruchamianie ekspor
tów do różnych formatów 3D i medialnych. Dochodzą do tego przejścia do wszystkich 
okien pomocniczych (User Guide, Pareto Dashboard, Holdout Analysis, BayesOpt Con
sole).

Skróty klawiszowe znajdują się po prawej stronie każdej pozycji menu. Konwencje: ⌘  
oznacza klawisz Command (Apple), ⇧  to Shift, ⌥  to Option (Alt) a ⌃  to Control. Przy
kład: ⇧⌘T  oznacza Shift+Command+T. Wszystkie udokumentowane tu skróty są dodat
kowo wyszczególnione w osobnym oknie przeglądu przez Help → Keyboard Shortcuts 
(⌘/​).

Następujące 42 pozycje są udokumentowane w kolejności inwentarza (M1–M42), po
grupowane według odpowiedniego menu na najwyższym poziomie. Wszystkie pozycje 
zostały zweryfikowane wobec bieżącego stanu kodu (linie 175–477). Żadne pozycje 
nie zostały usunięte ani przestarzałe w stosunku do inwentarza; nowa pozycja menu 
Edit (Cmd-Z dla „Remove Image„) jest dostarczana przez systemowy framework NSUn
doManager i dlatego nie pojawia się w kodzie RadianceKitApp (zobacz wskazówkę na 
końcu rozdziału).
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R A D I A N C E K I T Rozdział 1 — Pasek menu

Menu File

Rysunek 1:  Menu File rozwinięte — pozycje M1 do M6

Menu File zastępuje standardową pozycję Apple „New Window„ akcjami specyficznymi 
dla projektu. Obejmuje ładowanie/zapisywanie scen, dynamiczną listę Recent, import 
workspace oraz twardy reset do stanu pustego.

M1 File > Open Scene…

G DZ I E

Pasek menu → File → Open Scene… (⌘O).

T E C H N I C Z N I E

Otwiera okno dialogowe pliku dla formatów pakie
tu RadianceScene , .ply , .splat  i .spz . Po
jedynczy wybór, może pokazywać zarówno pliki, 
jak i katalogi (dla formatu pakietu). Po udanym 
wyborze ścieżka jest wpisywana na listę Recent, 
a scena ładowana asynchronicznie — poprzednia 
jest zastępowana, a potok treningu inicjalizowany 
załadowanym stanem. Pliki PLY/SPZ/Splat są odczy
tywane przez odpowiednie loadery formatu; pakiet 
.radiancescene  to katalog z manifestem, snap

shotem chmury i wynikami SfM.

P R O S T Y M I  S ŁOWA M I

Tak ładujesz już wytrenowaną 
scenę ponownie do aplikacji. 
Działa z własnym formatem Ra­
dianceKit oraz ze standardowy­
mi formatami PLY, SPLAT i SPZ, 
które tworzą inne programy do 
splattingu. Użyj tego, gdy np. 
wytrenowałeś scenę przez noc 
i chcesz następnego dnia kon­
tynuować lub eksportować. Przy 
otwieraniu dotychczasowy stan 
w oknie głównym jest zastępo­
wany — zapisz więc wcześniej, 
jeśli zależy ci jeszcze na bieżą­
cej scenie. Ścieżka automatycz­
nie ląduje w „Open Recent„ (M3), 
abyś następnym razem szybciej 
do niej dotarł.
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R A D I A N C E K I T Rozdział 1 — Pasek menu

M2 File > Save Scene…

G DZ I E

Pasek menu → File → Save Scene… (⌘S).

T E C H N I C Z N I E

Otwiera okno dialogowe zapisu pliku z Content-Ty
pe pakietu RadianceScene  i wstępnie wypełnioną 
nazwą pliku scene.radiancescene. Zapisuje pakiet 
katalogu z manifest.json , serializowaną chmurą 
gaussianów (snapshot PLY) i zrzutem wyniku SfM, 
tak aby po ponownym otwarciu działało również 
Continue-Training. Pozycja jest nieaktywna, dopóki 
nie istnieją gaussiany. Nie zapisuje do ścieżki logów 
treningu, lecz tam, gdzie wskazuje okno dialogowe 
zapisu — typowo pod ~/​Documents/​.

P R O S T Y M I  S ŁOWA M I

Zapisuje twoją bieżącą scenę ja­
ko plik (dokładniej: jako folder 
pakietu, który wygląda jak plik). 
Dopiero potem możesz tę scenę 
później ponownie otworzyć przez 
„Open Scene…„ (M1). W pakie­
cie lądują zarówno chmura gaus­
sianów, jak i wynik SfM, dzię­
ki czemu możesz także później 
dodać Continue-Training (M12–
M14). Dopóki nie zakończyłeś 
jeszcze treningu, pozycja jest 
wyszarzona. Domyślna nazwa to 
scene.radiancescene — mo­
żesz jednak w oknie dialogowym 
Save podać własną nazwę.

M3 File > Open Recent > [nazwa sceny]

G DZ I E

Pasek menu → File → Open Recent → (lista).

T E C H N I C Z N I E

Dynamiczne podmenu generowane z listy ostatnio 
otwieranych ścieżek (zapisanej w ustawieniach). 
Każdy wpis listy jest oznaczony nazwą pliku i łado
wany po kliknięciu. Gdy lista jest pusta, zamiast 
tego pojawia się dezaktywowana etykieta „No Re
cent Scenes„. W stylu Apple lista trzyma N ostatnio 
otwieranych scen — ograniczenie ma miejsce przy 
zapisie do ustawień, a nie w samym builderze menu.

P R O S T Y M I  S ŁOWA M I

Tutaj widzisz ostatnio otwarte 
sceny i możesz jednym kliknię­
ciem wskoczyć do nich z powro­
tem, bez konieczności przecho­
dzenia przez okno dialogowe pli­
ku. Jeśli właśnie zacząłeś, lista 
jest pusta i wyświetla się sza­
ro w menu. Każda scena, którą 
otwierasz przez „Open Scene…
„ (M1), automatycznie ląduje na 
tej liście. Jeśli kiedyś lista zrobi 
się zbyt pełna albo chcesz ją wy­
czyścić z powodów prywatności, 
użyj „Clear Recent” (M4).
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R A D I A N C E K I T Rozdział 1 — Pasek menu

M4 File > Open Recent > Clear Recent

G DZ I E

Pasek menu → File → Open Recent → Clear Recent.

T E C H N I C Z N I E

Czyści listę Recent w ustawieniach. Działa natych
miast, bez dialogu potwierdzenia. Pozycja pojawia 
się w podmenu tylko, gdy w liście Recent w ogóle są 
jakieś wpisy (znajduje się pod dzielnikiem po ścież
kach).

P R O S T Y M I  S ŁOWA M I

Usuwa listę ostatnio otwartych 
scen. Praktyczne, gdy bawiłeś się 
testowym zestawem danych i nie 
chcesz już widzieć ścieżek. Same 
pliki scen nie są przy tym usuwa­
ne — tylko skróty w menu. Akcja 
działa natychmiast, bez pytania; 
potem w podmenu pojawia się 
„No Recent Scenes„. Pozycja po­
jawia się tylko wtedy, gdy w liście 
są jakieś sceny — przy pustej li­
ście jest niewidoczna.

M5 File > Import COLMAP / Metashape Workspace…

G DZ I E

Pasek menu → File → Import COLMAP / Metashape 
Workspace… (⇧⌘I).

T E C H N I C Z N I E

Otwiera selektor folderu. Oczekuje folderu z ukła
dem workspace COLMAP (np. sparse/​0/​cameras.
{bin,txt} plus images/​). Po wyborze przeprowa
dzana jest wstępna weryfikacja workspace — rozpo
znaje trzy układy (sparse/​0/​, sparse/​, root) oraz 
czy rekonstrukcja jest binarna ( cameras.bin ) czy 
tekstowa ETH3D ( cameras.txt ). Przy powodzeniu 
workspace jest importowany; w przeciwnym razie 
pojawia się tylko ostrzeżenie w logu aplikacji. Zo
bacz także rozdział 9 „Backendy SfM„, Q6 dla peł
nej logiki potoku.

P R O S T Y M I  S ŁOWA M I

Jeśli używasz Metashape, COL­
MAP, RealityCapture lub podob­
nego oprogramowania do rekon­
strukcji kamer i masz eksport, 
wczytujesz tutaj folder. Radian­
ceKit pomija wtedy etap SfM 
i startuje od razu z trenin­
giem — to przy dużych scenach 
oszczędza godziny. Przeciągnię­
cie i upuszczenie na okno główne 
działa tak samo. Oczekiwany jest 
folder z układem COLMAP (czyli 
sparse/​0/​ z cameras.*  plus 
folder images/​). Więcej o ob­
sługiwanych układach i przepły­
wach pracy w rozdziale 9 „Bac­
kendy SfM„.

8 / 233



R A D I A N C E K I T Rozdział 1 — Pasek menu

M6 File > New Project

G DZ I E

Pasek menu → File → New Project (⇧⌘N).

T E C H N I C Z N I E

Sprawdza, czy jest niezapisana praca. Jeśli tak, 
pojawia się dialog potwierdzenia, zanim cokolwiek 
przepadnie. Jeśli nie ma nic do zapisania, reset 
działa bezpośrednio — czyści zaimportowane obra
zy, wynik SfM, chmurę gaussianów, stan treningu 
i wszystkie zależne wskaźniki UI. Uwaga: utwo
rzona przez użytkownika biblioteka ustawień wstęp
nych pozostaje zachowana, ponieważ znajduje się w 
ustawieniach aplikacji, a nie w stanie projektu.

P R O S T Y M I  S ŁOWA M I

Resetuje wszystko do pustego 
startu — tak, jakbyś właśnie 
świeżo otworzył aplikację. Jeśli 
masz jeszcze niezapisaną pracę, 
aplikacja wcześniej pyta. Użyj te­
go, gdy chcesz zacząć z zupeł­
nie inną sceną. Zaimportowane 
obrazy, wynik SfM, chmura gaus­
sianów i stan treningu są cał­
kowicie wymazywane. Twoje wła­
sne ustawienia wstępne pozosta­
ją jednak zachowane, ponieważ 
znajdują się w ustawieniach apli­
kacji i nie należą do sceny.

Menu Mode

Rysunek 2:  Menu Mode z przełącznikami Simple- i Expert-Mode

Dwa proste przełączniki między prowadzonym Simple Mode (typu kreator, 4 kroki) a 
pełnym Expert Mode (klasyczny układ Inspectora ze wszystkimi pokrętłami).
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R A D I A N C E K I T Rozdział 1 — Pasek menu

M7 Mode > Simple Mode

G DZ I E

Pasek menu → Mode → Simple Mode (⌘1).

T E C H N I C Z N I E

Przełącza stan aplikacji w tryb Simple. Główny ob
szar aplikacji pokazuje wtedy prowadzony przepływ 
pracy zamiast układu Expert. Stan trybu jest zapisy
wany w ustawieniach (zobacz S1 „Default Mode„ w 
rozdziale 3 Settings).

P R O S T Y M I  S ŁOWA M I

Przełącza na wariant krok-po-
-kroku, w którym aplikacja pro­
wadzi cię przez import, przetwa­
rzanie, podgląd i eksport. Po­
lecane, gdy dopiero zaczynasz 
lub szybko potrzebujesz wyni­
ku. Większość pokręteł szczegó­
łowych jest ukryta — pracujesz 
z sensownymi domyślnymi war­
tościami. Jeśli potem chcesz za­
głębić się bardziej, po prostu 
przełącz w Expert Mode (M8). 
Który tryb jest aktywny przy 
starcie aplikacji, możesz ustawić 
w ustawieniach (rozdział 3, S1).

M8 Mode > Expert Mode

G DZ I E

Pasek menu → Mode → Expert Mode (⌘2).

T E C H N I C Z N I E

Przełącza stan aplikacji w Expert Mode. Pojawia się 
wtedy pełny układ Inspectora ze wszystkimi sekcja
mi (Presets, TrainingConfig, Enhancements, Metrics, 
LossChart, ProjectNavigator). W Expert Mode do
stępne są wszystkie parametry treningu, selektor 
COLMAP, przełączniki Mid-Compact i diagnostyka. 
Również Live-Preview działa tylko w tym trybie.

P R O S T Y M I  S ŁOWA M I

Przełącza w pełny widok ze 
wszystkimi pokrętłami. Widzisz 
tu wykresy loss w czasie rzeczy­
wistym, możesz precyzyjnie do­
stroić wszystkie parametry i za­
rządzać kilkoma porównawczymi 
konfiguracjami przez ustawienia 
wstępne. Polecane, gdy chcesz 
zrozumieć, co trening robi we­
wnętrznie, lub gdy chcesz celowo 
eksperymentować. Również Live-
-Preview, selektor COLMAP i dia­
gnostyka są dostępne tylko tutaj. 
Jeśli czujesz się przytłoczony, 
wróć przez M7 do Simple Mode — 
twoja scena pozostaje przy tym 
zachowana.
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R A D I A N C E K I T Rozdział 1 — Pasek menu

Menu Training

Rysunek 3:  Menu Training z podmenu Continue — pozycje M9 do M14

Cztery akcje wokół przebiegu treningu: start, pauza, anulowanie i przedłużenie o okre
śloną liczbę iteracji. Wszystkie trzy pozycje Continue są zabramkowane IAP (w wersji 
Free-Trial nieklikalne).

M9 Training > Start Training

G DZ I E

Pasek menu → Training → Start Training (⇧⌘T).

T E C H N I C Z N I E

Startuje potok treningu asynchronicznie. Wyma
ganie: istnieje wynik SfM i obecnie nie działa 
żaden inny potok. Oba warunki blokują pozy
cję, jeśli niespełnione. Przy starcie odczytywane 
są bieżące wartości konfiguracji, tworzony no
wy log JSONL pod ~/​Documents/​RadianceKit/​Logs/​
training_​YYYY-MM-DD_​HHmmss.jsonl, i w zależności 
od wyboru strategii jechana jest ścieżka klasyczna 
lub MCMC. Stan treningu zmienia się z „idle„ na 
„training”.

P R O S T Y M I  S ŁOWA M I

Naciska duży zielony przycisk — 
gdy tylko zaimportujesz zdjęcia 
i rekonstrukcja kamer będzie go­
towa, rozpoczyna się właściwy 
trening Gaussian Splatting. Po­
zwól aplikacji działać; w zależno­
ści od ustawienia wstępnego od 
1 minuty (Quick) do kilku godzin 
(MCMC Quality). Pozycja pozo­
staje szara, dopóki nie ma jesz­
cze wyniku SfM lub trwa inny 
potok. Każdy przebieg zapisuje 
przy okazji log do ~/​Documents/​
RadianceKit/​Logs/​, który mo­
żesz później ocenić przez Pareto 
Dashboard (M40).
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M10 Training > Pause Training

G DZ I E

Pasek menu → Training → Pause Training.

T E C H N I C Z N I E

Pauzuje działający trening. Odblokowywany tylko, 
gdy stan treningu to „training„. Pauzowanie za
trzymuje pętlę iteracji w następnym bezpiecznym 
punkcie synchronizacji, zachowuje pełny stan GPU 
(bufory gaussianów, momenty optimizera, pozycja 
schedulera) i przełącza na „paused”. Wznowienie 
następuje przez ponowne naciśnięcie (tytuł pozycji 
jest statyczny — aplikacja przełącza jednak między 
Pause/Resume we właściwej logice). Pauzowane 
treningi nie przeżywają wyjścia z aplikacji; w takim 
przypadku zapisz scenę i rozszerz później przez 
pozycję Continue-Training (M12–M14).

P R O S T Y M I  S ŁOWA M I

Zatrzymuje trening na chwilę 
bez utraty postępu. Praktyczne, 
gdy komputer jest ci potrzebny 
chwilowo do czegoś ważniejsze­
go. Ponowne kliknięcie wznawia. 
Nie działa przez restarty aplika­
cji — jeśli naprawdę chcesz póź­
niej kontynuować, zakończ tre­
ning przez Cancel (M11), zapisz 
scenę przez Save Scene (M2) 
i potem użyj Continue Training 
(M12–M14). Podczas pauzy GPU 
całkowicie odpoczywa; pamięć 
pozostaje jednak zajęta.

M11 Training > Cancel Training

G DZ I E

Pasek menu → Training → Cancel Training.

T E C H N I C Z N I E

Anuluje działający trening. Aktywne, gdy stan tre
ningu nie jest „idle„. Ustawia flagę anulowania w 
silniku treningu, co czysto kończy pętlę iteracji w 
następnym punkcie synchronizacji, zapisuje finalny 
wpis Summary do logu JSONL i resetuje stan na 
„idle”. Dotychczas wytrenowana chmura pozostaje 
zachowana (można ją zapisać lub eksportować), ale 
jest oznaczona jako „cancelled„.

P R O S T Y M I  S ŁOWA M I

Definitywnie anuluje działający 
trening. Dotychczasowy stan po­
zostaje — jeśli więc po kilku ty­
siącach iteracji masz już prezen­
towalny wynik, możesz go potem 
mimo wszystko wyeksportować. 
Jeśli chcesz tylko krótko prze­
rwać, użyj zamiast tego Pause 
(M10). W logu treningu przebieg 
jest oznaczony jako „cancelled„, 
finalna wartość loss jest mimo 
to zapisywana. Anulowaną scenę 
możesz również później konty­
nuować przez Continue Training 
(M12–M14), o ile aplikacja w mię­
dzyczasie nie została zamknięta.
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M12 Training > Continue Training > +5 000 iteracji

G DZ I E

Pasek menu → Training → Continue Training → 
+5,000 iterations.

T E C H N I C Z N I E

Kontynuuje trening o 5 000 iteracji. Aktywne, gdy 
zakończony trening jest kontynuowalny i wersja peł
na jest odblokowana. Kontynuowalność obowiązuje, 
gdy istnieje zakończony trening, a pełny stan opti
mizera nadal jest w pamięci. Przy Continue prowa
dzone są dalej momenty Adam i scheduler LR, tak 
że kontynuacja zachowuje się jak ciągły przebieg 
25K/45K/60K zamiast nowego startu. Log JSONL 
otrzymuje nowy wpis konfiguracji z setupem przyro
stowym. Dostępne tylko w wersji pełnej.

P R O S T Y M I  S ŁOWA M I

Dodaje 5 000 dalszych kroków 
treningu. Użyj tego, gdy wynik po 
pierwszym przebiegu jest blisko, 
ale jeszcze nie do końca ostry. 
Działa tylko w płatnej wersji peł­
nej. W przeciwieństwie do cał­
kowicie nowego przebiegu stan 
optimizera pozostaje zachowany, 
dzięki czemu kontynuacja spra­
wia wrażenie ciągłego przebiegu. 
Jeśli potrzebujesz więcej niż 5 
000 kroków, weź od razu M13 
(+10 000) lub M14 (+20 000).

M13 Training > Continue Training > +10 000 iteracji

G DZ I E

Pasek menu → Training → Continue Training → 
+10,000 iterations.

T E C H N I C Z N I E

Identyczne jak M12, ale z 10 000 dodatkowymi ite
racjami. Te same warunki wstępne, ta sama ścieżka 
schedulera LR. Polecane, gdy początkowy trening 
został przeprowadzony z ustawieniem średniego 
poziomu i chcesz zobaczyć znaczącą poprawę jako
ści bez całkowitego restartowania przebiegu.

P R O S T Y M I  S ŁOWA M I

Wydłuża trening o 10 000 kroków 
— środkowa z trzech dostępnych 
wartości Continue. Dobry wybór, 
gdy pierwszy przebieg był okej, 
ale chcesz jeszcze wyraźnie le­
piej. Tak jak w M12 i M14 przebieg 
współczynnika uczenia jest płyn­
nie kontynuowany, zamiast star­
tować od nowa. Dostępne tylko w 
wersji pełnej.
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M14 Training > Continue Training > +20 000 iteracji

G DZ I E

Pasek menu → Training → Continue Training → 
+20,000 iterations.

T E C H N I C Z N I E

Identyczne jak M12 / M13, ale z 20 000 dodatkowy
mi iteracjami. Największy predefiniowany skok Con
tinue. Przy treningach MCMC to często jest to, co 
decyduje o różnicy między „pasuje„ a „przydatne do 
benchmarku”; przy Classic od 35–40K z doświad
czenia przybywa niewiele.

P R O S T Y M I  S ŁOWA M I

Dodaje 20 000 dodatkowych kro­
ków treningu, maksymalną war­
tość Continue. Użyj tego, gdy na­
prawdę chcesz wycisnąć ostat­
nią kroplę jakości. Przy klasycz­
nym treningu po 40 000 kroków 
często niewiele to już daje — 
przy MCMC natomiast często się 
opłaca, ponieważ tam konwer­
gencja przebiega wolniej. Licz się 
w zależności od sceny ze znaczą­
cym dodatkowym czasem. Jak 
M12 i M13 ta pozycja również jest 
dostępna tylko w wersji pełnej.

Menu Viewport

Rysunek 4:  Menu Viewport z Edit-Mode, sterowaniem kamerą i podmenu Background

Steruje widokiem 3D: Edit-Mode do selekcji gaussianów i cleanupu, sterowanie kamerą 
(auto-rotacja, odtwarzanie, nagrywanie), zrzut ekranu, kolor tła i reset.
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M15 Viewport > Enter/Exit Edit Mode

G DZ I E

Pasek menu → Viewport → Enter Edit Mode (lub 
„Exit Edit Mode„, w zależności od stanu). ⇧⌘E.

T E C H N I C Z N I E

Tytuł pozycji jest dynamiczny i pokazuje w zależno
ści od stanu „Exit Edit Mode„ lub „Enter Edit Mode”. 
Przy naciśnięciu Edit-Mode w rendererze widoku 
jest przełączany. Przy wyjściu z trybu Edit dodatko
wo resetowana jest bieżąca selekcja. Tryb Edit akty
wuje selekcję kliknięciem na gaussianach, selekcję 
prostokątem i usuwanie zaznaczonych gaussianów 
(zobacz obszar edytora UI). Dezaktywowane, dopó
ki nie jest podłączony renderer widoku.

P R O S T Y M I  S ŁOWA M I

Przełącza między normalnym wi­
dokiem 3D a trybem edycji, w 
którym możesz zaznaczać poje­
dyncze gaussiany i usuwać (np. 
floatery lub odstające punkty w 
tle). Przy wyjściu selekcja jest 
automatycznie resetowana. Po­
zycja pozostaje szara, dopóki w 
widoku nie jest widoczna jeszcze 
scena. Etykieta przełącza się w 
zależności od stanu między „En­
ter Edit Mode„ a „Exit Edit Mode” 
— zawsze więc widzisz, w jakim 
trybie obecnie jesteś.

M16 Viewport > Toggle Auto-Rotation

G DZ I E

Pasek menu → Viewport → Toggle Auto-Rotation 
(⌘⌥T).

T E C H N I C Z N I E

Włącza lub wyłącza ciągłą rotację kamery widoku 
wokół pionowej osi przez środek sceny. Oś i pręd
kość pochodzą z konfiguracji sterowania kamerą. 
Auto-rotacja jest czystym efektem widoku i nie 
wpływa ani na trening, ani na nagrywanie — jeśli 
równolegle używasz rejestratora wideo Turntable 
(M18), auto-rotacja dostarcza dokładnie tę ścieżkę, 
którą rejestrator przechwytuje.

P R O S T Y M I  S ŁOWA M I

Obraca kamerę cały czas powoli 
wokół twojej sceny, abyś mógł 
ją widzieć ze wszystkich stron, 
bez przeciągania myszą. Ponow­
ne kliknięcie zatrzymuje rotację. 
Praktyczne przy oglądaniu goto­
wych wytrenowanych scen lub 
jako animacja tła do demo na ży­
wo. Jeśli równolegle nagrywasz 
wideo (M18), auto-rotacja dostar­
cza dokładnie ten ruch, który re­
jestrator przechwytuje.

15 / 233



R A D I A N C E K I T Rozdział 1 — Pasek menu

M17 Viewport > Toggle Camera Playback

G DZ I E

Pasek menu → Viewport → Toggle Camera Play
back.

T E C H N I C Z N I E

Przełącza odtwarzanie ścieżki kamery. Gdy istnie
je zarejestrowana ścieżka kamery (np. z poprzed
niego nagrania lub ponieważ została wczytana 
transforms.json ), ścieżka jest odtwarzana — ka

mera widoku nie porusza się więc już po wejściach 
mysz/trackpad, lecz odtwarza trajektorię klatka po 
klatce. Ponowne naciśnięcie pauzuje odtwarzanie.

P R O S T Y M I  S ŁOWA M I

Odtwarza wcześniej zarejestro­
waną lub zaimportowaną ścieżkę 
kamery. Tak możesz prześledzić 
oryginalną ścieżkę, którą zrobio­
na była scena, lub sprawdzić 
planowany ruch orbitalny przed 
eksportem wideo. Podczas trwa­
nia odtwarzania wejścia mysz i 
trackpad są dezaktywowane — 
kamera ściśle podąża za ścieżką. 
Ponowne kliknięcie pauzuje od­
twarzanie. Jeśli nie wczytałeś ani 
nie zarejestrowałeś żadnej ścież­
ki kamery, nic się nie dzieje.

M18 Viewport > Record Turntable Video

G DZ I E

Pasek menu → Viewport → Record Turntable Video.

T E C H N I C Z N I E

Przełącza nagrywanie widoku. Przy pierwszym naci
śnięciu startuje rejestracja klatek do tymczasowej 
ścieżki; przy drugim naciśnięciu nagrywanie jest 
kończone, kodowane i zapisywane do ścieżki MP4 
(ścieżka jest pytana przez okno dialogowe zapisu). 
W przeciwieństwie do Export → Media → Orbit 
Video (M31), który tworzy stałą ścieżkę 360° z kon
figurowalnym czasem trwania, rejestrator Turntable 
nagrywa na żywo to, co widzisz w widoku — możesz 
więc również nagrać ręczną ścieżkę kamery.

P R O S T Y M I  S ŁOWA M I

Nagrywa bezpośrednio w wido­
ku wideo. Niezależnie od tego, 
czy kamera obraca się automa­
tycznie, czy poruszasz nią sam 
myszą — wszystko, co widzisz, 
jest zapisywane do pliku MP4. 
W przeciwieństwie do eksportu 
„Orbit Video„ (M31) sam okre­
ślasz ścieżkę kamery. Pierwsze 
kliknięcie startuje nagrywanie, 
drugie kończy je i pyta o miej­
sce zapisu. Praktyczne, gdy np. 
chcesz pokazać konkretne ujęcie 
szczegółu, które nie byłoby moż­
liwe ze sztywnym ruchem orbi­
talnym.
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M19 Viewport > Save Screenshot

G DZ I E

Pasek menu → Viewport → Save Screenshot (⇧⌘S).

T E C H N I C Z N I E

Przechwytuje pojedynczą klatkę widoku w pełnej 
rozdzielczości renderingu (czyli nie układ pikseli 
okna, lecz pełna zawartość celu renderingu) jako 
plik PNG. Ścieżka jest pytana przez okno dialogowe 
zapisu. Kolor tła (M21–M23) jest wpalany. Ustawie
nia upscalingu MetalFX/MPS z Enhancements (zo
bacz I27/I28) działają, jeśli aktywne — zrzut ekranu 
pokazuje więc upscalowany output.

P R O S T Y M I  S ŁOWA M I

Zapisuje migawkę twojego bieżą­
cego widoku 3D jako obraz PNG. 
Praktyczne do materiałów mar­
ketingowych lub szybkiego po­
równania. Uwaga: tło jest czę­
ścią obrazu — jeśli potrzebujesz 
przezroczystości, lepiej wyeks­
portuj plik sceny. Rozdzielczość 
odpowiada wewnętrznemu celo­
wi renderingu, a nie twojej wiel­
kości okna — obraz jest więc 
często ostrzejszy, niż wygląda 
w oknie. Ewentualne ustawienia 
upscalingu (Inspector → Enhan­
cements) również wchodzą w 
grę.

M20 Viewport > Copy Camera Info

G DZ I E

Pasek menu → Viewport → Copy Camera Info.

T E C H N I C Z N I E

Odczytuje bieżącą pozę kamery widoku (pozycja, 
punkt look-at, wektor up) oraz wartości FOV ze ste
rowania kamerą i zapisuje je jako wieloliniowy tekst 
do schowka. Format jest czytelny dla człowieka 
(label = value na linię), nie JSON. Praktyczne, by 
odtworzyć specyficzny widok do celów debugowa
nia lub udostępnić wsparciu.

P R O S T Y M I  S ŁOWA M I

Kopiuje bieżącą pozycję kamery i 
kierunek patrzenia jako tekst do 
schowka. Jeśli chcesz np. poka­
zać współprogramiście, skąd ja­
kieś miejsce w scenie wygląda 
dziwnie, wkleisz tekst po prostu 
do maila lub okna czatu. Format 
jest czytelny dla człowieka (jed­
na linia na wartość), nie JSON. 
Głównie przeznaczony do zgła­
szania błędów lub zapytań do 
wsparcia.
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M21 Viewport > Background > Dark Gray

G DZ I E

Pasek menu → Viewport → Background → Dark 
Gray.

T E C H N I C Z N I E

Ustawia kolor tła widoku na ciemny szary (RGB 
0.1/0.1/0.1). Renderer używa tego koloru jako tła, 
na którym gaussiany są kompozytowane. Domyślny 
kolor przy starcie aplikacji steruje opcja Settings S3 
„Default Viewport Background„.

P R O S T Y M I  S ŁOWA M I

Koloruje tło widoku 3D na ciem­
noszaro. Standardowy wybór dla 
większości scen — oferuje dobry 
kontrast zarówno dla jasnych, jak 
i ciemnych gaussianów, bez tego 
by oko czepiało się czystej po­
wierzchni czarnej lub białej. Ko­
lor jest również przejmowany w 
zrzutach ekranu (M19) i orbital­
nych wideo (M31). Jeśli Dark Gray 
jest dla ciebie zbyt mało spek­
takularny, dla porównania wypró­
buj również Black (M22) lub Whi­
te (M23). Który kolor jest aktyw­
ny przy starcie aplikacji, możesz 
ustawić w ustawieniach (S3).

M22 Viewport > Background > Black

G DZ I E

Pasek menu → Viewport → Background → Black.

T E C H N I C Z N I E

Ustawia kolor tła widoku na czystą czerń (RGB 
0/0/0). Pomaga, jeśli scena ma wiele jasnych floate
rów i chcesz je zidentyfikować, lub do materiałów 
marketingowych z ciemnym look-and-feel.

P R O S T Y M I  S ŁOWA M I

Czarne tło. Dobre dla bardzo 
jasnych scen lub gdy chcesz 
zajrzeć w tryb Edit i szukasz 
małych jasnych gaussianów (flo­
aterów), które giną w szarości. 
Również idealne do materiałów 
marketingowych z ciemnym, dra­
matycznym wyglądem. Kolor jest 
wpalany w zrzuty ekranu i wi­
deo orbitalne — jeśli potrzebu­
jesz przezroczystości do później­
szego compositu, czerń jest naj­
gorszym wyborem. Dla ciemnych 
floaterów przełącz w drugą stro­
nę na White (M23).
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M23 Viewport > Background > White

G DZ I E

Pasek menu → Viewport → Background → White.

T E C H N I C Z N I E

Ustawia kolor tła widoku na czystą biel (RGB 1/1/1). 
Użyteczne, gdy scena ma przeważnie ciemną za
wartość i chcesz zobaczyć ciemne floatery (typowy 
szum tła plenerowego).

P R O S T Y M I  S ŁOWA M I

Białe tło. Praktyczne, gdy motyw 
lepiej wygląda jasne-na-ciem­
nym, lub by znaleźć ciemne od­
stające punkty, które możesz po­
tem usunąć w trybie Edit (M15). 
Przy scenach plenerowych biel 
jest często bardziej użyteczna 
niż czerń, ponieważ typowe flo­
atery plenerowe są raczej ciem­
ne. Jak przy innych opcjach tła 
kolor jest przejmowany w zrzu­
tach ekranu i wideo.

M24 Viewport > Reset Camera

G DZ I E

Pasek menu → Viewport → Reset Camera.

T E C H N I C Z N I E

Resetuje kamerę widoku, opuszcza widok kamery 
treningu i zatrzymuje auto-rotację. W ten sposób 
kamera wraca na początkową pozycję (typowo: 
przed sceną, lekko z góry patrząc), auto-rotacja 
jest wyłączona, a jeśli renderer właśnie pokazywał 
kamerę treningu (jedną z póz SfM), wraca do Free-
-Camera.

P R O S T Y M I  S ŁOWA M I

Przywraca kamerę widoku w po­
zycję startową. Jeśli zgubiłeś się 
przy obracaniu lub wypchnąłeś 
scenę poza kadr — jedno kliknię­
cie tutaj i znów widzisz, co po­
winieneś widzieć. Jednocześnie 
wyłącza auto-rotację, jeśli wła­
śnie działa, i wraca z zamrożonej 
kamery treningu w wolny widok. 
Tak otrzymujesz w każdym przy­
padku czysty restart widoku.
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Menu Export

Rysunek 5:  Menu Export z trzema grupami podmenu — 3D Formats, Media i Photogramme
try

Osiem celów eksportu plus dwa eksporty fotogrametrii, zgrupowane w trzech sekcjach 
(3D Formats, Media, Photogrammetry). Pierwsze sześć budowanych jest przez wspólną 
rutynę pomocniczą, która otwiera okno dialogowe zapisu i rejestruje eksport w katalogu 
formatów. Pozycje fotogrametrii mają indywidualną logikę. Wszystkie eksporty fotogra
metrii i niektóre eksporty 3D są dostępne tylko w wersji pełnej.

M25 Export > 3D Formats > Export PLY…

G DZ I E

Pasek menu → Export → 3D Formats → PLY (⌘E).

T E C H N I C Z N I E

Otwiera okno dialogowe zapisu z domyślną nazwą 
gaussians.ply . Przy OK bieżąca chmura gaussia

nów jest zapisywana do standardowego formatu 
PLY ASCII/binarnego — zgodnego z SuperSplat, 
PolyCam, PlayCanvas i wszystkimi typowymi viewe
rami 3DGS. Pełne współczynniki SH, pełna precyzja 
(Float32 na pole). Rozmiar pliku często kilkaset MB 
przy ≥ 500K gaussianów.

P R O S T Y M I  S ŁOWA M I

Zapisuje twoją scenę 3D jako 
standardowy plik PLY. To najbar­
dziej uniwersalny format — pra­
wie każde oprogramowanie może 
to wczytać, od SuperSplat przez 
PolyCam po PlayCanvas. Pliki są 
jednak duże, często kilkaset me­
gabajtów. Użyj PLY, gdy chcesz 
kontynuować w pełnej jakości 
lub archiwizować. Jeśli chcesz 
scenę udostępnić przez sieć, zo­
bacz raczej SPZ (M27) lub Com­
pressed PLY (M26) — są znacznie 
mniejsze.
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M26 Export > 3D Formats > Export Compressed PLY…

G DZ I E

Pasek menu → Export → 3D Formats → Compressed 
PLY.

T E C H N I C Z N I E

Zapisuje chmurę gaussianów w formacie Compres
sed-PLY z własną kwantyzacją pól Position, Scale, 
Rotation i SH. 5–10× mniejsze pliki niż nieskompre
sowane PLY (M25) przy minimalnych stratach wizu
alnych. Zgodne z SuperSplat (który czyta standard 
Compressed-PLY) i PlayCanvas. Domyślna nazwa 
pliku gaussians_​compressed.ply.

P R O S T Y M I  S ŁOWA M I

Jak normalne PLY, ale 5–10 razy 
mniejsze. Jakość pozostaje pra­
wie taka sama. Użyj tego, gdy 
chcesz udostępnić plik online 
lub wysłać mailem. Działa bez­
pośrednio z SuperSplat i Play­
Canvas. Jeśli jednak twój sys­
tem docelowy potrzebuje jeszcze 
mniejszych plików (mobile, dema 
przeglądarkowe), weź zamiast te­
go SPZ (M27) — to jeszcze agre­
sywniej skompresowane. Dla peł­
nej jakości edycji weź nieskom­
presowane PLY (M25).

M27 Export > 3D Formats > Export SPZ…

G DZ I E

Pasek menu → Export → 3D Formats → SPZ.

T E C H N I C Z N I E

Zapisuje chmurę gaussianów w formacie SPZ — 
formacie splat opublikowanym przez Niantic z agre
sywną kwantyzacją (~90% mniejszy niż nieskom
presowane PLY). Optymalizowany przede wszystkim 
pod viewery webowe i aplikacje mobilne. Zgodny z 
Niantic Splatt3R, gsplat.js i viewerem przeglądarko
wym Niantic.

P R O S T Y M I  S ŁOWA M I

Jeden z najmniejszych formatów. 
Około 10× mniejszy niż normal­
ne PLY. Użyj tego przede wszyst­
kim, gdy chcesz pokazać scenę 
w przeglądarce lub oglądać przez 
aplikację mobilną. Dla maksy­
malnej jakości PLY jest lepszym 
wyborem. SPZ jest opracowany 
przez Niantic i działa bezpośred­
nio z gsplat.js, Splatt3R i viewe­
rem webowym Niantic. Z powodu 
silnej kompresji nie możesz pli­
ków SPZ łatwo dalej trenować — 
do edycji weź PLY.
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M28 Export > 3D Formats > Export glTF…

G DZ I E

Pasek menu → Export → 3D Formats → glTF.

T E C H N I C Z N I E

Zapisuje plik .glb  (binarny glTF) z rozszerzeniem 
KHR_gaussian_splatting. Zgodny ze standardem, 
odpowiedni do potoków używających silników glTF 
jak Babylon.js lub Three.js, implementujących roz
szerzenie KHR_gaussian_splatting.

P R O S T Y M I  S ŁOWA M I

Zapisuje scenę w formacie glTF, 
który rozumie wiele programów 
3D i silników webowych — pod 
warunkiem, że obsługują rozsze­
rzenie Gaussian Splatting. Jeśli 
masz specyficzny potok 3D (np. 
Three.js lub Babylon.js), który to 
rozumie, to jest twój format. Plik 
wychodzi jako binarny .glb  
— pojedynczy pakiet zawierający 
wszystko. Dla klasycznych prze­
pływów pracy splattingu zwykle 
PLY lub SPZ to lepszy wybór, po­
nieważ więcej narzędzi je bezpo­
średnio rozumie.

M29 Export > 3D Formats > Export .splat…

G DZ I E

Pasek menu → Export → 3D Formats → .splat.

T E C H N I C Z N I E

Zapisuje format .splat  Antimatter15 — stały roz
miar 32 bajty na gaussiana (pozycja jako 3× 
Float32, skala jako 3× Float32, rotacja jako 4× 
Uint8 znormalizowany kwaternion, RGB+Opacity ja
ko 4× Uint8). Brak współczynników SH wyższych 
niż DC. Najmniejszy plik z bezpośrednią zgodnością 
z przeglądarką. Dla gsplat.js i viewera online demo 
antimatter15.

P R O S T Y M I  S ŁOWA M I

Najprostszy format viewera we­
bowego. Mały i natychmiast wy­
świetlalny w każdej przeglądar­
ce. Traci jednak detal oświetle­
niowy (wyższe współczynniki SH 
przepadają — splat wygląda z 
każdego kąta tak samo, zamiast 
reagować na światło). Dobry do 
maksymalnej wydajności webo­
wej, do fotorealizmu raczej SPZ 
lub PLY. Działa z viewerem onli­
ne antimatter15 i gsplat.js. Każdy 
gaussian zajmuje stałe 32 bajty, 
co czyni format prostym i kom­
patybilnym — ale właśnie za ce­
nę głębi szczegółu.
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M30 Export > 3D Formats > Export SOG…

G DZ I E

Pasek menu → Export → 3D Formats → SOG.

T E C H N I C Z N I E

Zapisuje chmurę gaussianów w formacie SOG. SOG 
(„Self-Organizing Gaussian„) to format PlayCanvas 
z układem atlasu tekstur i kompresją WebP danych 
kwantyzowanych. Skaluje się z 15–20× lepszym 
współczynnikiem rozmiaru niż PLY. Eksport wywołu
je wewnętrznie cwebp  jako zewnętrzne narzędzie 
— dlatego w wersji sandbox (App Store) potencjal
nie ograniczony.

P R O S T Y M I  S ŁOWA M I

Bardzo mały format dla przepły­
wów PlayCanvas. Około 15–20 ra­
zy mniejszy niż PLY, ponieważ 
dane są pakowane do układu 
atlasu tekstur i kompresowane 
WebP. Jeśli nie masz przepływu 
PlayCanvas, SPZ lub Compres­
sed PLY zwykle to lepszy wybór. 
Eksport wywołuje wewnętrznie 
cwebp  jako zewnętrzne narzę­

dzie — w wersji App Store (sand­
box) ten krok może być ograni­
czony.

M31 Export > Media > Export Orbit Video…

G DZ I E

Pasek menu → Export → Media → Orbit Video.

T E C H N I C Z N I E

Renderuje orbitę 360° wokół środka sceny i koduje 
ją jako MP4 (H.264) lub MOV (HEVC, w zależności 
od domyślnych systemowych). W przeciwieństwie 
do M18 (nagrywanie na żywo) ścieżka jest tutaj 
sztywno zadana — czas trwania wybierany w usta
wieniach lub w kroku eksportu Simple Mode.

P R O S T Y M I  S ŁOWA M I

Tworzy automatycznie wideo z 
obrotem wokół twojej sceny. Brak 
ręcznego poruszania. Dobre do 
social media lub szybkiego de­
mo. Jeśli chcesz sam stero­
wać kamerą, użyj zamiast tego 
Record Turntable Video (M18). 
Ścieżka jest stała: pełna orbita 
360° wokół środka sceny, czas 
trwania wybierasz w ustawie­
niach lub w kroku eksportu Sim­
ple Mode. Wideo jest w zależno­
ści od systemu wyjściem jako 
H.264-MP4 lub HEVC-MOV.
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M32 Export > Media > Export Web Viewer…

G DZ I E

Pasek menu → Export → Media → Web Viewer.

T E C H N I C Z N I E

Pakuje samodzielny viewer HTML (oparty na 
gsplat.js) plus dane gaussianów zakodowane w 
Base64 do pojedynczego pliku .html . Plik ten 
działa offline w każdej nowoczesnej przeglądarce 
— brak zależności od serwera, brak zewnętrznych 
URL-i. Rozmiar pliku to około współczynnik 1.3 
większy niż wariant SPZ (przez narzut Base64).

P R O S T Y M I  S ŁOWA M I

Zapisuje twoją scenę jako samo­
uruchamiającą się stronę WWW. 
Podwójne kliknięcie na plik HTML 
→ przeglądarka otwiera się → 
gotowa interaktywna scena 3D. 
Działa bez internetu, można 
ją wysłać mailem, to najprost­
szy sposób udostępnienia wyni­
ku przyjaciołom lub klientom. 
Plik zawiera kompletny viewer 
gsplat.js oraz dane gaussianów 
w pojedynczym dokumencie — 
nic nie jest doładowywane z sie­
ci. Rozmiar pliku to około jedna 
trzecia większa niż eksport SPZ, 
ale za to u odbiorcy nie potrzebu­
jesz dodatkowego oprogramowa­
nia.

M33 Export > Photogrammetry > Export SfM (transforms.json)…

G DZ I E

Pasek menu → Export → Photogrammetry → Export 
SfM (transforms.json).

T E C H N I C Z N I E

Własna ścieżka eksportu (nie przez wspólną ruty
nę pomocniczą), ponieważ eksportowana jest nie 
chmura gaussianów, lecz wynik SfM. Otwiera okno 
dialogowe zapisu z transforms.json  jako domyśl
ną nazwą i Content-Type json . Przy OK zapisywa
ny jest zgodny z nerfstudio plik transforms.json  
z wewnętrznymi parametrami kamer, pozami (jako 
macierz 4×4 w konwencji NeRF) i ścieżkami klatek. 
Tekst pomocy w UI wskazuje, że obrazy treningo
we muszą zostać skopiowane jako siostrzany folder 
images/​. Aktywne tylko, gdy istnieje wynik SfM i 
wersja pełna jest odblokowana.

P R O S T Y M I  S ŁOWA M I

Jeśli chcesz dalej używać wyni­
ku SfM w innym oprogramowa­
niu jak nerfstudio, Brush, gsplat 
lub OpenSplat, eksportujesz tu­
taj pozycje kamer. Umieść dodat­
kowo swoje obrazy treningowe 
w folderze images/​ obok pliku 
transforms.json  — inaczej 

program docelowy nie będzie 
mógł przypisać obrazów. Pozycja 
jest wyszarzona, dopóki nie ma 
jeszcze wyniku SfM, i w wersji 
Free-Trial zablokowana. Dla prze­
pływu COLMAP-Workspace weź 
zamiast tego M34.
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M34 Export > Photogrammetry > Export SfM (COLMAP Workspace)…

G DZ I E

Pasek menu → Export → Photogrammetry → Export 
SfM (COLMAP Workspace).

T E C H N I C Z N I E

Otwiera okno dialogowe zapisu z domyślną na
zwą colmap-workspace  (bez rozszerzenia, ponie
waż to folder). Zapisuje standardowy workspace 
COLMAP z sparse/​0/​cameras.bin, images.bin , 
points3D.bin . Pozwala otworzyć obliczoną w Ra

dianceKit lub zaimportowaną rekonstrukcję SfM w 
innych narzędziach jak Postshot, Nerfstudio lub Me
shroom, lub przy ponownym przebiegu A/B wczytać 
do samego RadianceKit jako już-obliczone wejście 
(przez M5) — oszczędza czas obliczeń. Aktywne 
tylko, gdy istnieje wynik SfM i wersja pełna jest od
blokowana.

P R O S T Y M I  S ŁOWA M I

Jak M33, ale w formacie COLMAP 
zamiast nerfstudio. Jeśli uży­
wasz Postshot, Meshroom, Ner­
fstudio lub innego narzędzia z 
przepływem COLMAP, to jest twój 
eksport. Praktyczny efekt ubocz­
ny: możesz ten folder później 
przez M5 ponownie wczytać do 
RadianceKit i oszczędzić sobie 
czas obliczeń SfM przy następ­
nym przebiegu — szczególnie 
przy dużych scenach zysk czasu 
rzędu godzin. Jak M33 dostępne 
tylko, gdy istnieje wynik SfM, i w 
wersji Free-Trial zablokowane.

Menu Help

Rysunek 6:  Menu Help z pozycjami dokumentacji, folderów i analizy

Siedem pozycji: dwa okna dokumentacji (User Guide, Keyboard Shortcuts), trzy skróty 
do folderów (Training Logs, Exports, Storage) oraz trzy okna analizy (Pareto Dashboard, 
Holdout Analysis, BayesOpt Console). Zgodnie ze stylem Apple menu Help pojawia się 
zupełnie z prawej strony. Standardowe menu Help jest całkowicie zastąpione własnym 
wariantem RadianceKit.
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M35 Help > User Guide

G DZ I E

Pasek menu → Help → User Guide (⌘?).

T E C H N I C Z N I E

Otwiera okno User Guide. Pokazuje nawigację z 
paskiem bocznym tematów i obszarem szczegółów 
przewijania w domyślnym rozmiarze 860×640. Tre
ści są statycznie umieszczone (nie parsowane z 
Markdown).

P R O S T Y M I  S ŁOWA M I

Otwiera wewnętrzną instrukcję 
aplikacji. Jeśli nie chcesz czytać 
wszystkiego w tym podręczni­
ku, znajdziesz tam najważniejsze 
kroki bezpośrednio w programie. 
Instrukcja jest zbudowana jako 
osobne okno z paskiem bocznym 
tematów — możesz więc celowo 
skakać do poszczególnych tema­
tów. Treści są krótsze niż ten 
podręcznik i koncentrują się na 
najczęstszych przepływach pra­
cy.

M36 Help > Keyboard Shortcuts

G DZ I E

Pasek menu → Help → Keyboard Shortcuts (⌘/).

T E C H N I C Z N I E

Otwiera okno Keyboard Shortcuts — prosty układ 
przewijania ze wszystkimi skrótami aplikacji, zgru
powanymi według menu na najwyższym poziomie. 
Domyślny rozmiar 440×560. Treści są również sta
tycznie umieszczone.

P R O S T Y M I  S ŁOWA M I

Otwiera okno z kompletną li­
stą wszystkich skrótów klawi­
szowych. Jeśli np. nie pamię­
tasz, którym klawiszem urucha­
mia się trening, zaglądasz tam. 
Podsumowanie znajduje się tak­
że na końcu tego rozdziału. Lista 
jest zgrupowana według menu 
na najwyższym poziomie, tak że 
szybko skoczysz do właściwego 
obszaru. Pomocne, gdy przesta­
wiasz się ze stylu myszy na kla­
wiaturę.
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M37 Help > Open Training Logs…

G DZ I E

Pasek menu → Help → Open Training Logs… (⇧⌘L).

T E C H N I C Z N I E

Oblicza folder logów jako ~/​Documents/​RadianceKit/​
Logs, tworzy go w razie potrzeby i otwiera w Finde
rze. Każdy przebieg treningu zapisuje tam własny 
plik JSONL training_​YYYY-MM-DD_​HHmmss.jsonl.

P R O S T Y M I  S ŁOWA M I

Otwiera w Finderze folder 
z wszystkimi dotychczasowymi 
protokołami treningu. Jeśli coś 
poszło źle lub chcesz sprawdzić, 
kiedy dokładnie trening do jakiej 
wartości zbiegł, znajdziesz to tu­
taj w plikach JSONL. Na każdy 
przebieg treningu zakładany jest 
dokładnie jeden plik ze znaczni­
kiem czasu — możesz go również 
wczytać do innych narzędzi lub 
wysłać mailem do wsparcia. Jeśli 
chcesz oceny graficznej, Pareto 
Dashboard (M40) to lepsze wej­
ście.

M38 Help > Open Exports Folder…

G DZ I E

Pasek menu → Help → Open Exports Folder…

T E C H N I C Z N I E

Analogicznie do M37, ale z ~/​Documents/​
RadianceKit/​Exports. Tworzony przy pierwszym 
przebiegu auto-testu lub przy pierwszym klik
nięciu; potem lądują tam standardowe ścieżki 
wszystkich eksportów auto-testu (np. autotest_​
<timestamp>.ply). Wybrane ręcznie przez okno dia
logowe zapisu eksporty NIE muszą iść tutaj, lecz 
tam, gdzie użytkownik je zapisuje — dlatego ten 
folder jest interesujący przede wszystkim dla auto-
-testów.

P R O S T Y M I  S ŁOWA M I

Otwiera folder, w którym aplika­
cja składuje swoje własne eks­
porty (przede wszystkim prze­
biegi auto-testu). Jeśli zapisałeś 
jakiś eksport ręcznie przez okno 
dialogowe zapisu gdzie indziej, 
jest on tam, a nie w tym folde­
rze. Praktyczne do sprzątania lub 
by sprawdzić, ile miejsca zajmują 
wcześniejsze eksporty testowe. 
Jeśli potrzebujesz kompletnego 
przeglądu wraz z logami i pakie­
tami scen, weź zamiast tego Ma­
nage Storage (M39).
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M39 Help > Manage Storage…

G DZ I E

Pasek menu → Help → Manage Storage…

T E C H N I C Z N I E

Otwiera Storage-Browser (zobacz rozdział 4 Okna 
pomocnicze, ID W7–W12). Listuje wszystkie per
sistowane sceny, logi treningu, eksporty i cache 
w folderze ~/​Documents/​RadianceKit/​ z rozmiarem, 
umożliwia Reveal-in-Finder i Move-to-Trash na wpis.

P R O S T Y M I  S ŁOWA M I

Otwiera przeglądarkę okna po­
kazującą, ile miejsca Radiance­
Kit zajmuje na twoim dysku — 
na scenę, log i eksport. Możesz 
bezpośrednio usuwać pojedyn­
cze rzeczy bez konieczności cho­
dzenia do Findera. Praktyczne po 
dłuższym użytkowaniu, gdy dysk 
się zapełnia — wcześniejsze logi 
i eksporty auto-testów mogą su­
marycznie zajmować kilka giga­
bajtów. Przez Reveal-in-Finder w 
każdej chwili dostajesz się rów­
nież do klasycznego widoku.

M40 Help > Pareto Dashboard…

G DZ I E

Pasek menu → Help → Pareto Dashboard… (⇧⌘D).

T E C H N I C Z N I E

Otwiera Pareto Dashboard (zobacz rozdział 4, ID 
W13–W22). Dashboard ładuje wszystkie logi JSONL 
treningów z ~/​Documents/​RadianceKit/​Logs/​, po
rządkuje je według sceny i ustawienia wstępnego 
oraz rysuje wykres scatter Pareto (standard: Loss vs 
Gaussians, opcjonalnie Loss vs Wallclock lub PSNR 
vs iteracje).

P R O S T Y M I  S ŁOWA M I

Otwiera przegląd wszystkich do­
tychczasowych przebiegów tre­
ningu jako wykres. Od razu 
widzisz, który przebieg dostar­
czył najlepszej równowagi jako­
ści i rozmiaru. Praktyczne, gdy 
chcesz porównać różne ustawie­
nia wstępne ze sobą. Domyśl­
nie wykres pokazuje Loss prze­
ciwko liczbie gaussianów — mo­
żesz jednak również przełączyć 
na czas wallclock lub PSNR. Dane 
pochodzą z logów JSONL trenin­
gu (M37); im więcej masz prze­
biegów, tym bardziej wymowna 
staje się ocena.
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M41 Help > Holdout Analysis…

G DZ I E

Pasek menu → Help → Holdout Analysis… (⇧⌘H).

T E C H N I C Z N I E

Otwiera okno Holdout Analysis (zobacz rozdział 4, 
ID W23–W29). Ładuje transforms.json , rysuje ka
mery jako globus 3D i pozwala na rozdziały train/
test fold (kątowo lub liniowo, 2–8 foldów). Wyjściem 
jest fold-assignment.json, którego trening może 
użyć w odpowiednich konfiguracjach treningu jako 
zestaw testowy.

P R O S T Y M I  S ŁOWA M I

Pomaga ci rozdzielić twoje ujęcia 
kamer na zestawy treningowy i 
testowy — abyś mógł obiektyw­
nie zmierzyć, jak dobra jest twoja 
scena (na obrazach, których tre­
ning nie widział). Raczej narzę­
dzie badawcze i benchmarkowe. 
Kamery są przedstawiane jako 
globus 3D; możesz wybierać mię­
dzy 2 a 8 foldami, równomiernie 
w kącie lub liniowo po kolejności. 
Wynikiem jest mały plik JSON, 
którego trening potem używa ja­
ko zestawu testowego.

M42 Help > BayesOpt Console…

G DZ I E

Pasek menu → Help → BayesOpt Console… (⇧⌘B).

T E C H N I C Z N I E

Otwiera konsolę BayesOpt (zobacz rozdział 4, ID 
W30–W39). Ładuje predefiniowane przestrzenie po
szukiwań (np. „MCMC scale-reg + opacity-reg + 
ssim„), wykonuje próby Bayesian Optimization asyn
chronicznie i pokazuje krzywą zbieżności oraz log 
prób na żywo.

P R O S T Y M I  S ŁOWA M I

Wbudowana konsola auto-tune­
ra. Zamiast ręcznie próbować 
różnych parametrów, aplikacja 
może to sama uruchamiać przez 
noc i pod koniec proponować 
ci najlepsze wartości dla two­
jej sceny. Bardzo zaawansowa­
ne narzędzie — dla większości 
przepływów pracy dobre usta­
wienie wstępne (zobacz rozdział 
7) wystarcza. Wybierasz predefi­
niowaną przestrzeń poszukiwań 
(np. „MCMC scale-reg + opacity-
-reg + ssim„) i widzisz na żywo 
krzywą zbieżności oraz log prób. 
Zaplanuj w zależności od konfi­
guracji kilka godzin do dni.

Wskazówka: Cmd-Z w menu Edit

Od maja 2026 Project Navigator w Expert Mode wspiera usuwanie zaimportowanych 
obrazów przez przycisk minus lub klawisz Backspace, a cofanie przez Cmd-Z . Ta akcja 
Cmd-Z pojawia się w menu Edit macOS (dostarczanym przez SwiftUI) jako „Undo Re
move Image„, dopóki usunięty obraz jest jeszcze przywracalny. Jest rejestrowana przez 
standardowy system; dlatego nie ma własnego wpisu z ID M w inwentarzu.
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Skróty klawiszowe w przeglądzie

Pozycja menu Skrót

File > Open Scene… ⌘O

File > Save Scene… ⌘S

File > Import COLMAP / Metashape Workspace… ⇧⌘I

File > New Project ⇧⌘N

Mode > Simple Mode ⌘1

Mode > Expert Mode ⌘2

Training > Start Training ⇧⌘T

Viewport > Enter/Exit Edit Mode ⇧⌘E

Viewport > Toggle Auto-Rotation ⌘⌥T

Viewport > Save Screenshot ⇧⌘S

Export > 3D Formats > PLY ⌘E

Help > User Guide ⌘?

Help > Keyboard Shortcuts ⌘/

Help > Open Training Logs… ⇧⌘L

Help > Pareto Dashboard… ⇧⌘D

Help > Holdout Analysis… ⇧⌘H

Help > BayesOpt Console… ⇧⌘B

Menu Edit (dostarczane przez system, w Expert Mode przy aktywnej selekcji Project 
Navigator):

Akcja Skrót

Undo Remove Image ⌘Z

Remove Selected Image Backspace / Delete

30 / 233



R A D I A N C E K I T Rozdział 1 — Pasek menu

R O Z D Z I A Ł

Rozdział 2 — Inspector (Expert View)

Rysunek 7:  Tryb Expert pusty — Project Navigator po lewej (Images 0, Cameras, Log), pusty 
widok pośrodku, Inspector po prawej z sekcjami Presets/Training Configuration/Enhance

ments/Training Metrics

Pusty Inspector przed importem: Lewy pasek boczny pokazuje licznik Images 0 i 
wskazówkę „Drop images here / or tap + to import„. Inspector po prawej jest w pełni 
funkcjonalny, ale ustawienia wstępne są tylko informacyjne (brak aktywnego treningu). 
Domyślne ustawienie „Preview” (5K iter.) jest oznaczone. Camera Alignment na Apple 
Photogrammetry, Densification Classic, SSIM Weight 0.20, Render Scale 50%. Stany 
puste w Training Metrics („Start training to see live metrics„) i Loss History („Loss curve 
will appear during training”).
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Rysunek 8:  Inspector z załadowanymi 60 obrazami flowers — pasek boczny obrazów poka
zuje pierwsze nazwy plików frame_0001.jpg ff, nagłówek „60 images ready„

Inspector po imporcie: Status nagłówka „60 images ready„. Pasek obrazów listuje 
wszystkie 60 zaimportowanych klatek ( frame_0001.jpg  do frame_0945.jpg , każda 
16. klatka z zestawu 960-Cam-Bouquet jako podzbiór do szybkich iteracji). Logika 
Auto-Render-Scale sprawdza rozdzielczość obrazu (1536×2048 = 3.1 MP) i odpowied
nio dostosowuje Render Scale. Przycisk Play (zielony, dolny lewy) jest teraz aktywny i 
startuje trening z aktywnym ustawieniem wstępnym.

Rysunek 9:  Inspector w trakcie treningu — Live-Viewport pokazuje rekonstrukcję bukietu 
flowers, pasek metryk u dołu (Loss / LR / liczba gaussianów / iteracje), karta ustawienia 

„Preview„ z odznaką „Modified” jeśli parametry zostały zmienione

Inspector podczas treningu: Pasek tytułu pokazuje globalny postęp „RadianceKit — 
Training NN %„. Widok renderuje działającą rekonstrukcję gaussianów w czasie rzeczy
wistym (aktualizowane co 50 iteracji — interwał Live-Preview ustawialny w Settings → 
General → Training → Live Preview). Pasek metryk pod widokiem: bieżący Loss, Lear
ning Rate, liczba gaussianów i licznik iteracji (np. 1,600/5,000 przy ustawieniu Preview). 
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Karta ustawienia „Preview” w Inspectorze nosi odznakę „Modified„, gdy tylko jakiś para
metr odbiega od domyślnej wartości wbudowanej. Pasek boczny „Log” zbiera zdarzenia 
etapów SfM i treningu.

Rysunek 10:  Inspector po zakończeniu treningu — widok pokazuje gotową rekonstrukcję 
bukietu flowers (2,991 gaussianów po 5K iteracjach w 13s), pasek tytułu „Training Complete 

— 2,991 Gaussians„

Inspector po treningu: Pasek tytułu pokazuje finalną liczbę gaussianów (tutaj 2 991 — 
bardzo zwarte, ponieważ syntetyczna scena bukietu z Blendera na jasnym tle ma prostą 
geometrię). Widok pokazuje gotową chmurę punktów — orbitalna nawigacja przecią
gnięciem aktywna (obraca wokół środka sceny). Sekcja Training Metrics jest teraz 
wypełniona wartościami finalnymi, wykres Loss History pokazuje przebieg wszystkich 5 
000 iteracji. Sekcja eksportu poniżej jest teraz aktywna (wszystkie przyciski formatów 
włączone).

Inspector to prawy pasek boczny w Expert Mode (⌘2). Skupia wszystkie parametry 
istotne dla treningu w siedmiu zwijalnych sekcjach. Domyślna kolejność z góry na 
dół przy pierwszym uruchomieniu to: Look, Presets, Konfiguracja treningu, Metryki, 
wykres straty, Enhancements i Export. Sekcja „Look„ (post-treningowe korekty obra
zu) to faktyczna zmiana nazwy w UI dawnej sekcji „Finishing” — jej wewnętrzny 
rawValue  enum-a pozostaje ze względów persystencji „Finishing„, a wyświetlany na

główek brzmi „Look”. Każdą sekcję można zwinąć kliknięciem na nagłówku, kolejność 
zmienić przeciągnięciem (InspectorView.swift:81-97). Przy pierwszym uruchomie­
niu wszystkie siedem sekcji jest zwinięte (inspectorCollapsedSections domyślnie 
przyjmuje Set(InspectorSection.allCases)); stan aplikacji zapisuje potem preferencje 
zwinięcia i kolejności między uruchomieniami.

Szereg kontrolek z Inspectora pojawia się w niemal identycznej formie również w 
ustawieniach (rozdział 3) — typowo backend SfM, Sky-Masking i podobne wartości 
domyślne. Rozdział jest celowy: ustawienia dostarczają globalny szablon aplikacji dla 
nowotworzonych projektów, Inspector nadpisuje te wartości dla bieżącego otwartego 
projektu. Kto raz zna logikę obsługi jednej strony, może drugą używać na ślepo.

Lewa kolumna w Expert Mode — Project Navigator — nie należy do Inspectora, ale jest 
jego bezpośrednim sąsiadem. Tam można wybierać zaimportowane obrazy kliknięciem, 
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oglądać spacją w Quick-Look i usuwać przyciskiem minus lub klawiszem Delete (z Cmd-
-Z do cofania). Inspector podąża za bieżącą selekcją paska bocznego z kontekstowymi 
informacjami szczegółowymi, siedem głównych sekcji pozostaje jednak zawsze dostęp
ne.

Sekcja Look (L1–L5)

Sekcja Look (wewnętrzny rawValue  nadal „Finishing„) to najwyższa sekcja Inspectora 
i zbiera w jednym miejscu post-treningowe korekty obrazu. Wszystkie suwaki działają 
niedestrukcyjnie: każdy suwak nakłada FinishingPass  na nowo na niezmieniony, 
pierwotny snapshot (oryginalny kolor DC, opacity, skalowanie) — korekta jest więc 
idempotentna, nie kumulatywna. Wynik pojawia się na żywo w widoku (WYSIWYG, 
dokładnie tak, jak późniejszy eksport) i jest wpiekany w każdy eksport. Sekcja jest 
dostępna dopiero po zakończeniu przebiegu treningu (wcześniej widnieje „Available 
after a training run completes.”); jej wartości są resetowane przy każdym nowym 
treningu. Dopóki trwa eksport, wszystkie suwaki są zablokowane — pojawia się wska
zówka blokady „Locked while exporting — the file uses the current settings.„ i GroupBox 
jest wyłączony.

L1 Suwak Saturation

G DZ I E

Inspector → sekcja Look → GroupBox → Saturation.

T E C H N I C Z N I E

Suwak 0.5–1.2, wyświetlanie dwucyfrowe (np. 
„1.00″). Skaluje chrominancję SH-DC każdego Spla
ta względem wartości luminancji: 1.0 = bez zmian, 
< 1.0 = odbarwione (kolor ściągnięty do skali szaro
ści), > 1.0 = bardziej nasycone. Matematycznie kolor 
DC jest przeliczany wstecz z pierwotnego snapsho
tu ( desaturateDC ), tak że wielokrotne przesuwanie 
się nie sumuje. Zwalidowane na materiale z dro
nów DJI (wiadukt Pensford), który ma tendencję do 
przerysowania — domyślna wartość dla dronów to 
0.82. Działa tylko na bazę koloru (SH-stopień 0), 
wyższe współczynniki SH pozostają nietknięte.

P R O S T Y M I  S ŁOWA M I

Jak nasycone są kolory gotowe­
go Splata. 1.00 zostawia wszyst­
ko tak jak wytrenowane, wartości 
poniżej ściągają kolor w stronę 
szarości — dobre dla materiału 
z dronów lub wideo, który czę­
sto wychodzi przesycony. Warto­
ści powyżej 1.0 czynią go bar­
dziej nasyconym. Możesz dowol­
nie przesuwać tam i z powrotem, 
bez „nakręcania się„ efektu, bo 
aplikacja zawsze przelicza od no­
wa z niezmienionego oryginalne­
go stanu. Widoczne na żywo w 
widoku i dokładnie tak w ekspor­
cie.
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L2 Suwak Splat length

G DZ I E

Inspector → sekcja Look → GroupBox → Splat 
length.

T E C H N I C Z N I E

Suwak 0.3–1.0, wyświetlanie dwucyfrowe. Ściąga 
trzy osie skalowania każdego gaussiana w prze
strzeni logarytmicznej w stronę ich wartości średniej 
( shortenScale , współczynnik alpha ): 1.0 = bez 
zmian, mniejsze wartości czynią wydłużone „igło
we„ Splaty bardziej okrągłymi, 0 to czyste kule. 
Działa na igłowate, przeciągnięte Splaty bez zmiany 
rozmiaru całkowitego i redukuje przez to typowe ar
tefakty „konfetti”. Nakładane od pierwotnego snap
shotu (oryginalne skalowanie logarytmiczne), więc 
idempotentne. Komutuje ze Splat size (L3), bo oba 
działają w przestrzeni logarytmicznej.

P R O S T Y M I  S ŁOWA M I

Czyni przedługie, drzazgowate 
Splaty bardziej okrągłymi. 1.00 
zostawia kształt tak jak wytre­
nowany, niższe wartości ściska­
ją wydłużone „igły„ w bardziej 
okrągławe kleksy — to uspokaja 
ziarniste, gnębione artefaktami 
konfetti rekonstrukcje. Rozmiar 
całkowity pozostaje ten sam, 
chodzi tylko o wydłużenie. Można 
bezpiecznie łączyć ze Splat size 
(L3).

L3 Suwak Splat size

G DZ I E

Inspector → sekcja Look → GroupBox → Splat size.

T E C H N I C Z N I E

Suwak 0.5–2.0, wyświetlanie dwucyfrowe. Skaluje 
każdy gaussian na wszystkich trzech osiach jed
nolicie ( sizeScale ): 1.0 = bez zmian, < 1.0 = 
mniejsze/gęstsze/ostrzejsze, > 1.0 = większe/„pu
szystsze„ (wypełnia luki między Splatami). Ponie
waż skalowania leżą w przestrzeni logarytmicznej, 
mnożenie jest realizowane jako addytywny offset 
log(factor)  — to komutuje ze Splat length (L2), 

bo stały offset zostawia odchylenie-od-średniej nie
tknięte. Od pierwotnego snapshotu, więc idempo
tentne. Nowość w tej wersji.

P R O S T Y M I  S ŁOWA M I

Skaluje wszystkie Splaty rów­
nomiernie większe lub mniej­
sze. 1.00 to stan wytrenowany, 
wartości poniżej czynią chmurę 
punktów ciaśniejszą i ostrzejszą, 
wartości powyżej zakrywają lu­
ki między Splatami (działa mięk­
cej/„puszystiej„). Praktyczne, by 
optycznie domknąć dziurawą re­
konstrukcję albo odwrotnie od­
słonić więcej detalu. Bez proble­
mu współgra ze Splat length (L2) 
— oba suwaki nie wpływają na 
siebie nawzajem.
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L4 Fade far region (z sub-suwakami)

G DZ I E

Inspector → sekcja Look → GroupBox → przełącznik 
„Fade far region„ plus sub-suwaki „Fade start ×ra
dius” i „Fade floor„.

T E C H N I C Z N I E

Przełącznik aktywujący radialny spadek opacity 
wraz z dystansem od środka ciężkości kamer — sła
bo obserwowane „konfetti dali„ w tle są wygaszane. 
Tylko dla ujęć orbitalnych: przełącznik jest wy
łączony, gdy finishingContext.fadeEligible jest 
false (loty liniowe, zbyt mało lub zdegenerowane 
kamery); wtedy zamiast sub-suwaków pojawia się 
wskazówka „Far-fade applies only to orbit captures 
(not this scene).” Przydatność jest ustalana przez 
pokrycie azymutalne pozycji kamer (orbita okrąża 
środek ciężkości i wypełnia wiele sektorów kompa
su, lot liniowy tylko ~2). Dwa sub-suwaki sterują 
geometrią: Fade start ×radius (1.0–3.0) ustawia 
promień wewnętrzny jako wielokrotność promienia 
orbity, w obrębie którego obowiązuje pełna opacity; 
Fade floor (0.0–1.0) to współczynnik opacity daleko 
poza promieniem zaniku. Ważne: zanik pomija ob­
szar Sky-Dome (zamrożone gaussiany o indeksach 
[0, frozenCount)), żeby celowa kopuła tła nie była 
przyciemniana.

P R O S T Y M I  S ŁOWA M I

Wygasza miękkie resztki na ze­
wnętrznej krawędzi sceny — do­
kładnie te grudki „konfetti dali„, 
które przy ujęciach dookolnych 
unoszą się daleko z tyłu. Dzia­
ła tylko przy prawdziwych uję­
ciach orbitalnych/okrążających; 
przy prostych lotach dronem lub 
zbyt małej liczbie kamer prze­
łącznik jest wyszarzony, a wska­
zówka wyjaśnia dlaczego. Gdy 
jest aktywny, dochodzą dwa re­
gulatory precyzyjne: „Fade start 
×radius” określa, od jakiej od­
ległości (jako wielokrotność pro­
mienia okręgu) zaczyna się wy­
gaszanie, „Fade floor„ jak bardzo 
dalekie Splaty pozostają na koń­
cu jeszcze widoczne (0 = całkiem 
zniknęły, 1 = bez zmian). Celowo 
zrekonstruowany Sky-Dome (I44) 
nigdy nie jest przy tym ruszany 
— niebo zostaje zachowane.
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L5 Przycisk Reset finishing

G DZ I E

Inspector → sekcja Look → GroupBox → „Reset fini
shing„ (na dole, mały przycisk).

T E C H N I C Z N I E

Resetuje wszystkie ustawienia Look do wartości do
myślnych (FinishingPass.Settings() = Saturation 
1.0, Fade wyłączony, Splat length 1.0, Splat size 1.0) 
i natychmiast wyzwala ponowne finishing, tak że wi
dok wraca do niezmienionego wytrenowanego sta
nu. controlSize(.small). Ponieważ cały stos Look 
przelicza idempotentnie od pierwotnego snapshotu, 
„powrót do domyślnych„ to dokładnie pierwotny wy
nik treningu — brak utraty jakości przez wielokrotne 
przesuwanie tam i z powrotem. Jak wszystkie suwa
ki sekcji zablokowany podczas trwającego eksportu.

P R O S T Y M I  S ŁOWA M I

Jednym kliknięciem przywraca 
wszystkie suwaki Look do stan­
dardu (Saturation 1.00, Fade wy­
łączony, oba suwaki Splat na 
1.00) — widok pokazuje potem 
znów dokładnie świeżo wytreno­
wany wynik. Praktyczne, gdy się 
zagrałeś i chcesz czysto zacząć 
od nowa. Ponieważ aplikacja za­
wsze przelicza od oryginalnego 
stanu, nie ma przy tym żadnej 
utraty jakości. Gdy trwa eksport, 
przycisk (jak suwaki) jest zablo­
kowany.

Sekcja Presets (I1–I11)

Sekcja Presets to najszybsza droga do zastosowania przetestowanej konfiguracji. Wbu
dowane ustawienia (Capture Class, Classic, MCMC, Hybrid) dostarczają powtarzalne 
punkty startowe z 560+ udokumentowanych eksperymentów; własne ustawienia można 
zapisywać, eksportować, importować i udostępniać. Lista jest pogrupowana według 
kategorii (Capture Class, Classic, MCMC, Hybrid, Custom), a więcej niż jedna kategoria 
może być rozwinięta jednocześnie. Przez mechanizm menu kontekstowego (prawy klik 
na wierszu) dostępne są eksport, duplikowanie i — przy własnych ustawieniach — usu
wanie.
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I1 Przycisk Save…

G DZ I E

Inspector → sekcja Presets → przycisk Save… (pa
sek akcji na dole).

T E C H N I C Z N I E

Otwiera popover z polem tekstowym i przyciskami 
Save/Cancel. Bieżący stan TrainingConfig jest persi
stowany jako nowe ustawienie zdefiniowane przez 
użytkownika (kodowane JSON, zapisywane na po
ziomie aplikacji). Proces zapisu kopiuje wszystkie 81 
parametrów treningu plus bieżącą strategię densyfi
kacji. Ustawienie automatycznie ląduje w kategorii 
Custom, niezależnie od tego, z którego wbudo
wanego ustawienia zostało wyprowadzone. Puste 
nazwy i wejścia tylko z białymi znakami są odrzuca
ne. Istniejące już nazwy nie są odrzucane — każde 
ustawienie ma własny wewnętrzny ID, podwójne na
zwy są technicznie dozwolone, ale praktycznie my
lące.

P R O S T Y M I  S ŁOWA M I

Zabezpiecza twoją bieżącą konfi­
gurację jako wielokrotnie używal­
ne ustawienie wstępne. Naciśnij 
przycisk, podaj w popoverze na­
zwę i kliknij Save — wszystkie 
81 parametrów wraz ze strategią 
densyfikacji ląduje pod wybra­
ną nazwą w kategorii Custom. 
Potrzebne, gdy włożyłeś wysiłek 
i nie chcesz przy następnym 
projekcie znów zaczynać od ze­
ra. Szczególnie praktyczne dla 
powtarzających się setupów jak 
„Dron 4K„ lub „Indoor szybko”. 
Podwójne nazwy są technicznie 
dozwolone, ale praktycznie mylą­
ce — weź lepiej coś mówiącego.

I2 Pole tekstowe Preset Name

G DZ I E

Popover Save → pole tekstowe „Preset Name„.

T E C H N I C Z N I E

Proste pole tekstowe z zaokrągloną ramką, szerokie. 
Wartość jest przejmowana jako nazwa ustawienia 
przy kliknięciu na przycisk Save. Brak ograniczenia 
długości w UI, ale zapisana nazwa musi być kodo
walna JSON i przedstawialna w listach UI — emoji i 
znaki diakrytyczne działają. Zawartość jest automa
tycznie resetowana do pustego stringa przy otwar
ciu popovera. Przycisk Save pozostaje dezaktywo
wany, dopóki pole jest puste po przycięciu. Brak 
Auto-Suggest i brak preset domyślnych z nazwą ak
tualnie aktywnego ustawienia.

P R O S T Y M I  S ŁOWA M I

Tutaj wpisujesz nazwę dla twoje­
go ustawienia. Wybierz coś mó­
wiącego jak „Dron 4K 30fps„ lub 
„Wnętrze szybko” — pomaga ci 
to później w odnajdywaniu w ka­
tegorii Custom. Emoji i znaki dia­
krytyczne dozwolone, twardego 
limitu długości brak. Dopóki pole 
jest puste lub składa się tylko 
ze spacji, przycisk Save pozosta­
je wyszarzony. Przy ponownym 
otwarciu popovera pole jest znów 
puste — brak preset domyślnych 
z aktywnym ustawieniem.
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I3 Przycisk Cancel (Save-Dialog)

G DZ I E

Popover Save → przycisk Cancel (po lewej).

T E C H N I C Z N I E

Zamyka popover bez zapisywania. Odrzuca zawar
tość pola tekstowego — przy następnym otwarciu 
jest znów resetowany do pustego przez logikę 
przycisku Save… (I1). Standardowy styl przycisku, 
brak dialogów potwierdzenia, brak skrótów. Bieżą
cy TrainingConfig pozostaje niezmieniony, ponieważ 
ścieżka Save w ogóle nie została wykonana.

P R O S T Y M I  S ŁOWA M I

Zamyka popover Save bez za­
pisywania czegokolwiek. Jeśli 
zmieniłeś zdanie, popełniłeś lite­
rówkę lub przypadkowo otworzy­
łeś dialog — po prostu kliknij 
Cancel. Twoja bieżąca konfigura­
cja treningu pozostaje niezmie­
niona, ponieważ jeszcze nic nie 
zostało zapisane. Przy następ­
nym otwarciu popovera pole na­
zwy startuje znów puste. Brak 
pytania bezpieczeństwa, brak 
skrótu — po prostu kliknięcie i 
zniknęło.

I4 Przycisk Save (Save-Dialog)

G DZ I E

Popover Save → przycisk Save (po prawej, promi
nentny styl).

T E C H N I C Z N I E

Wyzwala właściwe persistowanie. Waliduje jeszcze 
raz niepustą nazwę (defensywne sprawdzenie) i 
wtedy zapisuje bieżący TrainingConfig jako JSON 
do pamięci aplikacji. Następnie zamyka popover. 
Wyróżniony niebieskim, wyszarzony dopóki pole 
tekstowe jest puste. Jeśli zapis się nie uda (np. 
ponieważ pamięć aplikacji jest pełna — bardzo nie
prawdopodobne), obecnie nie ma widocznego dia
logu błędu; ustawienie po prostu nie pojawiłoby się 
przy następnym starcie aplikacji.

P R O S T Y M I  S ŁOWA M I

Kliknięciem Save przejmujesz 
nazwę i zapisujesz bieżący se­
tup jako nowe ustawienie wstęp­
ne. Popover się zamyka, usta­
wienie natychmiast pojawia się 
w kategorii Custom listy usta­
wień wstępnych i od teraz można 
je aktywować kliknięciem. Przy­
cisk jest wyróżniony niebieskim 
( borderedProminent ) i pozo­
staje wyszarzony, dopóki pole 
nazwy jest puste. Jeśli zapis się 
nie uda (np. UserDefaults pełne), 
brak widocznego dialogu błędu 
— ustawienie po prostu zniknę­
łoby przy następnym starcie apli­
kacji.
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I5 Przycisk Export…

G DZ I E

Inspector → sekcja Presets → pasek akcji → przy
cisk Export…

T E C H N I C Z N I E

Eksportuje aktualnie wybrane ustawienie jako plik 
.radiancepreset  (wewnętrznie JSON). Dezakty

wowany, gdy nie ma wybranego ustawienia. Przy 
kliknięciu aplikacja otwiera dialog Save z predefi
niowaną nazwą pliku (nazwa ustawienia + rozsze
rzenie .radiancepreset ). Zapisany format zawiera 
kompletny TrainingConfig plus metadane (nazwa, 
kategoria, ID, flaga Built-in). Podwójne kliknięcie w 
Finderze otwiera aplikację — ale nie automatycznie 
import; użytkownik musi użyć przycisku Import (I6).

P R O S T Y M I  S ŁOWA M I

Wybierz ustawienie z listy i 
kliknij Export — wtedy mo­
żesz je zapisać jako plik 
.radiancepreset  i np. wy­

słać koledze lub przenieść na 
drugiego Maca. Odbiorca wczy­
tuje go po drugiej stronie przy­
ciskiem Import… (I6). Działa dla 
wbudowanych i własnych usta­
wień Custom równie dobrze. 
Przycisk jest wyszarzony, dopó­
ki w liście nic nie jest kliknięte. 
Wskazówka: przez menu kontek­
stowe (I8) idzie jeszcze szybciej 
— nie musisz ustawienia naj­
pierw zaznaczać.

I6 Przycisk Import…

G DZ I E

Inspector → sekcja Presets → pasek akcji → przy
cisk Import…

T E C H N I C Z N I E

Otwiera dialog pliku dopuszczający tylko pliki 
.radiancepreset  (wybór wielu dezaktywowany). 

Przy wybraniu plik JSON jest ładowany, walidowa
ny i wstawiany do kategorii Custom — z nowym 
wewnętrznym ID, by nie powstały kolizje z wbu
dowanymi. Import automatycznie ustawia kategorię 
na Custom, nawet jeśli wyeksportowane ustawienie 
pierwotnie było np. wbudowane. Uszkodzone lub 
niezgodne ze starszą wersją schematu pliki są po 
cichu odrzucane, bez dialogu błędu (log konsoli da
je jednak informację).

P R O S T Y M I  S ŁOWA M I

Wczytuje 
plik .radiancepreset  z dys­
ku. Użyteczne, gdy ktoś przesyła 
ci wypróbowany setup lub sam 
chcesz utrzymać swoje ulubio­
ne ustawienia w synchronizacji 
na kilku Macach. Zaimportowane 
ustawienia zawsze lądują w kate­
gorii Custom — nawet gdy pier­
wotnie były eksportowane z wbu­
dowanych. Uszkodzone lub prze­
starzałe pliki są po cichu igno­
rowane; w logu konsoli stoi wte­
dy powód. Wybór wielu w dialo­
gu jest dezaktywowany, więc na 
kliknięcie tylko jeden plik.
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I7 Wiersz ustawienia (aktywacja kliknięciem)

G DZ I E

Inspector → sekcja Presets → każdy wiersz ustawie
nia w każdej kategorii.

T E C H N I C Z N I E

Kliknięcie na wiersz ustawienia zastępuje wszystkie 
pola TrainingConfig wartościami z ustawienia, zapa
miętuje ID aktywnego ustawienia i resetuje status 
Modified. Aktywne ptaszki przed wierszem pojawia
ją się tylko, gdy ustawienie jest wybrane I niezmo
dyfikowane. Gdy tylko wartość w TrainingConfig 
zostanie zmieniona (suwak, stepper, przełącznik 
w innych sekcjach Inspectora), za nazwą pojawia 
się pomarańczowa odznaka „Modified„. Wbudowa
ne ustawienia nie mogą być nadpisywane — przy 
modyfikacji trzeba przez przycisk Save (I1) założyć 
własną kopię.

P R O S T Y M I  S ŁOWA M I

Kliknięcie na wiersz aktywuje 
ustawienie i przejmuje wszystkie 
zapisane tam wartości do bie­
żących ustawień treningu. Pta­
szek przed nazwą pokazuje, które 
ustawienie jest obecnie aktyw­
ne. Gdy tylko potem przekręcisz 
jakiś suwak, stepper lub prze­
łącznik w innych sekcjach, za 
nazwą pojawia się pomarańczo­
wa odznaka „Modified„ — ponie­
waż twój setup teraz odbiega od 
ustawienia. Wbudowanych usta­
wień nie da się nadpisać; jeśli 
chcesz zachować zmiany, załóż 
przez przycisk Save… (I1) własną 
kopię lub zduplikuj ustawienie 
(I9).

I8 Menu kontekstowe „Export…„

G DZ I E

Prawy klik na każdy wiersz ustawienia → pierwsza 
pozycja „Export…„.

T E C H N I C Z N I E

Identyczna funkcjonalność jak I5 (przycisk 
Export…), ale wygodniej dostępna — bez konieczno
ści wcześniejszego zaznaczenia ustawienia. Ekspor
tuje bezpośrednio ustawienie klikniętego wiersza. 
Działa dla wszystkich kategorii ustawień równo 
(wbudowane lub Custom), bez ograniczenia. Eks
port zawiera flagę Built-in i oryginalną kategorię, 
ale przy reimporcie kategoria jest mapowana na Cu
stom, jak opisano w I6.

P R O S T Y M I  S ŁOWA M I

Szybka droga do eksportu — pra­
wy klik na pożądane ustawienie 
i wybierz „Export…„. Oszczędza 
obejście przez wcześniejsze kli­
kanie i potem naciśnięcie przy­
cisku Export. Działa dla wszyst­
kich kategorii równo, również dla 
wbudowanych. Utworzony plik 
.radiancepreset  jest iden­

tyczny z tym z I5; przy później­
szym reimporcie ląduje automa­
tycznie w kategorii Custom.
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I9 Menu kontekstowe „Duplicate„

G DZ I E

Prawy klik na każdy wiersz ustawienia → druga po
zycja „Duplicate„.

T E C H N I C Z N I E

Klonuje ustawienie do kategorii Custom. Tworzy no
wy wewnętrzny ID, dokleja „ Copy„ do nazwy i zapi
suje kopię. Działa także dla wbudowanych ustawień 
— klon jest wtedy edytowalny. Oryginał pozostaje 
nietknięty. TrainingConfig jest kopiowany wartość 
po wartości (JSON roundtrip), tak by nie istniały re
ferencyjne powiązania między oryginałem a kopią.

P R O S T Y M I  S ŁOWA M I

Tworzy edytowalną kopię usta­
wienia w kategorii Custom. Prak­
tyczne, gdy np. chcesz wbudo­
wane ustawienie „Quality„ jako 
punkt wyjścia, a potem chcesz 
tylko nieco przesunąć suwak 
SSIM. Workflow: duplikuj, zmień 
nazwę (menu kontekstowe lub 
nowy przebieg Save…), dostosuj, 
gotowe. Oryginał pozostaje nie­
tknięty — możesz w każdej chwi­
li do niego wrócić. Działa także 
dla wbudowanych, co jest jedyną 
drogą przejęcia ich wartości jako 
bazy i jednocześnie uczynienia 
ich edytowalnymi.

I10 Menu kontekstowe „Delete„

G DZ I E

Prawy klik na własne wiersze ustawień → ostatnia 
pozycja „Delete„ (czerwony, destrukcyjny).

T E C H N I C Z N I E

Widoczna tylko dla ustawień Custom. Wbudowa
nych nie można usuwać. Pozycja jest oznaczona 
jako destrukcyjna, pojawia się w menu konteksto
wym na czerwono i jest oddzielona dzielnikiem, aby 
nie klikać jej przypadkowo. Nie ma żadnego dialogu 
potwierdzenia — jedno kliknięcie usuwa ustawienie 
natychmiast. Usunięte ustawienie nie jest do odzy
skania (Cmd-Z tu nie działa — Undo istnieje w 
bieżącym buildzie tylko dla listy obrazów, nie dla 
operacji na ustawieniach). Jeśli usunięte ustawienie 
było właśnie aktywne, bieżący TrainingConfig pozo
staje niezmieniony, tylko aktywny wybór ustawienia 
jest wyzerowany.

P R O S T Y M I  S ŁOWA M I

Usuwanie własnych ustawień. 
Przy wbudowanych (Quick, Pre­
view, Balanced, Quality, Ultra De­
tail, Drone / Aerial, 360° Walka­
round, Photo / Object itd.) „Dele­
te„ w ogóle nie jest widoczne — 
nie możesz ich przypadkowo za­
bić. Uwaga: brak pytania bezpie­
czeństwa i brak Undo, kliknięcie i 
ustawienie znika. Jeśli nie jesteś 
pewien, wcześniej przez Export… 
(I5/I8) pociągnij na dysk kopię 
bezpieczeństwa — możesz ją w 
każdej chwili ponownie zaimpor­
tować. Jeśli ustawienie było wła­
śnie aktywne, twój TrainingCon­
fig pozostaje niezmieniony, znika 
tylko ptaszek.
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I11 Nagłówek kategorii (zwijanie/rozwijanie)

G DZ I E

Inspector → sekcja Presets → każdy nagłówek ka
tegorii (Capture Class, Classic, MCMC, Hybrid, Cu
stom).

T E C H N I C Z N I E

Status zwinięcia na kategorię z różnymi domyślny
mi: kuratowana grupa Capture Class startuje rozwi­
nięte, Classic, MCMC, Hybrid i Custom startują 
zwinięte. Status nie jest persistowany — przy re
starcie aplikacji wszystkie kategorie są znów w 
stanie domyślnym. Strzałka chevron rotuje z anima
cją. Liczba po prawej w nagłówku pokazuje liczbę 
ustawień w tej kategorii. Obszar trafienia kliknięcia 
obejmuje cały obszar nagłówka.

P R O S T Y M I  S ŁOWA M I

Zwijanie i rozwijanie katego­
rii, aby utrzymać listę ustawień 
przejrzystą. Przy starcie aplikacji 
grupa Capture Class jest otwarta, 
Classic, MCMC, Hybrid i Custom 
zamknięte. Kliknięcie na nagłó­
wek (cały obszar jest klikalny) i 
lista wjeżdża z krótką animacją 
chevron na górę lub dół. Mała 
liczba po prawej pokazuje, ile 
ustawień leży w kategorii. Po re­
starcie aplikacji jest znów stan 
domyślny — aplikacja celowo nie 
zapisuje tego ustawienia zwinię­
cia.

Sekcja Konfiguracja treningu (I12–I22)

Rysunek 11:  Wycinek sekcji Konfiguracja treningu — Camera Alignment (Apple Photogram
metry aktywne, Native (Beta) nieaktywne), Densification (Classic aktywne), Max Iterations 

5,000 / Densify Until 3,500 z symbolem Link, suwak SSIM Weight 0.20, suwak Render Scale 
na 100 % (1,536×2,048 = 3.1 MP)

Tu lądują centralne dźwignie: który backend SfM ma liczyć, jak działa densyfikacja, 
ile iteracji, jak duża waga SSIM. Przy strategii MCMC pojawiają się dwa dodatkowe 
przełączniki („MCMC Quality„ i „Auto-scale by scene”), ukryte w trybie Classic. Przy 
backendzie Native SfM dochodzi pole FOV-Override, używane tylko dla klatek wideo 
bez ogniskowej EXIF.
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I12 Selektor Camera Alignment

G DZ I E

Inspector → Konfiguracja treningu → Camera Align
ment (selektor segmentowy u góry).

T E C H N I C Z N I E

Selektor segmentowy z dwiema opcjami: Apple 
Photogrammetry i Native (Beta). Wybór określa 
używany backend SfM przy następnej rekonstruk
cji kamer. Wpływa jednocześnie na to, które inne 
elementy Inspectora są widoczne: Native pokazuje 
dodatkowo FOV-Override (I13), potrzebny tylko przy 
klatkach wideo bez EXIF. Wskazówka: dla bardzo 
dużych ujęć plenerowych możesz wczytać wynik 
zewnętrznego narzędzia (Metashape lub COLMAP) 
przez import workspace — zobacz rozdział 1 (M5) i 
rozdział 9 (Q3, Q6).

P R O S T Y M I  S ŁOWA M I

Tutaj wybierasz, jak rekonstru­
owane są pozycje kamer — naj­
ważniejszy przełącznik dla koń­
cowej jakości. Apple Photogram­
metry to szybki standard i wy­
starcza w pełni dla większości 
skanów obiektów. Native (Beta) 
to własne zgodne z App Sto­
re rozwiązanie, dobre dla orbit 
i scen obrotowych, a przy klat­
kach wideo bez EXIF potrzebu­
je FOV-Override (I13). Przy bar­
dzo dużych zestawach plenero­
wych możesz alternatywnie poli­
czyć kamery w Metashape lub 
COLMAP i wczytać wynik przez 
import workspace. Szczegóły i 
rekomendacje na typ sceny znaj­
dziesz w rozdziale 9.

I13 Pole FOV Override (Native SfM)

G DZ I E

Inspector → Konfiguracja treningu → FOV Override 
(widoczne tylko przy Camera Alignment = Native).

T E C H N I C Z N I E

Numeryczne pole tekstowe (zakres 0-170°), do
myślnie 0 = automatyczne ustalenie z EXIF lub heu
rystyki. Ręczne wpisanie jest potrzebne, gdy obrazy 
wejściowe zostały wyekstrahowane z wideo bez 
metadanych ogniskowej. Typowe wartości: iPhone 
Wide ≈ 73°, DJI Mavic Wide-Crop ≈ 70°, dron z sen
sorem pełnoklatkowym ≈ 84°. Wartość jest ograni
czana do [0, 170] — wartości poza są bezpośrednio 
cofane. Wpływa tylko na natywny potok SfM (Q4/
Q5); Apple Photogrammetry kompletnie ignoruje tę 
wartość.

P R O S T Y M I  S ŁOWA M I

Jeśli twoje obrazy nie mają EXIF 
(typowo przy wyekstrahowanych 
klatkach wideo), wpisujesz tutaj 
poziomy zakres widzenia kame­
ry w stopniach. Wartości orien­
tacyjne: iPhone Wide ≈ 73°, DJI 
Mavic Wide-Crop ≈ 70°, dron z 
sensorem pełnoklatkowym ≈ 84°. 
0 pozwala aplikacji samej zgad­
nąć — często działa dobrze, ale 
przy rzadkich obiektywach mo­
że pójść źle. Wartości powyżej 
170° są automatycznie cofane. 
Pole jest widoczne i działa tylko, 
gdy wybrałeś Native jako Camera 
Alignment (I12) — Apple Photo­
grammetry kompletnie je ignoru­
je.
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I15 Selektor Densification

G DZ I E

Inspector → Konfiguracja treningu → Densification 
(selektor segmentowy, zawsze widoczny).

T E C H N I C Z N I E

Przełącza między dwiema strategiami densyfikacji: 
Classic (oryginalna procedura 3DGS z Clone/Split/
Prune i progiem gradientu) i MCMC (Stochastic 
Gradient Langevin Dynamics z relokacją, NeurIPS 
2024). Przy zmianie z Classic na MCMC aplikacja 
automatycznie ustawia specyficzne dla MCMC pola 
na sprawdzone wartości domyślne (Reg-Weights = 
0, MCMC-Cap-Multiplier 3.0, harmonogram Sample/
Noise). Bez tej automatycznej inicjalizacji sesje ze 
starymi ustawieniami cierpiały na błąd 1.4.4-MCMC-
-Collapse (460K→5 gaussianów, kill watchdoga). 
Wybór selektora dodatkowo określa, które elementy 
Inspectora są widoczne — przy MCMC pojawiają 
się I16/I17. Szczegółowe działanie pól w rozdziale 6, 
T11–T16 (Classic) i T61–T73 (MCMC).

P R O S T Y M I  S ŁOWA M I

Centralny wybór strategii dla ro­
śnięcia liczby gaussianów. Clas­
sic jest dobrze dostrojone z 459 
eksperymentów, generuje szyb­
kie i wysokiej jakości wyniki i 
nie musi znać pól MCMC. MCMC 
to nowsze podejście (NeurIPS 
2024), bardziej powtarzalne i re­
zygnuje z ręcznej regulacji pro­
gu — za to liczy około 6× 
dłużej przy porównywalnej jako­
ści. Przy przełączaniu na MCMC 
aplikacja automatycznie ustawia 
bezpieczne domyślne, aby tre­
ning nie wszedł w 1.4.4-Collapse. 
Szczegóły do pól strategii stoją 
w rozdziale 6 (T11–T16 Classic, 
T61–T73 MCMC).

I16 Przełącznik MCMC Quality

G DZ I E

Inspector → Konfiguracja treningu → MCMC Quality 
(tylko przy Densification = MCMC).

T E C H N I C Z N I E

Przełącza Gradient-Accumulation na 2 kroki (aktyw
ne) lub 1 krok (nieaktywne). Akumuluje gradienty 
z dwóch następujących po sobie widoków kamery, 
zanim wykonany zostanie krok optimizera. Empi
rycznie (Session 33, V544a) redukuje to finalny błąd 
L1 o ok. 6% (0.0246 z Quality vs 0.0261 bez, przy 
uśrednieniu 3 prób na Horse-Full-MCMC). Cena: 
podwojony czas treningu. Przy bardzo długich tre
ningach (200K iteracji) prowadzi to do dodatkowych 
10+ minut oczekiwania — więc opłaca się tylko, 
gdy ostatnie parę procent jakości naprawdę jest 
potrzebne. Wpływa tylko na trening, nie na format 
eksportu czy prezentację widoku.

P R O S T Y M I  S ŁOWA M I

Tryb Quality dla MCMC z Gra­
dient-Accumulation po dwóch 
widokach. Robi wynik końcowy 
empirycznie ok. 6% lepszym (L1 
0.0246 zamiast 0.0261 w teście 
Horse), kosztuje za to dwa ra­
zy tyle. Jeśli i tak już jedziesz 
trening 200K-MCMC (bywa 2 go­
dziny), dochodzi znowu szczupła 
godzina. Opłaca się przy final­
nych renderingach showcase lub 
pod koniec sesji Quality-Sweep, 
w codziennym workflow raczej 
nie. Widoczne tylko, gdy Densifi­
cation stoi na MCMC (I15).
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I17 Przełącznik Auto-scale by scene

G DZ I E

Inspector → Konfiguracja treningu → Auto-scale by 
scene (tylko przy MCMC).

T E C H N I C Z N I E

Gdy aktywny, skaluje efektywną górną granicę Max-
-Gaussians ze SfM-Init-Point-Count × MCMC-Cap-
-Multiplier (domyślnie 3.0). Przykład: SfM dostarcza 
250K punktów początkowych, podstawowy cap = 
150K, multiplier 3.0 → efektywna górna granica 
= max(150K, 750K) = 750K. Gdy dezaktywowany, 
ściśle obowiązuje tylko podstawowy. Wprowadzo
ne dla v1.4.5, ponieważ duże ujęcia plenerowe z 
ponad 1000 klatkami i odpowiednio wysoką gęsto
ścią punktów SfM przy sztywnym domyślnym 150K-
-Cap zagłodziły densyfikację — nadmiarowe punkty 
zostały, nowe nie mogły powstać. Domyślnie OFF w 
ustawieniach Custom, ON w wbudowanych MCMC. 
Wpływa tylko na czas treningu, nie na eksport.

P R O S T Y M I  S ŁOWA M I

Pozwala maksymalnej liczbie 
gaussianów rosnąć z rozmiarem 
sceny (dokładniej: z liczbą punk­
tów inicjalnych SfM). W małych 
scenach prawie nie zauważasz 
różnicy, w dużych scenach ple­
nerowych jest często decydują­
ce dla jakości — inaczej trening 
„dusi się„, ponieważ domyślna 
górna granica 150K jest dla sce­
ny zbyt niska. Wprowadzone spe­
cjalnie dla v1.4.5, gdy bardzo 
duże zestawy plenerowe (ponad 
1000 klatek) wyraźnie wisiały na 
cap. Przy wbudowanych ustawie­
niach MCMC już z góry włączo­
ne; w własnych ustawieniach do­
myślnie wyłączone.

I18 Stepper Max Iterations

G DZ I E

Inspector → Konfiguracja treningu → GroupBox → 
Max Iterations.

T E C H N I C Z N I E

Stepper z zakresem 1 000–100 000, krok 1 000. 
Określa łączną liczbę iteracji optimizera. Liniowo 
skorelowane z czasem treningu (połowa = ok. 50% 
czasu). Empiryczne sweet spoty: 20K (Classic Ba
lanced, L1≈0.028), 40K (Classic Quality, L1≈0.023), 
200K (MCMC Full, L1≈0.0246). Powyżej 40K przy 
Classic średnio daje zaledwie poprawę — Dimini
shing Returns. Przy zmianie, jeśli funkcja Link (I19) 
jest aktywna, Densify Until jest proporcjonalnie pod
ciągany (domyślny stosunek: 0.5, tj. Densify-Until = 
Max/2).

P R O S T Y M I  S ŁOWA M I

Ile kroków treningu jest wykony­
wanych — więcej jest lepiej, ale 
kosztuje też liniowo więcej cza­
su. Reguła kciuka: 20 000 dla do­
brej jakości, 40 000 dla optimum 
przy strategii Classic (powyżej 
średnio prawie nic nie daje). 
MCMC potrzebuje znacznie wię­
cej, 200 000 jest tu standardem. 
Podwojenie iteracji z grubsza po­
dwaja czas treningu. Przy aktyw­
nym przycisku Link (I19) Densify 
Until jest proporcjonalnie pod­
ciągany — praktycznie zawsze 
to, czego chcesz.
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I19 Przycisk Link/Unlink (Densify ↔ Iterations)

G DZ I E

Inspector → Konfiguracja treningu → GroupBox → 
mały przycisk Link między Max Iterations a Densify 
Until.

T E C H N I C Z N I E

Przycisk przełączający, który zamraża stosunek 
Densify Until do Max Iterations. Przy aktywnym (iko
na Link wyróżniona) przy każdej zmianie Max Itera
tions Densify Until jest proporcjonalnie podciągany. 
Przy Unlink (ikona Link-Plus) wartości pozostają 
niezależne. Domyślnie linked, ponieważ odzwiercie
dla to typową korelację — gdy ciągniesz trening na 
podwójne iteracje, zwykle chcesz też densyfikację 
proporcjonalnie dłużej. Stosunek jest obliczany przy 
ustawieniu przycisku Link z bieżącej wartości; typo
wy stosunek to 0.5 (Densify-Until = połowa liczby 
iteracji).

P R O S T Y M I  S ŁOWA M I

Mały przycisk klamry między Max 
Iterations a Densify Until. Gdy 
aktywny (ikona Link wyróżnio­
na), obie wartości wędrują razem 
— podwajasz Iterations, podwa­
ja się też Densify Until w tym 
samym stosunku. Gdy nie (ikona 
link.badge.plus ), możesz je 

ustawiać niezależnie. Standar­
dem jest zlinkowane, ponieważ 
odzwierciedla to typową korela­
cję — dłuższy trening zwykle też 
chce dłuższej fazy densyfikacji. 
W 99% przypadków zostaw za­
trzaśnięte.

I20 Stepper Densify Until

G DZ I E

Inspector → Konfiguracja treningu → GroupBox → 
Densify Until.

T E C H N I C Z N I E

Stepper z zakresem 500–50 000, krok 500. Okre
śla indeks iteracji, od którego nie dochodzą nowe 
gaussiany przez Clone/Split (Classic) lub relokację 
(MCMC). Po osiągnięciu udoskonalane są tylko po
zycja i kolor. Wyższe wartości = więcej gaussianów 
= większy plik, dłuższy czas na iterację (+30-60% 
GPU-Time na krok). Typowe wartości: 15K (dla 30K 
Max-Iter), 20K (dla 40K), 100K (dla 200K MCMC). 
Przy aktywnym Link (I19) automatycznie skalowane 
razem. Inaczej wpływa przy Classic vs MCMC: Clas
sic zatrzymuje całkowicie wzrost, MCMC zatrzymuje 
logikę relokacji, ale adaptacja Sample/Noise działa 
dalej.

P R O S T Y M I  S ŁOWA M I

Do której iteracji wolno dodawać 
nowe gaussiany — przy Clas­
sic przez Clone/Split, przy MCMC 
przez relokację. Potem chodzi już 
tylko o udoskonalenie koloru i 
formy istniejących punktów. Wy­
żej = więcej detalu, ale też więk­
szy plik i +30-60% czasu GPU 
na krok. Typowe wartości: 15K 
(dla 30K Max-Iter), 20K (dla 40K), 
100K (dla 200K MCMC). Wisi nor­
malnie przez Link (I19) na Max 
Iterations — rzadko sensowne 
ręczne oddzielanie.
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I21 Suwak SSIM Weight

G DZ I E

Inspector → Konfiguracja treningu → GroupBox → 
SSIM Weight.

T E C H N I C Z N I E

Suwak 0.0–1.0 w krokach 0.05, wyświetlanie jako 
„0.20″. Miesza L1-Loss (0.0) i SSIM-Loss (1.0). L1 
napina jasność na piksel, SSIM podobieństwo struk
turalne (krawędzie, lokalne statystyki). Domyślnie 
0.2 to wartość z oryginalnego artykułu 3DGS (Kerbl 
2023) i reverse-engineered jako solidny kompromis 
w licznych sesjach. Wyższe wartości (0.5+) preferu
ją zachowanie detalu, mogą jednak ignorować lokal
ne błędy jasności. Niższe wartości (< 0.1) prowadzą 
do utraty detalu na ostrych krawędziach. Obliczanie 
SSIM działa w shaderze z oknem Gaussa 11×11. Wy
dajność: przy 0.0 (tylko L1) trening jest ok. 8-12% 
szybszy, ponieważ obliczanie SSIM w shaderze jest 
pomijane.

P R O S T Y M I  S ŁOWA M I

Jak silnie ważone jest podobień­
stwo strukturalne obrazu (krawę­
dzie, lokalne wzory) wobec czy­
stego porównania jasności. 0.2 
to standard z oryginalnego ar­
tykułu 3DGS i wystarcza prawie 
dla wszystkich scen. Wyżej (0.5+) 
przy drobnych strukturach jak 
włosy, futro lub roślinność — 
tam pomaga większa waga struk­
tury. Niżej (0.0) sprawia, że tre­
ning jest ok. 8-12% szybszy, po­
nieważ obliczanie SSIM w shade­
rze jest pomijane, ale kosztuje 
detal na ostrych krawędziach. 
Kto nie ma dobrego powodu do 
zmiany, zostawia 0.2.

I22 Suwak Render Scale

G DZ I E

Inspector → Konfiguracja treningu → GroupBox → 
Render Scale.

T E C H N I C Z N I E

Suwak 0.25–1.0 w krokach 0.25, wyświetlanie jako 
„100%„. Skaluje rozdzielczość renderingu treningu 
względem wielkości obrazu źródłowego. Największa 
dźwignia na wydajność: 50% redukuje czas GPU o 
ok. 75% (ponieważ 4× mniej pikseli), 25% o ok. 
94%. Próg gradientu jest automatycznie skalowa
ny razem. Pod suwakiem pojawia się wyświetlacz 
rozdzielczości na żywo w MP (np. „2304×1296 
(3.0 MP)”). Jeśli bieżąca wartość odbiega od reko
mendowanej, w pomarańczowym tekście wyświetla 
się „— recommended: 50%„. Rekomendacja celuje 
w ~3 MP efektywnej rozdzielczości — najbardziej 
efektywnie przetwarzalny zakres przez GPU Apple 
Silicon. Obrazy źródłowe 4K dostają np. automa
tycznie rekomendację 25%, obrazy FullHD 100%. 
Zmiana wyzwala dodatkowo realokację bufora.

P R O S T Y M I  S ŁOWA M I

Z jaką rozdzielczością trening 
renderuje — jedna z najwięk­
szych dźwigni wydajności. Pełna 
(100%) daje najlepszą jakość, ale 
przy dużych obrazach kosztuje 
dużo czasu GPU. Połowa (50%) 
oszczędza około 75% czasu GPU, 
ponieważ liczone jest cztery ra­
zy mniej pikseli — idealne dla 
źródeł 4K. Pod suwakiem wi­
dzisz efektywną rozdzielczość w 
megapikselach; aplikacja celuje 
w około 3 MP, ponieważ to na 
Apple Silicon działa najefektyw­
niej. Jeśli twoja wartość odbiega 
od tego, aplikacja wyświetla po­
marańczową wskazówkę „recom­
mended„ — zwykle opłaca się za 
tym podążać.
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Sekcja Enhancements (I26–I29, I42–I44)

Rysunek 12:  Wycinek sekcji Enhancements — trzy wiersze: Post-Training Compactification 
(przełącznik włączony), Viewport Scaling (segmentowany picker Off/MetalFX/Lanczos), Per

ceptual Loss (suwak na „Off„). Każdy wiersz z podtytułem wyjaśnia funkcję

Sekcja Enhancements grupuje trzy funkcje poprawiające jakość obrazu bez zmieniania 
samej rdzeniowej pętli treningu. Pierwsze dwie (I26-I27) to etapy Post-Training lub 
Viewport: Compactification sprząta po końcu treningu, Viewport Scaling to czysty 
renderer widoku, który nie wpływa na działający trening. Perceptual Loss (I29) mimo 
przynależności do sekcji jest składnikiem treningu — jest aktywowane podczas treningu 
jako dodatkowy człon loss, stąd oddzielenie od przełączników widoku przez dzielnik. 
Od wersji v1.6 sekcja ma też grupę Outdoor (I42–I44: Sky Masking, Mid-Training Floater 
Cleanup, Reconstruct Sky Dome) — opcje treningowe przeciwko floaterom nieba, które 
dawniej mieszkały w oknie ustawień, a teraz siedzą tutaj per projekt.
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I26 Przełącznik Post-Training Compactification

G DZ I E

Inspector → Enhancements → Post-Training Com
pactification.

T E C H N I C Z N I E

Aktywuje post-processing V443: po zakończeniu 
iteracji treningu gaussiany z opacity poniżej 0.01 
(1% widoczności) są usuwane. Empirycznie reduku
je to rozmiar pliku o ~55-58% przy zerowej widocz
nej utracie jakości — ponieważ te gaussiany wizual
nie i tak nie wnoszą. Compactification działa jako 
GPU-Compact-Pass i trwa zależnie od liczby gaus
sianów ułamki sekund do kilku sekund. Nie wpływa 
na wydajność treningu. Gdy ten przełącznik jest 
wyłączony, eksportowane są również niewidoczne 
gaussiany — istotne tylko, gdy chcesz użyć formatu 
do dalszego etapu treningu (Continue Training), ina
czej marnotrawstwo pamięci.

P R O S T Y M I  S ŁOWA M I

Sprząta po treningu gaussiany, 
których i tak nie widzisz (opa­
city poniżej 1%). Robi pliki eks­
portu o około połowę mniejszy­
mi ( 55-58% redukcji rozmia­
ru) bez widocznej utraty jakości. 
Działa jako krótki przebieg GPU 
po ostatniej iteracji, trwa tylko 
ułamki sekund do kilku sekund. 
Praktycznie zawsze powinno być 
włączone — jedyny powód do 
wyłączenia to gdy chcesz później 
kontynuować trening przez Con­
tinue Training i musisz zacho­
wać również niewidoczne gaus­
siany. Przy normalnych przepły­
wach eksportu po prostu zostaw 
włączone.
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I27 Picker Viewport Scaling

G DZ I E

Inspector → Enhancements → Viewport Scaling 
(segmentowany picker z trzema opcjami: Off, Me
talFX, Lanczos).

T E C H N I C Z N I E

Jeden segmentowany picker wybierający upscaler 
widoku — trzy opcje są wzajemnie wykluczające. 
Gdy rozdzielczość treningu (przez I22 Render Sca
le) jest niższa niż wielkość widoku, wybrany tryb 
skaluje wyrenderowaną klatkę do wielkości wyświe
tlania. Off = proste rozciąganie bilinearne. MetalFX 
= bazowany na ML Spatial Upscaler od Apple, naj
ostrzejsza opcja (model ML zoptymalizowany na 
ostre krawędzie), narzut ok. 1-2ms na klatkę na 
GPU M3. Lanczos = Apple Metal Performance Sha
ders z 8-Tap-Sinc-resamplingiem, klasycznie bez 
ML, minimalny narzut (< 0.5ms), jakość poniżej Me
talFX, ale bez typowego dla ML „wygładzania„ drob
nych struktur liniowych. Potok renderera jest przy 
przełączaniu na żywo rekonfigurowany — widoczne 
natychmiast, bez restartu. Tło: Wcześniej były to 
dwa osobne przełączniki (MetalFX + Lanczos), które 
mogły być włączone jednocześnie — stan sprzecz
ny, w którym MetalFX po cichu wygrywał z Lanczo
sem. Picker usuwa ten stan; ewentualnie odziedzi
czony ze starszych sesji stan „oba włączone” sam 
się leczy przy następnym przełączeniu do MetalFX. 
Wpływa tylko na widok na żywo, nie na renderowa
ne eksporty (Orbit-Video, zrzuty ekranu) — te są 
renderowane w pełnej rozdzielczości źródła.

P R O S T Y M I  S ŁOWA M I

Wyostrza obraz na żywo w wi­
doku — szczególnie użyteczne, 
gdy pracujesz ze zredukowaną 
rozdzielczością treningu (Render 
Scale 50%, zobacz I22). Trzy 
stopnie, z których zawsze aktyw­
ny jest tylko jeden: „Off„ po pro­
stu rozciąga piksele, „MetalFX” 
używa machine learningu Ap­
ple dla najostrzejszych krawędzi 
(praktycznie zawsze najlepszy 
wybór), „Lanczos„ to klasyczny 
filtr bez ML — weź go jako fal­
lback, jeśli MetalFX wygładza ci 
w jakiejś scenie linie lub pokazu­
je artefakty. Działa na żywo, bez 
restartu. Wpływa tylko na widok 
na żywo, nie na eksportowane 
wideo orbitalne ani zrzuty ekranu 
— te są renderowane w pełnej 
rozdzielczości źródła. Inaczej niż 
wcześniej nie możesz już przez 
pomyłkę wybrać dwóch trybów 
jednocześnie.
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I29 Suwak Perceptual Loss

G DZ I E

Inspector → Enhancements → Perceptual Loss.

T E C H N I C Z N I E

Suwak 0.0–0.2 w krokach 0.01, wyświetlanie przy 
0.0 jako „Off„, inaczej jako „0.05” itd. Aktywuje do
datkowy człon loss, porównujący multi-skalowany 
Gaussian-Blur renderingu z obrazem ground-truth 
(3 skale rozmycia). Wychwytuje strukturalne różni
ce, których L1+SSIM samo nie widzi. Implementacja 
V460. Empirycznie wartość 0.05-0.1 poprawia oce
nę L1 w sesjach o kilka procent, kosztuje jednak 
~5% czasu treningu (dodatkowy forward-pass przez 
jądra rozmycia). Powyżej 0.15 trening staje się nie
stabilny i L1 znowu się pogarsza (człon loss dominu
je optymalizację). Działa podczas treningu, nie w 
post-processingu — mimo pozycji w sekcji „Enhan
cements„ to nie jest więc czysta wartość dodatkowa 
post-factum.

P R O S T Y M I  S ŁOWA M I

Dodatkowy udział loss sprawdza­
jący strukturalne podobieństwo 
obrazu przez trzy różne stop­
nie rozmycia. Pomaga szczegól­
nie w scenach z drobnymi struk­
turami jak włosy, tkanina lub 
roślinność, ponieważ wychwytu­
je wzory, których L1+SSIM samo 
nie widzi. Mniejsze wartości są 
bezpieczniejsze — 0.05 do 0.1 
to sweet spot, powyżej 0.15 tre­
ning staje się niestabilny i loss 
znowu się pogarsza. Na 0 (Off) 
funkcja jest całkowicie wyłączo­
na i nic nie kosztuje; aktywna 
pochłania ok. 5% czasu trenin­
gu na dodatkowy forward-pass 
przez jądra rozmycia. Działa mi­
mo sekcji „Enhancements„ bez­
pośrednio podczas treningu, nie 
dopiero w post-processingu.
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I42 Sky Masking

G DZ I E

Inspector → Enhancements (grupa Outdo
or) → przełącznik „Sky Masking„. Bound: 
AppState.trainingConfig.skyMaskingEnabled (per 
projekt, @DefaultFalse ). Default: false .

T E C H N I C Z N I E

Aktywuje pre-trainingową segmentację pikseli nieba 
opartą na Apple Vision. Przed startem treningu dla 
każdej kamery wejściowej obszar nieba jest ekstra
howany przez maskę pierwszego planu Apple Vision 
(Sky = Background) i przypisywany jako maska na 
piksel do danej kamery. Podczas treningu wkład w 
loss na piksel jest mnożony przez dopełnienie maski 
nieba — piksele nieba wnoszą 0 do gradientu, więc 
gaussiany rzutujące w niebo nie otrzymują sygna
łów optymalizacji i tym samym nie stają się „gęst
sze„ ani „jaśniejsze”. Znacząco redukuje floatery 
(ciemne grudki na niebie) w scenach plenerowych/
dronowych. Kosztuje ~3% regresji L1 przy klasycz
nym treningu 40K (zobacz memory/​dev_​outdoor-
floater-reduction.md). Sensowne tylko w scenach 
plenerowych z wyraźnie widocznym niebem; w sce
nach wnętrz lub z białym tłem segmentacja nieba 
identyfikuje błędne obszary i blokuje ważne sygnały 
loss. Wartość jest teraz przechowywana per projekt 
(już nie globalnie dla aplikacji) i podąża za ustawie
niem wstępnym / plikiem sceny.

P R O S T Y M I  S ŁOWA M I

Przy ujęciach plenerowych z nie­
bem w kadrze powstają czę­
sto czarne lub kolorowe grud­
ki na niebie — tzw. „floatery„. 
Ta opcja automatycznie wykry­
wa, gdzie jest niebo, i mówi tre­
ningowi: „Zostaw niebo w spoko­
ju.” Działa bardzo dobrze przy 
lotach dronem i scenach krajo­
brazowych. Przy wnętrzach lub 
ciemnych tłach może pogorszyć 
obraz — więc włączaj tylko, gdy 
widać prawdziwe niebo. Szcze­
góły: memory/​dev_​outdoor-
floater-reduction.md.
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I43 Mid-Training Floater Cleanup

G DZ I E

Inspector → Enhancements (grupa Outdoor) → 
przełącznik „Mid-Training Floater Cleanup„. Bound: 
AppState.trainingConfig.floaterCleanupEnabled 
(per projekt, @DefaultFalse ). Default: false .

T E C H N I C Z N I E

Włącza przy treningu Classic-40K (ustawienie „P4 
Quality„) dwa dodatkowe przebiegi kontroli gęsto
ści: przy iteracji 20,000 i przy iteracji 30,000. Oba 
przebiegi przeszukują wszystkie gaussiany według 
trzech kryteriów: (a) bardzo niskie opacity (standard 
0.005), (b) niewielki rozmiar w przestrzeni ekranu, 
(c) brak wkładów do loss w ostatnich 1000 itera
cjach. Gaussiany spełniające wszystkie trzy warunki 
są usuwane. Efekt: ~5–15% mniej gaussianów na 
końcu treningu, widocznie mniej ciemnych grudek 
na niebie w scenach dronowych/plenerowych. Kosz
tuje ~1–3% regresji L1 w scenach wnętrz close-
-up, dlatego nie aktywowane domyślnie. Wartość 
jest zapamiętywana między restartami (w przeci
wieństwie do S7). Dwie iteracje cleanupu (20K, 
30K) są twardo zdefiniowane i obecnie nie można 
ich zmienić przez UI; przy krótszych treningach 
(np. P2 Preview 5K) przełącznik nie ma efektu, 
ponieważ nigdy nie dochodzi do oznaczeń iteracji. 
Nowość: przełącznik jest teraz operowalny tylko 
wtedy, gdy aktywne ustawienie używa densyfikato
ra Classic (densificationStrategy == .classic). 
Przy MCMC lub Hybrid jest disabled i pojawia 
się wskazówka inline, ponieważ te strategie i tak 
same obsługują martwe gaussiany (MCMC przez re
lokację, Hybrid przez połączoną logikę reloc/noise) 
— manualne przebiegi cleanupu byłyby tam niesku
teczne lub kontrproduktywne. Referencja w kodzie: 
RadianceKitApp.swift, karta General. Szczegóły: 
memory/​dev_​outdoor-floater-reduction.md.

P R O S T Y M I  S ŁOWA M I

Podczas treningu powstają cza­
sem „martwe„ punkty gaussow­
skie, które nic już nie wnoszą 
do jakości obrazu, ale zajmują 
pamięć. Ta opcja sprząta dwu­
krotnie podczas długiego trenin­
gu (przy 20K i 30K iteracji) i 
usuwa te zwłoki. W scenach ple­
nerowych z niebem jest to szcze­
gólnie sensowne, ponieważ tam 
zbiera się większość floaterów. 
Przy małych treningach lub zbli­
żeniach mebli raczej niepotrzeb­
ne. Przełącznik da się włączyć 
tylko wtedy, gdy twoje ustawie­
nie używa densyfikatora Classic 
— przy ustawieniach MCMC lub 
Hybrid jest wyszarzony (wraz z 
krótkim wyjaśnieniem), ponieważ 
one same sprzątają swoje mar­
twe punkty.
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I44 Reconstruct Sky Dome

G DZ I E

Inspector → Enhancements (grupa Outdoor) → 
przełącznik „Reconstruct Sky Dome„. Bound: 
AppState.trainingConfig.skyDomeEnabled (per pro
jekt, @DefaultFalse ). Default: false .

T E C H N I C Z N I E

Aktywuje projekcję Sky-Dome przed treningiem 
(MVP V549e). Po SfM i przed startem treningu 
dla każdej kamery wejściowej maska nieba Apple 
Vision wspólna z S7 jest ekstrahowana z obrazu, 
piksele nieba są ze współczynnikami wewnętrznymi 
kamery odrzutowywane na powierzchnię wirtualnej 
kuli (standardowy promień 8× promień sceny). Na 
tej kuli inicjalizowanych jest ~5000 nowych gaussia
nów ze średnimi kolorami z odrzutowanych pikseli 
nieba, bardzo dużą skalą (1.0 w jednostkach sceny) 
i początkową opacity 0.95. Te 5000 gaussianów to 
nie jest klasyczna maska nieba — są trenowane 
jak wszystkie inne, ale przez wysoką początkową 
opacity pozostają w cienkiej skorupie. Wynik: przy 
widokach Novel-View 360° w scenach plenerowych/
dronowych zamiast ciemnych grudek confetti poja
wiają się faktyczne kolory nieba i struktury chmur. 
Wartość jest zapamiętywana między restartami. 
Sensowne tylko w scenach plenerowych z co naj
mniej 360° pokrycia kamer; przy czystych Object-
-Capture bez widoku nieba nie ma efektu. Status: 
eksperymentalne, szersza walidacja A/B na dalszych 
zestawach plenerowych jeszcze przed nami.

P R O S T Y M I  S ŁOWA M I

Zamiast tego, by trening pró­
bował „zgadnąć„ niebo z kilku 
widocznych pikseli (co prowadzi 
do floaterów), RadianceKit rzutu­
je piksele nieba bezpośrednio na 
wirtualną kulę wokół sceny przed 
startem treningu. Gdy potem ob­
rócisz gotową scenę w 360°, wi­
dzisz prawdziwe niebo zamiast 
czarnych grudek. Działa tylko 
przy ujęciach plenerowych, gdzie 
faktycznie niebo jest w kadrze. 
Przy skanach salonu lub ujęciach 
studyjnych nic nie daje.
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Sekcja Metryki (I30–I38)

Rysunek 13:  Wycinek sekcji Training Metrics po zakończonym treningu na bukiecie (5K ite
racji, 2 991 gaussianów finalnie) — tabela z metrykami treningu (Iteration, Loss, SSIM Loss, 

Combined Loss, Gaussian Count, Learning Rate, Elapsed, ETA)

Podczas działania treningu sekcja metryk pokazuje dziewięć wartości na żywo z pętli 
treningu. Przed startem treningu sekcja jest pusta („Start training to see live metrics„). 
Wszystkie wartości są aktualizowane co ~30 iteracji (częstotliwość aktualizacji strumie
nia). Sekcja jest read-only — żaden element nie jest klikalny ani zmienialny. Do głębszej 
analizy weź logi JSONL treningu z ~/​Documents/​RadianceKit/​Logs/​ (skrypt python3 
scripts/​analyze_​logs.py best 5).
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I30 Iteration

G DZ I E

Inspector → Metryki → Iteration. Read-only.

T E C H N I C Z N I E

Wyświetlanie w formacie „4523 / 40000″ — bieżąca 
iteracja przez łączną planowaną. Liczy synchronicz
nie z pętlą treningu, która pushuje wartości co ~30 
iter. Druga liczba odpowiada wartości Max-Itera
tions w momencie startu; nie zmienia się więcej, na
wet gdy użytkownik przekręci stepper — działający 
przebieg używa własnej kopii migawki. Gdy aplika
cja przez menu Training dosypuje iteracji (Continue 
Training +5K/+10K/+20K), mianownik się zwiększa.

P R O S T Y M I  S ŁOWA M I

Gdzie trening obecnie stoi. 
„4523 / 40000″ oznacza: 4523 
z 40 000 kroków przeszło, więc 
około 11%. Lewa liczba odlicza 
w takcie sekundowym; gdy stoi 
przez minuty, trening zawiesił się 
— zazwyczaj wskazówka na GPU-
-Throttling lub konkurencyjną 
aplikację. Prawa liczba odpowia­
da wartości Max-Iterations (I18) 
przy starcie treningu i nie zmie­
nia się więcej, nawet gdy później 
przekręcisz stepper. Przy Conti­
nue Training (+5K/+10K/+20K) ro­
śnie o dodatkowe kroki.

I31 Loss

G DZ I E

Inspector → Metryki → Loss. Read-only.

T E C H N I C Z N I E

Wartość float z sześcioma miejscami po przecin
ku (np. „0.024385″). Mierzy kombinowany Loss 
L1+SSIM (mix kontrolowany przez I21 SSIM Weight) 
plus opcjonalnie Perceptual Loss (I29) i inne regu
larizery. Skala nie jest absolutna, lecz zależna od 
sceny — wymaga dla większości porównań tego sa
mego zestawu danych. Typowe wartości końcowe 
przy dobrych konfiguracjach: - Classic Quality 40K 
iter: 0.022–0.025 (Horse, Truck, Garden) - MCMC 
Full 200K iter: 0.024–0.028 - Outdoor Dron 30K: 
0.030–0.060 (gorsze z powodu geometrii) - Indoor 
Apartments: 0.018–0.025

Wartości powyżej 0.10 po 5K iteracjach wskazują na 
problemy SfM (złe pozy kamer) — przerwij i policz 
SfM od nowa.

P R O S T Y M I  S ŁOWA M I

Jak bardzo wyrenderowany obraz 
odbiega jeszcze od oryginału — 
kombinacja z L1, SSIM i ewen­
tualnie Perceptual Loss. Mniej­
sze jest lepiej. Poniżej 0.03 jest 
zwykle naprawdę dobrze, poniżej 
0.05 jeszcze okej, sceny plene­
rowe leżą z powodu geometrii 
raczej przy 0.03-0.06. Powyżej 
0.10 po kilku tysiącach iteracji 
to sygnał ostrzegawczy — zwy­
kle przyczyna leży w rekonstruk­
cji kamer (SfM nie zadziałało czy­
sto). Skala nie jest absolutna, 
lecz zależna od sceny; porówna­
nia robić tylko w ramach tego sa­
mego zestawu danych. Gdy licz­
ba nagle skacze w górę, zwykle 
wydarzyło się zdarzenie eksplozji 
gradientu.
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I32 Learning Rate

G DZ I E

Inspector → Metryki → Learning Rate. Read-only.

T E C H N I C Z N I E

Wyświetlanie w notacji naukowej (np. „1.60e-04″). 
Bieżący współczynnik uczenia dla parametrów po
zycji (3DGS ma sześć niezależnych LR dla pozycji, 
SH-DC, SH-Rest, opacity, skali, rotacji — wyświetla
ny jest tu LR pozycji jako wartość reprezentatywna). 
Domyślna wartość początkowa 1.6e-4, opadająca 
przez Exponential-Decay do ~1.6e-6 na końcu tre
ningu. Spadek można dostosować przez pole LR-
-Schedule w konfiguracji treningu (pole T w rozdz. 
6). Gdy LR pozostaje niezwykle wysokie (np. 1e-3 
lub więcej po 10K iteracji), może to wskazywać na 
błędnie załadowaną konfigurację.

P R O S T Y M I  S ŁOWA M I

Jak duże są obecnie kro­
ki optymalizacji — konkretnie 
współczynnik uczenia dla po­
zycji gaussianów. Startuje przy 
1.60e-04 i opada wykładniczo 
do około 1.60e-06 na końcu tre­
ningu („1.60e-06″ = 0.0000016). 
Przebieg działa automatycznie, 
niczego tu nie musisz dostra­
jać. Gdy wartość po 10 000+ 
iteracjach jest wciąż większa 
niż 1e-3, prawdopodobnie zosta­
ła załadowana błędna config — 
przerwij trening i wybierz usta­
wienie wstępne na nowo. We­
wnętrznie 3DGS ma sześć nieza­
leżnych współczynników uczenia 
(pozycja, SH-DC, SH-Rest, opaci­
ty, skala, rotacja); tutaj widzisz 
tylko LR pozycji jako zastępcę.

I33 SH Degree

G DZ I E

Inspector → Metryki → SH Degree. Read-only.

T E C H N I C Z N I E

Liczba całkowita 0-3. Stopień Spherical Harmonics 
dla reprezentacji koloru. Zaczyna od 0 (tylko kom
ponenta DC, tj. niezależny od kierunku kolor na 
gaussiana — czyli tylko stała RGB) i rośnie progre
sywnie podczas treningu do 3. Standardowy harmo
nogram podnosi stopień przy 1000/2000/3000 ite
racjach o po
1. SH-3 odpowiada 48 współczynnikom koloru na 

gaussiana (3

kanały RGB × 16 funkcji bazowych SH). Wyższy 
stopień SH = więcej zależnego od kierunku odbicia 
(błyszczące powierzchnie pod różnymi kątami wi
dzenia wyglądają poprawnie różnie), ale też więcej 
pamięci i wolniejszy trening.

P R O S T Y M I  S ŁOWA M I

Jak złożona jest obecnie repre­
zentacja koloru na gaussiana. 
Startuje przy 0 (tylko jeden nie­
zależny od kierunku kolor na 
punkt) i jest stopniowo podcią­
gana na 3 — typowo przy itera­
cji 1000, 2000 i 3000. Stopień 
3 oznacza 48 współczynników 
koloru na gaussiana i pozwala 
na zależne od kierunku odbicia, 
czyli że błyszczące powierzch­
nie wyglądają poprawnie różnie z 
różnych kątów widzenia. Nie mu­
sisz aktywnie ruszać, harmono­
gram działa automatycznie. Wyż­
szy stopień kosztuje więcej pa­
mięci i lekko spowalnia trening 
— ale to cena za realistyczne re­
fleksy.
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I34 Gaussians

G DZ I E

Inspector → Metryki → Gaussians. Read-only.

T E C H N I C Z N I E

Bieżąca liczba gaussianów w modelu, sformatowana 
z separatorem Locale (np. „524.318″). Wzrost: - 
Classic: startuje od punktów początkowych SfM (ty
powo 50K-300K), rośnie przez Clone/Split aż krótko 
przed Densify Until, potem statyczne do końca tre
ningu (modulo Pruning) - MCMC: punkty Sample są 
dodawane do MCMC-Cap, potem tylko relokacja

Zdrowe wartości końcowe: - Classic Quality: 
400K-700K (Horse 524K, Garden 800K) - MCMC 
Full: dokładnie na cap (domyślnie 150K, z Auto-
-Scale Multiplier × SfM-Count zależnie od sceny 
500K-1.5M)

Przy MCMC liczba spada do < 60% cap → anomalia 
(wskaźnik kolapsu, wskazuje na zbyt agresywne re
gularizery).

P R O S T Y M I  S ŁOWA M I

Ile punktów gaussianów ma 
obecnie model 3D. Rośnie pod­
czas treningu, aż osiągnięte zo­
stanie Densify Until (I20); potem 
liczba pozostaje praktycznie sta­
ła. Więcej punktów = więcej de­
talu, ale też większy plik i wol­
niejsze renderowanie w widoku. 
500.000 gaussianów to typowa 
średnia wartość dla Classic-Qu­
ality na średniej scenie; MCMC 
Full ląduje w zależności od Auto-
-Scale (I17) przy 500K do 1.5M. 
Gdy liczba przy MCMC nagle spa­
da poniżej 60% cap, to wskaźnik 
kolapsu — zwykle zbyt agresyw­
ne regularizery.

I35 GPU Memory

G DZ I E

Inspector → Metryki → GPU Memory. Read-only.

T E C H N I C Z N I E

Oszacowanie zużycia pamięci bufora gaussianów 
jako liczba gaussianów × 616 bajtów (sformatowa
ne w stylu Memory). 616 bajtów to empiryczny 
rozmiar w pełni wyposażonego gaussiana (pozycja, 
skala, rotacja, opacity, współczynniki SH stopień 3, 
akumulator gradientu). Wyświetlanie nie obejmuje 
narzutu renderera (bufor kafelków, bufor sortowa
nia, bufor backward) — realne zapotrzebowanie na 
pamięć GPU leży typowo 2-3× powyżej tej wartości. 
Przy 500K gaussianów: wyświetlane ~290 MB, real
nie ~700 MB. Przy 1.5M gaussianów: wyświetlane 
~880 MB, realnie ~2.5 GB. Na M3 Max z 64+ GB 
Unified Memory niekrytyczne, na M3 Pro z 18 GB już 
limit.

P R O S T Y M I  S ŁOWA M I

Oszacowanie, ile pamięci GPU 
zajmują same gaussiany — około 
616 bajtów na punkt. Faktyczne 
zużycie GPU jest 2-3× wyższe niż 
wyświetlane, ponieważ renderer 
dokłada jeszcze własne bufory 
kafelków, sortowania i backward. 
Przy MacBooku z 16-18 GB Uni­
fied Memory powinieneś pozo­
stać poniżej 500K gaussianów; z 
M3 Max lub Studio (64+ GB) mo­
żesz luźno jechać 1.5M i więcej. 
Gdy trening nagle się wywala lub 
system swapuje, zwykle granica 
jest tu osiągnięta — Render Sca­
le (I22) w dół lub Densify Until 
(I20) zredukować.
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I36 Speed

G DZ I E

Inspector → Metryki → Speed. Read-only.

T E C H N I C Z N I E

Iteracje na sekundę z jednym miejscem po przecin
ku („24.3 it/s„). Obliczone przez trener jako średnia 
krocząca z ostatnich ~100 iteracji. Typowe wartości: 
- Quick Preset (1K iter): 80-120 it/s (krótko, brak 
steady-state) - Classic 20K @ 1.0 Render Scale 
(scena Truck, M3 Max): 25-35 it/s - Classic 20K @ 
0.5 Render Scale: 80-120 it/s - MCMC 200K @ 0.5 
Render Scale: 25-50 it/s (wolniejsze z powodu relo
kacji) - Przy 1M+ gaussianów i pełnej rozdzielczości: 
< 10 it/s

Spadająca prędkość w trakcie treningu jest normal
na — więcej gaussianów = więcej compute na itera
cję. Nagłe spadki (np. z 30 → 5 it/s) wskazują na 
GPU-Thermal-Throttling lub konkurujące aplikacje.

P R O S T Y M I  S ŁOWA M I

Jak szybko trening działa, w ite­
racjach na sekundę. Stoi typowo 
przy 20-50 it/s, przy zredukowa­
nej Render Scale (50%) i małych 
scenach również czasem 80-120 
it/s. Spada w trakcie treningu zu­
pełnie naturalnie, ponieważ wię­
cej gaussianów = więcej pracy 
na iterację. Nagłe spadki (np. 30 
→ 5 it/s) wskazują na GPU-Ther­
mal-Throttling lub konkurujące 
aplikacje — karty przeglądarki 
z wideo, backup Time Machine, 
indeksowanie Photos. Trzymanie 
aplikacji na pierwszym planie i 
zamykanie programów w tle czę­
sto pomaga. Przy 1M+ gaussia­
nów i pełnej rozdzielczości poni­
żej 10 it/s są normalne.

I37 Elapsed

G DZ I E

Inspector → Metryki → Elapsed. Read-only.

T E C H N I C Z N I E

Już upłynęły czas jako „4:23″ (m:ss) lub „1:23:45″ 
(h:mm:ss). Przełączenie formatu od 1 godziny. Mie
rzy tylko czysty czas treningu, nie poprzedzające 
fazy (obliczenia SfM, import obrazów). Przy Pause/
Resume zegar idzie dalej — jest więc wall-clock, nie 
czas CPU.

P R O S T Y M I  S ŁOWA M I

Jak długo trening już działa, jako 
czysty stoper (czas wall-clock). 
Format to „m:ss„ do jednej 
godziny, potem „h:mm:ss”. Nie 
„czas CPU„, tylko „jak długo już 
czekamy” — więc też czasy pau­
zy się liczą. Mierzy tylko czystą 
fazę treningu, nie poprzedzające 
obliczenia SfM ani import obra­
zów. Pomocne do porównania z 
ETA (I38) — gdy Elapsed znaczą­
co wystrzela poza pierwotne ETA, 
trening gdzieś stał się wolniejszy 
niż planowane.
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I38 ETA

G DZ I E

Inspector → Metryki → ETA. Read-only.

T E C H N I C Z N I E

Szacowany czas pozostały jako „17:42″ lub 
„1:12:35″. Obliczenie: (Max Iterations − bieżąca ite
racja) / iteracje na sekundę. Pokazuje „–„, gdy pręd
kość jest właśnie zero (zupełnie na początku lub 
przy pauzie). Oszacowanie nie jest dostosowywane 
do typowego spowolnienia pod koniec treningu — 
zwłaszcza przy MCMC i Classic z dużymi warto
ściami Densify-Until trening ma tendencję stawać 
się wolniejszym, ponieważ coraz więcej gaussia
nów wchodzi do obrazu. Realnie pozostaje typowo 
10-20% powyżej początkowego ETA.

P R O S T Y M I  S ŁOWA M I

Jak długo prawdopodobnie jesz­
cze trzeba czekać — obliczone 
z pozostałych iteracji i bieżącej 
prędkości (I36). Zgrubne osza­
cowanie: gdy Mac nagle staje 
się wolniejszy (więcej gaussia­
nów od fazy densyfikacji, Ther­
mal-Throttling, inne aplikacje), 
może trwać dłużej niż wyświe­
tlane. Aplikacja nie wlicza typo­
wego spowolnienia pod koniec 
treningu, dlatego prawdziwy ko­
niec ląduje zwykle 10-20% powy­
żej początkowego ETA. Doliczyć 
plus 15%, wtedy zwykle pasuje. 
Pokazuje „–„, gdy prędkość jest 
właśnie 0 (początek treningu lub 
pauza).
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Sekcja wykresu straty (I39–I41)

Rysunek 14:  Wycinek sekcji Loss History po zakończonym treningu — Current 0.0064, Min 
0.0035 (zielony), niebieski przebieg z 0.027 (iteracja 1) do 0.0035 (iteracja 5K) z charaktery

stycznym zagięciem ok. iter 200, pod spodem wykres Gaussian Count pomarańczowy

Sekcja wykresu straty wizualizuje przebieg treningu w czasie. Składa się z dwóch 
wykresów: wykresu krzywej Loss (duży, u góry, niebieski) i wykresu liczby gaussianów 
(mniejszy, na dole, pomarańczowy). Oba są budowane na żywo podczas treningu i 
persistują do następnego startu treningu. Przed pierwszym treningiem obszar jest pusty 
(„Loss curve will appear during training„). Wykresy są czystymi rysunkami SwiftUI-Path 
(brak frameworku Swift-Charts), aby również przy 100K+ punktach renderowały się 
płynnie.
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I39 Current Loss (wyświetlanie)

G DZ I E

Inspector → wykres straty → lewy obszar etykiety 
„Current: 0.0287″. Read-only.

T E C H N I C Z N I E

Wartość float ostatniego punktu próbki Loss, sfor
matowana z czterema miejscami po przecinku. 
Identyczna z I31 (Loss w sekcji Metrics), tylko sfor
matowana tu bardziej zwarto. Źródłem jest historia 
Loss — lista, która otrzymuje wpis na ~30 iteracji. 
Tylko wartości skończone są wpisywane na listę 
— NaN/Infinity (bardzo rzadkie, w przypadku błędu 
eksplozji gradientu) są filtrowane.

P R O S T Y M I  S ŁOWA M I

Bieżąca wartość Loss w krótszym 
zapisie niż w sekcji Metrics (czte­
ry miejsca po przecinku). Tre­
ściowo identyczna z I31, ale tutaj 
wyświetlanie siedzi bezpośred­
nio przy wykresie Loss i daje ci 
przy obserwacji krzywej dokład­
ną wartość liczbową. Aktualizo­
wane jak wszystkie metryki na 
żywo co  30 iteracji. Wartości 
NaN lub Infinity (skrajnie rzadkie 
przy błędach eksplozji gradien­
tu) aplikacja automatycznie od­
filtrowuje. Użyteczne, aby przy 
patrzeniu na wykres nie musieć 
skakać do innej sekcji.

I40 Min Loss (wyświetlanie)

G DZ I E

Inspector → wykres straty → prawy obszar etykiety 
„Min: 0.0245″ (zielony). Read-only.

T E C H N I C Z N I E

Minimum wszystkich kiedykolwiek widzianych war
tości Loss bieżącego przebiegu treningu. Rekompu
towane na żywo z historii Loss — brak osobnej 
persistencji. Wyświetlane zielonym tekstem, ponie
waż „Min„ = „Best so far”. Przerywana zielona linia 
na dolnej krawędzi wykresu wizualnie zaznacza tę 
pozycję Y. Przy sesjach Continue-Training śledzenie 
minimum startuje od nowa — stara historia jest w UI 
zastępowana nową (nie doczepiana). Gdy bieżący 
trening idzie gorzej niż poprzedni, wyświetlanie Min 
może więc być większe niż poprzedni wynik końco
wy.

P R O S T Y M I  S ŁOWA M I

Najniższa wartość Loss, którą ten 
trening dotychczas widział — 
wyświetlana zielonym, ponieważ 
„best so far„. Przerywana zielona 
linia na dolnej krawędzi wykresu 
zaznacza tę pozycję również wi­
zualnie. Gdy bieżąca krzywa leży 
właśnie wyraźnie powyżej, jest 
szansa jeszcze poprawy; zwy­
kle Min jest jednak wskaźnikiem 
wyniku końcowego, który cię 
później interesuje. Przy sesjach 
Continue-Training śledzenie Min 
startuje od nowa, ponieważ stara 
historia w UI jest zastępowana 
nową — wartość Min może przez 
to wyglądać gorzej niż poprzedni 
wynik końcowy.
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I41 Wykres Gaussian Count

G DZ I E

Inspector → wykres straty → drugi wykres pod 
spodem (pomarańczowy). Read-only.

T E C H N I C Z N I E

Wykres liniowy liczby gaussianów w iteracjach tre
ningu. Źródło: historia Gaussian-Count (lista par 
(Iter, Count), wypełniana przez trener co ~30 iter). 
Skala Y dynamiczna między minimum a maksimum 
historii. Przy strategii Classic krzywa wygląda zwy
kle tak: stale rośnie do Densify Until, potem płasko 
(z małymi wahaniami pruningu). Przy MCMC: stromy 
wzrost do cap, potem horyzontalna linia (relokacja 
utrzymuje liczbę stałą). Gdy krzywa opada mimo 
aktywnego treningu, densyfikacja zbyt agresywnie 
pruninguje — wskazówka na błędne domyślne lub 
znany błąd MCMC-Collapse (temat v1.4.4-Hotfix).

P R O S T Y M I  S ŁOWA M I

Jak liczba gaussianów rozwija się 
w czasie treningu — mniejszy 
pomarańczowy wykres pod krzy­
wą Loss. Przy strategii Classic 
linia stale rośnie, aż osiągnięte 
zostanie Densify Until (I20), po­
tem pozostaje płasko z małymi 
wahaniami pruningu. Przy MCMC 
strzela stromo do cap i pozosta­
je horyzontalna, ponieważ relo­
kacja utrzymuje liczbę stałą. Gdy 
krzywa mimo aktywnego trenin­
gu nagle zagina się w dół, den­
syfikacja zbyt agresywnie pru­
ninguje — klasyczna oznaka błę­
du MCMC-Collapse z v1.4.4. Wte­
dy pomaga aktualizacja aplikacji 
lub przełączenie z powrotem na 
Classic.

Jak czytać krzywą Loss?

Wykres Loss jest najważniejszym narzędziem diagnostycznym w Inspectorze — żaden 
inny wskaźnik nie pokazuje tak bezpośrednio, czy trening posuwa się użytecznie do 
przodu, czy zawisł. Typowa zdrowa forma to szybki spadek w pierwszych 1000-3000 
iteracji (z ~0.15 na ~0.05), po którym następuje powolny, równomierny spadek do 
końca treningu (na 0.020-0.030). Logarytmicznie krzywa wygląda przy tym jak gładka 
przekątna.

Co oznacza plateau przy Loss? Gdy krzywa pozostaje płaska przez kilka tysięcy itera
cji, są dwie możliwe lektury: (a) trening jest „zbieżny„ — Loss nie może już znacząco 
spadać, ponieważ model jest tak dobry, jak może być z danymi danych i ustawieniami. 
Jest to pożądane; to „gotowe”. (b) trening „wisi„ — Loss mógłby właściwie jeszcze 
spadać, ale optymalizacja stagnuje (minimum lokalne, współczynnik uczenia za mały, 
densyfikacja wyłączona). Rozróżnić: gdy wartość Loss leży w typowym dobrym zakresie 
(0.020-0.030 przy Indoor/Object, 0.040-0.060 przy plenerze) i krzywa od 5K iteracji 
jest płaska, jest zbieżne. Gdy wartość jest wyraźnie wyższa niż przy porównywalnych 
scenach (np. 0.08), zawisła.

Uwaga plateau gaussianów ≠ plateau Loss. Plateau w liczbie gaussianów nie oznacza 
„trening jest gotowy„. Oznacza tylko, że densyfikacja przestała dodawać nowe punkty 
— albo dlatego, że osiągnięto (Classic), albo dlatego, że cap MCMC jest pełny. Trening 
działa potem dalej i udoskonala już tylko istniejące punkty. Właściwy sygnał „gotowe” 
czytasz na krzywej Loss i wskaźniku iteracji (I30), nie tutaj.

Reguła kciuka do przerwania: gdy krzywa Loss po 5000+ iteracjach leży powyżej 0.08 
i prawie już nie spada, z wysokim prawdopodobieństwem rekonstrukcja SfM jest skrzy
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wiona. Przerwij trening, w rozdziale 9 sprawdź, czy wybrany backend SfM pasuje do 
sceny, ew. przełącz na COLMAP/Native, potem startuj na nowo. Lepiej zainwestować 10 
minut w lepsze SfM niż 2 godziny treningu ze złym wyrównaniem kamer.

Kiedy sięgnąć po Inspector?

Szybka referencja: która sekcja + które kontrolki dla którego typowego use-case?
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Typowe zadanie Sekcja ID kontrolek

Odbarwić kolory gotowego 
Splata

Look L1 (Saturation)

Zaokrąglić igłowe/konfetti 
Splaty

Look L2 (Splat length)

Wypełnić dziurawą chmurę / 
powiększyć Splaty

Look L3 (Splat size)

Wygasić dalekie „konfetti da
li„ przy orbitach

Look L4 (Fade far region)

Odrzucić korekty Look Look L5 (Reset finishing)

Wczytać predefiniowany setup Presets I7 (klik na wiersz)

Zapisać własny setup Presets I1 → I2 → I4

Udostępnić setup kolegom Presets I5 (Export) lub I6 (Import)

Zmienić backend SfM (np. po
nieważ Apple-PG zbyt niesta

bilne)

Konfiguracja trenin
gu

I12 (zobacz rozdz. 9)

Przetwarzać klatki wideo bez 
ogniskowej EXIF

Konfiguracja trenin
gu

I13 (FOV Override)

Wydajność COLMAP: GLOMAP 
zamiast klasycznego

Konfiguracja trenin
gu

I14

Z Classic na MCMC przełączyć Konfiguracja trenin
gu

I15

Trening dłużej działać Konfiguracja trenin
gu

I18 (Max Iter) + I20 (Densify 
Until) — sprzężone przez I19

Czas GPU zmniejszyć o połowę Konfiguracja trenin
gu

I22 (Render Scale na 50%)

Jakość treningu +6% (MCMC) Konfiguracja trenin
gu

I16 (MCMC Quality)

Scena plenerowa z wieloma 
punktami SfM

Konfiguracja trenin
gu

I17 (Auto-scale by scene)

Skonfigurować/zmienić ścieżkę 
COLMAP

Konfiguracja trenin
gu

I23 / I24 / I25

Zmniejszyć pliki eksportu Enhancements I26 (zawsze zostawić włączo
ne)

Widok ostrzejszy bez dodatko
wego czasu treningu

Enhancements I27 (Viewport Scaling → Me
talFX)

MetalFX zbyt wygładza → al
ternatywa

Enhancements I27 (Viewport Scaling → Lan
czos)

Ostatnia kropla detalu przy 
drobnych strukturach

Enhancements I29 (Perceptual Loss 0.05-0.1)

Nadzorować trening Metryki I30 (postęp), I36 (tempo), I38 
(pozostały czas)

Wcześnie ocenić jakość Metryki I31 (Loss < 0.05 po 5K = dobre)Podejrzenie problemu SfM Metryki + wykres 
Loss

I31 + I39 (Loss > 0.08 po 5K → 
SfM od nowa)

Convergence vs Stuck rozróż
nić

wykres straty I39 + I40 (czytanie plateau 
Loss)

Rozpoznać problem densyfika
cji

wykres straty I41 (krzywa gaussianów spada 
→ błąd)66 / 233



R A D I A N C E K I T Rozdział 2 — Inspector (Expert View)

R O Z D Z I A Ł

Rozdział 3 — Ustawienia

Okno ustawień otwiera się przez RadianceKit → Ustawienia... lub standardowy skrót 
klawiszowy ⌘, . Zawiera dwie karty: General i AI Helpers. W przeciwieństwie do war
tości Inspectora z rozdziału 2 ustawienia z tego okna działają globalnie dla aplikacji 
(we wszystkich projektach) — są trwale zapisywane i przeżywają restarty aplikacji. 
Karta General grupuje trzy sekcje tematyczne: Interface, Viewport i Training. Karta AI 
Helpers włącza pomocniki on-device do machine learningu (Vision, CoreML) dla wstęp
nego przetwarzania SfM i treningu. (Trzy przełączniki redukcji floaterów plenerowych — 
Sky Masking, Mid-Training Floater Cleanup, Reconstruct Sky Dome — które dawniej tu 
mieszkały, od wersji v1.6 przeniosły się do sekcji Enhancements w Inspectorze ekspert
skim, gdzie są teraz przechowywane per projekt; zobacz rozdział 2, I42–I44.)

Wcześniejsze elementy sterujące do zbiorczego włączania lub wyłączania wszystkich 
AI-Helpers w obecnej wersji już nie istnieją — odpowiednio nie są tu dokumentowane. 
Również wcześniejszy obszar „Coming Soon„ dla jeszcze niewysłanych pomocników 
został usunięty i nie jest tu referowany.
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Karta General

Rysunek 15:  Ustawienia → karta General z sekcjami Interface, Viewport, Training i Experi
mental
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S1 Default Mode

G DZ I E

Settings → General → Interface → selektor Default 
Mode. Bound:. Default: .simple .

T E C H N I C Z N I E

Steruje, w którym z dwóch trybów UI aplikacja 
otwiera się po następnym uruchomieniu. „Sim
ple Mode„ to prowadzony przepływ kreatora w 
4 krokach (Import → Processing → Preview → 
Export, udokumentowany w rozdziale 10 pod Z1–
Z4), „Expert Mode” to klasyczny układ trzech paneli 
z nawigatorem, widokiem 3D i Inspectorem ekspert
skim z rozdziału 2. Wartość jest zapamiętywana 
między restartami. Identyczny efekt jak menu Mode 
→ Simple Mode (⌘1) / Mode → Expert Mode (⌘2), z 
tym że menu przełącza bieżącą sesję, podczas gdy 
ten selektor ustala wartość domyślną dla przyszłych 
sesji. Oba tryby sięgają do tego samego stanu pro
jektu — projekty, kamery i konfiguracja treningu po
zostają zachowane przy zmianie trybu. Specyficzne 
dla trybu przyciski paska narzędzi są natychmiast 
ponownie renderowane.

P R O S T Y M I  S ŁOWA M I

Tutaj wybierasz, z jakim inter­
fejsem RadianceKit startuje przy 
następnym uruchomieniu. „Sim­
ple Mode„ to tryb początkujący: 
cztery przejrzyste kroki, predefi­
niowane ustawienia, prawie żad­
nych opcji. „Expert Mode” to peł­
ny układ skrzynki z narzędziami 
ze wszystkimi pokrętłami, jakie 
widzisz w rozdziale 2. Możesz 
w każdej chwili przełączać się 
przez menu „Mode„ tam i z po­
wrotem, bez utraty obrazów ani 
postępu treningu.

S2 Language

G DZ I E

Settings → General → Interface → selektor Langu
age. Bound:. Default: .system  (podąża za językiem 
macOS).

T E C H N I C Z N I E

Wybiera język wyświetlania całego UI aplikacji, 
niezależnie od języka systemu macOS. Radiance
Kit jest zlokalizowany w 17 językach ( de , en , 
pl , en-AU , ar-SA , plus 12 dalszych). Przy „Sys

tem„ aplikacja podąża za językiem macOS. Przy 
jawnym wyborze ustawienie języka jest zapamięty
wane między restartami; pełne działanie wymaga z 
reguły restartu aplikacji, ponieważ pakiety lokalizacji 
są ładowane tylko przy starcie. 298 udokumento
wanych kluczy lokalizacji w projekcie są wszystkie 
uwzględniane, włącznie ze wszystkimi tekstami w 
sub-widokach i podpowiedziach pomocy.

P R O S T Y M I  S ŁOWA M I

Jeśli twój Mac działa po angiel­
sku, ale wolisz niemiecki inter­
fejs RadianceKit (lub odwrotnie), 
ustaw to tutaj. Większość tek­
stów zmienia się natychmiast. 
Niektóre okna dialogowe poja­
wiają się w nowym języku dopie­
ro po restarcie aplikacji.
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S3 Viewport Background

G DZ I E

Settings → General → Viewport → selektor Backgro
und. Bound:. Default: .darkGray  (RGB 0.1, 0.1, 0.1).

T E C H N I C Z N I E

Ustawia domyślny kolor tła dla widoku 3D. Trzy 
opcje: „Dark Gray„ (RGB 0.1, 0.1, 0.1 — domyślne), 
„Black” (0, 0, 0) i „White„ (1, 1, 1). Ustawienie utrwa
la domyślną wartość dla nowych projektów i sesji 
przez restarty i jednocześnie natychmiast aktuali
zuje działający renderer Metal. Identyczne opcje 
znajdują się w menu Viewport → Background (M21, 
M22, M23), ale selektor ustawień ustawia domyślne, 
podczas gdy menu przełącza bieżący wyświetlany 
obraz. Ważne dla zrzutów ekranu i wideo demon
stracyjnych: białe tła silniej uwypuklają zielone/nie
bieskie floatery, ciemne tła są lepsze do czystych 
ujęć renderowanych.

P R O S T Y M I  S ŁOWA M I

Kolor za twoimi modelami 3D 
w oknie podglądu. Ciemnosza­
re jest standardem i pasuje do 
większości scen. Biały jest do­
bry do zrzutów ekranu, czarny 
działa bardziej elegancko przy 
ujęciach renderowanych. Możesz 
kolor w każdej chwili przełączyć 
przez menu „Viewport → Back­
ground„ dla bieżącej sceny — to 
ustawienie określa tylko, jaki ko­
lor ma być aktywny przy następ­
nym otwarciu.

S4 Auto-Rotate After Training

G DZ I E

Settings → General → Viewport → przełącznik „Au
to-Rotate After Training„. Bound:. Default: false .

T E C H N I C Z N I E

Startuje bezpośrednio po zakończeniu treningu cią
głą rotację typu turntable kamery widoku wokół 
środka ciężkości sceny (standardowa prędkość ob
rotu ~0.3 rad/s). Praktycznie użyteczne do sesji 
demonstracyjnych, porównań A/B oraz do bezpo
średniej oceny w widoku 360°, czy na brzegu 
sceny powstały „floatery„. Efekt jest wizualnie iden
tyczny z menu Viewport → Toggle Auto-Rotation 
(M16, ⌘⌥T), z tym że przełącznik tutaj wyzwala 
zachowanie automatycznie po zakończeniu treningu 
zamiast ręcznie. Można w dowolnej chwili przerwać 
przez menu lub kliknięcie w widok (co pauzuje 
rotację). Nie ma wpływu na wydajność treningu — 
rotacja startuje dopiero, gdy trening jest gotowy.

P R O S T Y M I  S ŁOWA M I

Gdy włączone, scena 3D obraca 
się automatycznie, gdy tylko tre­
ning się zakończy — jak karuzela. 
Miło, gdy przy nocnym treningu 
rano widzisz wynik już w ruchu, 
bez konieczności samodzielnego 
klikania. Przy długich sesjach, 
w których tylko nadzorujesz tre­
ning, pozostaw lepiej wyłączone.
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S5 Live Preview Interval

G DZ I E

Settings → General → Training 
→ selektor Live Preview. Bound: 
AppState.trainingConfig.livePreviewInterval. 
Default: 0  (Off).

T E C H N I C Z N I E

Określa, w jakim odstępie iteracji bieżący snapshot 
treningu jest renderowany do widoku 3D. Cztery 
dyskretne wartości: 0 („Off„), 50, 250, 1000 iteracji. 
Przy aktywnym Live Preview trener kopiuje bufor 
gaussianów z GPU do osobnego bufora renderowa
nia i wyzwala odświeżenie widoku. Przy „Off” widok 
jest aktualizowany dopiero po zakończeniu treningu. 
Koszt wydajności: co 50 iteracji ~5–10% wolniej na 
M3 Ultra, co 250 iteracji ~1–2% wolniej, co 1000 
iteracji niemierzalne. Narzut pamięci stały ~2 GB dla 
bufora snapshotu, niezależnie od interwału. War
tość służy jako domyślna dla nowych treningów; po 
starcie treningu Inspector treningu pokazuje rzeczy
wistą bieżącą wartość tego treningu. Przy interwale 
50 wrażenie wizualne to płynne „dorastanie„ chmu
ry punktów, przy 1000 wygląda to skokowo.

P R O S T Y M I  S ŁOWA M I

Podczas treningu możesz wy­
brać, jak często widok 3D jest 
aktualizowany. „Off„ oznacza: 
brak aktualizacji podczas trenin­
gu (najszybsze). „Every 50 Itera­
tions” pokazuje niemal w czasie 
rzeczywistym, jak powstaje twoja 
scena (nieco wolniejsze). Do wy­
godnego obserwowania przy ma­
łych treningach „Every 250″ to 
dobry kompromis.
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S6 Throttle Delay

G DZ I E

Settings → General → Training → selektor Throttle. 
Bound: AppState.trainingConfig.throttleDelayMs. 
Default: 0  (Off).

T E C H N I C Z N I E

Wstawia między iteracjami treningu sztuczne opóź
nienie w milisekundach. Cztery dyskretne wartości: 
0 („Off„), 2 („Light”), 5 („Moderate„), 10 („Eco”). 
Sens: przy dłuższych treningach (kilka godzin) GPU 
jest inaczej obciążone do 100%, co prowadzi do 
zauważalnie wolniejszego UI systemu (kursor myszy 
zacina się, inne aplikacje stają się ociężałe). Opóź
nienie throttle daje GPU przerwy, w których mogą 
być wykonywane inne zadania. Koszt wydajności 
jest znaczny: przy 5 ms throttle typowy trening 40K 
trwa około 50–80% dłużej niż bez throttle. W trybie 
wydajności „Eco„ (10 ms) opóźnienie na iterację 
jest dłuższe niż sama iteracja — współczynnik 2–
3× wolniej. Przy aktywnym throttle pod selektorem 
pojawia się wskazówka: „Throttle is on. Training will 
be slower than usual.” Sama aplikacja nie reaguje 
zauważalnie lepiej — tylko inne aplikacje korzystają.

P R O S T Y M I  S ŁOWA M I

Jeśli twój Mac podczas długie­
go treningu robi się zbyt gorą­
cy lub inne programy stają się 
zbyt ociężałe, włącz tutaj hamu­
lec. „Off„ daje GPU pełny gaz 
(najszybsze). „Light” robi małą 
przerwę między każdym krokiem 
(nieco wolniejsze, ale system re­
aguje lepiej). „Eco„ to najmoc­
niejszy hamulec — dobre dla 
nocnych treningów na MacBo­
oku, które nie powinny się zbyt­
nio grzać.
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Karta AI Helpers

Rysunek 16:  Ustawienia → karta KI-Helper z głównym przełącznikiem i podprzełącznikami
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S11 AI Helpers enabled (Master)

G DZ I E

Settings → AI Helpers → pierwsza sekcja → 
przełącznik „AI Helpers enabled„. Bound:. Default: 
true .

T E C H N I C Z N I E

Główny przełącznik nad wszystkimi funkcjami AI-
-Helpers w potoku. Gdy wyłączony, potok importu 
i SfM całkowicie pomija wszystkie etapy wstępne
go przetwarzania oparte na ML — brak wywołania 
Apple Vision, brak ładowania modelu CoreML, brak 
przebudzenia NPU. Gdy włączony, konsultowane są 
indywidualne podprzełączniki (S12–S13). Wartość 
jest zapamiętywana między restartami. Ma wpływ 
na następujące etapy: (a) Frame-Quality-Pre-Check 
przed SfM (S12), (b) wykrywanie zamknięcia pętli 
(S13). Ważne: gdy wyłączony, dwa podprzełączniki 
są dezaktywowane i wizualnie wyszarzone. Wska
zówka w stopce podkreśla, że wszystkie AI-Helpers 
działają ściśle on-device — brak przesyłania ob
razów, brak przetwarzania w chmurze. Gwarancja 
prywatności wynika z użycia wyłącznie frameworku 
Apple Vision (lokalnie na Neural Engine) oraz modeli 
CoreML, które leżą bezpośrednio w pakiecie aplika
cji.

P R O S T Y M I  S ŁOWA M I

Główny przełącznik dla wszyst­
kich funkcji, które wewnętrznie 
używają AI/machine learningu. 
Standard to „włączone„, ponie­
waż pomocniki oszczędzają wiele 
czasu bez konieczności, by two­
je obrazy opuszczały Maca. Jeśli 
chcesz je całkowicie wyłączyć 
(np. aby oszczędzać prąd lub po­
nieważ twój Mac nie ma NPU), 
wyłącz tutaj — wtedy dwie opcje 
poniżej automatycznie szarzeją i 
nic już nie robią.
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S12 Frame quality check

G DZ I E

Settings → AI Helpers → sekcja Available → prze
łącznik „Frame quality check„. Bound:. Default: 
true .

T E C H N I C Z N I E

Aktywuje screener jakości klatek (Faza 3.11), który 
przed wywołaniem SfM analizuje każdą zaimporto
waną klatkę. Kroki potoku na klatkę: (a) filtr warian
cji Laplasjana z Apple Vision (wykrywanie rozmycia 
— próg ~150), (b) sprawdzenie przeoraku / niedoek
spozycji oparte na histogramie (próg: >5% pikseli 
przy 0 lub 255), (c) wykrywanie pustych klatek (od
chylenie standardowe < 5 na wszystkich pikselach). 
Klatki przechodzące wszystkie trzy testy idą bezpo
średnio. Klatki nie przechodzące co najmniej jedne
go testu wyzwalają modalny dialog potwierdzenia, 
który listuje każdą problematyczną klatkę z miniatu
rą i uzasadnieniem i pyta, czy usunąć. Ważne: brak 
automatycznego usuwania — dialog jest zawsze wy
magany, użytkownik zachowuje ostateczną decyzję. 
Wydajność: ~50 ms na klatkę na M3 Ultra, działa 
równolegle. Gdy wyłączony, wszystkie klatki idą bez 
sprawdzenia do SfM. Przy wyłączonym Masterze 
(S11) ten przełącznik jest wizualnie wyszarzony i 
bez efektu. Status wysłany według pamięci: SHIP
PED 2026-05-23.

P R O S T Y M I  S ŁOWA M I

Przed właściwym treningiem 
aplikacja patrzy na każde zdję­
cie: czy jest rozmazane? całko­
wicie ciemne lub białe? puste? 
Jeśli tak, pyta cię, czy chcesz ob­
raz wyrzucić — nigdy nie usuwa 
nic automatycznie. To oszczędza 
później wiele godzin, ponieważ 
jedno totalnie rozmazane zdję­
cie może czasem zepsuć cały 
trening. Standard to „włączone„, 
ponieważ koszt jest prawie zero­
wy, a korzyść duża.
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S13 Loop closure detection

G DZ I E

Settings → AI Helpers → sekcja Available → prze
łącznik „Loop closure detection„. Bound:. Default: 
true .

T E C H N I C Z N I E

Aktywuje wykrywanie zamknięcia pętli oparte na 
Apple Vision Feature-Print. Dla każdej zaimporto
wanej klatki obliczany jest ~768-wymiarowy wektor 
cech, reprezentujący osadzenie neuronowe zawar
tości obrazu. Następnie wszystkie feature-prints są 
parami porównywane przez podobieństwo cosinu
sowe. Pary z podobieństwem > 0.85 i dystansem 
w indeksie klatek > 50 (czyli klatki niesąsiadujące) 
są identyfikowane jako „kandydaci na zamknięcie 
pętli„ i zapisywane do sidecar pliku JSONL w folde
rze projektu. Tylko informacyjne — zaimportowana 
sekwencja obrazów nie jest modyfikowana. Sens: 
daje solverowi SfM (zwłaszcza COLMAP) wskazów
kę, że te klatki w przestrzeni 3D należą do siebie. 
Dla natywnego SfM informacja sidecar jest obecnie 
tylko dokumentująca; COLMAP używa wskazówek 
wewnętrznie przez plik niestandardowych dopaso
wań (integracja ręczna możliwa, nie podpięta auto
matycznie). Wydajność: ~200 ms na klatkę na M3 
Ultra, działa równolegle. Gdy wyłączony, nie są ge
nerowane feature-printy. Przy wyłączonym Maste
rze (S11) wizualnie wyszarzony.

P R O S T Y M I  S ŁOWA M I

Gdy podczas fotografowania ob­
chodzisz obiekt dookoła i na koń­
cu ponownie lądujesz w punk­
cie startowym, ogromnie poma­
ga komputerowi o tym wiedzieć. 
Ta opcja automatycznie wykry­
wa, które z twoich zdjęć były 
robione „prawie z tego samego 
miejsca„, i zapisuje to do małego 
pliku pomocniczego. Narzędzia 
SfM (przede wszystkim COLMAP) 
mogą wykorzystać tę informację 
do dostarczenia czystszej rekon­
strukcji 3D. Standard to „włączo­
ne”, ponieważ działa bez twojego 
udziału i nic nie zmienia w two­
ich obrazach.

Ustawienia lustra Inspectora

Pozostałe wpisy ustawień (S17–S33) z tabeli inwentarza są lustrami z Inspectora 
ekspertskiego i są udokumentowane w rozdziale 2 (kontrolki Inspectora I12–I29). Nie 
pojawiają się fizycznie w oknie Settings, lecz były wymienione w inwentarzu tylko dlate
go, że działają przez właściwości TrainingConfig , które są persistowane przez i o tyle 
formalnie mają charakter ustawień. Po wyjaśnienia treściowe patrz tam.
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Kiedy co?

Ustawienie Zakres działania Trwałość

S1 Default Mode Aplikacja globalnie Restart aplikacji

S2 Language Aplikacja globalnie Restart aplikacji

S3 Viewport Back
ground

Aplikacja globalnie (Default) + Runti
me

Restart aplikacji

S4 Auto-Rotate 
After Training

Aplikacja globalnie Restart aplikacji

S5 Live Preview In
terval

Domyślne dla nowych treningów Restart aplikacji

S6 Throttle Delay Domyślne dla nowych treningów Restart aplikacji

S11 AI Helpers Ma
ster

Aplikacja globalnie Restart aplikacji

S12 Frame quality 
check

Aplikacja globalnie Restart aplikacji

S13 Loop closure 
detection

Aplikacja globalnie Restart aplikacji

Aplikacja globalnie = działa na wszystkie projekty. Domyślne dla nowych treningów 
= działa tylko na następny utworzony trening, bieżące sesje pozostają niezmienione. 
Bieżący trening = działa natychmiast na bieżącą konfigurację treningu, ale nie persistuje 
bez jawnego reimportu.
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R O Z D Z I A Ł

Rozdział 4 — Okna pomocnicze

Obok okna głównego (widok 3D plus Inspector) RadianceKit zarządza siedmioma kolej
nymi oknami, wszystkie otwierane przez menu Help. Lista od góry do dołu: User Guide 
(⌘?), Keyboard Shortcuts (⌘/), Open Training Logs… (nie otwiera okna aplikacji, lecz 
Finder; dlatego nie omawiane tu dalej), Manage Storage…, Pareto Dashboard… (⇧⌘D), 
Holdout Analysis… (⇧⌘H), BayesOpt Console… (⇧⌘B). Trzy z nich — Dashboard, 
Holdout, BayesOpt — to samodzielne narzędzia analityczne. Każde z nich ma własny 
stos view-model, czyta lub zapisuje pliki JSON na dysku, a dla każdego istnieje 
argument CLI, którym możesz przy starcie aplikacji wskazać okno na konkretny plik 
( --dashboard-dir , --holdout-file , --bayesopt-autorun ).

Cztery proste okna (User Guide, Keyboard Shortcuts, Manage Storage, plus podpozycje 
Open Training Logs / Open Exports Folder) otrzymują krótki wpis na element sterujący. 
Trzy okna analityczne są udokumentowane bardziej szczegółowo — każde z wprowa
dzeniem wyjaśniającym, co widzisz w oknie, kiedy je otworzyć i jak interpretować 
wyświetlany obraz.

Na końcu rozdziału znajduje się sekcja odsyłaczy do Inspectora okna głównego: co mo
żesz sensownie odczytać w wykresie Loss na żywo i we wskaźniku liczby gaussianów 
podczas działającego treningu.

78 / 233



R A D I A N C E K I T Rozdział 4 — Okna pomocnicze

User Guide (W1–W4)

Rysunek 17:  Okno User Guide z paskiem bocznym po lewej i wyrenderowaną treścią Mark
down po prawej

Co to jest: Wbudowane okno pomocy, które renderuje dostarczony z aplikacją plik 
guide_<jezyk>.md . Język jest wyprowadzany z ustawień (karta General → Language) 

lub, gdy stoi tam „System„, z preferencji języka macOS. Układ jest klasyczny: po lewej 
pasek boczny ze wszystkimi nagłówkami, po prawej tekst ciągły.

 Gdy potrzebujesz szybkiego przypomnienia o pojedynczym punkcie — czyli jako 
zamiennika hasła. Szczegółowa referencja to ten podręcznik; wbudowane okno pomocy 
jest raczej tym, czym byłoby --help  w wierszu poleceń. Jest aktualizowane z każdym 
wydaniem aplikacji, ale treściowo trzymane na poziomie bardziej powierzchownym.
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W1 NavigationSplitView (pasek boczny + szczegóły)

G DZ I E

Help → User Guide (⌘?).

T E C H N I C Z N I E

Układ dwukolumnowy z wąskim paskiem bocznym 
(co najmniej 180 pt szerokości) dla drzewa treści 
i przewijalnym obszarem szczegółów dla właściwej 
treści Markdown. Okno ma minimalny rozmiar 700 × 
500 pt. Przy pierwszym otwarciu okno ładuje pasu
jący guide_<lang>.md  z pakietu aplikacji (fallback 
guide_en.md ), parsuje go na rekordy bloków (na

główki H1–H4, akapity, listy, tabele, linie podziału) 
i ekstrahuje osobno strukturę nagłówków dla paska 
bocznego. Formatowanie inline (Bold, Italic, Code-
-Span) jest renderowane przez wbudowany silnik 
Markdown. Język czytany jest z ustawień aplikacji, 
ze specjalnym przypadkiem chińskiego ( zh-Hans ) 
i brazylijskiego portugalskiego ( pt-BR ), które są 
utrzymywane jako pełne tagi locale, ponieważ te 
warianty różnią się od zh lub pt.

P R O S T Y M I  S ŁOWA M I

Wbudowany tekst pomocy, po 
lewej lista tematów, po prawej 
treść. Język ustawia się automa­
tycznie według twoich ustawień 
systemu. Działa offline, ale celo­
wo jest tylko wersją krótką — 
pełna referencja to ten podręcz­
nik.

W2 List (pasek boczny nagłówków)

G DZ I E

Lewa kolumna w oknie User Guide.

T E C H N I C Z N I E

Lista wszystkich nagłówków H2 i H3 bieżącego do
kumentu Markdown. Wpisy H2 pojawiają się bez 
wcięcia ze średnią grubością czcionki, wpisy H3 z 
wcięciem 16 pt po lewej i zredukowanym stylem 
pierwszego planu. H4 i głębiej są ignorowane, po
nieważ głębia inaczej czyni pasek boczny nieprzej
rzystym. Identyfikatory kotwic są generowane z tek
stu nagłówka przez slugifikację (lowercase + spacje 
na myślniki + filtrowanie na litery/cyfry/myślniki — 
ten sam algorytm, którego GitHub używa do swoich 
kotwic Markdown, dzięki czemu również zewnętrzne 
URL-e do dokumentacji potencjalnie lądowałyby na 
tej samej kotwicy). Lista używa natywnego stylu 
macOS.

P R O S T Y M I  S ŁOWA M I

Pasek nawigacji po lewej stronie. 
Stuknij wpis i przeskakujesz do 
sekcji.
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W3 Button (nagłówek → skok do kotwicy)

G DZ I E

Na każdy wiersz paska bocznego jeden przycisk.

T E C H N I C Z N I E

Każdy wpis paska bocznego to przycisk ustawiają
cy bieżącą kotwicę, ale wyglądający optycznie jak 
wpis listy. Zmienna obserwatora wyzwala skok prze
wijania do odpowiedniej kotwicy z łagodną animacją 
przez 0,3 s. Po skoku wartość kotwicy jest rese
towana, aby następne kliknięcie tej samej kotwicy 
znów zadziałało (inaczej obserwator nie wyzwoliłby 
ponownie, bo wartość się nie zmieniła).

P R O S T Y M I  S ŁOWA M I

Kliknięcie prowadzi cię do odpo­
wiedniego miejsca w tekście po 
prawej.

W4 ScrollView (treść szczegółowa)

G DZ I E

Prawa kolumna.

T E C H N I C Z N I E

Przewijalny, pionowo stackujący obszar treści z lazy 
renderingiem, ponieważ dłuższe przewodniki łatwo 
mogą mieć ponad 200 bloków Markdown — wariant 
non-lazy instancjowałby je wszystkie jednocześnie. 
Każdy blok otrzymuje własne ID, albo kotwicę na
główka (dla skakalnych H1–H3), albo placeholder 
indeksu. Maksymalna szerokość 720 pt, padding 32 
poziomo / 24 pionowo, dzięki czemu długie linie 
zachowują dobrze czytelny układ. Tabele są rende
rowane komórka po komórce z poziomymi stosami i 
liniami podziału; kod inline przez wbudowany silnik 
Markdown. Prawdziwe bloki kodu są obecnie trakto
wane jako akapit — znane ograniczenie okna pomo
cy.

P R O S T Y M I  S ŁOWA M I

Właściwy tekst pomocy. Przewi­
jalny, dobrze czytelnej szeroko­
ści, czysta typografia.
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Keyboard Shortcuts (W5–W6)

Rysunek 18:  Okno Keyboard Shortcuts — pięć grup Navigation/Views/Capture/Editor/Tra
ining z kolumną skrótu po lewej i opisem po prawej

CO WIDAĆ NA OBRAZIE  Statyczna lista referencyjna w pięciu sekcjach. Navigation: 
Mouse Drag (Orbit/Fly), Shift+Drag/Right-Drag (Pan), Scroll (Zoom), WASD (ruch fly-
-through), Q/E (Up/Down), F (przełącz Orbit/Fly), podwójne kliknięcie (wycentrowanie), 
Cmd+Scroll (dostosowanie FoV). Views: R (reset kamery), T (auto-rotacja), P (Camera 
Playback), B (cykl tła), 0–9 (skok do kamery treningowej 1=10%/5=50%/0=last), strzał
ki lewo/prawo (poprzednia/następna kamera). Capture: S (zrzut ekranu na pulpit), V 
(Turntable-Video), C (kopiowanie informacji o kamerze). Editor: Tab (tryb edycji), Click/
Drag (Paint-Select), Option+Click (deselect), X / Delete (usuń selekcję), Cmd-Z (cofnij 
ostatnie usunięcie), [ / ] (rozmiar pędzla mniejszy/większy), Esc (zwolnij selekcję). 
Training: Start, Pause/Resume, Cancel, Continue +5K/+10K/+20K przez skróty menu w 
M9–M14.

82 / 233



R A D I A N C E K I T Rozdział 4 — Okna pomocnicze

Co to jest: Prosty statyczny przegląd wszystkich skrótów klawiszowych — Navigation, 
Views, Capture, Editor, Training. Treść jest hardkodowana, brak ładowania Markdown.

 Gdy szukasz najszybszej drogi do zrobienia czegoś w widoku. WASD-Fly-Through, R 
dla reset kamery, B dla cyklu tła — wszystkie stoją tu.

W5 ScrollView (obszar treści)

G DZ I E

Help → Keyboard Shortcuts (⌘/).

T E C H N I C Z N I E

Prosty obszar przewijania z pionową listą w środku. 
Padding 20 wokół, brak drzewa nawigacji bocznej 
(lista jest dostatecznie krótka). Treści zgrupowane 
w pięciu sekcjach (Navigation, Views, Capture, Edi
tor, Training). Na kombinację klawiszy jeden wiersz 
z tłumaczalnym tekstem w obu kolumnach. Lewa 
kolumna (kod klawisza) zafiksowana na 180 pt sze
rokości, dzięki czemu opisy po prawej pozostają wy
równane pionowo. Brak interakcji poza przewijaniem 
— kliknięcie wiersza nic nie wyzwala, skróty klawi
szowe są rzeczywistymi modyfikatorami klawiatury 
w menu i w widoku.

P R O S T Y M I  S ŁOWA M I

Tabela wszystkich klawiszy skró­
tów. Statyczna ściągawka do 
szybkiego zerknięcia.

W6 VStack (sekcje skrótów)

G DZ I E

Wewnątrz ScrollView.

T E C H N I C Z N I E

Sekcje stackowane do lewej z odstępem 16 pt. We
wnątrz pięciu sekcji nagłówek + sekwencja wierszy. 
Nagłówki używają drugorzędnego stylu Subheadline 
— celowo nie format Title, ponieważ sekcje nie 
muszą być nawigowalne. Treść jest celowo płaska 
(brak disclosure, brak wyszukiwania, brak filtru), 
aby komponent działał niezmiennie w każdej wersji 
macOS i plik pozostał czytelny.

P R O S T Y M I  S ŁOWA M I

Grupowanie klawiszy według 
funkcji (Navigation, Views, Editor 
i tak dalej).
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Manage Storage (W7–W12)

Rysunek 19:  Okno Manage Storage — nagłówek pokazuje „693 items · 16.74 GB total„, 
tabela z plikami eksportu PLY posortowana według daty, każda pozycja z pigułką formatu + 

nazwa pliku + rozmiar + data

CO WIDAĆ NA OBRAZIE  Widok tabelaryczny wszystkich zarządzanych przez RadianceKit 
plików. Nagłówek liczy 693 pozycje, łączny rozmiar 16.74 GB. Pasek narzędzi u góry: 
„Show in Finder„
1. „Refresh„. Każdy wiersz: ikona PLY, nazwa pliku (np.

training_​20260527T211321Z.ply), data eksportu, rozmiar (waha się 7 KB do 218 MB), 
ikona lupy (Reveal) i ikona kosza (Move to Trash). Pliki są posortowane według daty, 
najnowsze u góry. W tym ujęciu demonstracyjnym dominują eksporty PLY, ponieważ 
dużo pracowano z --benchmark .

Co to jest: Przegląd użycia dysku dla wszystkiego, co RadianceKit składuje pod ~/​
Documents/​RadianceKit/​ — logi, eksporty, sceny, pakiety capture (od towarzysza iOS), 
importy (staging-kopie obrazów wejściowych). Na pozycję rozmiar w bajtach i dwa 
przyciski: „pokaż w Finderze„ i „przenieś do kosza”. NIE jest to automatyczne sprzątanie 
— aplikacja sama niczego nie usuwa; ty decydujesz na pozycję.
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 Gdy dysk się zapełnia. Przede wszystkim logi się zbierają (jeden JSONL na próbę 
treningu, plus _​qualityMetrics.json); eksporty oczywiście też (PLY 100% surowych 
danych, jeden na eksport). Również użyteczne po crashu, gdy katalog staging importów 
ma jeszcze stare kopie obrazów wejściowych (zobacz „Disk-pressure incident„ w dev_​
v549f-needle-reduction.md).

W7 Przycisk „Show in Finder„

G DZ I E

Nagłówek u góry po prawej w oknie przeglądarki 
storage.

T E C H N I C Z N I E

Otwiera cały katalog RadianceKit (~/​Documents/​
RadianceKit/​) w Finderze, dzięki czemu możesz 
bezpośrednio zobaczyć strukturę folderu i też mani
pulować nią z samego Findera. Akcja otwiera nowe 
okno Findera i nie przechodzi do kontenera sandbox 
aplikacji — ~/​Documents/​RadianceKit/​ to regular
nie dostępna dla aplikacji domena Documents, nie 
ścieżka kontenera sandbox.

P R O S T Y M I  S ŁOWA M I

Otwiera katalog w Finderze, abyś 
mógł sam operować plikami.

W8 Przycisk „Refresh„

G DZ I E

Nagłówek, obok przycisku Finder.

T E C H N I C Z N I E

Wyzwala skanowanie w tle, które działa na zainicjo
wanym przez użytkownika asynchronicznym zada
niu, dzięki czemu skanowanie dużych drzew katalo
gów nie blokuje UI. Właściwe chodzenie przebiega 
przez każdy znany podkatalog (Logs, Exports, Sce
nes, Captures, Imports) i generuje pozycję storage 
na bezpośrednie dziecko. Na pozycję ustalany jest 
rekursywny rozmiar — preferowane jest faktyczne 
zużycie dysku (włącznie ze współdzieleniem har
dlinków APFS) z fallbackiem na logiczny rozmiar 
pliku.

P R O S T Y M I  S ŁOWA M I

Wczytuje listę na nowo, gdy 
w międzyczasie w Finderze coś 
usunąłeś lub dodałeś.
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W9 List (wpisy storage)

G DZ I E

Główna treść pod nagłówkiem.

T E C H N I C Z N I E

Lista z układem na wiersz: kategoria-specyficzna 
ikona SF Symbol (dokument dla logów, strzałka 
uploadu dla eksportów, sześcian dla scen, taca dla 
importów), nazwa + podtytuł (etykieta kind + sfor
matowana data modyfikacji), licznik bajtów po pra
wej (wyrównany do prawej, monospaced), przycisk 
Reveal (symbol lupy), przycisk Trash (kosz). Sorto
wanie: pierwotnie według kind (sceny najpierw, po
tem eksporty, logi, captures, importy, inne), drugo
rzędnie według daty modyfikacji malejąco (najnow
sze u góry). Gdy skanowanie wciąż trwa, w miejscu 
wyświetlany jest postęp „Scanning…„. Gdy nic nie 
znaleziono, wyświetlanie empty-state z ikoną tacy.

P R O S T Y M I  S ŁOWA M I

Lista wszystkich twoich danych 
RadianceKit, posortowana we­
dług typu i aktualności. Na pozy­
cję widzisz rozmiar i możesz bez­
pośrednio usunąć.

W10 Przycisk wiersza „Reveal in Finder„

G DZ I E

Na wiersz, symbol lupy po prawej.

T E C H N I C Z N I E

Otwiera Finder i zaznacza specyficzny element (plik 
lub folder). Różnica wobec W7: W7 otwiera katalog 
root; W10 zaznacza dokładnie tę jedną pozycję. 
Praktyczny workflow: zidentyfikuj duży wpis, kliknij 
na lupę, potem skopiuj go na przykład na zewnętrz
ny wolumin.

P R O S T Y M I  S ŁOWA M I

Skacze w Finderze bezpośrednio 
na ten wpis, abyś szybko go zna­
lazł.
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W11 Przycisk wiersza „Move to Trash„

G DZ I E

Na wiersz, symbol kosza po prawej obok lupy.

T E C H N I C Z N I E

Wyzwala okno potwierdzenia dialogu (W12). Dopie
ro po potwierdzeniu działa standardowa operacja 
macOS „przenieś do kosza„ (czyli odwracalna, nie 
bezpośrednie usunięcie). Po udanym trash wpis jest 
usuwany z listy i licznik łącznych bajtów aktualizo
wany. Przy błędach wyświetlany jest modalny dialog 
błędu.

P R O S T Y M I  S ŁOWA M I

Przenosi pozycję do kosza. Dia­
log wcześniej pyta.

W12 ConfirmationDialog (potwierdzenie usunięcia)

G DZ I E

Wyzwalane przez W11, prezentowane jako sheet 
macOS.

T E C H N I C Z N I E

Standardowy dialog potwierdzenia z dynamicznym 
tytułem „Delete <name>?„ i wierszem wiadomości 
jawnie wskazującym, że pozycja ląduje w koszu i 
z niego jest przywracalna (do czasu opróżnienia 
kosza). Dwa przyciski: „Move to Trash” jako akcja 
destrukcyjna (prezentowana czerwono) i „Cancel„ z 
automatycznym przypisaniem Esc. Dialog jest non-
-modal w tym sensie, że blokuje tylko to okno, nie 
całą aplikację — to standard macOS dla odwracal
nych usunięć.

P R O S T Y M I  S ŁOWA M I

Pytanie bezpieczeństwa przed 
usunięciem. „Move to Trash„ jest 
odwracalne — dopóki kosz nie 
zostanie opróżniony.
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Pareto Dashboard (W13–W22)

Rysunek 20:  Pareto Dashboard — pusty stan przed importem raportu

Pusty stan (po pierwszym otwarciu) — empty-state z call-to-action „Open Reports 
Folder…„. Punkty danych pojawiają się, gdy tylko raporty treningu są wczytane, zobacz 
następne zdjęcie.

Rysunek 21:  Pareto Dashboard z 129 wczytanymi raportami benchmark — Gaussians vs 
PSNR z frontem Pareto, filtry Scene/Strategy/Mip

CO WIDAĆ NA OBRAZIE  Pasek narzędzi nagłówka pokazuje „129 reports of 129″ (wszystkie 
raporty w wybranym folderze pomyślnie sparsowane — 21 dodatkowych plików nie 
udało się sparsować z powodu starszego formatu, zobacz listę wskazówek po prawej). 
Osie: selektor X-Axis na Gaussians , selektor Y-Axis na PSNR (dB) . Wykres scatter: 
zielone punkty = strategia Classic, niebieskie punkty = MCMC. Przerywana linia frontu 
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Pareto biegnie wzdłuż najlepiej osiągniętych wartości PSNR i osiada na plateau ok. 
PSNR≈30 dB od ok. 500K gaussianów. Pigułki filtrów po prawej: 7 scen (bicycle, bonsai, 
family, flowers, kitchen, stump, truck), 2 strategie (classic, mcmc), 3 opcje Mip-Splat
ting (All, On, Off). Obecnie wszystkie filtry otwarte, stąd gęsty klaster punktów.

Co to jest: Narzędzie porównawcze wielu przebiegów. Trenowałeś w przeszłości kilka 
scen lub tę samą scenę z różnymi ustawieniami wstępnymi — każdy taki przebieg tre
ningu produkuje (gdy podałeś --benchmark  lub uruchomiłeś przez funkcję benchmark) 
plik JSON-raportu, zawierający m.in. final-PSNR, SSIM, LPIPS, liczbę gaussianów i czas 
wallclock. Dashboard wczytuje cały folder takich raportów jednocześnie i plotuje je jako 
2D scatter z wybieralnymi osiami. Dodatkowo front Pareto (zbiór niezdominowanych 
punktów) jest rysowany jako przerywana linia.

 Po założeniu co najmniej trzech lub czterech raportów treningu. Z mniejszą liczbą 
punktów linia frontu nie jest wymowna. Typowy use-case: próbowałeś zrekonstruować 
scenę plenerową i kolejno wypróbowałeś P3 Balanced (Classic), P4 Quality (Classic), P7 
MCMC Quality i P9 Outdoor (tuned) — teraz chcesz wiedzieć, która konfiguracja daje 
najlepszą PSNR na sekundę czasu treningu lub która potrzebuje najmniej gaussianów 
dla danej PSNR.

JAK INTERPRETOWAĆ  Obie osie są swobodnie wybieralne (X: psnr , ssim , lpips , …; Y 
tak samo). Logika frontu Pareto w ParetoFront2D.indices wie dla każdej metryki, czy 
„mniejsze = lepsze„ (np. LPIPS, Loss, Time) czy „większe = lepsze” (PSNR, SSIM) — 
linia biegnie więc w zależności od wyboru osi z lewego dolnego do prawego górnego 
rogu lub z lewego górnego do prawego dolnego, zawsze wzdłuż najlepszej osiągniętej 
kombinacji. Punkt jest Pareto-optymalny, gdy ŻADEN inny punkt w OBU wymiarach nie 
jest przynajmniej równie dobry (czyli żaden inny go nie dominuje). Pareto-optymalne 
punkty leżą na linii, inne punkty na prawo/powyżej (zależnie od orientacji osi) od niej. 
Punkty NA linii to prawdziwi kandydaci na „najlepsze ustawienie wstępne„; punkty 
DALEKO od linii to zmarnowany czas treningu.

PIGUŁKI FILTRÓW  Możesz ograniczyć wybór do konkretnej sceny (gdy np. chcesz porów
nywać tylko przebiegi plenerowe), do konkretnej strategii (Classic lub MCMC) lub do 
Mip-Splatting on/off (istotne po Fazie Q1.5, gdzie Mip pozostaje jako opt-in Advanced 
Flag).

 Masz trzy raporty dla sceny „truck„ pod ~/​Documents/​RadianceKit/​Reports/​: Run A 
(P4 Quality, 40K iter, 524K Gs, 105 s, PSNR 23.4), Run B (P7 MCMC, 200K iter, 150K 
Gs, 693 s, PSNR 24.6), Run C (P9 Outdoor, 100K iter, 1.25M Gs, 312 s, PSNR 25.8). 
Ustaw oś X na trainingTime, oś Y na PSNR. Run B leży po prawej u góry, Run C jeszcze 
bardziej w prawo u góry, Run A po lewej u dołu. Front Pareto łączy A i C — oba niezdo
minowane. Run B jest „lost” (C jest lepsze w Time I PSNR). Wniosek: dla „truck„ nie 
opłaca się domyślne MCMC; albo szybko+ok (A), albo długo+bardzo dobrze (C). Zapisz 
konfigurację z C jako własne ustawienie wstępne (Inspector → I1 Save Preset).

Następna akcja: Najlepszą konfigurację zapisać jako ustawienie wstępne. Konkretnie: 
spójrz na punkty Pareto (hover pokazuje PSNR/SSIM/LPIPS/Gs/Time w tooltipie), zdecy
duj, który najlepiej pasuje ci pod kątem trade-off Time-vs-Quality, otwórz odpowiedni 
raport (nazwa pliku zawiera timestamp przebiegu), skopiuj jego konfigurację treningu 
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w nowym przebiegu lub zapisz ją po następnej sesji treningu jako ustawienie wstępne 
przez Inspector.

W13 Przycisk „Open Reports Folder…„

G DZ I E

Pasek narzędzi u góry po lewej.

T E C H N I C Z N I E

Otwiera dialog wyboru folderu z prośbą „Select a 
folder containing benchmark .json reports„. Po po
twierdzeniu działa zadanie w tle parsujące sekwen
cyjnie wszystkie pliki .json  w folderze. Błędne ra
porty (zepsuty JSON, błędny schemat) są zbierane 
i wyświetlane na dole paska bocznego jako „N file 
failed to parse” — bez crasha. Gdy drugie kliknięcie 
nastąpi podczas trwającego pierwszego ładowania, 
poprzednie zadanie jest anulowane, aby dwa wyniki 
jednocześnie nie pisały do stanu.

Także przez CLI: --dashboard-dir /​sciezka/​do/​
raportow ładuje folder już przy starcie aplikacji.

P R O S T Y M I  S ŁOWA M I

Wybiera folder, w którym 
leżą twoje raporty bench­
mark. Standardowa ścieżka 
to ~/​Documents/​RadianceKit/​
Reports/​. Ładuje wtedy wszyst­
kie JSONy naraz.

W14 Selektor „X-Axis„

G DZ I E

Nad wykresem, po lewej.

T E C H N I C Z N I E

Selektor menu ze wszystkimi dostępnymi osiami 
metryk modułu dashboard (PSNR, SSIM, LPIPS, 
liczba gaussianów, czas treningu itd.). Domyślnie 
liczba gaussianów. Przy zmianie hover-punkt jest 
resetowany, ponieważ wcześniej podświetlona po
zycja w starym układzie współrzędnych osi po 
zmianie osi nie ma więcej sensu. Selektor jest ogra
niczony do szerokości zawartości, aby nie ciągnął 
się przez całą szerokość.

P R O S T Y M I  S ŁOWA M I

Która metryka ma stać na osi 
poziomej. Zwykle „czas trenin­
gu„ lub „liczba gaussianów”, po­
nieważ to „koszty„, które chcesz 
porównywać.
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W15 Selektor „Y-Axis„

G DZ I E

Nad wykresem, obok X-Axis.

T E C H N I C Z N I E

Identyczne do W14, tylko że domyślnie PSNR. Wy
bór osi jest zapisywany niezależnie, więc użytkow
nik może też wybierać bezsensowne kombinacje 
(X=PSNR, Y=PSNR — wyrzuciłoby wszystkie punk
ty na przekątną). Takie kombinacje nie są jednak 
wyłapywane; celowa decyzja, ponieważ porównanie 
„SSIM vs PSNR„ jest jak najbardziej interesujące, by 
zobaczyć jak konsystentne są metryki.

P R O S T Y M I  S ŁOWA M I

Co stoi na osi pionowej. Normal­
nie „PSNR„ lub „SSIM” jako miara 
jakości.

W16 Przełącznik „Show Pareto Front„

G DZ I E

Po prawej obok selektorów osi.

T E C H N I C Z N I E

Standardowy przełącznik macOS. Gdy aktywny, na 
wykresie Pareto dodatkowo do chmury punktów ry
sowana jest linia z obliczonym frontem Pareto 2D. 
Styl: przerywana (wzór 4–4), półprzezroczysta sza
rość, grubość linii 1,5 pt. Obliczenia Pareto działają 
na głównym wątku — przy typowej liczbie raportów 
(≤ ~50) jest to bez problemu szybkie. Gdy przełącz
nik jest wyłączony, linia jest pominięta, dzięki czemu 
pozostają tylko gołe punkty.

P R O S T Y M I  S ŁOWA M I

Pokazuje linię prowadzącą przez 
„dotychczas najlepsze„ punkty. 
Gdy linia ci przeszkadza (np. po­
nieważ chcesz porównywać tylko 
pojedyncze trade’y), wyłącz ją.
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W17 Pigułki filtra „Scene„

G DZ I E

Prawy pasek boczny w oknie dashboard.

T E C H N I C Z N I E

Pigułki filtra dla każdej sceny występującej w wczy
tanych raportach. Własny układ flow, który auto
matycznie przepakowuje pigułki na kilka wierszy, 
gdy tylko szerokość zostanie wyczerpana. Aktywne 
pigułki otrzymują akcentowe tło, nieaktywne neu
tralne standardowe tło Material. Wybór wielu jest 
możliwy (semantyka set); gdy żadna pigułka nie jest 
wybrana, wszystkie sceny są uznawane za „prze
puszczone„ — tzn. logika set jest „pusty wybór = 
wszystko”, nie „pusty wybór = nic„.

P R O S T Y M I  S ŁOWA M I

Kliknięcie na nazwę sceny filtruje 
punkty na tylko tę scenę. Wybór 
wielu możliwy. Puste = wszystkie 
sceny.

W18 Pigułki filtra „Strategy„

G DZ I E

Pod filtrem Scene na pasku bocznym.

T E C H N I C Z N I E

Dokładnie jak W17, ale dla strategii treningu — 
typowo dwie wartości „classic„ i „mcmc”, wyprowa
dzone z pola Strategy z JSON-raportów benchmark. 
Pomocne, gdy zmieszałeś raporty obu strategii i 
chcesz widzieć tylko jeden rodzaj (np. „pokaż tylko 
MCMC, ponieważ Classic już wykluczyłem„).

P R O S T Y M I  S ŁOWA M I

Filtr według Classic lub MCMC. 
Standardowo oba aktywne.
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W19 Pigułki filtra „Mip-Splatting„

G DZ I E

Pod filtrem Strategy na pasku bocznym.

T E C H N I C Z N I E

Filtr trójwartościowy (zamiast set jak W17/W18): 
„All„ / „On” / „Off„. Tło: Mip-Splatting został w 
Fazie Q1.5 oceniony jako eksperymentalna poprawa 
wieloskalowa i finalny werdykt brzmiał „brak konse
kwentnego ładnego wygranego; zachować jako opt-
-in Flag”. Gdy robisz porównania Mip-on/off, często 
chcesz móc bardzo ostro rozdzielić. Stąd dedyko
wany filtr ternarny ze stanami „przepuść wszystko„, 
„tylko Mip włączone”, „tylko Mip wyłączone„. Sekcja 
paska bocznego jest pokazywana tylko, gdy w ze
stawie danych jest co najmniej jeden raport Mip I co 
najmniej jeden bez Mip (inaczej filtrowanie nie ma 
sensu).

P R O S T Y M I  S ŁOWA M I

Gdy chcesz porównywać Mip-
-Splatting on/off, tutaj trójdziel­
ny filtr. Inaczej ignoruj.

W20 ChipButton (przełącznik filtra, all/on/off)

G DZ I E

Komponent pomocniczy, używany w W17/W18/W19.

T E C H N I C Z N I E

Minimalistyczny wrapper przycisku. Treść: tekst 
etykiety z grubością Caption i padding 10 poziomo / 
5 pionowo. Tło warunkowe: gdy aktywne → kolor 
akcentu aplikacji z białym tekstem; w przeciwnym 
razie neutralne standardowe tło Material z czarnym 
tekstem. Forma to Capsule (pigułka). Plain-Button
style, aby Material Capsule nie był pokrywany przez 
systemową ramkę.

P R O S T Y M I  S ŁOWA M I

Same okrągłe przyciski filtra. 
Optycznie jak tag iOS.
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W21 Chart (Pareto-Scatter)

G DZ I E

Środkowy obszar dashboardu.

T E C H N I C Z N I E

Wykres Swift-Charts z dwiema warstwami: 1. punkt 
na raport — pozycja z wybranych metryk X i Y, 
kolor według Strategy, symbol według statusu Mip. 
Rozmiar symbolu normalnie 80, podświetlonego 200 
(gdy ID odpowiada aktualnie hoverowanemu rapor
towi). 2. linia dla frontu Pareto, tylko gdy przełącz
nik włączony.

Overlay wykresu: przezroczysty prostokąt rejestruje 
ruch myszy; na klatkę ustalana jest euklidesowo naj
bliższa pozycja punktu w ramce plot i hoverowany 
raport aktualizowany, jeśli dystans leży poniżej 24 
px (inaczej resetowany). Tak otrzymujesz tooltip bez 
klikania — wystarczy hover.

P R O S T Y M I  S ŁOWA M I

Właściwy wykres scatter. Każdy 
punkt to przebieg treningu. Ho­
ver dla tooltipu szczegółów.

W22 Tooltip (szczegóły hover)

G DZ I E

Pod wykresem, wyświetlany przy hover.

T E C H N I C Z N I E

Stos poziomy: nazwa sceny (Headline), tag Strategy 
(Caption), linia podziału, potem metryki PSNR/SSIM/
LPIPS/Gs/Time w małych grupach pionowych (label 
+ wartość monospaced). Gdy Mip był aktywowany, 
dodatkowo tag „Mip„ Capsule w kolorze akcentu. 
Tło półprzezroczyste rozmycie, zaokrąglony prosto
kąt z promieniem 8 pt. Wyświetlany tylko, gdy mysz 
faktycznie jest nad punktem. Znika automatycznie 
przy opuszczeniu.

P R O S T Y M I  S ŁOWA M I

Karta szczegółów na dole, gdy 
najedziesz myszą na punkt. Po­
kazuje wszystkie metryki jakości 
i konfigurację przebiegu jedno­
cześnie.
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Holdout Analysis (W23–W29)

Rysunek 22:  Holdout Analysis — pusty stan przed wczytaniem transforms.json

Pusty stan z empty-state i call-to-action „Open transforms.json…„. Akceptuje format 
NeRF-Studio i Instant-NGP.

Pusty stan (po pierwszym otwarciu) — znaczniki kamer pojawiają się, gdy tylko wczyta
ny jest transforms.json , zobacz następne zdjęcie.

Rysunek 23:  Globe Holdout z 100 kamerami NeRF-Blender-Mic, 5 foldów po 20 kamer, 
strategia Angular aktywna

CO WIDAĆ NA OBRAZIE  Nagłówek pokazuje wczytany plik (transforms_​train.json) i licz
bę kamer („100 cameras„). Lewy pasek boczny: selektor strategii z dwiema opcjami — 
Angular

(longitudinal) aktywne (wyrównuje foldy według sektorów długości/szerokości na 
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sferze, dzięki czemu każdy fold testowy jest geometrycznie gęsty) vs Linear (round-
robin) (oparte na kolejności, każda k-ta klatka jako zestaw testowy). Suwak k-foldów 
stoi na 5, selektor folda testowego na fold 1. Przycisk Export generuje fold-
assignment.json dla Nerfstudio/Instant-NGP. Środkowy panel: projekcja globusa 3D 
wszystkich 100 kamer — zielone punkty = Train, czerwone punkty = bieżący fold testo
wy (fold 1 z 20 kamerami). Prawy pasek boczny (Angular Correlation): na fold 20 kamer 
+ Mean Nearest Angle (fold 1: 7.9°, fold 2: 7.8°, fold 3: 7.7°, fold 4: 7.0°, fold 5: 6.3°) — 
mniejsza wartość oznacza, że kamery w obrębie tego folda leżą ciasno koło siebie, czyli 
rozdział Holdout jest przestrzennie koherentny.

Co to jest: Wizualizator 3D twojego układu kamer z logiką cross-validation. Wczytu
jesz transforms.json  (standardowy format Nerfstudio / Instant-NGP dla póz kamer), 
aplikacja czyta wszystkie kamery, rzutuje ich kierunki patrzenia na sferę jednostkową 
i pokazuje je jako małe kulkowe znaczniki na wirtualnym globusie. Następnie dzieli 
kamery na k  foldów (według wybranej strategii: angular lub linear), zaznacza zielonym 
udział treningowy a czerwonym udział testowy (Holdout), i oblicza na fold score Angular 
Correlation, mówiący ci jak daleko fold testowy leży w przestrzeni kątów widzenia od 
folda treningowego.

 Gdy chcesz robić ocenę holdout — czyli: jak dobrze twój model generalizuje 
na niewidziane kąty widzenia? Standardem w treningu jest „every-8th view jako Holdo
ut„ (konwencja Mip-NeRF360), ale to bardzo liniowy podział. Gdy twoje obrazy są 
np. zgrupowane czasowo (najpierw jedna strona obiektu, potem druga), to „every-8th” 
nie jest reprezentatywne — losowa pozycja sekwencji ląduje w teście, ale wszyscy jej 
sąsiedzi są w treningu, to za proste. Przy „angular„ stratyfikuje się zamiast tego po 
przestrzeni kątów widzenia: każdy fold zawiera kamery ze wszystkich obszarów orbity, 
dzięki czemu test naprawdę testuje luki w generalizacji.

JAK INTERPRETOWAĆ  Angular vs Linear: - Angular (standard): dzieli kamery według kąta 
longitudinalnego (współrzędna φ wokół osi Y) na k  równych sektorów. Fold 0 to kame
ry z φ ∈ [0°, 360/k°), fold 1 następne i tak dalej. Zaleta: każdy fold pokrywa wycinek 
orbity; fold testowy jest przestrzennie kompaktowy, ale szeroko rozłożony po zestawie 
danych świata. Dobre dla klasycznych ujęć orbitalnych. - Linear (round-robin): indeks 
folda = (image_index modulo k). To prosty podział „every-k-th„. Działa, gdy kolejność 
obrazów NIE ma biasu przestrzennego (np. losowo posortowane ujęcia dronowe). Działa 
źle, gdy obrazy klastrują się czasowo.

W globusie 3D od razu widzisz: zielone punkty (trening) i czerwone punkty (test). Gdy 
czerwone punkty wszystkie klastrują w jednym rogu, holdout jest słaby (brak dobrego 
testu generalizacji). Gdy leżą równomiernie między zielonymi, jest dobry. Score Angular 
Correlation na fold (prawy pasek boczny, w stopniach) mówi dodatkowo: mniejsza war
tość = test jest bliski treningu (każda kamera testowa ma bliską kamerę treningu, łatwy 
test); większa wartość = test jest daleko od treningu (trudniejsza generalizacja).

 Nagrałeś swoją scenę Truck z 251 obrazami, eksportujesz przez pozycję menu 
M33 (Export SfM transforms.json) plik nerfstudio. Otwórz okno Holdout (⇧⌘H), wczytaj 
JSON przez „Open transforms.json…„, spójrz na globus. k=5 (domyślnie) daje ci 5 fol
dów. Kliknij na „Fold 3” — zobacz czy czerwone znaczniki są w miarę równomierne. Jeśli 
tak: „Export fold-assignment.json„, umieść wyeksportowany plik w folderze raportów, 
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a przy następnym przebiegu treningu z --benchmark  (lub odpowiednimi ustawieniami 
Inspectora) dokładnie ten podział foldów jest używany jako Holdout testowy — zamiast 
standardu „every-8th”.

W23 Przycisk „Open transforms.json…„

G DZ I E

Pasek narzędzi u góry po lewej.

T E C H N I C Z N I E

Otwiera dialog wyboru pliku ograniczony do plików 
JSON. Po potwierdzeniu moduł Holdout ładuje plik. 
Loader parsuje zarówno format nerfstudio (intrinsics 
kamer plus listę klatek ze ścieżką obrazu i macierzą 
transformacji), jak i format instant-ngp (taka sama 
budowa). Na klatkę kierunek patrzenia jest ekstra
howany z macierzy transformacji (oś z lokalnej bazy 
kamery) i zapisywany. Gdy parsowanie zawiedzie, 
wyświetlana jest wiadomość błędu w obszarze sta
tusu.

Także przez CLI: --holdout-file /​sciezka/​do/​
transforms.json startuje okno bezpośrednio z 
wczytanym plikiem.

P R O S T Y M I  S ŁOWA M I

Ładuje twój JSON póz kamer. 
Standardem są eksporty Ner­
fstudio i Instant-NGP. Radian­
ceKit sam może eksportować 
transforms.json przez menu → 
Export → SfM.

W24 Selektor „Strategy„ (angular/linear)

G DZ I E

Lewy pasek boczny, u góry.

T E C H N I C Z N I E

Selektor radiowy z dwiema opcjami: Angular i Line
ar. Zmiana strategii automatycznie wyzwala ponow
ne obliczenie foldów. Kierunki patrzenia to lista 
wektorów jednostkowych 3D na sferze; strategia 
Angular rzutuje je na kąt longitudinalny φ i sortuje, 
strategia Linear robi po prostu podział modulo po 
indeksie klatki.

P R O S T Y M I  S ŁOWA M I

Angular dla równomiernych ujęć 
orbitalnych (standard, bezpiecz­
ne), Linear tylko gdy twoje obra­
zy nie klastrują przestrzennie.
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W25 Suwak „k Folds„

G DZ I E

Lewy pasek boczny, pośrodku.

T E C H N I C Z N I E

Suwak od 3 do 10, krok 1. Przy zmianie oblicze
nie foldów jest automatycznie inicjowane na nowo, 
dzięki czemu lista foldów, indeksy Training/Test i 
score na fold są od razu nowo obliczane. Wybrana 
wartość jest wyświetlana jako tekst monospaced-
-digit po prawej obok etykiety.

Reguła kciuka: k=5 to standard (daje ci 20% test na 
fold, to zwykłe dla cross-validation). k=10 gdy masz 
bardzo dużo danych i potrzebujesz więcej foldów do 
siły statystycznej. k=3 gdy masz mało danych.

P R O S T Y M I  S ŁOWA M I

Ile foldów w podziale. 5 to stan­
dard i pasuje prawie zawsze.

W26 Selektor „Test Fold„

G DZ I E

Lewy pasek boczny, pod suwakiem k.

T E C H N I C Z N I E

Selektor menu. Opcje są dynamicznie 0..<k, etykieta 
„Fold 1″ do „Fold N„ (czyli 1-indeksowane w UI, 0-
-indeksowane wewnętrznie). Gdy wcześniej wybra
ny indeks ≥ k (np. ponieważ zredukowałeś k z 10 
do 5), jest automatycznie resetowany na 0. Wybrany 
fold testowy jest na globusie prezentowany czerwo
no, wszystkie inne zielono.

P R O S T Y M I  S ŁOWA M I

Który fold jest obecnie foldem 
testowym. Możesz przeklikać i 
widzisz, jak każdy pojedynczy 
fold wygląda na globusie.
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W27 Przycisk „Export fold-assignment.json„

G DZ I E

Lewy pasek boczny, na dole.

T E C H N I C Z N I E

Otwiera dialog zapisu z domyślną nazwą pliku fold-
assignment.json. Po potwierdzeniu moduł Holdout 
koduje bieżący podział w schemat JSON (przy
pisanie fold na klatkę plus meta-blok strategii). 
Plik ten można potem przy następnym treningu 
z --benchmark  przekazać, dzięki czemu ten sam 
Holdout jest używany do finalnej oceny metryki. 
Błędy zapisu wyświetlane jako tekst błędu; sukces 
zielonym tekstem jako „Saved to (filename)„.

P R O S T Y M I  S ŁOWA M I

Zapisuje bieżący podział Train/
Test jako JSON. Plik ten możesz 
potem przy treningu bezpośred­
nio przekazać, dzięki czemu ten 
sam zestaw testowy zostanie po­
nownie użyty.

W28 SCNView (globus kamer 3D)

G DZ I E

Środkowy panel w oknie Holdout.

T E C H N I C Z N I E

Widok globusa SceneKit. Scena składa się z: kuli 
Wireframe (promień 1.0, 36 segmentów, ciemno
szary), trzech kolorowych kikutów osi (czerwony/
zielony/niebieski dla X/Y/Z, każdy 1.2 długości), i 
na kamerę małej kuli znacznika (promień 0.03) na 
odpowiedniej pozycji kierunku patrzenia na sferze 
jednostkowej (lekko na zewnątrz, aby nie zniknąć W 
kuli wireframe). Znaczniki przy każdej zmianie folda 
NIE są przebudowywane — przebudowa jest po
trzebna tylko, gdy zmienia się lista klatek (czyli no
wy JSON jest wczytywany). Zamiast tego na update 
działa in-place aktualizacja kolorów materiału: czer
wony dla indeksów Test, zielony dla treningu, jasno
szary gdy ani jedno ani drugie. Tak ticki suwaka 
pozostają wydajne nawet przy N > 1000 kamer.

Sterowanie kamerą jest włączone — możesz myszą 
obracać globus, zoomować, panować. Oświetlenie 
sprawia, że znaczniki nie wyglądają płasko. Tło 
ciemnoszare.

P R O S T Y M I  S ŁOWA M I

Globus 3D z pozycjami kamer. 
Zielony = trening, czerwony = 
test, jasnoszary = nieprzypisany 
(nie występuje, wszystkie kame­
ry gdzieś należą). Myszą możesz 
obracać globus i zoomować.
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W29 FoldCard (Tap to Select Fold)

G DZ I E

Prawy pasek boczny, sekcja „Angular Correlation„.

T E C H N I C Z N I E

Na fold widok karty — zaokrąglony prostokąt z pro
mieniem 6 pt, padding 10, pionowy układ z dwoma 
wierszami (u góry „Fold N„ + liczba kamer, na dole 
„Mean nearest angle:” + wartość w stopniach). Ko
lor tła warunkowo: aktywny fold = kolor akcentu pół
przezroczysty, nieaktywne = neutralne standardowe 
Material. Stuknięcie wybiera fold i globus przebar
wia się na żywo.

Score „Mean nearest angle„ to średni najmniejszy 
kąt na kamerę testową do najbliższej kamery trenin
gu (wewnętrznie liczony w radianach, w UI wyświe
tlany w stopniach).

P R O S T Y M I  S ŁOWA M I

Na fold mała karta po prawej z 
liczbą kamer i średnim odstępem 
do najbliższej kamery treningu. 
Kliknięcie na nią wybiera ten fold 
jako test.

BayesOpt Console (W30–W39)

Rysunek 24:  Konsola BayesOpt — pusty stan przed startem próby

Pusty stan z selektorem Search-Space (RadianceKit defaults
(6-dim)), suwakiem Trial-Budget (domyślnie 40), Random-Seed (42) i trzema pustymi 
panelami dla wykresu Convergence, Trial Log i listy parametrów Search-Space.

Pusty stan (po pierwszym otwarciu) — wykres Convergence i tabela Trial wypełniają się, 
gdy tylko przebieg zostanie uruchomiony, zobacz następne zdjęcie.
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Rysunek 25:  Konsola BayesOpt po 40 próbach — wykres Convergence rośnie stromo do 
próby 15, Best Value 0.9943, Trial Log z tagami init/bo/restart

CO WIDAĆ NA OBRAZIE  Status u góry po prawej „Finished — best 0.9943 after 40 
trials„. Lewy pasek boczny: selektor Search-Space na RadianceKit defaults (6-
dim), Trial-Budget 40, Random Seed 42. Lista parametrów pokazuje sześć hiperpara
metrów do strojenia z ich zakresami wartości: mipSmoothing3DScale [0.05, 0.5], 
mipFilter2DVariance [0.1,

0.6], densifyGradThreshold [5e-07, 5e-06], ssimWeight [0.05, 0.5], mcmcNoiseScale 
[1e-05, 0.0001], mcmcRelocationInterval [50, 200]. Pośrodku: wykres Convergence 
(X = indeks próby 1–40, Y = wartość Objective 0–1) — szare punkty = próbki począt
kowe (LHS), niebieskie punkty = akwizycja BayesOpt, pomarańczowe punkty = próby 
restartu (#22 i #31). Linia najlepszej wartości rośnie stromo do próby ~7, potem tylko 
marginalna poprawa do próby 15, od tego momentu płaski plateau przy 0.99+. Prawy 
pasek boczny: Trial-Log #1–#34 z score + tag (init/bo/restart). Przycisk Save-Best-
-Config u góry po prawej zapisuje bayesopt-best.json .

Co to jest: Konsola Bayes-optymalizacji do poszukiwania hiperparametrów. Bayes-Opt 
to automatyczna procedura próbująca jak najmniej eksperymentów znaleźć optymalny 
punkt nieznanej funkcji — typowo: „która kombinacja z mcmcMaxGaussians, capMulti
plier, ssimWeight i gradThreshold daje najlepszą PSNR dla mojej klasy sceny?„. Zamiast 
siatki 6^4 = 1296 prób Bayes-Opt próbuje około 40–100 świadomych prób i dociera 
blisko optimum.

Ważne: Bieżąca dostarczona w aplikacji wersja nie przeprowadza optymalizacji wobec 
rzeczywistych przebiegów treningu (to trwałoby dni), lecz wobec syntetycznego demo-
-Objective — wielomodalnego krajobrazu z charakterem hill-climbingu plus lekkim 
noisem. To jest tak celowo: okno ma pokazywać ci zachowanie optymalizatora (przebieg 
zbieżności, punkty próbek, Best-So-Far) i pozwolić ci zrozumieć definicje Search-Spa
ce. Dla rzeczywistych przebiegów BayesOpt sterowanych treningiem (jak w Fazie Q7 dla 
ustawień Scene-Class) używany jest osobny offline workflow CLI; okno jest wariantem 
Live-UI.

 Trzy przypadki użycia: 1. Chcesz zrozumieć, jak działa BayesOpt — wtedy uruchom 
demo-przebieg i obserwuj wykres Convergence. 2. Planujesz nową klasę sceny (np. 
„akwaria„ lub „antyczne meble”), dla której wbudowane 10 ustawień nie pasuje idealnie. 
Zdefiniuj mentalnie przestrzeń poszukiwań, sprawdź ją tutaj z „Bowl demo„ lub ustawie
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niem „Densify”, eksportuj potem Best-Config jako JSON i użyj jako punktu startowego 
dla rzeczywistego przebiegu treningu. 3. Chcesz zainspekcjonować zdefiniowane w pa
kiecie RKBayesOpt domyślne Search-Spaces (Mip-Subset, RadianceKit Defaults) — są 
wyszczególnione w panelu parametrów lewego paska bocznego.

JAK INTERPRETOWAĆ  - Wykres Convergence (środkowa kolumna): Y = najlepsza do
tychczas osiągnięta wartość funkcji Objective. X = indeks próby. Początkowo stromo 
rosnące (BayesOpt próbuje próbki początkowe losowo, niektóre z nich są szczęśliwe), 
potem coraz bardziej płaskie, ponieważ region bliski-optimum jest wyczerpany. Gdy 
linia pozostaje płaska przez 20+ prób, możesz przebieg zatrzymać — dalsze próby nic 
już nie dają. Poszczególne punkty na wykresie to indywidualne wartości prób (czyli nie 
„best so far„), pokolorowane według fazy: szary = próbka początkowa, niebieski = akwi
zycja BayesOpt, pomarańczowy = restart. - Tabela prób (prawa kolumna): #1, #2, #3, … 
z wartością i tagiem fazy. Najlepsza dotychczas próba jest oznaczona żółtą gwiazdką. 
Z tabeli możesz zidentyfikować najlepszą próbę i jej wartości parametrów obejrzeć póź
niej przy eksporcie. - Inspektor Search-Space (lewy pasek boczny): pokazuje dla wy
branego ustawienia wszystkie nazwy parametrów i ich zakresy poszukiwań [lo, hi] . 
Gdy stoisz przy ustawieniu „RadianceKit defaults (6-dim)”, widzisz np. „densifyGradTh
reshold [5e-7, 5e-6]„ — czyli log-uniform między tymi dwiema wartościami.

 Wybierz ustawienie „RadianceKit defaults (6-dim)„, Trial-Budget 40, Seed 42. Kliknij 
„Start”. Obserwuj: pierwsze 8 prób jest szarych (próbki początkowe, Latin-Hypercube), 
następne niebieskie (BayesOpt-akwirowane). Wykres Convergence robi się stromy do 
próby ~15, potem się spłaszcza. Przy próbie ~30–40 najlepsza wartość się stabilizuje. 
Kliknij „Save Best Config„ — zostanie zapisany bayesopt-best.json  z nazwą ustawie
nia, indeksem próby, wartością i dekodowanymi wartościami parametrów. Ten JSON 
możesz potem ręcznie wprowadzić do definicji swojego ustawienia.
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W30 Przycisk „Start„

G DZ I E

Pasek narzędzi po lewej, w stanie Idle/Finished.

T E C H N I C Z N I E

Resetuje listę prób, przełącza w stan Running, ge
neruje nowe ID przebiegu (do wykrywania stale przy 
wielu kliknięciach Start) i tworzy świeżą bramkę 
Pause. Potem startuje zadanie w tle, wykonujące 
optimizer jako asynchroniczny strumień. Rozmiar 
próbek początkowych wynika z min(8, budget /​ 4 
+ 1) — czyli typowo 8 próbek Latin-Hypercube przy 
budżecie ≥ 28, mniej przy małym budżecie. Aktuali
zacje prób są odbierane przyrostowo i dołączane 
do listy. Ochrona przed stale: gdy w międzyczasie 
drugie kliknięcie Start ustawi nowe ID przebiegu, 
aktualizacje ze starego przebiegu są odrzucane.

Primary-Action-Style dla prominentnego wyglądu 
przycisku.

P R O S T Y M I  S ŁOWA M I

Uruchamia świeży przebieg opty­
malizacji z bieżącą przestrzenią 
poszukiwań, budżetem i seedem.

W31 Przycisk „Pause„

G DZ I E

Pasek narzędzi po lewej, w stanie Running.

T E C H N I C Z N I E

Ustawia aktywną bramkę Pause i przełącza w stan 
Paused. Właściwy efekt: runner czeka w pętli pollin
gu 50 ms, zanim oceni następną funkcję Objective. 
To znaczy, że właśnie działająca próba jest dopro
wadzana do końca (jest syntetyczna i trwa tylko 
mikrosekundy), ale żadna kolejna próba nie jest 
inicjowana. Gdy Resume zadziała, idzie dalej tam, 
gdzie się zatrzymał.

P R O S T Y M I  S ŁOWA M I

Zatrzymuje przebieg. Bieżące 
obliczenie dobiega do końca, po­
tem pauzuje.
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W32 Przycisk „Stop„

G DZ I E

Pasek narzędzi po lewej, w stanach Running i Pau
sed.

T E C H N I C Z N I E

Anuluje zadanie runnera, zeruje referencję, zwalnia 
bramkę Pause (jeśli wciąż pauzowane), i przełącza 
w stan Finished (gdy istnieją próby) lub Idle (gdy 
żadne). Już obliczone próby pozostają widoczne w 
liście — Stop ich nie usuwa. Rola przycisku destruk
cyjna pokazuje przycisk na czerwono, ponieważ 
anuluje przebieg.

P R O S T Y M I  S ŁOWA M I

Definitywnie anuluje przebieg. 
Próby pozostają widoczne, mi­
mo to możesz eksportować Best-
-Config.

W33 Przycisk „Resume„

G DZ I E

Pasek narzędzi po lewej, w stanie Paused.

T E C H N I C Z N I E

Zwalnia bramkę Pause i przełącza z powrotem w 
stan Running. Zadanie runnera już działa (czeka w 
pętli pollingu); gdy pętla zauważy, że pauza jest 
zwolniona, działa dalej i startuje następną próbę.

P R O S T Y M I  S ŁOWA M I

Kontynuuje pauzowany przebieg.
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W34 Przycisk „Save Best Config„

G DZ I E

Pasek narzędzi po prawej, zawsze widoczny (ale 
dezaktywowany, gdy nie ma bestTrial).

T E C H N I C Z N I E

Otwiera dialog zapisu z domyślną nazwą pliku 
bayesopt-best.json , ograniczone do JSON. Po 

potwierdzeniu budowany jest słownik payload: na
zwa ustawienia, indeks próby, wartość (score Ob
jective), parametry (słownik dekodowanych nazw 
parametrów → wartości). Dekodowanie projektuje 
znormalizowane współrzędne przestrzeni poszuki
wań w [0,1]^d z powrotem do oryginalnego zakresu 
wartości (ze skalami log-uniform / linear / integer 
odpowiednio). Wyjście JSON jest pretty-printed z 
posortowanymi kluczami. Przy błędzie zapisu (w 
bieżącej wersji demo) cicho ignorowane — brak UI 
błędu, ponieważ to ścieżka demo.

Przycisk pozostaje szary, dopóki żadna próba nie 
została przeprowadzona.

P R O S T Y M I  S ŁOWA M I

Zapisuje wartości parametrów 
dotychczas najlepszej próby jako 
JSON. Możesz potem te wartości 
ręcznie przejąć do swojej konfi­
guracji ustawienia.
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W35 Selektor ustawienia „Search Space„

G DZ I E

Lewy pasek boczny, u góry.

T E C H N I C Z N I E

Selektor menu z czterema opcjami ustawienia: - 
„RadianceKit defaults (6-dim)„ — kompletna stan
dardowa przestrzeń poszukiwań ze wszystkimi hi
perparametrami Q7. - „Mip subset (2-dim)” — 
tylko mipSmoothing3DScale [0.05, 0.5] log-uniform 
i mipFilter2DVariance [0.1, 0.6] linear. Użytecz
ne, gdy chcesz stroić Mip-Splatting dla klasy 
sceny. - „densify-until + ssim-weight + grad-
-thresh„ — trzy parametry istotne dla densyfikacji 
(densifyGradThreshold log-uniform, ssimWeight  li
near, densifyUntilIter  integer). - „Bowl demo 
(1-dim)” — pedagogiczna przestrzeń poszukiwań 
pojedynczego parametru do dem „jak działa Bay
esOpt„.

Gdy przebieg jest aktywny, przestrzeni poszukiwań 
nie można zmienić (zmyliłaby optimizer).

P R O S T Y M I  S ŁOWA M I

Którą przestrzeń poszukiwań hi­
perparametrów BayesOpt prze­
szukuje. Standardem jest „Ra­
dianceKit defaults„. Do celowa­
nych prób strojenia Mip „Mip 
subset”. Do zrozumienia, jak 
działa BayesOpt, „Bowl demo„.

W36 Suwak „Trial Budget„

G DZ I E

Lewy pasek boczny, pod selektorem Search-Space.

T E C H N I C Z N I E

Suwak od 10 do 200, krok 5. Domyślnie 40. To 
znaczy: BayesOpt może zrobić maksymalnie N prób. 
Pierwsze są próbkami początkowymi (Latin-Hyper
cube), reszta to rzeczywiste próby BayesOpt. Regu
ły kciuka w praktyce: przestrzeń poszukiwań z d 
wymiarami potrzebuje około 10d do 20d prób dla 
dobrego optimum. Przy 6-dim Defaults więc 60–
120, przy 2-dim Mip-Subset 20–40, przy 1-dim 
Bowl-Demo 10–20.

Podczas przebiegu suwak jest dezaktywowany.

P R O S T Y M I  S ŁOWA M I

Ile prób optymalizacji maksymal­
nie. Więcej prób = lepsze rozwią­
zanie, ale kosztuje więcej czasu. 
40 to dobry domyślny dla demo-
-Objective.
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W37 Suwak „Random Seed„

G DZ I E

Lewy pasek boczny, pod suwakiem Budget.

T E C H N I C Z N I E

Suwak od 1 do 100, krok 1. Domyślnie 42. Seed jest 
przekazywany zarówno do początkowych próbek 
Latin-Hypercube, jak i do komponentu Noise demo-
-Objective. Powtarzalność: ten sam seed + ta sama 
przestrzeń poszukiwań + ten sam budżet daje do
kładnie identyczną sekwencję prób. Użyteczne dla 
„czy wszyscy twoi koledzy otrzymują ten sam prze
bieg, gdy odtwarzają demo?„. Podczas przebiegu 
dezaktywowany.

P R O S T Y M I  S ŁOWA M I

Steruje generatorem losowości. 
Ten sam seed = ten sam przebieg 
— do reprodukowania.

W38 Chart (Convergence)

G DZ I E

Środkowa kolumna okna.

T E C H N I C Z N I E

Wykres Swift-Charts z dwiema warstwami: 1. linia 
„best-value-so-far„ na próbę — monotonicznie ro
snąca lub pozostająca taka sama krzywa w kolorze 
akcentu. 2. punkt na próbę z indywidualną wartością 
Objective, pokolorowany według fazy. Rozmiar sym
bolu 40. Trzy etykiety fazy: „init” (szary), „bo„ (nie
bieski), „restart” (pomarańczowy).

Mała legenda pokazuje kolory faz u góry po lewej. 
Gdy lista prób jest pusta (przed pierwszym Star
tem), wyświetlany jest zamiast tego empty-state z 
ikoną wykresu i wskazówką „Press Start to begin a 
BayesOpt run.„.

P R O S T Y M I  S ŁOWA M I

Wykres przebiegu. Ciągła linia to 
„dotychczas najlepsza znalezio­
na wartość„; punkty to poszcze­
gólne próby. Gdy linia pozostaje 
długo płaska, BayesOpt znalazł 
optimum.
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W39 Tabela (Trial Log)

G DZ I E

Prawa kolumna okna.

T E C H N I C Z N I E

Obszar przewijania z lazy stackowanymi wierszami 
prób. Na wiersz horyzontalny stos: numer próby 
(3-cyfrowo monospaced, po lewej), wartość (mono
spaced, wyrównana do prawej, 70 pt szerokości), 
tag fazy (Capsule, wypełniony kolorem fazy przy 
25% opacity), opcjonalnie żółta gwiazdka, gdy ta 
próba jest aktualnie najlepsza. Mechanizm auto-
-scroll automatycznie skacze na koniec, gdy tylko 
nowa próba dochodzi — dzięki czemu możesz prze
bieg na żywo czytać na dole ekranu, bez samodziel
nego przewijania.

P R O S T Y M I  S ŁOWA M I

Tabela wszystkich prób. Wartość, 
faza, gwiazdka dla najlepszej. 
Przewija się automatycznie, no­
we próby pojawiają się u dołu.

Okno główne: przebieg straty i liczba gaussianów (I39–I41, odsyłacz)

Trzy wyświetlania Inspectora w oknie głównym zasługują na własne wyjaśnienie, ponie
waż podczas działającego treningu są stale widoczne i istnieją ważne reguły kciuka, 
kiedy przebieg wygląda zdrowo. Wyświetlania znajdują się w Inspectorze pod sekcją 
„Loss Chart„ (zobacz rozdział 2 — Inspector) i uzupełniają analizę Holdout z okna 
pomocniczego powyżej.

Kiedy krzywa Loss jest zdrowa? Zdrowa krzywa Loss pokazuje trzy fazy: (1) Warmup 
— pierwsze 200–500 iteracji Loss spada stromo z wysokich (typowo 0.15–0.25 dla 
L1+SSIM łączonego w zależności od sceny) na około połowę. Gdy Loss w tej fazie NIE 
spada, zwykle wejście jest błędne (obrazy zepsute, pozy SfM złe, liczba gaussianów 
początkowych zbyt mała). (2) Densyfikacja — między ~500 a densifyUntilIteration 
(klasycznie 15K, MCMC do 20K lub 25K) Loss spada dalej, często z małymi skokami w 
dół, gdy operacje densify wstawiają nowe gaussiany a optimizer je wykorzystuje. Liczba 
gaussianów rośnie w tej fazie. (3) Refinement — potem Loss biegnie w spłaszczający 
się tail. Typowe wartości końcowe: Truck Tanks-&- Temples z P4 Quality ląduje przy 
L1 ≈ 0.023, Horse z Full Classic V546 przy L1 ≈ 0.0230, sceny Outdoor-Mip-NeRF360 
często gorzej (0.04–0.07).

Co oznacza plateau? Plateau (krzywa Loss biegnie horyzontalnie przez kilka tysięcy 
iteracji) ma dwie interpretacje: (a) model jest zbieżny, dalszy trening niczego więcej nie 
daje — to dobry przypadek. (b) model jest stuck (minimum lokalne, słaba informacja 
gradientu, cap na limicie bufora) — zły przypadek. Oba wyglądają na wykresie identycz
nie. Rozróżnienie: spójrz na liczbę gaussianów. Gdy też jest płaska I blisko cap MCMC 
(np. 150K z 150K przy .fullMCMC ), jesteś przy limicie — albo cap zwiększyć, albo za
akceptować plateau. Gdy liczba gaussianów wciąż rośnie, ale Loss nie spada, to stuck.
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Kiedy przerwać vs trenować dalej? Reguła kciuka: 10K iteracji bez poprawy Min-Loss 
→ przerwać, dalsze iteracje są zmarnowane. Wcześniej: możesz przez Cmd+T (menu 
Training → Continue Training → +5K iterations) jeszcze podłączyć przedłużenie, gdy 
widzisz graniczną poprawę. Uwaga: przy MCMC plateau jest często prawdziwe — cap to 
naturalna granica.

Plateau liczby gaussianów to NIE sygnał „gotowe„. Oznacza tylko, że MCMC osią
gnęło cap lub że densyfikacja Classic jest wyczerpana. Prawdziwe pytanie „gotowe” 
zadaje dopiero analiza Holdout — PSNR/SSIM/LPIPS na niezależnym zestawie testowym, 
oceniane w oknie Holdout (W23–W29) lub przez flagę --benchmark .

PSNR/Holdout to prawda, Loss tylko proxy. Loss to metryka względna: spada, gdy 
twój model dostosowuje się do widoków treningowych. Niski Loss nie oznacza jednak 
automatycznie dobrego modelu — gdy model wyuczył się obrazów treningowych na 
pamięć (overfitting), Loss byłby mały, ale PSNR na niewidzianych widokach (Holdout) 
byłaby zła. Dlatego: do finalnej oceny jakości zawsze patrz na metryki Holdout, nie na 
końcowy Loss sam w sobie.

Pudełko reguł kciuka

• User Guide i Keyboard Shortcuts to statyczna pomoc — przy pytaniach hasłowych 
szybko, do głębi używać tego podręcznika.

• Manage Storage otworzyć, gdy tylko dysk spadnie poniżej 10% wolnego miejsca. Logi 
i staging importów to typowi winowajcy.

• Pareto Dashboard sensowne dopiero po co najmniej trzech lub czterech raportach 
treningu. Oś X = koszty (Time / Gs), oś Y = jakość (PSNR / SSIM). Front Pareto 
pokazuje efektywne kombinacje.

• Holdout Analysis używać, zanim publikujesz z innymi benchmarki PSNR — zapewnia 
ci, że twój zestaw testowy jest naprawdę reprezentatywny.

• BayesOpt Console jest przede wszystkim narzędziem do nauki i inspekcji definicji 
przestrzeni poszukiwań. Do rzeczywistego strojenia hiperparametrów sterowanego 
treningiem używać offline workflow CLI.

• Plateau Loss i plateau liczby gaussianów są interpretowane oddzielnie. Limit cap to 
nie sygnał „gotowe„. Prawdziwą jakość mierzy tylko Holdout-PSNR.

• 10K iteracji bez poprawy Min-Loss → trening zatrzymać.
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R O Z D Z I A Ł

Rozdział 6 — Konfiguracja treningu

Rysunek 26:  Preview-Preset als JSON exportiert + in TextEdit angezeigt — Felder id/name/
category/version/createdAt/description, trainingConfig mit allen relevanten Parametern (ma

xIterations 5000, densifyUntilIteration 3500, ssimWeight 0.20, renderScale 0.50, strategy 
classic, cameraAlignment applePhotogrammetry, densifyGradThreshold 2.0e-06, opacityRe

setInterval 3000, minOpacity 0.005, sechs Bool-Toggles)

WAS IM BILD ZU SEHEN IST  Ein typischer Preset-JSON-Export. Top-Level-Felder: id  
(UUID), name , (classic | mcmc | sceneClass | custom), (Schema-Version), (Timestamp), 
(Free-Text). Verschachteltes -Objekt enthält die für Reproduzierbarkeit kritischen Para
meter — beim Import wird der gesamte Block in die TrainingConfig -Struktur deseria
lisiert, und Defaults aus der App-Version füllen die Felder, die in der JSON fehlen (z. 
B. nach App-Update). Wer ein Preset an einen anderen Mac übergibt, schickt einfach 
diese JSON-Datei rüber.

Die TrainingConfig -Struktur ist das Herzstück jedes Trainingslaufs in RadianceKit. 
Sie versammelt jeden Parameter, der das Training beeinflusst — von der maximalen 
Iterationszahl über die acht Lernraten bis hin zu den Spezialfeldern für MCMC, Mip-
-Splatting, das Curriculum und die scene-aware Cap-Logik. Du bearbeitest sie in der 
Sidebar im Bereich Trainings-Konfigurations-Sektion (Expert View), speicherst sie als 
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Preset oder reichst sie als JSON-Export an einen anderen Mac weiter. Beim Training 
wird genau dieses Objekt eingefroren und ans GPU-Backend gegeben.

Dieses Kapitel ist Referenz-Material für Power-User und Skript-Autoren. Es listet alle 81 
öffentlichen Felder, die 9 statischen Presets und die eine öffentliche Methode. Quellda
tei ist TrainingConfig.swift — bei Zweifeln gilt der dort hinterlegte Doc-Comment und 
der Initializer-Default als Source-of-Truth.

H I N W E I S  ·  U I  V S .  P R E S E T/ C L I

Nur 12 der 81 Felder haben einen direkten Schieberegler, Toggle oder Picker im 
Inspector (sandboxed App-Store-Build): T1, T2, T17, T20, T22, T38, T56–T58, 
T60, T61, T73. Die restlichen 69 Felder werden über das gewählte Preset (Kapitel 
7) gesetzt und lassen sich nur per CLI-Flag (siehe Kapitel 5) direkt überschre
iben. Diese Trennung ist Absicht: Defaults bleiben stabil und produktionserprobt, 
Power-User haben dennoch eine Escape-Luke. Wenn ein Feld dich besonders inte
ressiert: schau zuerst in Kapitel 2 (Inspector) und Kapitel 5 (CLI) nach, ob du es 
ohne JSON-Bastelei erreichst.

Inhaltsverzeichnis:

1. Iteration (T1–T2)
2. Learning Rates (T3–T10)
3. Densification — Classic (T11–T16)
4. Loss (T17–T20)
5. SH-Degree-Progression (T21)
6. Performance (T22–T25)
7. Diagnose und Punktwolken-Vorbereitung (T26–T30)
8. Regularisierung (T31–T37)
9. Refinement (T38–T44)

10. Sky-Dome (T45–T48)
11. Adam + LR-Schedule (T49–T55)
12. Post-Processing + Apple AI (T56–T60)
13. MCMC-Densification (T61–T73)
14. Mip-Splatting (Q1.5) (T74–T76)
15. Adaptive Densification (Q5) (T77–T79)
16. Curriculum (Q6) (T80–T81)
17. Statische Presets (TP1–TP9)
18. Methode:
19. Welches Feld wofür? (Cheat-Sheet)
20. Gefährliche Felder
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Iteration (T1–T2)

T1 maxIterations

S ZC Z E G Ó ŁY

Default: 30 000 (Initializer), 35 000 ( .full ), 200 
000 ( .fullMCMC ) Range: 1 000 – 500 000 (UI-Sli
der), keine harte obere Grenze in der Logik Defined 
in:

T E C H N I C Z N I E

Gesamtzahl der Trainings-Iterationen, die das Bac
kend durchläuft. Eine Iteration bezeichnet ein 
Forward-Render einer einzelnen Trainingskamera, 
einen Backward-Pass über alle Loss-Komponen
ten (L1 + SSIM + optionale Regularisierungen + 
Sky-Mask) und einen Adam-Optimizer-Schritt. Die
se Zahl wirkt direkt auf die anderen Schedules: 
Position-Lernrate folgt einer Cosine-Annealing-Ku
rve von 0 bis entweder T1  selbst oder bis 
T49 positionLRScheduleEndIteration; Densification 
stoppt bei T2 densifyUntilIteration; MCMC-No
ise-Decay endet bei T69 mcmcNoiseDecayEnd; SH-
-Degree-Upgrades passieren an den drei in T21  
definierten Marken. Bei klassischer Densification 
liegt der empirisch ermittelte sweet spot bei 20 
000–35 000 Iterationen (Sessions 1–32, V546-Te
sts), bei MCMC bei 60 000–200 000 (V534). Eine 
drastische Erhöhung über die in Preset hinterlegten 
Werte hinaus bringt selten zusätzliche Qualität — 
Adam-Momentum sättigt, und ohne LR-Decay-Ende 
stagniert der Loss. Umgekehrt führt Unterschre
itung von ~5 000 zu unvollständig konvergierten 
Geometrien (Density-Control hat zu wenig Zeit zum 
Klonen/Splitten).

P R O S T Y M I  S ŁOWA M I

Wie lange die App rechnet. Mehr 
Iterationen = besseres Ergeb­
nis, aber irgendwann nicht mehr 
spürbar besser, dafür viel länger. 
Die Presets sind so gewählt, dass 
du ohne nachzudenken einen gu­
ten Wert hast: Quick 1 000, Pre­
view 5 000, Balanced 20 000, 
Quality 35 000, MCMC Quality 
200 000. Wenn du selbst dran 
drehst, gilt: bei MCMC darfst du 
gerne hoch (100 000–200 000), 
bei Classic nicht über 40 000 — 
bringt dann nichts mehr.
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T2 densifyUntilIteration

S ZC Z E G Ó ŁY

Default: 15 000 (Initializer), 5 000 ( .full ), 160 
000 ( .fullMCMC ) Range: 0 – Defined in:

T E C H N I C Z N I E

Iteration, ab der die Densification aufhört. Bis hier
hin werden Gaussians über die in T11–T16  (Clas
sic) oder T67–T70  (MCMC) parametrisierten Re
geln geklont, gesplittet und geprunt; danach bleibt 
die Gaussian-Anzahl konstant und nur noch Positio
nen, Rotationen, Skalen, Opazitäten und SH-Koeffi
zienten werden optimiert (Refinement-Phase). Im 
3DGS-Originalpaper liegt der Wert bei 50 % von 
T1 , in RadianceKits .full -Preset bei nur ~14 

% (5 000 von 35 000) — Folge der V310/V338-
-Experimente, die zeigten, dass nach 5 000 Itera
tionen weitere Densifizierung das Resultat eher ver
schlechtert (mehr Floaters, mehr Speicherbedarf, 
kein Qualitätsgewinn). MCMC dagegen läuft die Re
location bis 80 % von T1  (V504b), weil MCMC 
keine schädlichen Floaters produziert. Wird T2  zu 
klein gewählt (< 1 000), entstehen zu wenige Gaus
sians; zu groß bei Classic (> 50 % von T1 ) führt 
zu Overgrowth und RGB-Saturation-Outliers (siehe 
Outdoor-Overtraining-Findings).

P R O S T Y M I  S ŁOWA M I

Bis wann die App neue Gaussians 
erzeugen darf. Danach wird nur 
noch verfeinert, was schon da 
ist. Bei klassischem Training mit 
35 000 Iterationen ist hier 5 000 
der richtige Wert — alles darüber 
macht die Szene matschiger. Bei 
MCMC ist es 80 % der Gesam­
titerationen (also 160 000 bei 
200 000-Lauf). Wenn du Quality-
-Preset änderst, lass dieses Feld 
lieber in Ruhe.
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Learning Rates (T3–T10)

T3 positionLearningRate

S ZC Z E G Ó ŁY

Default: 0.00016 Range: 1e-7 – 1e-3 (empfohlen) 
Defined in:

T E C H N I C Z N I E

Adam-Lernrate für die XYZ-Position jeder Gaussian 
zu Beginn des Trainings (Iteration 0). Folgt einer 
Cosine-Annealing-Kurve und sinkt im Laufe des 
Trainings auf T4 positionLearningRateFinal. Der 
Default 0.00016 stammt aus dem 3DGS-Originalpa
per (Kerbl et al. 2023) und ist in RadianceKit auch 
bei Erhöhung der Bildauflösung nicht zu skalieren 
— die Position bewegt sich im Welt-Koordinatensys
tem, nicht im Pixelraum. Eine deutliche Erhöhung 
(> 0.0005) bewirkt, dass Gaussians über lange Di
stanzen springen und der Loss instabil wird; Werte 
deutlich darunter (< 0.00005) führen dazu, dass 
falsch initialisierte Punktwolken nie ihren Platz fin
den. V414 testete eine Verdopplung des Init-Werts 
→ 16.8 % schlechterer L1-Loss; die V544a-Tunings 
bestätigten den Paper-Default als optimal. Beachte: 
bei .fullMCMC  lassen wir diesen Wert bewusst be
im Default — MCMC braucht konstante Lernraten für 
seine Relocation-Logik, daher bringt das Tunen hier 
nichts.

P R O S T Y M I  S ŁOWA M I

Wie schnell sich die Splatt-Punk­
te im Raum bewegen dürfen. 
Der Standardwert ist sehr gut 
justiert und braucht eigentlich 
keine Änderung. Nur wenn dir 
Splats im Bild „herumeiern„ oder 
eine ganze Ecke fehlt, weil sich 
nichts hinbewegt, wäre die Lern­
rate ein Punkt zum Drehen — 
aber dann passt typischerwe­
ise vorher schon etwas anderes 
nicht (Kameraposen, Initialpunk­
twolke).
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T4 positionLearningRateFinal

S ZC Z E G Ó ŁY

Default: 0.0000016 (Initializer + Paper), 0.000016 
( .full , .fullMCMC  — 10× höher) Range: 0 – De­
fined in:

T E C H N I C Z N I E

Endwert der Position-LR-Cosine-Annealing-Ku
rve. Erreicht wird er entweder bei 
T1 maxIterations  oder, falls gesetzt, bei T49 
positionLRScheduleEndIteration. Der RadianceKit-
- .full -Preset verwendet 0.000016 — also 10× 
höher als der Paper-Default 0.0000016. V420-
-Experimente zeigten, dass 0.5× des Final-Werts 
(0.000008) den Loss um 6.4 % verschlechtert; 
V414 zeigte, dass 2× Init-Wert ihn um 16.8 % 
verschlechtert. Der hohe Final-Wert ist nicht Trade-
-off, sondern bewusste Wahl: bei zu starkem Decay 
verlieren die Gaussians während der Refinement-
-Phase ihre Fähigkeit, sich auf neu hinzugekomme
ne Densification-Kandidaten einzustellen. Über die 
V431/V433-Erweiterung kann die Schedule-Phase 
verkürzt werden ( T49 < T1 ), sodass T4  bereits 
vor Trainingsende erreicht wird und der Rest des 
Trainings bei konstanter Mini-LR läuft — typische 
Konfiguration: T49 = 20 000 , T1 = 35 000 , Refi
nement also bei 0.000016 für 15 000 Iterationen.

P R O S T Y M I  S ŁOWA M I

Wie langsam die Position-Lernra­
te am Ende des Trainings wird. 
Wir haben das bewusst weniger 
aggressiv eingestellt als das Ori­
ginalpaper — Splats können bis 
zum Schluss noch ein bisschen 
wackeln, das macht sie schärfer. 
Wenn du daran drehst: höher = 
unruhigere Splats am Ende, nie­
driger = Splats können sich nicht 
mehr anpassen, wenn neue au­
ftauchen.

115 / 233



R A D I A N C E K I T Rozdział 6 — Konfiguracja treningu

T5 shDCLearningRate

S ZC Z E G Ó ŁY

Default: 0.0025 (Initializer + Paper), 0.005 ( .full  
und alle MCMC-Presets — 2×) Range: 0.0001 – 
0.05 Defined in:

T E C H N I C Z N I E

Adam-Lernrate für den DC-Anteil (degree 0, al
so konstantes Albedo) der spherical-harmonic-Far
be. SH-DC entspricht dem direktionsunabhängigen 
Grundton einer Gaussian, gewissermaßen die „Ba
sisfarbe„. Die V176- und V188-Experimente fanden 
2× höher als der Paper-Default optimal — schnellere 
Farb-Konvergenz, gerade weil bei kurzem Training (, 
5 000 Iterationen) die SH-DC sonst nicht in Form 
kommt. Anders als die geometrischen LRs hat SH-
-DC keinen Decay; die Lernrate bleibt über alle 
Iterationen konstant (oder folgt nur dem optiona
len extended-phase-Decay aus T51 ). V416 testete 
eine Vervierfachung auf 0.01 → 6.4 % schlechterer 
Loss bei beta2=0.99-Adam.

P R O S T Y M I  S ŁOWA M I

Wie schnell sich die Grundfarbe 
jedes Splats anpasst. Den Wert 
ändert man fast nie selbst — 
die Presets haben den richti­
gen Wert. Höher ginge schneller, 
kann aber zu instabilen Farben 
führen.
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T6 shRestLearningRate

S ZC Z E G Ó ŁY

Default: 0.000125 (Initializer + Paper), 0.00025 
( .full  und MCMC — 2×) Range: 0.000001 – 
0.005 Defined in:

T E C H N I C Z N I E

Adam-Lernrate für die SH-Koeffizienten höherer 
Ordnung (Degree 1, 2, 3 — also die view-direc
tion-abhängigen Farbanteile, die für Glanzlichter, 
Spiegelungen und sanfte Schattierung sorgen). 20× 
kleiner als T5  per Paper-Konvention, weil diese 
Koeffizienten quadratisch in Anzahl wachsen (3 für 
Degree 1, 5 für Degree 2, 7 für Degree 3 → insge
samt 15 Floats pro Gaussian) und ohne kleinere 
Lernrate das Bild übersättigen würden. Wird in zwei 
Schritten freigeschaltet — bis zur ersten Marke in 
T21 shDegreeUpgradeIterations ist nur Degree 0 
aktiv (also nur T5 ), danach 1, später 2, schließlich 
3. Niedrige Werte hier sind besonders wichtig auf 
Szenen mit viel diffuser Beleuchtung; bei sehr glän
zenden Oberflächen (Auto-Lack, Wasser) lohnt sich 
kein Drehen — die SH-Repräsentation an sich ist 
begrenzt.

P R O S T Y M I  S ŁOWA M I

Wie schnell die richtungsabhän­
gigen Farb-Effekte (Spiegelun­
gen, Glanz) lernen. Standard­
mäßig sehr klein, weil sonst al­
les glänzt. Den Wert lässt man 
besser stehen — wer Glanzlich­
ter besser hinbekommen will, ist 
eher bei MCMC und längerer Tra­
iningszeit besser bedient als bei 
dieser LR.
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T7 opacityLearningRate

S ZC Z E G Ó ŁY

Default: 0.05 (Initializer + Paper), 0.1 ( .full , 
MCMC — 2×) Range: 0.001 – 1.0 Defined in:

T E C H N I C Z N I E

Adam-Lernrate für die logit-Opazität jeder Gaus
sian. Die App speichert Opazität als unbeschränkten 
Float-Wert und transformiert ihn mit Sigmoid in [0, 
1]; die LR wirkt im Logit-Space. Der Paper-Default 
0.05 ist nach V50-Tests (Best Single-Run L1 0.1664) 
wiederhergestellt, V71 revertete V67s 0.025. Die 
V188-Verdopplung auf 0.1 macht das Pruning effi
zienter — tote Gaussians fallen schneller unter den 
T14 pruneOpacityThreshold ab. V418 zeigte: 0.05 
mit beta2=0.99-Adam ist 7.1 % schlechter als 0.1 — 
die Wechselwirkung mit der Adam-Konfiguration ist 
nicht trivial. Niedrige Werte (< 0.01) führen dazu, 
dass „dead„ Gaussians ewig herumliegen und Spe
icher verbrauchen; zu hohe Werte (> 0.5) können zu 
Opacity-Explosion führen, daher wird der Logit-Wert 
im Optimizer auf [−15, 3] geclampt (siehe Notiz 
„Opacity Explosion Prevention” in CLAUDE.md).

P R O S T Y M I  S ŁOWA M I

Wie schnell Splats durchsich­
tig oder undurchsichtig wer­
den. Wichtig fürs Aufräumen 
— Splats, die nichts beitragen, 
müssen schnell verschwinden, 
damit kein Schleier entsteht. 
Standardwert passt, nur Profis 
ändern ihn.
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T8 opacityLearningRateFinal

S ZC Z E G Ó ŁY

Default: 0.0 (= „kein Decay„) Range: 0 oder 0.001 – 
Defined in:

T E C H N I C Z N I E

Optionaler Cosine-Decay-Endwert für die Opacity-
-LR (V427). Wenn 0.0, ist Decay deaktiviert und 
die Opacity-LR bleibt über das gesamte Training 
konstant bei T7 . V427 testete einen Decay 0.1 → 
0.01 — Ergebnis 11.5 % schlechterer Loss; reverted, 
daher der Default „aus„. Die Hypothese hinter dem 
Feld: in der Refinement-Phase könnte konstante 
Opacity-LR zu Oszillation führen, sodass Splats, die 
schon das richtige Maß an Transparenz erreicht ha
ben, durch zufällige Gradient-Schwankungen wieder 
verschoben werden. Empirisch bestätigt sich das 
nicht — die Logit-Clamping-Logik fängt das ohnehin 
ab. Das Feld bleibt verfügbar für zukünftige Experi
mente; auch sehr lange MCMC-Läufe (> 500K Itera
tionen) könnten davon profitieren.

P R O S T Y M I  S ŁOWA M I

Ob die Opacity-Lernrate gegen 
Ende kleiner werden soll. Stan­
dard: nein. Wir haben es pro­
biert, war schlechter, lassen es 
deaktiviert. Bleib bei 0.

T9 scaleLearningRate

S ZC Z E G Ó ŁY

Default: 0.005 (Initializer + Paper), 0.01 ( .full , 
MCMC — 2×) Range: 0.0001 – 0.1 Defined in:

T E C H N I C Z N I E

Adam-Lernrate für die drei Skalen-Komponenten je
der Gaussian im log-Space (RadianceKit speichert 
log(scale), damit Skalen positiv bleiben). Der Paper-
-Default 0.005, in RadianceKit verdoppelt auf 0.01 
für besseren Scale-Konvergenz bei den optimierten 
Lernraten-Konfigurationen. V423-Experiment: 0.005 
mit beta2=0.99-Adam → 18.7 % schlechterer Loss 
und sichtbar zu wenige Gaussians (Density-Con
trol konnte nicht klonen, weil die Skalen-Updates 
zu lahm waren). Skala kontrolliert die Ausdehnung 
jeder Gaussian — zu schnelles Lernen führt zu „ne
edle„-Gaussians (extrem lange dünne Splats, siehe 
T34 scaleRatioPruneThreshold), zu langsames Ler
nen lässt Splats zu kompakt bleiben und Density-
-Control muss zu oft splitten.

P R O S T Y M I  S ŁOWA M I

Wie schnell die Form der Splats 
sich anpasst. Standard ist gut. 
Wenn du das hochdrehst, be­
kommst du gerne „Nadel„-Splats 
— extreme lange dünne Tropfen, 
die das Bild floaten lassen.
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T10 rotationLearningRate

S ZC Z E G Ó ŁY

Default: 0.001 (Initializer + Paper), 0.002 ( .full , 
MCMC — 2×) Range: 0.0001 – 0.05 Defined in:

T E C H N I C Z N I E

Adam-Lernrate für die vier Quaternion-Komponen
ten jeder Gaussian. Die Quaternion wird in jedem 
Optimizer-Schritt nach der Adam-Update wieder 
normalisiert (L2-Norm = 1) — andernfalls würde 
die Kovarianzmatrix entartet. RadianceKit verdop
pelt den Paper-Default in den Quality-Presets, weil 
Rotation gegenüber Skala / Position kleinere absolu
te Gradient-Magnituden hat (auf der Einheitssphäre 
bleibt jeder Schritt kurz) und ohne 2× wäre die Ro
tation im 35 000-Iterations-Window deutlich unter-
-konvergiert. V188 dokumentiert. Auf NeRF-Blen
der-Szenen (Lego, Chair) wirkt sich Rotation beson
ders aus — die Kanten der Objekte richten sich erst 
nach 5 000–10 000 Iterationen richtig aus.

P R O S T Y M I  S ŁOWA M I

Wie schnell sich die Splats dre­
hen lernen — also auf der Obe­
rfläche eines Objekts in die rich­
tige Ausrichtung kommen. Stan­
dard passt. Anders ausgedrückt: 
wenn Splats wie schief liegen­
de Klötze aussehen statt sich an 
die Oberfläche anzuschmiegen, 
ist eher die Trainingszeit zu kurz, 
nicht diese Lernrate zu niedrig.
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Densification — Classic (T11–T16)

T11 densifyGradThreshold

S ZC Z E G Ó ŁY

Default: 0.000002 (Initializer, kalibriert für 0.5× Au
flösung), 0.0000011 ( .full , kalibriert für 1.0×), 
0.000004 ( .quickTest , kalibriert für 0.25×), 2e-7 
( .fullClassicPaper ) Range: 1e-8 – 1e-3 (au
flösungsabhängig) Defined in:

T E C H N I C Z N I E

Schwellwert für die L2-Norm des bildschirm
raum-projizierten Gradienten dMean2D , oberhalb 
dessen eine Gaussian für Klonen oder Splitten 
markiert wird. Der absolute Wert hängt direkt 
von der Trainingsauflösung ab — dMean2D  ska
liert ungefähr wie 1/Auflösung² (mehr Pixel = 
kleinere Per-Pixel-Gradienten). Daher braucht je
de T22 trainingRenderScale-Stufe einen kalibrier
ten Schwellwert: 0.25× → 4e-6, 0.5× → 2e-6, 
1.0× → 5e-8 … 1.1e-6 ( .full ). Der Paper-
-Default 0.0002 ist NDC-normalisiert und in Ra
dianceKits Welt-Raum-Pipeline nicht direkt vergle
ichbar. Mit dem in V440 zugeschalteten T52 
adaptiveDensifyThreshold-Flag lässt sich der Wert 
in Laufzeit aus dem p98 der aktuellen Gradient-
-Verteilung berechnen — aber V440 testete das auf 
realen Szenen und produzierte 63 K Gaussians (ka
tastrophaler Pruning-Verlust); das Flag bleibt aus. 
Q5 (T77–T79) liefert eine alternative Adaptive-Logik 
via rolling median. Gefahrlos ist dieses Feld nicht 
— Halbierung erzeugt 2–4× mehr Gaussians (Spe
icher-Druck, OOM-Risiko); Verdopplung kann die 
Szene unter-densifizieren.

P R O S T Y M I  S ŁOWA M I

Wie empfindlich die App ist, 
wenn sie entscheiden soll, ob ein 
Splat zu wenig dargestellt wird 
und vervielfältigt werden muss. 
Niedriger Wert = empfindlicher 
= mehr Splats. Höher = weni­
ger Splats. Das ist einer der ge­
fährlichsten Werte überhaupt: zu 
niedrig und der Mac läuft mit Mil­
lionen Splats voll Speicher und 
stürzt eventuell ab. Lass das Feld 
in Ruhe, oder ändere es nur in 
Schritten von 10 %.

121 / 233



R A D I A N C E K I T Rozdział 6 — Konfiguracja treningu

T12 densifyFromIteration

S ZC Z E G Ó ŁY

Default: 500 Range: 100 – 5 000 Defined in:

T E C H N I C Z N I E

Erste Iteration, ab der Densification aktiv wird. 
Vorher passiert nur „nacktes„ Lernen auf der ini
tialen SfM-Punktwolke, ohne dass neue Gaussians 
erzeugt werden. Der Default 500 stammt aus dem 
3DGS-Paper und gibt der Initialisierung Zeit, sich 
zu stabilisieren — wenn schon ab Iteration 0 den
sifiziert wird, klonen sich falsch positionierte SfM-
-Punkte vielfach, bevor sie überhaupt ihren rich
tigen Platz finden. V349 testete 1000 → leicht 
schlechter Loss; der Default ist optimal.

P R O S T Y M I  S ŁOWA M I

Wann die App das erste Mal an­
fängt, Splats zu klonen. Vorher 
lernt sie nur die schon vorhande­
nen Punkte. 500 ist der Standar­
dwert — gibt der App genug Zeit, 
sich erst mal zu orientieren, be­
vor sie vervielfacht.

T13 densifyInterval

S ZC Z E G Ó ŁY

Default: 100 (Initializer, MCMC), 200 ( .full ) Ran­
ge: 50 – 1 000 Defined in:

T E C H N I C Z N I E

Wie viele Iterationen zwischen zwei Densification-
-Schritten liegen. Im Paper-Default 100 — alle 
100 Iterationen wird die Liste der densify-Kandida
ten ausgewertet, geklont/gesplittet und gleichzeitig 
die Liste der prune-Kandidaten (sigmoid(opacity) 
< T14 pruneOpacityThreshold) entfernt. V112-Tests 
fanden 200 als optimal für .full  — das entlastet 
die GPU, weil weniger Reorganisations-Passes lau
fen, und gibt jeder Gaussian mehr Zeit, sich nach 
einer Klone-Aktion einzupendeln. V417 testete 100 
mit beta2=0.99 → 5.8 % schlechter (957 K Gaus
sians, Überdensifizierung). Bei MCMC wird dasselbe 
Feld als Relocation-Interval interpretiert; siehe T67 
mcmcRelocationInterval für die MCMC-spezifische 
Logik.

P R O S T Y M I  S ŁOWA M I

Wie oft die App nach neuen 
Splats schaut. 100 = oft, 200 = 
mittel. Höher heißt: jeder Splat 
hat länger Zeit sich einzurich­
ten, bevor wieder vervielfältigt 
wird. Das ist gut. Auf 50 zu 
senken kann den GPU dauerhaft 
beschäftigen, ohne dass es nen­
nenswert besser wird.
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T14 pruneOpacityThreshold

S ZC Z E G Ó ŁY

Default: 0.005 (Initializer, Paper, MCMC), 0.001 
( .full ) Range: 0.0001 – 0.1 Defined in:

T E C H N I C Z N I E

Sigmoid-Opazitäts-Schwelle, unter der eine Gaus
sian beim nächsten Densification-Step gelöscht 
wird. Wirkt zusammen mit T7 opacityLearningRate 
und der Logit-Clamp-Logik im Optimizer. V393 
senkte den Default von 0.005 auf 0.001 in .full  
— Folge: Splats die nur unter exotischen Blickwin
keln eine Rolle spielen, bleiben länger erhalten und 
tragen zur SH-Detail bei. V394 testete 0.0001 → 
leicht schlechter (zu wenig gepruntet, Speicher ver
schwendet). Wichtig: Density-Control muss IMMER 
prunen, auch wenn die Buffer-Kapazität durch an
dere Maßnahmen schon voll ist (siehe „Density 
Control Must Always Prune„ in CLAUDE.md) — 
sonst akkumulieren tote Gaussians und der Count 
friert ein.

P R O S T Y M I  S ŁOWA M I

Wann ein Splat als „durchsichtig 
genug„ gilt, um gelöscht zu wer­
den. 0.005 ist der Paper-Stan­
dard, wir haben in Quality 0.001 
— also wir geben Splats län­
ger eine Chance. Das macht we­
iches Licht und schwache Schat­
ten besser darstellbar. Höher zu 
setzen (über 0.01) lässt die Splat-
-Anzahl schnell sinken — kann 
sinnvoll sein bei Speicherknap­
pheit, kostet aber Detail.
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T15 opacityResetInterval

S ZC Z E G Ó ŁY

Default: 3 000 (Initializer + Paper), 100 
000 ( .full  = effektiv deaktiviert), 200 000 
( .fullMCMC  = deaktiviert) Range: 1 000 – 100 
000+ Defined in:

T E C H N I C Z N I E

Alle wie viele Iterationen wird die Opazität aller 
Gaussians auf einen niedrigen Wert (~0.01) zurück
gesetzt — eine Maßnahme aus dem 3DGS-Paper, 
um „eingefrorene„ Splats neu zu beurteilen. V194 
zeigte, dass mit RadianceKits Warmup + Stochastic-
-Trainings-Setup + 2× Lernraten der Opacity-Reset 
5.5 % Qualität kostet und der Logit-Clamp die 
Reset-Funktion bereits abdeckt. Daher in .full  
praktisch deaktiviert (100 000 > 35 000 = nie 
ausgelöst). V421 testete Reset alle 3 000 mit 
beta2=0.99 → 4.9 % schlechter; reverted. Bei 
.fullClassicPaper  (Q1.5-A, Paper-treuer Test) ist 

es bewusst wieder auf 3 000 gesetzt — das war 
eines der Lever, mit denen die Paper-Magnitude-
-Gaussian-Budgets erreicht werden sollten.

P R O S T Y M I  S ŁOWA M I

Alle wie viele Iterationen die App 
die Sichtbarkeit aller Splats auf 
„fast unsichtbar„ zurücksetzt — 
eine Art Reset-Knopf für die Opa­
city. Bei uns deaktiviert (Wert 
so hoch, dass es nie passiert), 
weil andere Mechanismen das 
überflüssig machen. Nur bei Pa­
per-getreuen Experimenten an­
schalten.
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T16 maxScreenSize

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 (off) oder > 0 
Defined in:

T E C H N I C Z N I E

Maximale Bildschirmraum-Größe (in projizierten Pi
xeln), die eine Gaussian erreichen darf, bevor sie 
zwangsweise gesplittet wird. Der Wert ist auf 0 
gesetzt (V48 testete und reverted) — RadianceKits 
Density-Control verwendet stattdessen den Welt-
-Raum-Skala-Schwellwert aus der dMean2D -Logik. 
Bleibt im Feldkatalog enthalten, weil künftige Expe
rimente mit Mip-Splatting (T74–T76) oder szenen
spezifischen Splatting-Strategien davon profitieren 
könnten. Aktivierung (Wert > 0, z.B. 20) würde sehr 
groß gewordene Splats im Bildschirm zwingen, sich 
aufzuteilen — relevant bei großen, glatten Wand
flächen, wo ein einzelnes Riesensplat zu wenig De
tail bietet.

P R O S T Y M I  S ŁOWA M I

Begrenzung, wie groß ein ein­
zelner Splat auf dem Bildschirm 
werden darf. Bei uns aus. Ein­
geschaltet würde es bewirken, 
dass riesige flache Splats (z.B. 
auf einer Wand) zwangsweise in 
mehrere kleine zerlegt werden. 
Lass es aus, falls nicht ausdrüc­
klich Experimente damit.
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Loss (T17–T20)

T17 ssimWeight

S ZC Z E G Ó ŁY

Default: 0.2 (Initializer + Paper + .full ), 0.05 (alle 
MCMC-Presets) Range: 0.0 – 1.0 Defined in:

T E C H N I C Z N I E

Gewicht des D-SSIM-Anteils in der kombinierten 
Loss-Funktion loss = (1 - λ) * L1 + λ * 
D-SSIM, wobei λ = T17 . Der 3DGS-Paper-Default 
0.2 ist für Classic-Densification optimal — V383 te
stete 0.3 → 28.9 % schlechter, V373b bestätigte 
0.2 als sweet spot. Für MCMC wurde in V521b/
V534 unabhängig festgestellt: 0.05 ist optimal, weil 
MCMC durch seine stochastische Exploration einen 
stärkeren L1-Signal-Anteil braucht — höhere SSIM-
-Gewichte würden die Relocation-Entscheidungen 
verwässern. SSIM ist deutlich teurer zu rechnen als 
L1 (lokale 11×11-Fenster über das ganze Bild); Ra
dianceKit nutzt eine MPS-beschleunigte Implemen
tierung, die unter 1 ms pro 1080p-Bild bleibt. Q7-
-BayesOpt-Sweeps fanden szenenspezifische Opti
ma zwischen 0.05 ( .outdoorPreset : 0.082) und 
0.171 ( .indoorPreset ).

P R O S T Y M I  S ŁOWA M I

Wie wichtig die App neben „jeder 
Pixel stimmt„ auch „Strukturen 
sind ähnlich” findet. 0.2 ist der 
Standard und liefert ein gutes 
Bild. Niedriger = pixel-genauer, 
aber kann weichere Übergänge 
bekommen. Höher = strukturähn­
licher, aber Details werden we­
icher. Lass die Presets entsche­
iden.
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T18 ssimWeightRefinement

S ZC Z E G Ó ŁY

Default: 0.0 (= „kein Wechsel, behalte ssimWeight„) 
Range: 0 oder 0 – 1.0 Defined in:

T E C H N I C Z N I E

Optionaler SSIM-Wert für die Refinement-Phase 
nach T2 densifyUntilIteration. V428 testete 0.2 
→ 0.3 im Refinement → 16 % schlechterer Loss 
(sowohl L1 als auch SSIM verschlechterten sich); re
vertet, daher Default 0.0. Die Hypothese hinter dem 
Feld war, dass nach der Densification — wenn ke
ine neuen Gaussians mehr entstehen — ein stärke
rer SSIM-Anteil die strukturelle Schärfe maximieren 
würde. Empirisch falsch: SSIM-Gewicht zu erhöhen 
heißt indirekt L1-Gewicht zu senken, und L1 ist 
das deutlich aussagekräftigere Signal in der Final-
-Refinement-Phase. Das Feld bleibt verfügbar für 
künftige Experimente mit perceptueller Loss (T60) 
oder Edge-Loss (T19), wo eine Refinement-spezifi
sche Loss-Komposition sinnvoll sein könnte.

P R O S T Y M I  S ŁOWA M I

Spezial-Einstellung für die zwe­
ite Trainingsphase (Verfeinerung 
nach Splat-Vervielfältigung). Bei 
0.0: dieselbe SSIM-Gewichtung 
wie davor. Drehen bringt empi­
risch nichts, daher aus.
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T19 edgeLossWeight

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 oder 0.001 – 
1.0 Defined in:

T E C H N I C Z N I E

V437-Experimental-Loss: Gewicht eines Sobel-Gra
dient-Domain-L1-Loss, der die Bildkanten direkt 
vergleicht (Ground-Truth-Sobel vs Render-Sobel) 
zusätzlich zu L1+SSIM. Hypothese: Kanten-Informa
tion ist ein perceptueller Eckpfeiler von Bildqualität 
und ein expliziter Term sollte Gaussians ermutigen, 
Kanten besser zu treffen. Test-Ergebnisse: Gewicht 
0.1 → 11 % schlechterer Loss, 0.01 → quality-neu
tral aber 10 % langsamer. Der Sobel-Pass kostet 
einen zusätzlichen MPS-Forward auf Ground-Truth 
und Render. Daher dauerhaft deaktiviert. Künftiger 
Use-Case: Szenen mit harten künstlichen Kanten 
(Architektur, Möbel, Renderings) könnten profitieren 
— Q7-Scene-Class-Presets haben das aber nicht 
gepickt, sondern stattdessen das SSIM-Gewicht 
skaliert.

P R O S T Y M I  S ŁOWA M I

Experimenteller Zusatz, der Kan­
ten extra wichtig nimmt. Bringt 
empirisch nichts. Bleibt aus.
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T20 skyMaskingEnabled

S ZC Z E G Ó ŁY

Default: false (Initializer und alle Presets) Range: 
boolean Defined in:

T E C H N I C Z N I E

Schaltet Sky Masking ein. Dabei wird 
in jedem Bild via Apple Vision Frame
work (VNGenerateForegroundInstanceMaskRequest) 
die Sky-Region ausmaskiert, und der Loss in die
sem Bereich auf null gesetzt. Sinn: Outdoor-Szenen 
leiden oft daran, dass blaue/graue/weiße Sky-Pixel 
die App dazu bringen, Gaussians genau dort zu 
plazieren — was als „floater„ wahrgenommen wird. 
Ohne Sky-Mask wäre der Loss in diesem Bereich 
nie null, weil der Himmel im Bild leicht variiert und 
die App ewig versucht, das mit Splats nachzubauen. 
Die Vision-Maske wird einmal pro Kamera vor dem 
Training berechnet und im RAM gehalten. Wird ty
pischerweise zusammen mit T45 skyDomeEnabled  
aktiviert (UI-Logik in der Settings-View). Bei Innen-
-Szenen oder synthetischen Renderings deaktiviert 
lassen — die Maske würde dort fälschlicherweise 
Decken oder Wände als „Sky” erkennen.

P R O S T Y M I  S ŁOWA M I

Schaltet einen Spezialmodus für 
Außen-Aufnahmen an: der Him­
mel wird beim Training ignoriert, 
damit nicht versucht wird, ihn 
mit Splats nachzubauen. Emp­
fohlen für jede Außen-Szene. Bei 
Innen oder bei 3D-Renderings 
aus Blender aus lassen.

129 / 233



R A D I A N C E K I T Rozdział 6 — Konfiguracja treningu

SH-Degree-Progression (T21)

T21 shDegreeUpgradeIterations

S ZC Z E G Ó ŁY

Default: [1_​000, 2_​000, 3_​000] (Initializer), 
[2_​000, 5_​000, 8_​000] ( .full , MCMC), 
[1_000, 2_000]  ( .preview  — Degree 3 über

sprungen) Range: [Int] , jeder Wert in 
[0, maxIterations] , monoton steigend Defined 

in:

T E C H N I C Z N I E

Iterationen, an denen der aktive SH-Degree von 
0→1, 1→2, 2→3 hochgeschaltet wird. Vor der ersten 
Marke sind nur die DC-Komponenten aktiv (also T5 
shDCLearningRate), nach der ersten Marke die DC + 
3 Degree-1-Koeffizienten, nach der zweiten Marke 
+ 5 Degree-2-Koeffizienten, nach der dritten Marke 
alle 15 Koeffizienten. Der Speicherbedarf pro Gaus
sian wächst dabei in Stufen — 4 Floats → 16 Floats 
→ 36 Floats → 64 Floats. Die Quality-Presets ve
rzögern die Aufstufungen gegenüber Initializer De
faults (V228), weil die Geometrie zuerst stabilisieren 
soll, bevor die Farbdetails mit ihrer höheren Frequ
enz draufkommen. V384 testete [1K, 2K, 3K]  für 
.full  → 9.3 % schlechter — bestätigt das Delay. 
.preview  kappt bei Degree 2, weil Degree 3 in 

5 000 Iterationen nicht konvergiert und nur Optimi
zer-Kapazität verbraucht. Q6 (T80–T81) bietet eine 
alternative Curriculum-Logik, die diese Liste dyna
misch überschreibt.

P R O S T Y M I  S ŁOWA M I

An welchen Punkten im Tra­
ining die App lernt, dass Farben 
aus verschiedenen Blickwinkeln 
unterschiedlich aussehen kön­
nen (Glanzlichter, Spiegelungen). 
Erst spät — damit erst die Form 
stimmt, dann die Farbe. Die Wer­
te in den Presets sind so einge­
stellt, dass das gut funktioniert. 
Nichts dran ändern, außer du we­
ißt genau warum.
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Performance (T22–T25)

T22 trainingRenderScale

S ZC Z E G Ó ŁY

Default: 1.0 (Initializer, .full , MCMC, Scene-
-Class), 0.5 ( .preview ), 0.25 ( .quickTest ) Ran­
ge: 0.05 – 2.0 (typisch 0.25, 0.5, 1.0) Defined in:

T E C H N I C Z N I E

Render-Auflösung beim Training relativ zur Origina
lauflösung der Trainingsbilder. Bei 0.5 wird jedes 
Bild auf 50 % Breite × 50 % Höhe heruntergerech
net (also 25 % der Pixel) und das Gaussian-Rende
ring erfolgt in dieser kleineren Auflösung. Reduziert 
sowohl Speicher- als auch Rechenaufwand quadra
tisch. Wichtig: T11 densifyGradThreshold muss 
zur gewählten Auflösung passen — die Gradient-
-Magnituden skalieren mit 1/Auflösung², daher hat 
.quickTest  (0.25×) einen viel höheren Threshold 

(4e-6) als .full  (1.0×, 1.1e-6). RadianceKit warnt 
bei sehr großen Bildern und passt automatisch an — 
3-MP-Ziel-Auflösung. Bei extremen 4K-Eingangsbil
dern wäre 0.5 oder sogar 0.25 sinnvoll, sonst läuft 
jeder Mac auch nur in CPU-Compaction.

P R O S T Y M I  S ŁOWA M I

Wie groß die Bilder beim Tra­
ining sind. 1.0 = original, 0.5 = 
halb so groß. Halbe Größe = vier 
mal schneller, aber feinste De­
tails fehlen. Die Presets wählen 
den richtigen Wert; bei extrem 
großen Eingangsbildern (über 12 
Megapixel) schaltet die App au­
tomatisch runter.

T23 resolutionWarmupScale

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 oder 0.1 – De­
fined in:

T E C H N I C Z N I E

V133-Optimierung: Trainiere die Densification-Pha
se (Iter 0 bis T2 ) in einer niedrigeren Auflösung 
als die Refinement-Phase. V308 hat sie für .full  
wieder ausgeschaltet, weil bei T22 = 1.0  und Co
sine-Annealing der Time-Win marginal war und Qu
alität minimal litt. Bleibt im Feldkatalog, weil sie 
bei 4K-Eingaben und langen Trainingsläufen wieder 
sinnvoll werden könnte — Q6 Curriculum (T80) hat 
eine ähnliche Logik aufgegriffen, dort ist sie aber an 
die LR-Schedule gekoppelt. Wenn aktiviert und T80 
curriculumResolutionRamp ebenfalls true, gewinnt 
Q6 und überschreibt diesen Wert.

P R O S T Y M I  S ŁOWA M I

Spezial-Feature: in der ersten 
Trainingshälfte mit kleineren Bil­
dern lernen, in der zweiten mit 
großen. Spart Zeit. Aus, weil die 
neuere Q6-Variante das besser 
löst.
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T24 tileSize

S ZC Z E G Ó ŁY

Default: 16 Range: 8, 16, 32 Defined in:

T E C H N I C Z N I E

Größe der Rasterisierungs-Tiles in Pixeln. Das Gaus
sian-Splatting-Rendering ist tile-basiert: das Bild 
wird in 16×16-Pixel-Kacheln zerlegt, jede Kachel 
sammelt die für sie relevanten Gaussians, sortiert 
sie nach Tiefe und blendet sie ein. 16 ist der von 
praktisch allen 3DGS-Implementierungen verwen
dete Standard und in den RadianceKit-Metal-Ker
nels hartkodiert; eine Änderung dieses Werts würde 
Re-Compilation der Shader bedingen und ist im ak
tuellen Stand nicht effektiv. Bleibt als Feld, falls eine 
künftige Engine-Version Tile-Size dynamisch unter
stützt.

P R O S T Y M I  S ŁOWA M I

Interner Render-Parameter. 
Standard 16, nicht ändern.

T25 throttleDelayMs

S ZC Z E G Ó ŁY

Default: 0 (Initializer, .full , MCMC, Scene-
-Class), 0 ( .preview ) Range: 0 – 100 Defined in:

T E C H N I C Z N I E

Künstliche Verzögerung zwischen Trainings-Itera
tionen in Millisekunden. 0 = volle Geschwindigkeit 
(Standard). Höhere Werte machen den Mac wäh
rend des Trainings „benutzbarer„, indem GPU/CPU 
regelmäßig Atempausen bekommen — die Bedien
freundlichkeit anderer Apps steigt, die Trainingszeit 
aber linear mit dem Delay. Typische Werte: 1–2 ms 
(„leichtes” Throttling, +5 % Trainingszeit, Mac fühlt 
sich responsiver an), 5 ms („Mittelschwer„, +15 % 
Trainingszeit), 10+ ms („Eco”, potentiell doppelte 
Trainingszeit). Wird im Inspector unter „Performan
ce„ geboten, ist aber nicht in der Standardansicht — 
siehe Backlog dev_ux-backlog.md , der vorschlägt, 
ihn aus dem Expert View zu entfernen, weil falsch 
verstanden er die Trainingszeit dramatisch verlän
gert.

P R O S T Y M I  S ŁOWA M I

Wie viele Millisekunden Pau­
se die App zwischen Trainings­
schritten macht. 0 = keine Pause, 
schnellstmöglich. Höhere Werte 
machen den Mac während des 
Trainings besser benutzbar — 
aber das Training dauert dann 
auch länger. Auf einem M3 Ultra 
oder Mac Studio kannst du das 
auf 0 lassen; auf einem MacBook 
Air wäre 2 oder 5 ein guter Wert.
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Diagnose und Punktwolken-Vorbereitung (T26–T30)

T26 depthDistortionWeight

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 oder 0.0001 – 
0.05 Defined in:

T E C H N I C Z N I E

V366-Experimental: Gewicht eines Depth-Distor
tion-Regularisierungs-Loss. Bestraft Gaussians, die 
entlang eines Render-Strahls zwar tief gestaffelt 
sind, aber konzeptuell zur selben Oberfläche ge
hören — das encouraged konzentrierte Tiefenverte
ilungen und reduziert Floaters. Tests: 0.01 → 4.5 
% schlechter, 0.001 → 8.1 % schlechter. Der theore
tische Vorteil — Multi-View-Konsistenz verbessern 
— schlägt sich nicht im L1-Loss nieder, weil die Hy
pothese implizit annimmt, dass die SfM-Geometrie 
korrekt ist und die Gaussians nur „gestapelt„ wer
den müssen. In der Praxis ist die SfM-Punktwolke 
meist die schwächste Komponente, nicht die Stape
lung. Bleibt verfügbar für Multi-View-Datensätze mit 
besonders sauberen Posen (Synthetic, Mip-NeRF 
360 mit Ground Truth).

P R O S T Y M I  S ŁOWA M I

Experimentelles Feature zur Ver­
meidung mehrerer Splats hinte­
reinander an derselben Stelle. 
Nicht aktiviert, weil die Tests 
nichts gebracht haben.

T27 singleViewOverfit

S ZC Z E G Ó ŁY

Default: false Range: boolean Defined in:

T E C H N I C Z N I E

Diagnose-Flag: wenn true, wird in jeder Trainingsi
teration zwingend Kamera-Index 0 verwendet statt 
einer zufällig aus dem Camera-Pool. Sinn: Wenn das 
Modell nicht mal eine einzige View überfitten kann 
(sprich, der Loss auf View 0 auch nach 10 000 Ite
rationen nicht gegen Null geht), ist im Forward/Bac
kward-Pass ein fundamentaler Bug. Dieser Schalter 
wurde während der Entwicklung der Metal-Shader 
und der Differentiable-Rasterizer-Kernels intensiv 
genutzt — V42–V47 Phase. Heute nur noch als Sa
nity-Check verfügbar, wenn jemand Backend-Code 
modifiziert hat und ein Regression Test machen will. 
Per CLI mit --single-view .

P R O S T Y M I  S ŁOWA M I

Test-Modus für Entwickler. Sie 
können damit prüfen, ob die App 
überhaupt aus EINEM Bild lernen 
kann. Für normale Benutzer irre­
levant, immer aus lassen.
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T28 maxCameras

S ZC Z E G Ó ŁY

Default: 0 (= „alle Kameras verwenden„) Range: 0 
oder 1 – N Defined in:

T E C H N I C Z N I E

Diagnose-Limit aus V43: trainiere nur mit den ersten 
N Kameras, ignoriere alle weiteren. Sinn ursprün
glich: Hypothese testen, dass zu viele Kameras Gra
dient-Konflikte erzeugen (zu viele widersprüchliche 
Loss-Signale für dieselbe Gaussian). Test-Ergebnis: 
kein systematischer Vorteil bei künstlicher Begren
zung — Mehr-Frames bringen praktisch immer mehr 
Qualität. Bleibt als CLI-Flag ( --max-cameras N ) für 
gezielte Experimente, z.B. „funktioniert das Training 
auf den ersten 100 Bildern eines 1 500-Bild-Droh
nenflugs?„ Im UI nicht exponiert.

P R O S T Y M I  S ŁOWA M I

Diagnose-Feld für Entwickler — 
nur die ersten N Bilder verwen­
den, Rest ignorieren. Normaler 
Benutzer braucht nicht, Wert auf 
0 = alle Bilder. Mehr Bilder = bes­
seres Ergebnis (siehe feedback_​
more-frames-better.md).

T29 maxInitialPoints

S ZC Z E G Ó ŁY

Default: 0 (= „alle SfM-Punkte verwenden„) Range: 
0 oder 1 000 – 200 000+ Defined in:

T E C H N I C Z N I E

V54-Sicherung: limitiert die Anzahl der initialen 
SfM-Punkte, mit denen das Training startet. Dich
te COLMAP-Rekonstruktionen können > 60 000 
Punkte produzieren, was bei großen Initial-Skalen 
zu 200–300 Gaussians pro Pixel-Überlapp führt — 
das macht ein „Nebelfeld„ aus, in dem das Tra
ining nicht konvergiert. Subsampling auf ~16 000 
Punkte (Hard-cap-Logik in der Trainings-Engine) 
bringt die Initial-Dichte auf das Niveau, das das 
Referenz-3DGS verwendet, und reduziert Overlap 
dramatisch. Wird bei sehr dichten SfMs automatisch 
gesetzt; per CLI mit --max-points N .

P R O S T Y M I  S ŁOWA M I

Wie viele Anfangs-Punkte aus 
der Kamera-Rekonstruktion ver­
wendet werden. Bei sehr dichten 
Rekonstruktionen (mehr als 60 
000) limitiert die App automa­
tisch auf 16 000 — sonst gibt 
es zu viel Nebel am Anfang. Du 
brauchst das nicht zu setzen; die 
App regelt es.
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T30 cameraClusterOutlierMultiplier

S ZC Z E G Ó ŁY

Default: 10.0 (alle Presets — niemals überschrie
ben) Range: 1.0 – 100.0 Defined in:

T E C H N I C Z N I E

Multiplikator für den Camera-Cluster-Outlier-Filter, 
eingeführt in Phase 3.10 A.1. Vor dem Training 
berechnet die Trainings-Engine das Centroid aller 
Kamera-Positionen und die maximale Distanz einer 
Kamera vom Centroid. SfM-Punkte, deren Distanz 
vom Centroid multiplier × maxCameraDistance 
überschreitet, werden als Outlier verworfen. Default 
10× bewahrt das Verhalten vor Phase 3.10. Ein sub
tiler Bug: Tighter SfM (Kameras enger zusammen) 
→ kleinerer → kleinerer Schwellwert → mehr Punk
te werden als Outlier verworfen. Looser SfM → 
größerer Schwellwert → weniger Punkte verworfen. 
Dies ist eine der Ursachen für die Phase-3.9-Fun
nel-vs-Training-Anti-Korrelation: bessere SfM kann 
downstream zu schlechterem Training führen, we
il zu viele Initialpunkte gekillt werden. Das Feld 
liegt als CLI-Override (--camera-cluster-outlier-
multiplier) für die A.3-Sweeps; im UI nicht expo
niert. Werte unter 5 sind in der Regel zu restriktiv, 
über 20 wirkungslos.

P R O S T Y M I  S ŁOWA M I

Spezial-Filter, der Punkte aus der 
Rekonstruktion verwirft, die weit 
weg von der Kamera-Wolke lie­
gen. 10 = die App ist großzügig, 
behält fast alles. Erhöhen kann 
sinnvoll sein, wenn weit entfern­
te Punkte (Berge in der Ferne) im 
Bild aussehen wie schwebende 
Klümpchen. Niedriger setzen nur 
in Notfall — verlierst dabei Detail 
in der Ferne.
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Regularisierung (T31–T37)

T31 coarseToFineBlurRadius

S ZC Z E G Ó ŁY

Default: 0 (= deaktiviert) Range: 0 oder 1 – 10 De­
fined in:

T E C H N I C Z N I E

V369-Experimental: Box-Blur-Radius, der zu Beginn 
der Densification-Phase auf das Ground-Truth-Bild 
angewendet und linear bis zum Ende der Densifica
tion ( T2 ) auf 0 reduziert wird. Hypothese: Coarse-
-to-Fine-Training — erst grobe Strukturen lernen, 
dann Details — sollte stabilere Geometrie liefern. 
Tests: r=3 → 9.6 % schlechter, r=1 → 5.1 % schlech
ter. Der Grund für das Fehlschlagen: die Densifi
cation entscheidet basierend auf bilddomänen-Gra
dienten, und Bluren reduziert genau die Signale, die 
für „hier muss klone werden„ wichtig sind. Bleibt im 
Feld-Katalog für künftige Tests mit anderem Densi
ty-Control-Schema.

P R O S T Y M I  S ŁOWA M I

Experimenteller „Erst-grob-
-dann-detailliert„-Modus. Hat 
nichts gebracht, bleibt aus.

T32 scaleRegWeight

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 oder 0.0001 – 
0.05 Defined in:

T E C H N I C Z N I E

V370-Experimental: L1-Regularisierung auf welt-
-räumliche Skala. Bestraft Gaussians, die zu groß 
werden — verhindert „Mega-Splatts„, die ganze 
Wandflächen mit einer Gaussian abdecken. Tests: 
0.01 → 200 % schlechterer Loss (2 M Gaussians, 
totale Explosion), 0.001 → 214 % schlechter. Der 
Grund: Skala-Regularisierung kommt mit Density-
-Control in Konflikt — kleinere Skalen heißen, mehr 
Gaussians werden gebraucht, also splittet Density-
-Control häufiger, was wiederum mehr Gradient-Au
fwand bedeutet. Disabled, aber dokumentiert für 
Mip-Splatting-Experimente (T74): in diesem Kontext 
könnte eine Skalen-Untergrenze sinnvoll sein.

P R O S T Y M I  S ŁOWA M I

Regularisierung, die Splats 
zwingt, klein zu bleiben. Hat in 
Tests Splat-Explosionen ausge­
löst (Millionen Splats). Nicht akti­
vieren.
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T33 anisotropyRegWeight

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 oder 0.0001 – 
0.05 Defined in:

T E C H N I C Z N I E

V445-Experimental: Penalty auf das max(sca
le)/min(scale)-Verhältnis, soll extrem langgezoge
ne „Needle„-Gaussians verhindern, die als flo
ater wahrgenommen werden. Tests: 0.01 → 69 
% schlechter, 0.001 → 15 % schlechter. Der 
Grund: Regularisierung zwingt Splats in Richtung 
„runde” Form, was auf einer flachen Oberfläche 
(Wand, Tisch, Boden) genau falsch ist — dort 
ist eine flache, breite Gaussian effizienter als 
eine kugelförmige. Disabled. V549f bot mit T34 
scaleRatioPruneThreshold einen alternativen, ge
zielteren Ansatz, der ebenfalls revertet wurde.

P R O S T Y M I  S ŁOWA M I

Regularisierung, die zu lange 
dünne Splats bestraft. Klingt sin­
nvoll, war in Tests aber schlech­
ter. Aus.

T34 scaleRatioPruneThreshold

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 oder 5.0 – 
100.0 (typisch 10.0 – 30.0) Defined in:

T E C H N I C Z N I E

Experimentelles post-Training-Pruning, das jede 
Gaussian löscht, deren max(scale)/min(scale)-Ver
hältnis den hier gesetzten linearen Schwellwert 
überschreitet. Zielt auf extrem langgezogene „Ne
edle/Disc„-Floaters ab, die durch Regularisierung 
allein nicht eliminiert werden können. Im Test ent
fernte das Pruning Floaters wie erhofft, aber gleich
zeitig auch sinnvolle flache Splats auf Wänden und 
Böden — das Bild wurde löchriger. Daher per De
fault aus, das CLI-Flag (--scale-ratio-prune N) 
bleibt für gezielte Experimente verfügbar. Empfoh
lene Werte falls man trotzdem testen will: 30 (sehr 
konservativ, entfernt nur extreme Outlier), 10 (ag
gressiv, kostet Detail).

P R O S T Y M I  S ŁOWA M I

Versuch, ganz langgezogene 
Splatts nach dem Training rau­
szufiltern. War in Tests netto-ne­
gativ — Floater weg, aber auch 
Detail weg. Aus.
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T35 opacityRegWeight

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 oder 0.0001 – 
0.05 Defined in:

T E C H N I C Z N I E

V446-Experimental: Binary-Cross-Entropy-Penalty, 
der Opazität gegen 0 oder 1 zieht (also weg 
von „halb-transparent„). Hypothese: scharfere Opa
zitätsverteilung würde Bildklarheit verbessern. Test 
mit T33 kombiniert → Regularisierung kostet Quali
tät, beide deaktiviert. Disabled. Achtung: in 1.4.3-
-Beta tauchte ein Bug auf, der genau dieses Feld 
in einer Default-Wert-Veränderung (Initializer = 0.01) 
hatte, was zu Mass-Extinction des Gaussian-Counts 
(460 K → 5 in einer Iteration) führte. Seit 1.4.4 fest 
auf 0.0 als Default verankert.

P R O S T Y M I  S ŁOWA M I

Regularisierung, die Splats en­
tweder ganz transparent oder 
ganz solid macht. Bringt nichts, 
kann sogar gefährlich werden 
(1.4.3-Bug Mass-Extinction). Lass 
auf 0.

T36 opacityDecayFactor

S ZC Z E G Ó ŁY

Default: 0.0 (Initializer = deaktiviert), 0.9995 
( .full , .classicBalanced  — HTGS-Standard) 
Range: 0 (off) oder 0.95 – 1.0 Defined in:

T E C H N I C Z N I E

V546-Implementation des HTGS-Schemas (Hierar
chical Time-Gating, Eurographics 2025): alle T37 
opacityDecayInterval Iterationen wird die sigmoid-
-Opazität jeder Gaussian mit diesem Faktor multipli
ziert. 0.9995 × 100 Anwendungen ergibt ~95 %-
-Verbleib pro Densification-Phase — ein leichter 
aber stetiger Abwärts-Druck auf alle Opacities, der 
schwach beigetragende Gaussians verlässlich ge
gen den T14 pruneOpacityThreshold sinken lässt. 
Das Resultat: 14 % besserer L1-Loss auf Horse Full 
(3-Trial-Avg V546) gegenüber V438 ohne Decay. 
Nur während Densification-Phase aktiv (bis T2 ), 
danach läuft das Training ohne Decay weiter, damit 
die im Refinement etablierten Opacities stabil ble
iben. Bei MCMC nicht verwendet (MCMC hat eigene 
Mechanismen via T67 mcmcRelocationInterval + 
T68 mcmcDeadOpacityThreshold).

P R O S T Y M I  S ŁOWA M I

„Sanftes Verblassen„ aller Splats 
über die Trainingszeit. Macht in­
aktiv gewordene Splats schnel­
ler transparent, sodass sie be­
im Aufräumen weggehen. War 
der wichtigste Quality-Hebel des 
V546-Updates: 14 % besser. In 
Quality-Preset eingebaut. Selbst 
zum Drehen nicht empfohlen, 
weil exakt austariert.
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T37 opacityDecayInterval

S ZC Z E G Ó ŁY

Default: 50 Range: 10 – 500 Defined in:

T E C H N I C Z N I E

Iterations-Intervall, in dem T36 opacityDecayFactor 
angewendet wird. HTGS-Paper-Default 50, in 
.full  belassen. Lange Intervalle (>200) heben 

den Effekt teilweise auf, weil zwischen zwei Anwen
dungen genug Gradient-Updates passieren, dass 
Opacity wieder steigt. Kürzere Intervalle (<20) ma
chen Decay zu aggressiv. Nur in Densification-Pha
se aktiv.

P R O S T Y M I  S ŁOWA M I

Wie oft das „Verblassen„ ange­
wendet wird. 50 = alle 50 Ite­
rationen ein bisschen verblasse-
-Schritt. Passt.

Refinement (T38–T44)

T38 gradientAccumulationSteps

S ZC Z E G Ó ŁY

Default: 1 (= „eine View pro Adam-Schritt„) Range: 
1 – 8 Defined in:

T E C H N I C Z N I E

V424-Feature: Anzahl der Views, deren Gradienten 
akkumuliert werden, bevor ein Adam-Update ausge
führt wird. Bei > 1  läuft die App auf einem separa
ten, „unfused„ Backward-Project-Pfad, der die Gra
dienten in einem separaten Buffer summiert; die 
finale Anwendung skaliert mit 1/N, um die Magnitude 
konstant zu halten. V424 testete 2-View → quality-
-neutral, aber 10 % langsamer (weil unfused-Pfad 
teurer ist als fused-Pfad). Reverted für .full , aber 
für MCMC bewusst verwendet — .fullMCMC  läuft 
mit, aber V544a-Tests zeigten, dass mit der Quality-
-Gap zu Classic auf 5 % schrumpft (statt 11 %). Im 
Initializer-Default 1, im aktuellen Preset 1, bleibt CLI-
-Flag ( --accum-steps N ).

P R O S T Y M I  S ŁOWA M I

Wie viele Bilder die App betrach­
tet, bevor sie die Splats anpasst. 
1 = jedes Bild einzeln. Höher = 
mehrere Bilder gleichzeitig an­
schauen und dann einen Mittel­
wert anwenden. Bringt im Stan­
dardfall nichts; bei MCMC kann 2 
ein bisschen helfen.
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T39 testViewIndices

S ZC Z E G Ó ŁY

Default: []  (= leer, alle Views werden zum 
Training verwendet) Range: Set<Int> , beliebige 
Untermenge der Camera-Indices Defined in:

T E C H N I C Z N I E

V546-Feature: Set von Camera-Indices, die NICHT 
zum Training verwendet, sondern als Holdout 
für PSNR/SSIM/LPIPS-Auswertung gespart werden. 
Wird automatisch gesetzt, wenn der --benchmark
-CLI-Flag aktiv ist: dann jede achte View, begin
nend bei Index 0 (LLFF-Standard, identisch mit 
den Mip-NeRF-360- und 3DGS-Paper-Konventio
nen). Ohne benchmark leer — das Training nutzt alle 
Views. Vorsicht: das manuelle Setzen dieses Feldes 
ohne Verständnis der Indizes kann den Benchmark 
unbrauchbar machen (z.B. wenn alle Indices über N 
gesetzt werden, während es nur N-50 Views gibt → 
keine Holdouts → keine Auswertung). Beim eigenen 
Preset-Export wird testViewIndices nicht persistiert, 
weil es szenenabhängig ist und sonst zwischen 
verschiedenen Datensätzen sinnlose Werte hinter
lassen würde.

P R O S T Y M I  S ŁOWA M I

Welche Bilder beim Training 
„ausgespart„ werden, um sie 
später für Qualitätsmessung zu 
nutzen. Du setzt das nicht selbst; 
das --benchmark -Flag macht 
das automatisch (jedes achte 
Bild ist Test). Wenn du eigene In­
dices setzt: gefährlich, kann den 
Benchmark verfälschen.
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T40 refinementPruneInterval

S ZC Z E G Ó ŁY

Default: 0 (= deaktiviert) Range: 0 oder 100 – 5 
000 Defined in:

T E C H N I C Z N I E

V425-Feature: alle N Iterationen während 
der Refinement-Phase (nach T2 ) wird 
ein zusätzlicher Prune-Pass laufen gelassen, 
der Gaussians mit sigmoid(opacity) < T41 
refinementPruneOpacityThreshold entfernt. Sinn: 
während Densification gibt es regelmäßige Density-
-Control-Calls, danach nicht mehr — Gaussians, 
deren Opacity weiter sinkt, bleiben aber im Buffer. 
V425 testete und reverted: das zusätzliche Pru
ning korrelierte mit V426 (Two-Phase Densification, 
ebenfalls in 0 Gaussians cascade failure abgebro
chen). Disabled. CLI-Flag verfügbar für Experimen
te; falls aktiviert, sind 1 000 oder 2 000 sinnvolle 
Werte.

P R O S T Y M I  S ŁOWA M I

Zusätzliches Aufräumen wäh­
rend der Verfeinerungsphase. 
Bringt nichts, bleibt aus.

T41 refinementPruneOpacityThreshold

S ZC Z E G Ó ŁY

Default: 0.0 (= „verwende T14 „) Range: 0 oder 
0.001 – 0.1 Defined in:

T E C H N I C Z N I E

V425b: separater Opacity-Schwellwert für Refi
nement-Pruning. Nach Densification haben die 
meisten Gaussians eine deutlich höhere Opaci
ty erreicht (> 0.001), sodass der Standard-T14 
pruneOpacityThreshold zu lasch wäre. Wenn T40  
aktiv, bestimmt dieses Feld den eigenen Schwel
lwert. Bei 0.0 wird T14  weiterverwendet. Nur rele
vant wenn T40 > 0.

P R O S T Y M I  S ŁOWA M I

Schwellwert für das zusätzli­
che Refinement-Aufräumen (sie­
he T40). Beide Felder nicht aktiv, 
also irrelevant.
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T42 midTrainingCompactificationIterations

S ZC Z E G Ó ŁY

Default: []  (= deaktiviert) Range: [Int] , Werte 
in (densifyUntilIteration, maxIterations) Defi­
ned in:

T E C H N I C Z N I E

V549-Feature: explizite Iteration-Punkte während 
der Refinement-Phase, an denen ein Compactifica
tion-Pass läuft (entfernt sigmoid(opacity) < 0.01 
+ Outlier-Scale-Gaussians, dieselbe Logik wie T56 
postTrainingCompactification). Sinn: lange Refi
nement-Phasen können Confetti-/Floater-Akkumu
lation zeigen, deren SH dann auf view-spezifi
sche Artefakte überfitten. Typische Konfiguration 
falls aktiviert: [10000, 20000, 30000] für 40K 
Classic. ABER: V549-A/B-Tests auf Family-Dataset 
zeigten in allen Konfigurationen schlechteres L1: 
[10K,20K,30K]@0.01  → −48 % Count aber +36 

% L1; [20K,30K]@0.005  → −44 % Count aber 
+45 % L1; [20K,30K]@0.001  → −17 % Count aber 
+87 % L1. Daher disabled. CLI-Flag --mid-compact 
"10000,20000" verfügbar, falls man den visuellen 
Floater-Tradeoff (weniger Confetti im Viewport) ge
genüber dem Loss-Regression bevorzugt.

P R O S T Y M I  S ŁOWA M I

Zwischendurch-Aufräumaktio­
nen während des Trainings. In 
Tests hat das Aufräumen das 
Endergebnis schlechter gemacht 
(zwar weniger Floater, aber auch 
weniger Detail). Aus, kann via CLI 
eingeschaltet werden, falls Flo­
ater dich mehr stören als ein 
etwas matschigeres Bild.
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T43 frustumCullEnabled

S ZC Z E G Ó ŁY

Default: false Range: boolean Defined in:

T E C H N I C Z N I E

V549b-Feature: nach Training werden alle Gaus
sians entfernt, die außerhalb der Vereinigung aller 
Trainings-Kamera-Frusta liegen. Solche Gaussians 
wurden nie vom Loss-Signal eingeschränkt und sind 
immer Floater. Besonders effektiv für Szenen, in 
denen die Novel-View hinter oder neben dem Kame
rapfad liegt (z.B. Rückseite eines linearen Drohnen
flugs) — die Floater dort werden in der Training
sphase nie sichtbar, beim späteren Bewegen im 
3D-Viewer aber sehr wohl. V549b A/B auf Droh
nenflügen positive Ergebnisse, daher als Opt-In ver
fügbar. Default false, weil bei Object-Captures mit 
voller Orbit-Coverage die Frustum-Union die ganze 
Szene umfasst und das Feature nichts entfernt — 
wird in Settings unter „Floater Reduction„ angebo
ten und auch in Q9 Outdoor-Preset implizit über 
T44 frustumCullExpansion getestet (Q7-BayesOpt 
hat es aber nicht aktiviert, weil Outdoor-Sky-Dome 
dasselbe Problem besser löst).

P R O S T Y M I  S ŁOWA M I

Spezial-Filter für Drohnenflüge 
oder lineare Aufnahmen: nach 
dem Training werden Splats ge­
löscht, die in keiner Kame­
ra „gesehen„ wurden. Optional 
einschaltbar in den Settings. 
Bei einfachen Objekt-Aufnahmen 
unnötig.

T44 frustumCullExpansion

S ZC Z E G Ó ŁY

Default: 1.1 Range: 1.0 – 2.0 Defined in:

T E C H N I C Z N I E

NDC-Margin für T43 frustumCullEnabled. 1.0 würde 
exakt am Bildrand schneiden, was wackelige Splatts 
am Bildrand zu sehr kürzen würde. 1.1 = 10 % Pad
ding über die exakte Kamera-Framing hinaus — gibt 
etwas Toleranz für Randpixel, die in einer leicht ver
setzten Novel-View doch sichtbar werden könnten. 
Werte > 1.2 machen den Cull praktisch unwirksam, 
weil das erweiterte Frustum sehr viel mehr Raum 
umfasst.

P R O S T Y M I  S ŁOWA M I

Wie streng der oben beschrie­
bene Filter zuschneidet. 1.1 = 
ein bisschen Sicherheitsabstand 
zum Bildrand. Lass den Wert.
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Sky-Dome (T45–T48)

T45 skyDomeEnabled

S ZC Z E G Ó ŁY

Default: false (Initializer + alle Presets außer P9 
Outdoor) Range: boolean Defined in:

T E C H N I C Z N I E

V549e-Feature: vor Training-Start wird eine kugel
förmige Punktwolke generiert (Fibonacci-sphere mit 
T46  Sample-Points), in einem Radius von T47 
skyDomeRadiusMultiplier × scene_​extent um den 
Szenen-Mittelpunkt platziert und mit den Farben 
aus den sky-maskierten Pixeln aller Trainings-Ka
meras (siehe T20 skyMaskingEnabled) initialisiert. 
Diese Sky-Dome-Gaussians werden am Anfang des 
Gaussian-Buffers eingefügt und während Training 
„eingefroren„ (Position/Skala/Rotation-Gradienten = 
0, nur SH und Opacity bleiben optimierbar). Effekt: 
statt schwarzer „Confetti”-Bereiche in der Ferne 
sieht der User in Novel-Views einen echten Himmel. 
V549e-MVP funktioniert auf Drohnen- und Land
schaftsszenen sehr gut; in P9 Outdoor-Preset De
fault-on. Bei Innen-Szenen aus lassen — die Sphere 
würde sinnlos außerhalb des Raums hängen.

P R O S T Y M I  S ŁOWA M I

Schaltet eine künstliche „Him­
melskuppel„ um die Szene 
ein. Macht Außenaufnahmen viel 
schöner: statt schwarzer Klümp­
chen am Bildrand zeigt die App 
den echten Himmel. Pflicht für 
Drohnenflüge und Landschaften, 
sinnlos für Innenräume.
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T46 skyDomeSampleCount

S ZC Z E G Ó ŁY

Default: 5 000 Range: 1 000 – 50 000 (typisch 2 
000 – 10 000) Defined in:

T E C H N I C Z N I E

Anzahl der Fibonacci-Sphere-Sample-Punkte auf 
der Sky-Dome-Sphere. Höhere Werte → dichteres 
Sky-Dome (besser bei großen Auflösungen und viel 
sichtbarem Himmel), aber mehr Speicherbedarf. 5 
000 ist sweet spot für 4K-Renderings; bei niedrige
ren Auflösungen reicht 2 000–3 000. Die Punkte 
werden nach Cosine-Distance zu jedem Trainings-
-Kamera-View-Vektor mit den entsprechenden sky-
-maskierten Pixeln initialisiert — Sample-Points, de
ren View-Cone keine Kamera sieht, bleiben mit nie
drigem Opazitäts-Initialwert hinten, werden aber im 
Training nicht verändert (eingefroren).

P R O S T Y M I  S ŁOWA M I

Wie dicht der künstliche Himmel 
ist. 5 000 Punkte reichen norma­
lerweise. Mehr = besserer Über­
gang aus der Ferne, aber kostet 
etwas Speicher.

T47 skyDomeRadiusMultiplier

S ZC Z E G Ó ŁY

Default: 30.0 (Initializer + meisten Presets), 59.0 
(P9 Outdoor, Q7-BayesOpt-Optimum) Range: 5.0 – 
200.0 Defined in:

T E C H N I C Z N I E

Radius der Sky-Dome-Sphere relativ zur Szenen-
-Ausdehnung (= mittlere Distanz zwischen Kamera-
-Positionen). 30 = die Kugel hat den 30-fachen 
Durchmesser der Kamera-Wolke. Zu klein (< 5) → 
Sky-Dome interferiert mit der Szene selbst (z.B. 
ein Sky-Dome-Splatt landet im Vordergrund); zu 
groß (> 100) → float32-Präzisionsverlust an den 
Sky-Dome-Positionen, was Render-Glitches in der 
Ferne auslöst. Q7-BayesOpt auf Bicycle (Mip-NeRF 
360) fand 59.0 als szenenspezifisches Optimum für 
outdoor — das deutet darauf hin, dass die Stan
dard-30.0 für tiefe Landschaften zu klein ist und die 
Sky-Dome-Pixel in den Bildrand-Bereichen sichtbar 
als „Wand„ rendern.

P R O S T Y M I  S ŁOWA M I

Wie weit weg die künstliche Him­
melskuppel sein soll. 30 = ziem­
lich weit. Bei großen Landscha­
ften ist 50–60 besser (Outdoor-
-Preset macht das automatisch). 
Zu klein wäre, als hätte man 
Klümpchen direkt vor der Linse.
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T48 frozenGaussianCount

S ZC Z E G Ó ŁY

Default: 0 (= keine eingefrorenen Gaussians) Ran­
ge: 0 oder 1 – T46  Defined in:

T E C H N I C Z N I E

Anzahl der Gaussians am Anfang des Buffers, de
ren Position/Skala/Rotation-Gradienten im Optimizer 
auf null gesetzt werden — sie bleiben über das 
gesamte Training räumlich starr. Density-Control 
darf sie nicht klonen, splitten oder prunen. Genutzt 
für Sky-Dome-Injection (siehe T45 ): wenn Sky-
-Dome an ist, wird dieses Feld automatisch auf T46 
skyDomeSampleCount gesetzt. Manuelles Setzen ist 
möglich (z.B. um eine vor-platzierte Punktwolke aus 
einem LiDAR-Scan einzufrieren), aber im UI nicht di
rekt zugänglich. Wichtig: die ersten N Gaussians im 
Buffer sind immer die frozen — die Reihenfolge im 
Buffer entscheidet, nicht ein expliziter Index.

P R O S T Y M I  S ŁOWA M I

Wie viele Splats am Anfang fest 
sind und sich nicht bewegen dür­
fen. Wird automatisch auf die 
Sky-Dome-Anzahl gesetzt, wenn 
Sky-Dome an ist. Selbst dran 
drehen brauchst du nicht.

Adam + LR-Schedule (T49–T55)

T49 adamResetIteration

S ZC Z E G Ó ŁY

Default: 0 (= deaktiviert) Range: 0 oder 100 – De­
fined in:

T E C H N I C Z N I E

V430-Feature: Iteration, an der die Adam-Optimi
zer-Momentum-Akkumulatoren (m1, m2) auf null 
zurückgesetzt werden. Bias-Korrektur danach läuft 
mit (iter - adamResetIteration) statt mit iter . 
V430 testete Reset bei 5 000 (nach Densification-
-Ende) → 12.8 % schlechter Loss. Grund: das 
Adam-Momentum, das sich während Densification 
aufgebaut hat, trägt Information über die typischen 
Gradient-Magnituden bei und beschleunigt die Refi
nement-Phase. Es wegzuwerfen kostet die ersten 
~500 Iterationen Refinement an Konvergenz. Disa
bled. Bleibt CLI-Flag für Forschungsexperimente.

P R O S T Y M I  S ŁOWA M I

Reset-Knopf für das interne 
Adam-Optimierer-„Gedächtnis„. 
Hat in Tests geschadet, bleibt 
aus.
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T50 positionLRScheduleEndIteration

S ZC Z E G Ó ŁY

Default: 0 (Initializer = „verwende maxIterations„), 
20 000 ( .full  — Cosine endet bei 20K trotz maxI
ter=35K), 30 000 ( .fullClassicPaper ) Range: 0 
oder 1 000 – Defined in:

T E C H N I C Z N I E

V431-Feature: Iteration, an der die Cosine-
-Annealing-Kurve für Position-LR ihr Minimum 
erreicht. Wenn 0, ist das identisch mit 
T1 maxIterations . Wenn > 0, läuft die Schedu

le bis zu diesem Wert und bleibt danach bei T4 
positionLearningRateFinal konstant. Das erlaubt 
eine „extended refinement phase„ mit minimaler 
aber konstanter Lernrate — verfeinert Positionen 
langsam ohne erneuten Decay. .full  macht das 
(Schedule-Ende bei 20K, Training läuft bis 35K), 
V434c/V434d bestätigten: 15K und 25K beide etwa 
gleich, 20K minimal optimal. Wird in Verbindung mit 
T51  weiterverwendet, um auch die Nicht-Position-

-LRs in der extended phase zu modifizieren.

P R O S T Y M I  S ŁOWA M I

Wann die App aufhört, die Posi­
tion-Lernrate weiter zu senken. 
Wenn niedriger als die maximale 
Iteration, läuft danach mit kon­
stanter Mini-Rate — das verfe­
inert sehr langsam aber sehr sta­
bil. In Quality-Preset eingebaut, 
brauchst nicht zu drehen.

T51 extendedPhaseLRDecay

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert, konstante LRs) Range: 0 
oder 0.01 – 1.0 Defined in:

T E C H N I C Z N I E

V433-Feature: minimaler Multiplikator für die Nicht-
-Position-LRs (Skala, Rotation, Opacity, SH) in der 
„extended phase„ — sprich: nachdem T50  erreicht 
ist und Position-LR bereits bei T4  ist. Wenn 0.1, 
werden Skala/Rotation/Opacity/SH ihrerseits cosine-
-decayed von 1.0 (= ihr Standard-LR) auf 0.1× ihres 
Standards. Wenn 0.0 (Default), bleiben sie konstant. 
V457 testete vollen Decay (0.0 = decay-bis-null) 
gegen kein-Decay und fand: avg 0.0400 (2 Runs) 
= gleicher Loss wie V438 ohne Decay. Behavior cle
aner mit Decay, aber nicht messbar besser. Daher 
disabled. Bleibt im CLI als --nonpos-lr-scale F.

P R O S T Y M I  S ŁOWA M I

In der späten Verfeinerungspha­
se auch Farb- und Form-Lernra­
ten kleiner machen. Macht das 
Training „stabiler„, aber empi­
risch nicht besser. Aus.
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T52 adaptiveDensifyThreshold

S ZC Z E G Ó ŁY

Default: false Range: boolean Defined in:

T E C H N I C Z N I E

V440-Experimental: wenn true, berechnet die App 
in jedem Densification-Schritt das p98 der aktu
ellen Gradient-Verteilung und nutzt es als dynami
schen Schwellwert (geclamped auf mindestens 0.5× 
des konfigurierten Werts aus T11 , damit es nicht 
zu sehr ausreißt). Hypothese: Automatische Anpas
sung an aktuelle Szenen-Phase würde Density-Con
trol robuster machen — z.B. zu Anfang strenger pru
ning, später lasser, oder umgekehrt. V440 testete 
und revertete: katastrophaler Drop auf 63 K Gaus
sians (Mass-Pruning, weil das p98 in den ersten 
Iterationen extrem hoch ist und dann fast nichts den 
Threshold überschreitet). Der fixe Threshold ist be
reits gut kalibriert, dynamische Anpassung schadet 
mehr als sie nutzt. Q5 (T77) bietet eine alternative 
Adaptive-Logik via rolling median, die das Problem 
umgeht.

P R O S T Y M I  S ŁOWA M I

Adaptive Versions des Densify-
-Schwellwerts. In Tests katastro­
phal (Splat-Anzahl auf 63K abge­
stürzt). Aus. Q5 hat eine bessere 
Variante davon.

T53 mergeAfterDensification

S ZC Z E G Ó ŁY

Default: false (Initializer), true ( .full , 
.classicBalanced , .fullClassicPaper ) Range: 

boolean Defined in:

T E C H N I C Z N I E

V438-Feature: am Ende der Densification-Phase 
(Iter T2 ) wird ein einmaliger Merge-Pass durchge
führt, der nahe beieinanderliegende Gaussians mit 
ähnlicher Skala und Farbe zusammenfasst. Redu
ziert die Gaussian-Anzahl um typisch 5–15 % ohne 
sichtbaren Qualitätsverlust. Sinn: nach intensivem 
Klonen entstehen Cluster von quasi-identischen 
Gaussians, die nichts Neues beitragen — das Mer
ging gibt Optimizer-Kapazität für andere Bereiche 
frei. Standard in Classic-Quality-Presets. Bei MCMC 
nicht verwendet, weil MCMC durch seine Reloca
tion-Logik solche Cluster gar nicht erst entstehen 
lässt.

P R O S T Y M I  S ŁOWA M I

Am Ende der Splat-Vervielfäl­
tigungs-Phase Klone, die fast 
identisch sind, zusammenfas­
sen. Reduziert Datenmenge ohne 
sichtbaren Effekt. Standard­
mäßig in Quality-Preset an.
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T54 densifyPhase2FromIteration

S ZC Z E G Ó ŁY

Default: 0 (= deaktiviert) Range: 0 oder T2  – T1  
Defined in:

T E C H N I C Z N I E

V426-Experimental: ermöglicht eine zweite Densifi
cation-Phase, die nach der Refinement-Pause bei 
dieser Iteration startet und bis T55  läuft. Hypo
these: nach einer Refinement-Phase haben die Gra
dient-Akkumulatoren stabilere Magnitudes und kön
nen präziser sagen, welche Bereiche noch zusätzli
che Gaussians brauchen. V426 testete und reverte
te: Two-Phase Densification fiel in 0-Gaussians-Ca
scade-Failure (mit V425 Refinement-Pruning kombi
niert zerstörte es den Buffer). Disabled. CLI-Flag 
verfügbar für Experimente.

P R O S T Y M I  S ŁOWA M I

Zweite Vervielfältigungsrunde 
nach Pause. Hat in Tests den 
Splat-Bestand vernichtet. Aus.

T55 densifyPhase2UntilIteration

S ZC Z E G Ó ŁY

Default: 0 Range: 0 oder T54  – T1  Defined in:

T E C H N I C Z N I E

Ende der V426-Two-Phase-Densification. Nur rele
vant wenn T54 > 0 . Beide Felder zusammen disa
bled.

P R O S T Y M I  S ŁOWA M I

Ende der zweiten Vervielfälti­
gungsrunde (siehe T54). Beide 
aus.
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Post-Processing + Apple AI (T56–T60)

T56 postTrainingCompactification

S ZC Z E G Ó ŁY

Default: true (in allen Production-Presets), false 
( .quickTest , .preview ) Range: boolean Defined 
in:

T E C H N I C Z N I E

V443-Feature: nach Trainingsende werden Gaus
sians mit sigmoid(opacity) < 0.01 hart entfernt (sie 
tragen praktisch nicht mehr zum Bild bei). Redu
ziert Gaussian-Count um typisch 58 % und Export-
-Dateigröße um 55 % ohne sichtbaren Qualitätsver
lust. Standardmäßig in Production-Presets aktiv — 
das Endresultat soll möglichst kompakt ausgeliefert 
werden können. In .quickTest  aus, weil ein Dia
gnose-Lauf sowieso nicht exportiert wird. Anders 
als T42 midTrainingCompactificationIterations 
(V549) findet die Compactification erst am Ende 
statt — Refinement kann bis dahin alle Gaussians 
benutzen.

P R O S T Y M I  S ŁOWA M I

Aufräumen nach dem Training: 
nahezu unsichtbare Splats wer­
den entfernt. Macht die Export-
-Datei rund halb so groß ohne 
Qualitätsverlust. Pflicht-Feature, 
aus lassen nur in Diagnose-Läu­
fen.

T57 metalFXUpscaling

S ZC Z E G Ó ŁY

Default: false Range: boolean Defined in:

T E C H N I C Z N I E

V444-Feature: aktiviert Apples MetalFX Spatial 
Upscaler statt bilineare Interpolation im 3D-Vie
wer-Output. Wenn Trainingsauflösung < Viewport-
-Größe (z.B. Training auf 0.5×, Viewport-Anzeige 
in voller Auflösung), kann MetalFX ein deutlich 
schärferes Bild liefern. Ändert sich live im View
port, kein Re-Training nötig. Schließt sich mit T58 
mpsLanczosScaling aus — MetalFX hat Vorrang. 
Empfehlung: einschalten, wenn das Bild im Viewer 
„verwaschen„ wirkt im Vergleich zum erwarteten 
Detail.

P R O S T Y M I  S ŁOWA M I

Apple-ML-basierte Bild-Schär­
fung im 3D-Viewer. Hilft, wenn du 
in einem niedrigerer Auflösung 
trainiert hast und das Ergebnis 
im Vollbild zeigst. Live-Toggle, 
probier aus.
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T58 mpsLanczosScaling

S ZC Z E G Ó ŁY

Default: false Range: boolean Defined in:

T E C H N I C Z N I E

V444-Feature: MPSImageLanczosScale für View
port-Skalierung statt bilineare Interpolation. Lan
czos ist ein klassisches Sinc-basiertes Resampling-
-Verfahren, das deutlich schärfere Ergebnisse als 
Bilinear liefert mit minimalem Overhead. Live-Tog
gle. Wird von T57  überschrieben, wenn beide an.

P R O S T Y M I  S ŁOWA M I

Klassisches Schärfungsverfah­
ren für den 3D-Viewer (Lanczos). 
MetalFX (T57) ist ML-basiert und 
meist besser; Lanczos ist eine 
weniger aggressive Alternative.

T59 livePreviewInterval

S ZC Z E G Ó ŁY

Default: 50 (Initializer und meisten Presets) Range: 
0 (off) oder 10 – 5 000 Defined in:

T E C H N I C Z N I E

Wie oft während des Trainings der 3D-Viewer mit 
den aktuellen Gaussians aktualisiert wird. 50 = alle 
50 Iterationen ein neues Render im Viewer — gut 
genug, um den Fortschritt zu beobachten, ohne das 
Training zu verlangsamen. 0 = Viewer wird gar nicht 
aktualisiert (Hintergrund-Training, max Geschwin
digkeit). Typische Anpassung: bei .quickTest  run
ter auf 10 (man will jeden Schritt sehen), bei langen 
MCMC-Läufen hoch auf 500–2000 (Update-Over
head in Summe spürbar).

P R O S T Y M I  S ŁOWA M I

Wie oft die 3D-Vorschau während 
des Trainings aktualisiert wird. 
50 = alle 50 Iterationen. Höher 
= weniger oft = etwas schnel­
ler, aber du siehst seltener Fort­
schritt. 0 = keine Vorschau (für 
maximales Tempo).
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T60 perceptualLossWeight

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert) Range: 0 oder 0.001 – 
0.5 Defined in:

T E C H N I C Z N I E

V444-Future-Feature: Gewicht eines perceptuellen 
Loss-Terms via MPSGraph (VGG-ähnliches kleines 
Netzwerk). Würde strukturelle und texturelle Ähn
lichkeit auf einer höheren semantischen Ebene als 
L1+SSIM erfassen — typisch in Forschungs-Pipeli
nes, wo „pixel-perfect„ weniger wichtig ist als „sieht 
realistisch aus”. Implementation noch ausstehend 
(Code-Stub vorhanden, aber Forward-Pass nicht 
implementiert). Default 0.0. Bleibt im Feldkatalog für 
künftige Aktivierung; CLI-Flag --percep-weight F  
reserviert.

P R O S T Y M I  S ŁOWA M I

Geplantes Feature, das mit KI-
-Hilfe „natürlich aussehend„ an­
strebt statt „pixelgenau”. Noch 
nicht fertig implementiert.

MCMC-Densification (T61–T73)

T61 densificationStrategy

S ZC Z E G Ó ŁY

Default: .classic  (Initializer + Classic-Presets), 
.mcmc  (alle MCMC-Presets + Scene-Class) Range: 
.classic  oder .mcmc  Defined in:

T E C H N I C Z N I E

Wählt zwischen Classic-Densification (Klon/Split/
Prune, Kerbl et al. 2023) und MCMC-Densifica
tion (Stochastic Gradient Langevin Dynamics mit 
Relocation, Kheradmand et al. NeurIPS 2024). 
Bei .classic  werden T11–T16  ausgewertet, bei 
.mcmc  die T62–T73 . Achtung beim Wechsel: Clas

sic Defaults und MCMC Defaults sind völlig anders 
kalibriert — wer den Picker im Expert View flippt, 
ohne ein passendes Preset zu laden, riskiert 1.4.3-
-Bug-Style Mass-Extinction (460 K → 5 in einer 
Iteration, weil MCMC-OpacityReg auf 0.01 die Clas
sic-Opacities killt). Daher die MCMC-Init Defaults 
absichtlich „weichgespült„ (alle Reg-Werte 0.0).

P R O S T Y M I  S ŁOWA M I

Welcher Algorithmus zum Ver­
mehren der Splats verwendet 
wird. Classic = ursprüngliche 
Methode (schnell, viele Splats). 
MCMC = neuere Methode (lang­
samer, viel weniger Splats, dafür 
kompakter). Die Presets wählen 
das richtige. Selbst nur umschal­
ten, wenn du auch das passen­
de Preset (P5–P7 oder P8–P10) 
lädst.
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T62 mcmcMaxGaussians

S ZC Z E G Ó ŁY

Default: 150 000 (Initializer + .fullMCMC  + 
.mcmcBalanced ), 100 000 ( .mcmcPreview ), 1 500 

000 ( .fullMCMCMip  — Mip-Splatting-Variante mit 
10× Budget), 1.19 M ( .renderPreset ), 1.25 M 
( .outdoorPreset ), 670 K ( .indoorPreset ) Ran­
ge: 0 (= „verwende Buffer-Kapazität„) oder 10 000 
– 5 000 000 Defined in:

T E C H N I C Z N I E

Harte Obergrenze für die Anzahl der Gaussians bei 
MCMC-Strategie. Die Anzahl wächst graduell um 
T70 mcmcGrowthRate  (typisch 5 %) pro Relocation-

-Step bis zu diesem Cap. V473/V531 fanden 150 
K als sweet spot — über 200 K dilutet die Splat-
-Qualität (zu viele kleine, redundante Gaussians), 
unter 100 K bleibt die Szene unter-densifiziert. Bei 
sehr großen Szenen (z.B. 1 545-Foto-Drohnenflug 
mit 158 K SfM-init) ist 150 K zu niedrig — daher 
die 1.4.5-Erweiterung T72 mcmcCapMultiplier + T73 
mcmcAutoScaleByScene. Q7-BayesOpt fand szenen
spezifische Optima zwischen 670 K (Indoor) und 
1.25 M (Outdoor). Bei Wert 0 verwendet die Engine 
die volle Buffer-Kapazität als Cap.

P R O S T Y M I  S ŁOWA M I

Maximale Anzahl Splats bei 
MCMC. 150 000 ist der Standard 
und reicht für die meisten Sze­
nen. Outdoor- und Render-Pre­
sets (P8, P9) gehen auf 1+ Mil­
lion für Detail-reichere Szenen. 
Hochsetzen kann Detail bringen, 
kostet Speicher; runter ist eher 
eine Notbremse.
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T63 mcmcNoiseScale

S ZC Z E G Ó ŁY

Default: 0.00005 (5e-5 = Paper-Default) Range: 
1e-6 – 1e-3 Defined in:

T E C H N I C Z N I E

Multiplikator für das Gauss’sche Rauschen, das in 
jeder MCMC-Iteration zur Position jeder Gaussian 
addiert wird (SGLD-Logik). Höher = mehr Explo
ration (Gaussians wandern mehr, finden poten
ziell bessere Plätze), niedriger = mehr Exploitation 
(Gaussians bleiben da, wo sie schon gut sind). V467 
und V536 bestätigten 5e-5 als optimal — 1e-5/2e-5 
zu wenig Exploration, 1e-4 zu viel (Splats zerlau
fen). Wird über die Trainingszeit cosine-decayed 
bis T69 mcmcNoiseDecayEnd — am Ende des Decay-
-Bereichs ist Noise effektiv 0 und die Gaussians 
konvergieren.

P R O S T Y M I  S ŁOWA M I

Wie viel zufälliges „Wackeln„ die 
App den Splats erlaubt, damit sie 
selber den besten Platz finden. 
Standardwert ist optimal gete­
stet. Wenn du das hochdrehst, 
werden die Splats unruhig.

T64 mcmcOpacityRegWeight

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert in den RadianceKit De
faults, Paper: 0.01) Range: 0 oder 0.001 – 0.05 
Defined in:

T E C H N I C Z N I E

MCMC-spezifische L1-Penalty auf Opacity. Paper-
-Default 0.01 (drückt unbenutzte Gaussians gegen 
Null, macht sie für Relocation verfügbar). V464b 
zeigte aber: ohne Reg ist es in RadianceKit mess
bar besser (Session 28 bestätigt). Grund: Das mit 
T68 mcmcDeadOpacityThreshold definierte Pruning-
-Kriterium reicht alleine — eine zusätzliche L1-Pe
nalty zwingt auch wertvolle, niedrig-Opacity-Gaus
sians zum Sterben. Daher Default 0. Achtung: in 
1.4.3-Beta-Build war der Initializer-Default fälschlich 
0.01, was im Mass-Extinction-Bug resultierte (siehe 
T61-Erläuterung); seit 1.4.4 auf 0.0 fixiert.

P R O S T Y M I  S ŁOWA M I

MCMC-Spezialregularisierung. 
Aus, weil der andere MCMC-Me­
chanismus (Schwellwert in T68) 
das schon abdeckt. Auf 0 lassen.
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T65 mcmcScaleRegWeight

S ZC Z E G Ó ŁY

Default: 0.0 (= deaktiviert, Paper: 0.01) Range: 0 
oder 0.001 – 0.05 Defined in:

T E C H N I C Z N I E

MCMC-spezifische L1-Penalty auf die Skala-Eigen
werte. Paper-Default 0.01. V464b: ohne Reg besser, 
gleiche Begründung wie T64. Disabled in allen 
RadianceKit-MCMC-Presets. Achtung wie bei T64: 
1.4.3-Bug.

P R O S T Y M I  S ŁOWA M I

Wie T64, aber für Splat-Größe. 
Aus.

T66 mcmcRelocationInterval

S ZC Z E G Ó ŁY

Default: 100 (Initializer + alle MCMC-Presets, Pa
per-Standard), 155 (P9 Outdoor — Q7-BayesOpt-
-Optimum) Range: 50 – 500 Defined in:

T E C H N I C Z N I E

Iterations-Intervall, in dem MCMC tote Gaussians 
(sigmoid(opacity) < T68 mcmcDeadOpacityThreshold) 
zu neuen Positionen relociert. V537 testete 50 
(zu disruptiv, Loss schwankt) und 200 (marginal 
schlechter, MCMC verliert Reaktionsfähigkeit). 100 
ist optimal. Q7-BayesOpt auf Bicycle fand 155 als 
szenenspezifisches Optimum für outdoor — die 
etwas längeren Intervalle geben Adam mehr Zeit, 
neu plazierte Gaussians zu integrieren, bevor das 
nächste Reloc-Event sie unter Druck setzt.

P R O S T Y M I  S ŁOWA M I

Alle wie viele Iterationen MCMC 
die toten Splats irgendwo anders 
hin verschiebt. 100 ist Standard. 
Selbst dran drehen brauchst 
du nicht — Outdoor-Preset hat 
schon den optimalen Wert.
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T67 mcmcWarmupIterations

S ZC Z E G Ó ŁY

Default: 500 Range: 100 – 5 000 Defined in:

T E C H N I C Z N I E

Anzahl der Initial-Iterationen, in denen noch keine 
MCMC-Relocation passiert. Erst nach diesem War
mup beginnt die Reloc-Logik. Sinn: in den ersten 
Iterationen sind die Opacity-Werte noch nicht ein
geschwungen — würde direkt mit Reloc gestartet, 
würden Gaussians an den falschen Stellen plaziert 
und müssten gleich wieder bewegt werden, was 
Adam-Momentum zerstört. Paper-Default 500. Ra
dianceKit übernimmt diesen Wert, weil V464b zeig
te dass es robust ist.

P R O S T Y M I  S ŁOWA M I

Wie viele Iterationen MCMC erst 
„ankommen„ darf, bevor es an­
fängt, Splats umzustellen. 500 
ist Standard und passt.

T68 mcmcDeadOpacityThreshold

S ZC Z E G Ó ŁY

Default: 0.005 (Initializer, Paper-Standard), 0.01 
( .fullMCMC  und alle MCMC-Presets — V535-Opti
mum) Range: 0.001 – 0.05 Defined in:

T E C H N I C Z N I E

sigmoid(Opacity)-Schwellwert, unter dem eine 
Gaussian als „tot„ gilt und für Relocation in Frage 
kommt. V535 fand 0.01 als optimal (0.005 margi
nal, 0.02 schlechter). Höher = aggressiveres Reloc 
(mehr Gaussians werden bewegt), niedriger = vor
sichtiger. 0.01 entspricht ungefähr „0.5 % visuelle 
Sichtbarkeit”. P10 Indoor verwendet via Q7-Bay
esOpt 0.0142 als Optimum.

P R O S T Y M I  S ŁOWA M I

Ab welcher Durchsichtigkeit ein 
Splat als „tot„ gilt, sodass MCMC 
ihn woanders hinschiebt. 0.01 ist 
optimal in unseren Tests. Selbst 
dran drehen brauchst du nicht.
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T69 mcmcNoiseDecayEnd

S ZC Z E G Ó ŁY

Default: 0 (Initializer = „kein Decay„), 160 
000 ( .fullMCMC  = 80 % von 200K), 96 000 
( .mcmcBalanced  = 80 % von 120K), 40 000 
( .mcmcPreview ) Range: 0 oder 1 000 – Defined in:

T E C H N I C Z N I E

Iteration, an der das T63 mcmcNoiseScale -Rau
schen vollständig auf null gedämpft wird (Cosine-
-Decay von Iter 0 bis hier). V497c/V502 fanden 80 
% der maxIterations optimal — gibt MCMC genug 
Exploration-Zeit, lässt aber die letzten 20 % zur Ko
nvergenz ohne Rauschen. 0 = konstantes Rauschen 
über alle Iterationen (selten sinnvoll, MCMC kann 
dann nicht konvergieren).

P R O S T Y M I  S ŁOWA M I

Wann das zufällige „Wac­
keln„ der Splats aufhört. In den 
MCMC-Presets bei 80 % der Ge­
samtiterationen — erst Explora­
tion, dann Konvergenz. Lass den 
Wert.

T70 mcmcGrowthRate

S ZC Z E G Ó ŁY

Default: 0.05 (Paper-Standard = 5 %) Range: 0.01 
– 0.2 Defined in:

T E C H N I C Z N I E

Wachstumsrate des MCMC-Populations-Targets 
pro Relocation-Step. Die Logik: bei je
dem Reloc-Event wird das Ziel-Populations-
-Größe um (1 + growthRate)  erhöht, bis T62 
mcmcMaxGaussians (oder die per T72/​T73 skalierte 
Variante) erreicht ist. V512/V522 fanden 0.05 als 
optimal — höhere Werte führen zu zu schnellem 
Wachstum (Gaussians werden eingefügt, bevor das 
Adam-Momentum sie integrieren kann), niedrigere 
zu unter-densifizierten Szenen am Ende.

P R O S T Y M I  S ŁOWA M I

Wie schnell die Splat-Anzahl bei 
MCMC wächst. 5 % pro Schritt ist 
optimal. Lass den Wert.
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T71 mcmcSigmoidK

S ZC Z E G Ó ŁY

Default: 100.0 Range: 10.0 – 500.0 Defined in:

T E C H N I C Z N I E

Sigmoid-Sharpness-Parameter für die MCMC-No
ise-Attenuation. Im SGLD-Schritt wird das pro-
-Gaussian-Rauschen durch gedämpft — hoch-opa
ke Gaussians (deren Logit positiv ist) bekommen 
exponentiell weniger Rauschen als niedrig-opake. K 
= 100 ist scharf, sprich der Übergang von „voll-
-Noise„ zu „kein-Noise” passiert sehr schnell um 
Opacity 0.5. V484–V487 fanden K = 100 optimal 
— kleinere Werte (10–50) lassen auch hoch-opake 
Gaussians mit-Wackeln (zerstört konvergierte Gaus
sians), größere (> 500) machen den Übergang kün
stlich hart und tote Gaussians werden gar nicht 
mehr bewegt.

P R O S T Y M I  S ŁOWA M I

Spezialparameter, der bestimmt, 
wie scharf MCMC zwischen 
„durchsichtig genug zum Ver­
schieben„ und „solid, nicht an­
rühren” unterscheidet. Standar­
dwert ist optimal. Nicht dran dre­
hen.

T72 mcmcCapMultiplier

S ZC Z E G Ó ŁY

Default: 3.0 (Initializer + .fullMCMC ), 2.0 
( .mcmcPreview ), 2.5 ( .mcmcBalanced ), 2.98 (P8 
Render), 5.32 (P9 Outdoor), 1.76 (P10 Indoor) Ran­
ge: 0 (= deaktiviert) oder 1.0 – 10.0 Defined in:

T E C H N I C Z N I E

1.4.5-Feature: szenen-adaptive Cap-Skalierung. 
Wenn T73 mcmcAutoScaleByScene true ist, wird der 
effektive Cap als berechnet (geclamped an Buffer-
-Kapazität). Hintergrund: bei großen Szenen (z.B. 
1 545-Foto-Drohnenflug → 158 K SfM-init) ist 
T62 = 150 000  zu niedrig — Density-Control wür

de gar nicht wachsen können. Mit Multiplier 3.0 
wird der Cap bei diesem Beispiel auf 474 K skaliert 
(158 K × 3.0). Q7-BayesOpt fand szenenspezifische 
Optima: Outdoor profitiert von hohem Multiplier 
(5.32 → ~830 K Cap bei 156 K bicycle-init), Indoor 
begnügt sich mit 1.76 (Wände sättigen schneller). 
Komplette Auflösung des Caps siehe -Methode.

P R O S T Y M I  S ŁOWA M I

Multiplikator, der den Splat-Cap 
automatisch an die Szenen-
-Größe anpasst. Große Szene = 
mehr Anfangspunkte = höherer 
Cap. Standard 3× passt für die 
meisten Szenen; Outdoor-Preset 
geht auf 5× (große Tiefenbere­
iche), Indoor auf 1.76× (Wände 
begrenzen ohnehin).
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T73 mcmcAutoScaleByScene

S ZC Z E G Ó ŁY

Default: true (Initializer + alle MCMC-Presets) Ran­
ge: boolean Defined in:

T E C H N I C Z N I E

1.4.5-Feature: Master-Switch für die scene-aware 
Cap-Logik (siehe T72 +). Wenn false, wird aus
schließlich T62 mcmcMaxGaussians als Cap verwen
det (zurück zu 1.4.4-Verhalten). Standardmäßig an, 
weil die Mass-Extinction-Probleme bei großen Sze
nen aus 1.4.3 sonst wiederkehren. Manuell deakti
vieren nur, wenn du explizit ein hartes Cap setzen 
willst — z.B. um eine 150 K-Variante zu trainieren, 
deren Endgröße planbar ist.

P R O S T Y M I  S ŁOWA M I

Schaltet die automatische An­
passung des Splat-Caps an 
die Szenen-Größe an. Standard­
mäßig an. Aus lassen nur, wenn 
du selbst genau eine bestimmte 
Splat-Anzahl haben willst.

Mip-Splatting (Q1.5) (T74–T76)

Status: Q1.5 wurde am 2026-05-25 nach 14 autonomen Iterationen + Overni
ght-1.5M-Confidence-Check als „closed no-win„ verworfen (max Δ@2× = +0.27 dB, 
Original-Gate verlangte ≥ +1.5 dB Mittelwert über 0.5×/2×, FAILT auf 0/11 Pair-Sce
nes). Die Felder bleiben opt-in für Forschungs-Experimente; alle Production-Pre
sets haben. Siehe Verdict: docs/​plans/​2026-05-25-phase-q1.5-final-verdict.md.
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T74 useMipSplatting

S ZC Z E G Ó ŁY

Default: false (alle Production-Presets), true 
( .fullMCMCMip  — Forschungs-Sibling) Range: bo
olean Defined in:

T E C H N I C Z N I E

Aktiviert Mip-Splatting (Yu et al. CVPR 2024): 3D-
-Smoothing-Filter + 2D-Filter + α-Kompensation, 
der die per-Gaussian-Frequenz auf die Nyquist-
-Grenze der dichtesten Trainingskamera-Sampling-
-Rate begrenzt. Theoretisches Ziel: Eliminierung 
von Aliasing bei Rendering in off-training-Skalen 
(0.5× oder 2× der Trainingsauflösung). In den 
Preprocess- und Backward-Projection-Shadern ak
tiviert, funktional korrekt verifiziert in Q1.5-D-Test. 
Aber: der Original-Akzeptanz-Gate (Δ@1× ≥ +0.3 
dB UND avg(Δ@0.5×, Δ@2×) ≥ +1.5 dB) wurde 
auf keinem von 11 Pair-Scenes erreicht. Maximal be
obachtet: family 750K classic Δ@2× = +0.270 dB. 
Outdoor-Szenen (Truck, Flowers) zeigten sogar Ver
schlechterung 1× und 0.5×. Hypothese: 3D-Smo
othing konkurriert mit MCMC-Relocation bei high-
-Gs. Feld bleibt für künftige Multi-Scale-Re-Eval mit 
korrekter Mip-NeRF-360-Methodology (siehe O3-
-Backlog im Benchmark-Pfad).

P R O S T Y M I  S ŁOWA M I

Aliasing-Filter aus einem 2024er-
-Paper. Theoretisch toll, prak­
tisch hat er in unseren Tests 
nichts gebracht und manchmal 
sogar geschadet. Bleibt verfüg­
bar für Experimentierer, aber wir 
empfehlen ihn nicht. Aus lassen.

T75 mipSmoothing3DScale

S ZC Z E G Ó ŁY

Default: 0.2 (Paper-Default) Range: 0.05 – 1.0 De­
fined in:

T E C H N I C Z N I E

3D-Smoothing-Skala-Parameter (Yu et al. §3.3, Pa
per-Default 0.2). Größer = mehr Welt-Raum-Glät
tung pro Gaussian (= mehr Anti-Aliasing, aber auch 
mehr blur in der Default-Skala), kleiner = schärfer 
aber anfälliger für Aliasing. Wird nur konsultiert, 
wenn T74 useMipSplatting = true. In Q1.5-Tests 
nicht weiter optimiert — die A/B-Gate hat schon mit 
Paper-Default 0.2 verloren, weitere Sweeps wären 
zwecklos.

P R O S T Y M I  S ŁOWA M I

. Wenn du Mip nicht eingeschal­
tet hast, irrelevant.
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T76 mipFilter2DVariance

S ZC Z E G Ó ŁY

Default: 0.3 (= exakt das V242-Legacy-Verhalten) 
Range: 0.1 – 1.0 Defined in:

T E C H N I C Z N I E

2D-Mip-Filter-Varianz, die zur Σ_2D-Diagonale ad
diert wird (Varianz direkt, nicht quadriert). 0.3 
ist exakt der V242-Legacy-Wert, der vor Mip-
-Splatting hardcoded im Kernel war. Wenn T74 
useMipSplatting = false, ignoriert der Kernel die
sen Wert komplett und schreibt das hartkodierte 0.3 
— sodass die Baseline nicht regredieren kann (Co
dex-Round-1-S3-1-Garantie). Wenn, wird der hier 
gesetzte Wert verwendet. Bleibt im Feld-Katalog für 
Mip-Sweeps.

P R O S T Y M I  S ŁOWA M I

Weiterer Mip-Splatting-Parame­
ter. Bei Mip-aus: irrelevant.

Adaptive Densification (Q5) (T77–T79)

T77 adaptiveDensification

S ZC Z E G Ó ŁY

Default: false Range: boolean Defined in:

T E C H N I C Z N I E

Q5-Feature: rolling-median-Tracker als Alternative 
zum fixen T11 densifyGradThreshold. Wenn true, 
wird in jedem Densify-Step der aktuelle Schwel
lwert mit median(letzte N avgGrad-Samples) × 
T79 adaptiveDensifyMultiplier überschrieben. N 
= T78 adaptiveWindow . Strikter als V440 p98 (die 
katastrophale 63 K-Pruning-Falle), median + 2× 
sitzt etwa beim p70–p80 der Gradient-Verteilung 
in steady state. Q5-Tests: alleinstehend FAIL 0/3 
Szenen, aber gemeinsam mit Q6 (siehe T80/T81) 
PASS 1/3 Szenen — das Bundle Q5+Q6 wurde 
2026-05-25 als opt-in gepasst und ist via CLI 
--adaptive-densify  aktivierbar. Q6 ist dabei der 

„Carrier„ des Quality-Gewinns, Q5 trägt eher zur 
Stabilität bei.

P R O S T Y M I  S ŁOWA M I

Selbstlernender Densify-Schwel­
lwert. Statt einer fest eingestel­
lten Empfindlichkeit passt die 
App sich der Szene an. Alleine 
getestet nicht besser, mit dem 
Curriculum aus Q6 zusammen 
aber ja. Beide gemeinsam ein­
schalten oder beide aus.
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T78 adaptiveWindow

S ZC Z E G Ó ŁY

Default: 1 000 Range: 100 – 10 000 Defined in:

T E C H N I C Z N I E

Rolling-Median-Window in Densification-Events 
(NICHT Iterationen — jeder T13 densifyInterval-
-Step liefert ein Sample). Default 1 000 — bei 
heißt das die letzten 100 000 Trainings-Iterationen 
tragen zum Median bei, also typisch die gesamte 
Trainingshistorie bis hierhin. Frühe Phase (vor T78  
Samples): Tracker returns nil → Fallback auf fixen 
Threshold T11 . Nur relevant wenn.

P R O S T Y M I  S ŁOWA M I

Wie viele alte Densify-Schritte in 
den Median für T77 einfließen. 
Standard 1000 ist gut. Nur rele­
vant wenn Q5-Adaptive an.

T79 adaptiveDensifyMultiplier

S ZC Z E G Ó ŁY

Default: 2.0 Range: 1.0 – 4.0 Defined in:

T E C H N I C Z N I E

Multiplikator auf den Rolling-Median für den adap
tiven Schwellwert. Default 2.0 entspricht ungefähr 
p70–p80 der typischen Gradient-Verteilung. Niedri
ger = aggressiveres Wachstum (mehr Klone), höher 
= strenger (weniger Klone). Q5-Tests in Range 1.5–
3.0 — 2.0 bestes Default. Nur relevant wenn.

P R O S T Y M I  S ŁOWA M I

Faktor für T77/T78. Standard 2.0 
= strenger als der typische Me­
dian. Nicht dran drehen.
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Curriculum (Q6) (T80–T81)

T80 curriculumResolutionRamp

S ZC Z E G Ó ŁY

Default: false Range: boolean Defined in:

T E C H N I C Z N I E

Q6-Feature: Trainings-Auflösung startet 
bei 0.5× und wechselt bei T50 
positionLRScheduleEndIteration /​ 2 (oder T1 
maxIterations /​ 2, falls T50 nicht gesetzt) auf T22 
trainingRenderScale. Verwendet die in Q1.5.1 en
twickelte resize/​restoreImageBuffers-Infrastruk
tur. Überschreibt T23 resolutionWarmupScale, wenn 
aktiviert. Q6 ist als „Carrier des Quality-Ge
winns„ im Q5+Q6-Bundle gepasst (siehe T77) — die 
schrittweise Auflösungserhöhung gibt der App Zeit, 
grobe Geometrie auf der niedrigeren Auflösung zu 
finden, bevor sie zur feinen Detailarbeit übergeht. 
Über CLI: --curriculum-resolution.

P R O S T Y M I  S ŁOWA M I

„Erst grob, dann fein„ für die 
Trainingsauflösung. Halbe Au­
flösung in der ersten Hälfte, 
dann volle Auflösung. Hilft in 
bestimmten Szenen, in anderen 
nicht — am besten mit T81 zu­
sammen einschalten.

T81 curriculumSHProgression

S ZC Z E G Ó ŁY

Default: false Range: boolean Defined in:

T E C H N I C Z N I E

Q6-Feature: 
überschreibt T21 shDegreeUpgradeIterations mit 
[maxIter/​4, maxIter/​2, maxIter*3/​4], verteilt also 
die SH-Aufstufungen gleichmäßig über die Training
szeit statt sie front-zu-loaden. Hypothese: stabile 
Geometrie wird vor Color-Detail-Explosion etabliert, 
was die View-Direction-abhängigen Glanz-Effekte 
präziser positioniert. Q5+Q6 zusammen PASS 1/3 
Szenen, Q6 als Carrier des Gewinns (Q5 alone FA
IL). Via CLI: --curriculum-sh .

P R O S T Y M I  S ŁOWA M I

„Erst Form, dann Farbe„ — die 
Glanz-Effekte werden erst spät 
im Training freigeschaltet, so­
dass die Splats zuerst ihre Posi­
tion und Größe finden. Mit T80 
zusammen einschaltbar; alleine 
bringt es nicht ganz so viel.

Statische Presets (TP1–TP9)

Hier nur die strukturellen Unterschiede zum Initializer-Default. Die volle Marketing-
-Beschreibung der elf UI-Presets P1–P11 findest du in Kapitel 7.
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TP1 .preview

S ZC Z E G Ó ŁY

Diagnose-/Vorschau-Preset für Systeme ≥ 10 GB 
RAM. Overrides gegenüber Initializer: - 30 000 → 
5 000 - 15 000 → 3 500 (70 % von maxIter) - 
1.6e-6 → 1.6e-5 (10× höher, weniger aggressiver 
Decay) -,,,, jeweils 2× (V176) - 3 000 → 100 000 
(effektiv aus, V172: Reset zerstört kurze Trainings) 
- [1K, 2K, 3K]  → [1K, 2K]  (V182: Degree 3 ko
nvergiert in 2K Iter nicht) - 1.0 → 0.5

P R O S T Y M I  S ŁOWA M I

jede beliebige Initial-Begutach­
tung einer neu importierten Bil­
dreihe — 2–3 min Wartezeit, an­
schließend reicht das Ergebnis 
für eine binäre Frage „lohnt sich 
Quality-Lauf?„.

TP2 .full

S ZC Z E G Ó ŁY

Production-Quality Classic. Overrides: - 30 000 → 
35 000 (V550: 40K-Tests Truck-Overtraining +10.7 
% Gs bei −1.3 % L1) - 15 000 → 5 000 (V310 
sweet spot, V338 7K worse) - Alle LRs 2× (V188) - 
1.6e-6 → 1.6e-5 (V45 10×) - 2e-6 → 1.1e-6 (V335) 
- 100 → 200 (V112) - 0.005 → 0.001 (V393) - 3 
000 → 100 000 (V194 disabled, V421 confirmed) - 
[1K, 2K, 3K]  → [2K, 5K, 8K]  (V228 delayed) - 

0.0 → 0.9995 (V546 HTGS, 14 % Verbesserung) - 
50 (unverändert, V546) - false → true (V438) - 0 
→ 20 000 (V431) - true (V443, schon Initializer-De
fault für .full )

P R O S T Y M I  S ŁOWA M I

jede Standard-Foto-Aufnahme 
(Objekt, kleiner Raum, Skulptur) 
mit < 500 Bildern. Die in V546 
angekündigte 14 % Loss-Verbes­
serung gegen V438 wurde 3-
-Trial-gemittelt auf Horse Full 
bestätigt.

TP3 .fullClassicPaper

S ZC Z E G Ó ŁY

Q1.5-A-Test-Sibling von TP2, paper-treuer Classic. 
Overrides gegenüber TP2: - 35 000 → 30 000 
(Paper-Standard) - 5 000 → 15 000 (Paper: 50 % 
von maxIter) - 1.6e-5 → 1.6e-6 (Paper-Default) -,, 
zurück auf Paper Defaults (0.05, 0.005, 0.001) - 
1.1e-6 → 2e-7 (kalibriert für ~1-2M Gs auf Bicycle) - 
200 → 100 (Paper) - 0.001 → 0.005 (Paper-Default) 
- 100 000 → 3 000 (Paper §5.2, riskant — kann 
V194-Regression auslösen) - 0.9995 → 0.0 (Paper 
hat keinen Decay) - 20 000 → 30 000 (cosine läuft 
auf 100 % von maxIter)

P R O S T Y M I  S ŁOWA M I

Q1.5-Forschungs-Experimente, 
die Paper-Magnitude-Gaussian-
-Budgets (1–2 M) für Mip-Splat­
ting-Tests brauchen. Nach Q1.5-
-„closed no-win„-Verdict bleibt 
das Preset für advanced users 
zugänglich, ist aber nicht Pro­
duction-empfohlen.
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TP4 .fullMCMC

S ZC Z E G Ó ŁY

Production-Quality MCMC. Overrides gegenüber In
itializer: - 30 000 → 200 000 (V534, MCMC braucht 
5× mehr Iter als Classic) - 15 000 → 160 000 
(V504b 80 % von maxIter) - 1.6e-6 → 1.6e-5 
- LR-Schedule wie TP2 (alle 2×) - 0.2 → 0.05 
(V521b/V534: MCMC braucht stärkeres L1-Signal) 
- [1K, 2K, 3K]  → [2K, 5K, 8K]  - .classic  → 
.mcmc  - 150 000 (im Initializer schon, im Preset 

bestätigt) - 5e-5 (V467/V536 optimal) - 0.005 → 
0.01 (V535 optimal) - 0 → 160 000 (80 % von ma
xIter, V497c/V502) - 3.0 (im Initializer schon) - true 
(im Initializer schon) - 3 000 → 200 000 (effektiv 
aus, MCMC nutzt Reloc statt Reset)

P R O S T Y M I  S ŁOWA M I

Web-Auslieferung, Object-Captu­
res mit Detail-Anspruch, Droh­
nenflüge (auch wenn dann P9 
Outdoor noch besser ist). 71 % 
weniger Gaussians als Classic 
bei vergleichbarer L1.

TP5 .fullMCMCMip

S ZC Z E G Ó ŁY

Q1.5-D-Test-Sibling von TP4, mit Mip-Splatting + 
Paper-Magnitude-MCMC-Budget. Overrides gege
nüber TP4:
• mcmcMaxGaussians 150 000 → 1 500 000 (10×, 

Paper-Magnitude)
• useMipSplatting false → true (Mip-on)

P R O S T Y M I  S ŁOWA M I

Alle anderen Felder identisch zu 
TP4. Q1.5 D-PASS auf Bicycle 
2026-05-24 (bricht 12-Iter-Multi-
-Scale-FAIL-Streak). Q1.5-Endur­
teil 2026-05-25 trotzdem closed-
-no-win — Mip-Splatting-Gewinn 
nicht reproduzierbar über 11 Pa­
ir-Scenes. Preset bleibt opt-in.

TP6 .classicBalanced

S ZC Z E G Ó ŁY

Mid-Tier Classic. Overrides gegenüber TP2: - 35 
000 → 20 000 (V149: 20K = 30K bei 33 % weniger 
Zeit) - 20 000 → 0 (Cosine läuft auf maxIter = 20K, 
kein extended phase)

P R O S T Y M I  S ŁOWA M I

Standardfälle mit kürzerer War­
tezeit. V149 als sweet spot iden­
tifiziert.
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TP7 .mcmcPreview

S ZC Z E G Ó ŁY

MCMC-Diagnose. Overrides gegenüber TP4: - 200 
000 → 60 000 (V494b) - 160 000 → 48 000 (80 
%) - 150 000 → 100 000 (V473b) - 160 000 → 40 
000 (V494b) - 3.0 → 2.0 (1.4.5: Preview = lighter 
scaling)

P R O S T Y M I  S ŁOWA M I

schnell ein MCMC-Resultat se­
hen, um zu beurteilen, ob 
TP4 oder ein Scene-Class-Preset 
lohnt.

TP8 .mcmcBalanced

S ZC Z E G Ó ŁY

Mid-Tier MCMC. Overrides gegenüber TP4: - 200 
000 → 120 000 (V518) - 160 000 → 96 000 (80 %) 
- 160 000 → 96 000 (80 %) - 3.0 → 2.5 (zwischen 
Preview 2.0 und Full 3.0)

P R O S T Y M I  S ŁOWA M I

MCMC ohne den vollen 200K-
-Lauf. ~120 K Iterationen sind ein 
guter Kompromiss aus Qualität 
und Wartezeit.

TP9 .quickTest

S ZC Z E G Ó ŁY

Reiner Funktionstest. Overrides gegenüber Initiali
zer: - 30 000 → 1 000 - 15 000 → 500 - 2e-6 → 
4e-6 (kalibriert für 0.25× Auflösung) - 100 → 50 - 3 
000 → 100 000 (aus, da viel zu kurz) - 1.0 → 0.25

P R O S T Y M I  S ŁOWA M I

Sanity-Check „startet das Tra­
ining überhaupt sinnvoll?„. Dau­
er < 30 s auf M3 Ultra. Sieht 
garantiert matschig aus.

Methode:

Signature: public func resolveMcmcMaxGaussians(initialPointCount: Int, 
bufferCapacity: Int) -> Int Defined in:

 Einzige Source-of-Truth für die Frage „wie viele Gaussians darf MCMC maxi

mal wachsen lassen?„. Berechnet sich aus drei Eingaben: dem konfigurierten T62 
mcmcMaxGaussians (mit Mass-Extinction-Floor 150 000, falls 0), dem (Anzahl der SfM-
-Init-Punkte) und der (vorallozierte Gaussian-Buffer-Größe). Logik:

1. base = T62 > 0 ? T62: 150_​000 (der Mass-Extinction-Floor schützt gegen Initia
lizer-Default-Bugs wie den 1.4.3-Mass-Extinction-Vorfall)

2. Falls T73 mcmcAutoScaleByScene && initialPointCount > 0 && T72 
mcmcCapMultiplier > 0:
• scaled = max(base, ceil(initialPointCount × T72)) sonst

3. Falls bufferCapacity > 0 : return min(scaled, bufferCapacity)
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4. Sonst return scaled

Beispiel: Bicycle (Mip-NeRF 360, 194 Foto-Frames) → SfM-init ~156 K Punkte, 
T62 = 150 000 , T72 = 5.32 ,, Buffer-Kapazität 8 M. Resolved Cap = min(8M, 
max(150K, ceil(156K × 5.32))) = min(8M, 830K) = 830 K. Das ist der effektive 
Wachstums-Cap, an den die MCMC-Relocation-Logik sich hält.

 Berechnet die wirkliche maximale Splat-Anzahl bei MCMC. Nimmt deine Einstellung, 

schaut sich an, wie viele Punkte deine Szene anfangs hat, und skaliert mit dem 
Multiplier , falls die automatische Anpassung an ist. So passt sich der Cap an die 

Szene an, statt für eine kleine und eine riesige Szene den gleichen Wert zu erzwingen. 
Du musst die Methode nicht selbst aufrufen — das Training nutzt sie intern.

Welches Feld wofür? (Cheat-Sheet)

Ziel Felder zum Drehen

Mehr Detail in der 
Ferne

T62 mcmcMaxGaussians hoch, T72 mcmcCapMultiplier 5+

Mehr Detail allge
mein (Classic)

T1 maxIterations  hoch (≤ 40K), T2 densifyUntilIteration ≤ 
14 % von T1

Floater in Droh
nenflügen reduzie

ren

T43 frustumCullEnabled an, T20 skyMaskingEnabled an, 
T45 skyDomeEnabled  an

Schöner Himmel in 
Außen-Szenen

T45 skyDomeEnabled  an, T47 skyDomeRadiusMultiplier 30–60

Kleinere Export-
-Datei

Strategie .mcmc  (T61), T56 postTrainingCompactification an, 
T62 mcmcMaxGaussians ≤ 200K

Schnelleres Tra
ining

T22 trainingRenderScale 0.5, T1 maxIterations  halbieren — 
aber nicht beides!

Bessere Glanzlich
ter

T21 shDegreeUpgradeIterations mit [2K, 5K, 8K]  (kein early-
-front-load), MCMC + 200K iter

Mac responsiv hal
ten

T25 throttleDelayMs 5–10 (kostet ~15 % Trainingszeit)

Live-Vorschau 
häufiger

T59 livePreviewInterval runter auf 10–20

Sanftere Übergän
ge an Schatten

T17 ssimWeight  etwas hoch (0.15–0.25), aber nicht über 0.3

Innenräume kom
pakt halten

P10 Indoor-Preset (, T72 = 1.76 )
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Gefährliche Felder

Diese Felder können bei Falsch-Konfiguration zu OOM, App-Crash, Mass-Extinction der 
Gaussians oder unbrauchbaren Benchmark-Daten führen. Mit Vorsicht zu behandeln:

• T11 densifyGradThreshold — eine Halbierung kann 2–4× so viele Gaussians erzeu
gen, was schnell den GPU-Speicher sprengt. Auch zu beachten: muss zur T22 
trainingRenderScale passen (1.0× → 1e-6, 0.5× → 2e-6, 0.25× → 4e-6).

• T72 mcmcCapMultiplier — bei großen Szenen mit > 200 K SfM-init-Punkten und Mul
tiplier > 5 entsteht ein Resolved-Cap von Millionen Gaussians. Auf 36-GB-RAM-Macs 
OOM möglich. Outdoor-Preset 5.32 funktioniert nur, weil Mip-NeRF-360-Bicycle 156 
K init-Punkte hat → 830 K Cap.

• T39 testViewIndices — manuelles Setzen kann den Benchmark unbrauchbar machen 
(alle Indices > N → keine Holdouts). Lass das --benchmark -Flag das setzen.

• T64 mcmcOpacityRegWeight und T65 mcmcScaleRegWeight — In 1.4.3-Beta auf 0.01 
gesetzt, was zu Mass-Extinction führte (460 K → 5 Gaussians in einer Iteration). Seit 
1.4.4 auf 0.0 fixiert, aber manuelles Erhöhen kann das Problem reproduzieren.

• T15 opacityResetInterval — wenn nicht 100 000+ (effektiv aus) und das Training 
kürzer als 10 000 Iterationen ist, zerstört der Reset die Konvergenz. .preview  hat es 
deshalb auf 100 000 trotz maxIterations = 5 000.

• T54/​T55 densifyPhase2* — Two-Phase Densification ist in Tests in 0-Gaussians-
-Cascade abgebrochen. Lass beide auf 0.

• T74 useMipSplatting — Q1.5 closed-no-win 2026-05-25, kann auf manchen Outdo
or-Szenen sogar PSNR verschlechtern. Default off, opt-in nur für Forschung.

Wenn ein Feld auf dieser Liste steht und du es ändern willst, mache vorher eine 
Sicherung deines aktuellen Presets (Export als JSON) und überlege, ob du das Resultat 
reproduzierbar messen kannst — sonst weißt du hinterher nicht, ob du eine Verbesse
rung oder Verschlechterung herbeigeführt hast.
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R O Z D Z I A Ł

Rozdział 7 — Wbudowane ustawienia 
wstępne jakości

Rysunek 27:  Sekcja Ustawienia wstępne ze wszystkimi czterema rozwiniętymi grupami — 
CAPTURE CLASS (4 ustawienia: Drone/Aerial, 360° Walkaround, 360° Walkaround (High 

Detail), Photo/Object), CLASSIC (5 ustawień: Quick/Preview/Balanced/Quality/Ultra Detail), 
MCMC (3 ustawienia, wskazówka „No threshold tuning„), HYBRID (1 ustawienie: Balanced 

(Hybrid))

CO WIDAĆ NA OBRAZIE  Sekcja Ustawienia wstępne w Inspectorze, wszystkie cztery grupy 
rozwinięte. CAPTURE CLASS z czterema kuratorowanymi ustawieniami dla rzeczywi
stych ujęć (Drone / Aerial, 360° Walkaround, 360° Walkaround (High Detail), Photo / 
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Object) — to grupa podstawowa i w Trybie początkującym jedyna widoczna. CLASSIC 
z Quick (1K iter.), Preview (5K iter., aktywny wybór z niebieskim ptaszkiem), Balanced 
(20K iter.), Quality (35K iter.) i Ultra Detail (35K iter.). MCMC z podtytułem „No thre
shold tuning„ — MCMC nie potrzebuje progu Densify-Until: Preview (60K iter., 100K 
gaussianów), Balanced (120K, 150K), Quality (200K, 150K). HYBRID z ustawieniem Ba
lanced (Hybrid) (20K iter., 150K gaussianów). Wiersz akcji w stopce: Save…, Export…, 
Import…

Ustawienie wstępne to przygotowana konfiguracja treningu. RadianceKit dostarcza 
trzynaście wbudowanych ustawień wstępnych w czterech grupach: cztery ustawienia 
Capture-Class (P9–P12) — kuratorowane, wzrokowo zwalidowane na prawdziwym ma
teriale społeczności receptury dla rzeczywistych rodzajów ujęć (dron, obejście 360°, 
foto-obiekt), i oś podstawowa od v1.6 —, pięć ustawień Classic (P1–P5: Quick/Preview/
Balanced/Quality/Ultra Detail), trzy ustawienia MCMC (P6–P8) oraz jedno ustawienie 
hybrydowe (P13), które łączy strategie Classic i MCMC. Wcześniejsze ustawienia „Sce
ne-Class„ (Render/3D, Outdoor, Indoor, w Fazie Q7 akademicko dostrojone względem 
scen Mip-NeRF-360 i NeRF-Blender) zostały w v1.6 wycofane jako widoczna grupa — 
wzrokowo zwalidowana na prawdziwym materiale Capture-Class jest teraz osią podsta
wową; konfiguracje dostrojone w Q7 pozostają zachowane tylko wewnętrznie. Wybie
rasz ustawienia na pasku bocznym w obszarze Presets lub w Trybie początkującym 
przy imporcie. Przyciski +  otwierają okna dialogowe, aby dodać własne ustawienia 
obok — trzynastu wbudowanych nie da się usunąć, ale można je zduplikować.

W Expert View ustawienia wstępne pojawiają się pogrupowane według rodzaju ujęcia 
i strategii (Capture Class / Classic / MCMC / Hybrydowy). Kliknięcie wpisu zapisuje 
przypisaną do niego konfigurację treningu do bieżącego stanu. To nie jest zrzut — gdy 
potem przekręcisz suwakami, stan się zmieni, ale samo ustawienie pozostanie niezmie
nione; kolorowa wskazówka pokazuje wtedy „modified„.

Które ustawienie wstępne kiedy jest właściwe, zależy przede wszystkim od typu sceny i 
sprzętu. Trzy zestawienia tabelaryczne na końcu rozdziału to podsumowują.
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P1 — Quick

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Classic„ → pozycja „Quick”. Końcówka UUID …001 .

T E C H N I C Z N I E

Ustawienie diagnostyczne z 1 000 iteracjami, kla
syczną (adaptacyjną) strategią densyfikacji i skalo
waniem rozdzielczości treningu 0.25× (obraz wej
ściowy jest przed treningiem zmniejszany do 25%). 
Nie służy do dostarczania finalnej sceny, lecz do 
szybkiego stwierdzenia, czy konfiguracja (pozy ka
mer, chmura punktów, seria zdjęć) w ogóle wykazu
je sensowny ruch w wartościach loss. Na M3 Ultra 
typowo poniżej 30 sekund na 50–200 obrazach. 
Mała rozdzielczość zaciemnia rzeczywistą jakość 
obrazu, ale utrzymuje zapotrzebowanie na pamięć 
i koszty renderingu na bardzo niskim poziomie. Wy
bierane także automatycznie jako domyślne przy 
pierwszym uruchomieniu, gdy system ma mniej niż 
10 GB RAM.

P R O S T Y M I  S ŁOWA M I

Szybki test funkcjonalny. Wrzu­
casz obrazy, czekasz ledwie pół 
minuty, sprawdzasz czy pojawia 
się surowy zarys sceny. Jeśli ob­
raz w podglądzie wygląda jak 
rozmyta plama — pasuje, tak ma 
być. Jeśli natomiast widzisz tyl­
ko ciemne punkty albo totalnie 
zniekształconą formę, prawdo­
podobnie pozy kamer są błędne 
(patrz rozdział 9). Aby uzyskać 
prezentowalny wynik, potrzebu­
jesz potem co najmniej P2 lub P3.

P2 — Preview (Classic)

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Classic„ → pozycja „Preview”. Końcówka UUID 
…002 .

T E C H N I C Z N I E

5 000 iteracji densyfikacji Classic, skalowanie roz
dzielczości 0.5×, podwójne współczynniki uczenia 
względem standardu. Densyfikacja (klonowanie + 
dzielenie) jest aktywna przez pierwsze 2 500 itera
cji, później tylko pruning. Domyślne ustawienie dla 
systemów z ≥ 10 GB RAM. Na M3 Ultra typowo 
90 sekund do 3 minut dla sceny z 200 obrazami. 
Daje użyteczne wrażenie geometrii i pozy kamery, 
ale tekstury są wyraźnie rozmyte — rozdzielczości 
renderingu 0.5× nie da się potem ominąć przez po
nowny trening z P3 lub P4, ponieważ współczynniki 
uczenia są skalibrowane pod połowiczną rozdziel
czość.

P R O S T Y M I  S ŁOWA M I

Standard dla „rzutu okiem„. Je­
śli właśnie zaimportowałeś nowe 
obrazy i chcesz zobaczyć, czy 
scena w ogóle daje się zrekon­
struować, to jest właściwy po­
ziom. Około 2–3 minut czekania, 
potem możesz obracać scenę w 
widoku 3D i ocenić, czy inwesty­
cja w kolejne treningi ma sens. 
Dopiero gdy wynik podglądu wy­
gląda już dobrze, opłaca się 
przejść do Balanced lub Quality.
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P3 — Balanced (Classic)

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Classic„ → pozycja „Balanced”. Końcówka UUID 
…005 .

T E C H N I C Z N I E

20 000 iteracji densyfikacji Classic przy pełnej roz
dzielczości obrazu. Densyfikacja działa przez pierw
sze 15 000 iteracji, od iter 3 000 z interwałem 
densyfikacji 100. Empirycznie „sweet spot„ z udoku
mentowanych sesji treningowych: przy klasycznej 
densyfikacji na Horse Full i Truck loss L1 stabilizuje 
się między iter 18 000 a 22 000, dłuższy trening nie 
przynosi istotnej poprawy poniżej Quality (P4). Na 
M3 Ultra typowo 30–60 sekund na 200 obrazach, 
5–8 minut na 1 000+ obrazach.

P R O S T Y M I  S ŁOWA M I

„Dobry kompromis„. Większość 
scen wygląda już z tym dobrze, 
bez konieczności czekania go­
dziny. Jeśli chcesz pokazać wy­
nik końcowy gdziekolwiek (social 
media, strona internetowa, demo 
dla klienta), to często wystarcza. 
Dopiero gdy chcesz wczytać się 
w model splat lub potrzebujesz 
szczegółów tekstury powierzch­
ni, opłaca się skok do P4 Quality 
lub P7 MCMC.

P4 — Quality (Classic)

G DZ I E

Inspector → sekcja Ustawienia wstępne → gru
pa „Classic„ → pozycja „Quality”. Końcówka UUID 
…003 .

T E C H N I C Z N I E

35 000 iteracji densyfikacji Classic z V546-„Opaci
ty Decay„ (HTGS, Eurographics 2025): po każdym 
cyklu densyfikacji opacity wszystkich istniejących 
gaussianów mnoży się przez współczynnik < 1.0, 
co niezawodnie usuwa nieaktywne gaussiany przy 
pruningu i tym samym na identycznej liczbie iter 
osiąga 14% lepszy loss L1 niż klasyczny przebieg 35 
000. Loss SSIM jest włączony ( ssimWeight=0.05 ). 
Na M3 Ultra typowo 2–4 minuty na 200 obrazach. 
Dostarcza na NeRF-Blender (Lego, Chair, Drums) 
finalne L1 ≈ 0.023 — najlepszy wariant Classic w 
560+ udokumentowanych eksperymentach. Uwaga: 
potrzebuje ~3–5 GB pamięci GPU; na systemach 8-
-GB bezpieczniejszym wyborem jest P3.

P R O S T Y M I  S ŁOWA M I

Najlepszy wariant klasyczny. Da­
je ostrą teksturę i drobną geome­
trię, zwłaszcza w ujęciach obiek­
tów (rzeźba, krzesło, waza). Przy 
dużych scenach plenerowych lub 
pomieszczeniach prawie nie wi­
dzisz różnicy względem Balan­
ced — tam zmiana na ustawienie 
MCMC (P6–P8) lub Capture-Class 
(P9–P12) opłaca się bardziej niż 
skok z P3 na P4. Kto chce abso­
lutnego maksimum rodziny Clas­
sic, bierze P5 Ultra Detail.
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P5 — Ultra Detail (Classic)

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Classic„ → pozycja „Ultra Detail”. Końcówka UUID 
…008 .

T E C H N I C Z N I E

Około 35 000 iteracji densyfikacji Classic — 
zwycięzca przebiegu held-out matrycy jakości 
(2026-06-10). Na wszystkich trzech testowanych 
scenach Mip-NeRF-360 Ultra Detail bije wbudowa
ne ustawienie MCMC „Quality„ (P8) przy porówny
walnym czasie zegarowym o około +0.94 dB PSNR. 
Tym samym jest najmocniejszym ustawieniem jako
ściowym grupy Classic i najostrzejszym wariantem 
Classic, jaki dostarcza RadianceKit. Na M3 Ultra 
typowo w tych samych ramach czasowych co P4 
Quality (2–5 minut na 200 obrazach), potrzebuje 
jednak nieco więcej pamięci GPU; na systemach 8-
-GB bezpieczniejszym wyborem pozostaje P3.

P R O S T Y M I  S ŁOWA M I

Najostrzejszy poziom Classic i 
zwycięzca held-out naszych te­
stów jakości: na rzeczywistych 
scenach około jeden decybel le­
piej niż wariant MCMC „Quali­
ty„ — przy podobnym czasie 
oczekiwania. Jeśli chcesz mak­
symalnej wierności detalu przy 
sprawdzonej klasycznej densyfi­
kacji i masz wystarczająco pa­
mięci GPU, to pierwszy wybór. 
Jeśli pamięci nie starcza lub po­
trzebujesz możliwie małego pli­
ku eksportowego, zostań przy P4 
Quality lub ustawieniu MCMC.

P6 — Preview (MCMC)

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„MCMC„ → pozycja „Preview”. Końcówka UUID 
…006 .

T E C H N I C Z N I E

60 000 iteracji densyfikacji MCMC (3DGS-MCMC, 
NeurIPS 2024) przy limicie 100 000 gaussianów. 
MCMC zastępuje heurystyczną logikę klonowania/
dzielenia relokacją Markov Chain Monte Carlo: mar
twe gaussiany są na nowo rozmieszczane przez 
głębokości próbkowania ważone sigmoidą, co daje 
kontrolowaną i powtarzalną liczbę gaussianów. Limit 
twardo ogranicza maksymalną liczbę przy 100K — 
to oszczędza pamięć i czas renderingu, ale kosztuje 
detal. Na M3 Ultra typowo 5–8 minut na 200 obra
zach. Nadaje się jako „test funkcjonalny MCMC„ — 
pomaga ocenić, czy zmiana z Classic na MCMC ma 
sens, zanim zainwestujesz więcej czasu w P7 lub 
P8.

P R O S T Y M I  S ŁOWA M I

Jak P2 Preview, ale z nowszą pro­
cedurą MCMC. Często daje nie­
co bardziej zwarte, równomiernie 
rozłożone chmury splat niż wa­
riant Classic. Do pierwszej oce­
ny sceny wystarczają zwykle 5–
8 minut. Jeśli wynik podglądu ci 
się podoba, następnym krokiem 
jest P7 (Balanced) lub od razu P8 
(Quality MCMC).
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P7 — Balanced (MCMC)

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„MCMC„ → pozycja „Balanced”. Końcówka UUID 
…007 .

T E C H N I C Z N I E

120 000 iteracji MCMC przy limicie 150 000 gaus
sianów. Średni poziom MCMC — prawie finalna licz
ba gaussianów z P8 Quality, ale tylko 60% iteracji. 
Empirycznie loss L1 w udokumentowanych sesjach 
treningowych wynosi 0.026–0.028 na Horse Full, w 
porównaniu do P8 z 0.0246 — czyli około 7% wyżej, 
za to połowiczny czas oczekiwania. Na M3 Ultra 
typowo 8–15 minut na 200 obrazach. Używa proce
dury, która skaluje efektywny limit gaussianów do 
gęstości punktów wejściowej chmury SfM (zobacz 
T75 w rozdziale 6).

P R O S T Y M I  S ŁOWA M I

MCMC z porządną głębią szcze­
gółu, ale bez długiego pełne­
go przebiegu P8. Dla większo­
ści scen to wystarcza, zwłasz­
cza jeśli chcesz wcisnąć przebieg 
MCMC w ramy czasowe przerwy 
obiadowej. Jeśli pamięci jest ma­
ło (np. na procesorach M tylko 16 
GB), zostań tutaj — P8 potrzebu­
je więcej pamięci GPU.

P8 — Quality (MCMC)

G DZ I E

Inspector → sekcja Ustawienia wstępne → gru
pa „MCMC„ → pozycja „Quality”. Końcówka UUID 
…004 .

T E C H N I C Z N I E

200 000 iteracji MCMC przy limicie 150 000 gaus
sianów, loss SSIM 0.05, MCMC-Noise-Decay przez 
80% iteracji. Najlepszy pojedynczy przebieg L1 w 
560+ eksperymentach: 0.0238 na Horse Full, uśred
nione przez 3 próby 0.0246 (w porównaniu do P4 
0.0230 na tej samej scenie). MCMC dostarcza przy 
tym 71% mniej gaussianów (150K vs ~524K) — 
decydujące, gdy chcesz dostarczyć wynik w inter
necie, ponieważ mniejsza chmura daje znacząco 
mniejsze pliki eksportowe. Czas treningu na M3 Ul
tra typowo 20–35 minut na 200 obrazach; na zesta
wach 1 000+ raczej 1–2 godziny. Najlepszy wybór, 
gdy pożądana jest maksymalna jakość obrazu przy 
minimalnym rozmiarze końcowym.

P R O S T Y M I  S ŁOWA M I

Najlepszy wariant MCMC. Daje 
bardzo czyste, zwarte chmury 
splat — idealne, gdy chcesz po­
tem osadzić wynik jako webowy 
widok 3D lub przesłać jako plik 
(plik jest mniejszy niż przy P4 
Quality przy porównywalnej jako­
ści optycznej). Potrzebujesz jed­
nak do tego cierpliwości — na 
dużych ujęciach ponad godzina 
oczekiwania. Zaplanuj to raczej 
jako przebieg „przez noc„.
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Rysunek 28:  Grupa CAPTURE CLASS rozwinięta ze wszystkimi czterema kuratorowanymi 
ustawieniami dla rzeczywistych ujęć — Drone / Aerial (MCMC, 40K iter., limit 1,5 M), 360° 

Walkaround (MCMC, 40K, limit 1,5 M), 360° Walkaround (High Detail) (Hybrydowy, 40K, limit 
1,5 M, opcjonalny) i Photo / Object (Hybrydowy, 40K, limit 1,5 M). Ta grupa stoi na samej 

górze i w Trybie początkującym jest jedyną widoczną.

CO WIDAĆ NA OBRAZIE  Inspector z rozwiniętą grupą CAPTURE CLASS — grupą ustawień 
podstawowych od v1.6, w Trybie początkującym jedyną wyświetlaną. Każdy wpis to 
wzrokowo zwalidowana na prawdziwym materiale społeczności receptura dla konkret
nego rodzaju ujęcia (dron, obejście 360°, foto-obiekt), a nie wartość zoptymalizowana 
względem akademickiego zestawu testowego. Wybór kliknięciem zapisuje przypisaną 
konfigurację treningu do bieżącego stanu.
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P9 — Drone / Aerial

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Capture Class„ → pozycja „Drone / Aerial”. Koń
cówka UUID …010 .

T E C H N I C Z N I E

Ustawienie Capture-Class dla orbit z powietrza i z 
drona wokół budynków i krajobrazów. Densyfikator 
MCMC, 40 000 iteracji, limit 1,5 mln gaussianów, 
loss SSIM 0.5 plus człon Edge-Aware 0.1. Decydują
ca jest kara za anizotropię z wagą 0.003 przy progu 
proporcji 6 — „zabójca spaghetti„ przeciwko typo
wym igłowatym artefaktom, które generuje materiał 
z drona. Zwalidowane na rzeczywistym locie drona 
DJI 4K nad wiaduktem Pensford (sprawdzone wzro
kowo, nie tylko metrycznie).

P R O S T Y M I  S ŁOWA M I

Dla ujęć z powietrza — loty dro­
na wokół budynku, nad krajobra­
zem, wzdłuż fasady. Mocna kara 
za anizotropię uprząta igłowate 
lub spaghetti-podobne artefakty, 
które materiał z drona chętnie 
produkuje. Jeśli twój materiał 
jest nakręcony z ziemi, lepiej pa­
suje Photo / Object lub ustawie­
nie Classic.

P10 — 360° Walkaround

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Capture Class„ → pozycja „360° Walkaround”. Koń
cówka UUID …011 .

T E C H N I C Z N I E

Ustawienie Capture-Class dla filmów typu walkaro
und 360°. Densyfikator MCMC, 40 000 iteracji, limit 
1,5 mln gaussianów, loss SSIM 0.5 plus człon Edge-
-Aware 0.1, łagodna kara za anizotropię (waga 0.001 
przy progu proporcji 15). Maska osób i nieba jest 
aktywna. Ustawienie oczekuje filmu 360° equirect, 
który jest wewnętrznie reprojektowany na perspek
tywiczne kadry o szerokości około 90°, zanim ruszy 
trening. Zwalidowane na obejściach 360° w 8K z ki
jem do selfie (scena Monument, sprawdzone wzro
kowo).

P R O S T Y M I  S ŁOWA M I

Dla filmów typu obejście 360° — 
przechodzisz z kamerą 360° lub 
kijem do selfie przez pomiesz­
czenie albo wokół obiektu. Ra­
dianceKit sam rozkłada panora­
mę kulistą na normalne kąty wi­
dzenia i maskuje przechodniów 
oraz niebo. Aby uzyskać maksy­
malną ostrość na tym samym 
materiale, wypróbuj dodatkowo 
wariant High Detail (P11).
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P11 — 360° Walkaround (High Detail)

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Capture Class„ → pozycja „360° Walkaround (High 
Detail)”. Końcówka UUID …013  (opcjonalny).

T E C H N I C Z N I E

Opcjonalne ustawienie Capture-Class dla filmów ty
pu walkaround 360° z maksymalnym detalem. Den
syfikator hybrydowy (klasyczne clone/split na bazie 
gradientu absolutnego + szum MCMC + relokacja), 
40 000 iteracji, limit 1,5 mln gaussianów, kara za 
anizotropię 0.0015 przy progu proporcji 15, loss 
SSIM 0.2 i człon Edge-Aware 0 — zablokowana 
receptura screen-split „r50″. Na materiale 360° 
bije standardowe ustawienie MCMC „360° Walkaro
und„ (P10) pod względem PSNR, LPIPS i widoczne
go konfetti, i to przy około jednej trzeciej liczby 
splatów. Stoi celowo opcjonalnie obok standardowe
go ustawienia 360°, dopóki nie zostanie zwalidowa
ne na większej liczbie scen.

P R O S T Y M I  S ŁOWA M I

Ostrzejsza alternatywa dla stan­
dardowego ustawienia 360° 
(P10): więcej detalu, mniej kon­
fetti, znacznie mniejszy plik. Stoi 
celowo obok zamiast je zastępo­
wać — jak dotąd potwierdzone 
na garstce scen. Jeśli twoje obej­
ście 360° jest czysto nakręcone, 
wypróbuj najpierw to ustawienie 
i porównaj wynik z P10.

P12 — Photo / Object

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Capture Class„ → pozycja „Photo / Object”. Koń
cówka UUID …012 .

T E C H N I C Z N I E

Ustawienie Capture-Class dla orbit obiektów z 
ostrych pojedynczych zdjęć (bez wideo). Densyfika
tor Hybrid-t1 (z relokacją), 40 000 iteracji, limit 1,5 
mln gaussianów, loss SSIM 0.5 plus człon Edge-
-Aware 0.1, łagodna kara za anizotropię (waga 0.001 
przy progu proporcji 15), Opacity Decay 0.9995 
co 50 iteracji, bez maskowania. Zwalidowane na 
163 wysokorozdzielczych zdjęciach 41-MP szkieletu 
(sprawdzone wzrokowo). Niewiele widoków (do oko
ło 600) pozostaje przy tym poniżej progu Hybrid-
-Collapse.

P R O S T Y M I  S ŁOWA M I

Dla ujęć obiektów z ostrych poje­
dynczych zdjęć — okrążasz rzeź­
bę, model, produkt z kamerą 
i robisz zdjęcia zamiast wideo. 
Bez maskowania, bo ostre zdję­
cia mają zwykle czyste tło. Dla 
źródeł wideo weź zamiast tego 
ustawienie 360° lub Drone.
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P13 — Zrównoważony (Hybrydowy)

G DZ I E

Inspector → sekcja Ustawienia wstępne → grupa 
„Hybrydowy„ → pozycja „Zrównoważony (Hybrydo
wy)”. Końcówka UUID …009 .

T E C H N I C Z N I E

20 000 iteracji z hybrydową strategią densyfikacji: 
klasyczne, sterowane gradientem clone/split lokuje 
pojemność tam, gdzie potrzebuje jej loss, szum 
SGLD z MCMC dalej eksploruje, a martwe gaussiany 
są relokowane, zamiast przepadać w pruningu. Opa
city Decay (V546) zastępuje resety opacity; kara za 
anizotropię (waga 0.001, próg proporcji 15) trzyma 
w ryzach igłowate splaty. Górny limit gaussianów 
skaluje się ze sceną (baza 150K, scene-aware ×3.0). 
Zwalidowane na pięciu scenach względem czystego 
MCMC przy tym samym budżecie: średnio +0.45 
dB PSNR przy 20–30% mniejszej liczbie gaussianów 
(stonehenge +1.23, family +0.82, garden +0.47 dB). 
Na M3 Ultra typowo 5–10 minut na 200 obrazach.

P R O S T Y M I  S ŁOWA M I

Mocny pierwszy wybór dla final­
nego wyniku: ostrzejszy detal niż 
ustawienia MCMC przy podobnie 
zwartym pliku, w ułamku czasu 
treningu P8. Jeśli masz czas tyl­
ko na jeden przebieg jakościowy 
i żadna z klas ujęcia wyraźnie nie 
pasuje, zacznij tutaj. Ustawienia 
Classic pozostają lepsze do szyb­
kich testów, a ustawienia Captu­
re-Class (P9–P12) są pierwszym 
wyborem, gdy twoja scena wy­
raźnie pasuje do jednego z tych 
rodzajów ujęcia.
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Kiedy które ustawienie wstępne?

Scenariusz Test wstępny Główny przebieg

Test funkcjonalny nowych 
obrazów, < 30s

P1 Quick —

Orbit obiektu z ostrych 
pojedynczych zdjęć

P2 Preview P12 Photo / Object

Skan pojedynczego 
obiektu (wideo), < 500 

zdjęć

P2 Preview P4 Quality lub P8 Quality 
MCMC

Film typu walkaround 
360°

P6 Preview MCMC P10 360° Walkaround 
(ostro: P11 High Detail)

Orbit z powietrza / drona, 
krajobraz

P6 Preview MCMC P9 Drone / Aerial

Dostawa do sieci (małe, 
zwarte)

P2 P8 Quality MCMC (naj
mniejszy plik przy pełnej ja

kości)

Ostry detal w krótkim 
czasie, zwarty eksport

P2 lub P6 P13 Zrównoważony (Hy­
brydowy)

Maksymalna wierność de
talu, strategia Classic

P3 lub P6 P5 Ultra Detail

Druk, marketing, pełny 
detal

P3 lub P6 P4 Quality (Classic) lub P5 
Ultra Detail
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Szybkie porównanie
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Usta­
wie­
nie

Stra­
tegia

Iter. Maks. 
Gs

Skala 
renderu

Typowy czas (200 obr., M3 
Ultra)

Q-Swe­
ep

P1 
Qu
ick

Classic 1 000 ∞ 0.25× ~30 s —

P2 
Preview

Classic 5 000 ∞ 0.5× 2–3 min —

P3 
Ba
lan
ced

Classic20 000 ∞ 1.0× 30–60 s —

P4 
Qu
ality

Classic35 000 ∞ 1.0× 2–4 min V546 
HTGS

P5 
Ul
tra 
De
tail

Classic ~35 
000

∞ 1.0× 2–5 min Ma
trix Δ+0.94 

dB

P6 
Preview 
MCMC

MCMC60 000 100 
K

1.0× 5–8 min —

P7 
Ba
lan

ced MCMC

MCMC 120 
000

150 
K

1.0× 8–15 min —

P8 
Qu

ality MCMC

MCMC 200 
000

150 
K

1.0× 20–35 min V544a

P9 Dro
ne / Aerial

MCMC40 000 1.5 
M

1.0× 10–25 min Wzrok / 
wia
dukt

P10 360° 
Wal
ka
ro

und

MCMC40 000 1.5 
M

1.0× 10–25 min Wzrok / 
Mo
nu

ment

P11 360° 
Wal
ka
ro

und (High 
De
tail)

Hybry
dowy

40 000 1.5 
M

1.0× 10–25 min Wzrok 
(opt-
-in)

P12 Pho
to / 
Ob
ject

Hybry
dowy

40 000 1.5 
M

1.0× 10–25 min Wzrok / 
szkie

let

P13 Zrów
no
wa
żo
ny 

(Hy
bry
do
wy)

Hybry
dowy

20 000 150 
K

1.0× 5–10 min Ma
trix Δ+0.45 

dB
181 / 233



R A D I A N C E K I T Rozdział 7 — Wbudowane ustawienia wstępne jakości

Własne ustawienia wstępne

Przyciskiem Save… w sekcji Ustawienia wstępne (I1 w rozdziale 2) zapisujesz bieżą
cą konfigurację treningu jako własne ustawienie wstępne. Własne ustawienia nie są 
„Built-in„ i można je zmieniać nazwę, eksportować (jako JSON), udostępniać przecią
gnięciem, duplikować i usuwać. Trzynaście wbudowanych ustawień P1–P13 pozostaje 
nietknięte przez przycisk usuwania.

Reguła kciuka: Jeśli zmieniasz w jakimś ustawieniu coś, czego częściej będziesz 
potrzebować — Sky-Dome włączony, wyższa waga SSIM dla konkretnej klasy sceny, 
odmienne liczby iteracji — to zapisz ten wariant jako własne ustawienie. Tak będziesz 
wiedzieć przy następnym przebiegu, że to konfiguracja odbiegająca od standardu.
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R O Z D Z I A Ł

Rozdział 8 — Formaty eksportu

Rysunek 29:  Wybór formatu eksportu w Trybie początkującym — sześć kart formatów

Rysunek 30:  Siatka formatów eksportu na żywo po treningu 5K iter na bukiecie flowers — 
wszystkie sześć kart z dynamicznym obliczaniem rozmiaru (PLY 742 KB wybrane, SPZ 74 KB, 
glTF 708 KB, .splat 96 KB, Orbit Video ~Zero KB, Web Viewer 133 KB), historia eksportu po 

prawej z już zapisanym PLY

Co widać na obrazie (2 991 gaussianów, SH degree 3, syntetyczny bukiet Bjoerna 
z Blendera jako zestaw testowy bez problemów IP): Wartości rozmiaru pod każdą 
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kartą formatu są obliczane na żywo z bieżącej liczby gaussianów i narzutu formatu 
— nie zakodowane sztywno. Z 2 991 gaussianów (SH degree 3) powstaje 742 KB 
PLY, 74 KB SPZ (współczynnik ~10× mniejszy dzięki kwantyzacji), 708 KB glTF (z 
rozszerzeniem KHR_​gaussian_​splatting, dlatego prawie równoważny PLY), 96 KB .splat 
(skompresowany format 24 bajty na gaussian). Orbit Video pokazuje „~Zero KB„, 
ponieważ rozmiar jest znany dopiero po kodowaniu MP4. Web Viewer (133 KB) pakuje 
samodzielny plik HTML z osadzonym viewerem WebGL i skompresowanymi danymi 
splat — większy niż samo .splat z powodu narzutu viewera. Historia eksportu po prawej 
listuje już zakończony eksport PLY („training_20260527T211321Z.ply, 743 KB, 23:13”) z 
pigułką formatu i akcją Reveal-w-Finderze.

Zakończony trening daje chmurę gaussianów — zbiór kilkuset tysięcy do milionów 
rozkładów Gaussa 3D, które razem rekonstruują scenę. RadianceKit zna dziesięć dróg 
zapisu tej chmury na dysk. Sześć z nich to czyste formaty danych 3D (PLY, Compressed 
PLY, SPZ, SOG, glTF, .splat), jeden pakuje chmurę wraz z gotowym viewerem HTML 
(Web Viewer), jeden renderuje plik MP4 z orbitalnej ścieżki kamery (Orbit Video), a 
dwa eksportują nie zawartość gaussianów, lecz tylko wynik SfM (pozy kamer i zgrubną 
chmurę punktów) do ponownego użycia w innych potokach treningu (transforms.json + 
workspace COLMAP).

Który format kiedy jest właściwy, zależy od celu. Do archiwizacji pełnych danych bez 
utraty jakości bierze się PLY. Do viewerów webowych na własnej stronie zwykle wystar
cza .splat lub wbudowany Web Viewer. Gdy plik musi być minimalny, opłaca się SPZ lub 
SOG. Do ponownego użycia wyniku SfM w Nerfstudio, Postshot lub Brush właściwymi 
drogami są transforms.json i workspace COLMAP.

Wszystkie funkcje eksportu znajdują się w menu „Export„ oraz w Trybie początkującym 
na ostatnim etapie kreatora. Większość formatów jest w pełni zgodna z sandboxem 
i działa w wersji App Store. Tylko SOG wymaga zewnętrznego pliku wykonywalnego 
( cwebp ), który w buildzie App Store niekoniecznie jest dostępny — szczegóły w E4.
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E1 — PLY (.ply)

G DZ I E

Pasek menu → Export → 3D Formats → Export PLY… 
(⌘E). Tryb początkujący: krok kreatora Export → 
karta formatu „PLY„. Rozmiar: typowo 100% (war
tość referencyjna). Zgodny z: SuperSplat, PolyCam, 
wszystkie viewery 3DGS.

T E C H N I C Z N I E

PLY jest kanonicznym formatem zapisu dla 3D 
Gaussian Splatting. RadianceKit zapisuje binarny 
plik Little-Endian ze standardowym układem właści
wości 3DGS: na każdego gaussiana trójkomponen
towa pozycja, trzy normalne stale ustawione na 
zero, trzy współczynniki SH DC ( f_dc_0..2 ) dla 
bazowego koloru RGB, następnie do 45 dalszych 
współczynników SH ( f_rest_0..44 ) w transpono
wanym układzie Channel-Major zdefiniowanym w 
artykule Kerbl 2023 (najpierw wszystkie współczyn
niki kanału R, potem wszystkie G, potem wszystkie 
B), za nimi opacity w postaci logit (surowe warto
ści pre-sigmoid), trzy skale w przestrzeni log oraz 
rotacja jako kwaternion wxyz. Maksymalny ekspor
towany stopień SH jest ograniczony do minimum 
z życzenia użytkownika i faktycznie wyuczonego 
stopnia; domyślnie 3 (45 reszt współczynników). 
Przed zapisem rozmiar payloadu jest obliczany w 
liczbach 64-bitowych, aby wychwycić przepełnienie 
przy ekstremalnie dużych chmurach. Plik zapisywa
ny jest atomowo, co przy dużych chmurach przej
ściowo zajmuje podwójną ilość miejsca na dysku.

P R O S T Y M I  S ŁOWA M I

To „plik oryginalny„. Największy 
plik, największa zgodność, brak 
strat. Jeśli nie wiesz, który for­
mat wybrać, weź PLY — otwiera 
się w niemal każdym narzędziu 
3DGS. Dla 1 miliona gaussianów 
to zależnie od stopnia SH między 
200 a 800 MB. Jeśli plik jest zbyt 
duży, spójrz na E2 (skompreso­
wane PLY) lub E3 (SPZ).
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E2 — Compressed PLY (.ply)

G DZ I E

Pasek menu → Export → 3D Formats → Export 
Compressed PLY… Tryb początkujący: karta forma
tu „Compressed PLY„. Rozmiar: ok. 10–20% wzglę
dem PLY (5- do 10-krotna kompresja). Zgodny z: 
SuperSplat, silnik PlayCanvas, viewery webowe.

T E C H N I C Z N I E

Wariant formatu PLY od PlayCanvas z chunkowaną 
kwantyzacją. Gaussiany są grupowane w chunki po 
256. Na chunk w nagłówku osobno zapisywane 
są granice Min/Max dla pozycji, skali i koloru; po
szczególne gaussiany referencjonują swoje wartości 
względem tych granic i są kompresowane do po 32 
bity: pozycja i skala z pakowaniem 11-10-11 bitów, 
rotacja jako kwaternion 2-10-10-10 bitów „Smallest-
-Three„, kolor jako RGBA 8-8-8-8. Wyższe współ
czynniki SH są kwantyzowane tylko do 8 bitów na 
komponent ( shCoeffCount * 3  uchar na gaussian). 
Sam format wciąż jest PLY z nagłówkiem ASCII i 
przez to zasadniczo walidowalny narzędziami PLY, 
ale właściwości wierzchołków są zadeklarowane ja
ko pola uint . Stopień SH jest domyślnie 0 (brak 
współczynników reszty), aby maksymalizować kom
presję — wyższe stopnie SH można jawnie wybrać.

P R O S T Y M I  S ŁOWA M I

Oszczędna na miejscu wersja 
PLY. Identyczna zgodność z silni­
kami jak normalne PLY, ale 5- 
do 10-krotnie mniejsze. Super­
Splat i PlayCanvas czytają na­
tywnie. Do wdrożeń webowych 
prawie zawsze lepsze niż normal­
ne PLY. Strata jakości z kwanty­
zacji wizualnie zwykle niezauwa­
żalna, dopóki scena nie zawiera 
ekstremalnie wysokich częstotli­
wości szczegółów.
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E3 — SPZ (.spz)

G DZ I E

Pasek menu → Export → 3D Formats → Export 
SPZ… Tryb początkujący: karta formatu „SPZ„. Roz­
miar: ok. 10% względem PLY (90% mniejszy). 
Zgodny z: Niantic Scaniverse, Niantic Spatial Fields, 
MetalSplatter.

T E C H N I C Z N I E

Format SPZ-v2 od Niantica. Pozycje są pakowa
ne jako 24-bitowy Fixed-Point (daje ok. 0,25 mm 
rozdzielczości), skale jako kwantyzacja 8-bitowa 
w przestrzeni log, rotacje jako 8-bitowy Smallest-
-Three (w v2 zapisywane są tylko xyz, w jest 
wyprowadzane przez dekoder z normy kwaternio
nu), opacity jako wartości 8-bitowe po sigmoidzie. 
SH DC jest zapisywany ze specyficznym dla SPZ 
wzorem pakowania (dc_​raw * 0.15 * 255 + 0.5 
* 255), wyższe pasma SH z 5 bitami (Band 1) lub 
4 bitami (Band 2-3) na współczynnik. Cały zapa
kowany blob binarny jest następnie kompresowany 
standardowym gzip (RFC 1952), co daje format 
kontenera gzipped z magic bytes 1f 8b . Radiance
Kit wywołuje do tego systemowy gzip , ponieważ 
wbudowane API zlib firmy Apple generuje zastrze
żone framing Apple, które nie byłoby zgodne z 
czytnikami SPZ w Spatial Fields ani MetalSplatter. 
Systemowy gzip  jest również wewnątrz sandboxa 
macOS możliwy do spawnowania.

P R O S T Y M I  S ŁOWA M I

Najmniejszy standardowy plik. 
Jeśli znasz Scaniverse od Nianti­
ca — to format, którego używa 
ta aplikacja. Bardzo mały, bar­
dzo przyjazny dla ładowania w 
aplikacjach mobilnych. W chmu­
rowym viewerze Niantica (Spatial 
Fields) bezpośrednio użyteczny. 
Około 90% mniejszy niż PLY z ty­
mi samymi danymi, przy tym dla 
większości scen optycznie ledwo 
do odróżnienia.
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E4 — SOG (.sog)

G DZ I E

Pasek menu → Export → 3D Formats → Export 
SOG… Tryb początkujący: karta formatu „SOG„. 
Rozmiar: ok. 5–6% względem PLY (15- do 20-krot
na kompresja — najmniejsza opcja). Zgodny z: silnik 
PlayCanvas, edytor SuperSplat.

T E C H N I C Z N I E

„Spatially Ordered Gaussians„ — format PlayCa
nvas, który zapisuje chmurę gotową dla GPU w kilku 
obrazach WebP bezstratnych. Najpierw wszystkie 
gaussiany są przestrzennie sortowane kodem Mor
ton 3D (30-bit Z-Order, po 10 bitów na oś), co 
zapewnia obrazom późniejszą lokalność cache w 
renderze. Następnie pozycje są symetryczną trans
formacją log (dla lepszego zakresu dynamicznego) 
kwantyzowane do wartości 16-bitowych i dzielone 
na dwa obrazy RGBA ( means_l.webp  dla dolnych 
8 bitów, means_u.webp  dla górnych). Rotacje są 
kodowane jako Smallest-Three z 3×8 bitami plus 
2-bitowym trybem w jednym obrazie RGBA (tryb 
ląduje w alfa jako 252 + largest ). Skale i SH 
DC są kwantyzowane każdy z 256-wpisowym co
debookiem (rozproszonym percentylowo na wszyst
kich wartościach), indeksy lądują w scales.webp  
i sh0.webp . Pięć obrazów plus meta.json  z code
bookami i granicami pakowane jest do pliku ZIP 
(własny enkoder, ponieważ sandbox blokuje syste
mowy zip ) i zapisywane z rozszerzeniem .sog .

Uwaga sandbox: SOG to jedyna opcja formatu wy
magająca zewnętrznego pliku wykonywalnego. Etap 
enkodera WebP wywołuje cwebp  z /​usr/​local/​bin/​
cwebp lub /​opt/​homebrew/​bin/​cwebp. Jeśli żaden plik 
wykonywalny cwebp nie zostanie znaleziony, kod 
spada na surowe kodowanie PNG — ale: fallback 
PNG nie działa w SuperSplat. W wersji App Store 
oceniaj dostępność na podstawie wariantu builda; w 
wariancie deweloperskim cwebp musi być zainstalo
wane przez Homebrew ( brew install webp ).

P R O S T Y M I  S ŁOWA M I

Najmniejszy format 3DGS w 
ogóle, znacznie mniejszy niż 
SPZ. Ale: potrzebuje narzędzia 
cwebp  na twoim Macu, ponie­

waż RadianceKit sam nie potrafi 
generować wszystkich formatów 
obrazu. Zainstaluj je jeden raz 
przez Homebrew, potem wszyst­
ko działa. W wersji App Store 
ewentualnie nie w pełni funk­
cjonalny — jeśli przy eksporcie 
wyjdzie PNG zamiast WebP, nie 
możesz pliku otworzyć bezpo­
średnio w SuperSplat. Kto pracu­
je bez Homebrew, bierze zamiast 
tego SPZ (E3).
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E5 — glTF (.glb)

G DZ I E

Pasek menu → Export → 3D Formats → Export 
glTF… Tryb początkujący: karta formatu „glTF„. 
Rozmiar: porównywalny z PLY. Zgodny z: viewe
ry glTF z rozszerzeniem KHR_​gaussian_​splatting 
(standard draft Khronos).

T E C H N I C Z N I E

Zapisuje samowystarczalny plik binarny .glb  (brak 
osobnego załącznika bin) zgodnie ze specyfika
cją rozszerzenia KHR_​gaussian_​splatting. Pozycje 
są zapisywane jako zwykłe dane wierzchołków 
POSITION  glTF (float3), wszystkie inne atrybuty 

(rotacja jako float4, skala jako float3, opacity jako 
float, współczynniki SH jako float3 × shCoeffCount) 
leżą w dodatkowych atrybutach wierzchołków i są 
referencjonowane przez rozszerzenie. Ważne: glTF 
używa praworęcznego układu Y-up, COLMAP/3DGS 
pracuje Y-down/Z-forward. Eksporter stosuje więc 
obrót o 180 stopni wokół osi X — pozycje są 
przepisywane jako (x, -y, -z) , kwaterniony do
stosowywane do (w, x, -y, -z) . To daje geome
trycznie poprawną, zgodną z ręcznością (nie odbitą 
lustrzanie) prezentację w viewerach glTF. Chunki 
JSON i binarne są paddingowane do wyrównania 4-
-bajtowego, jak wymaga standard GLB.

P R O S T Y M I  S ŁOWA M I

Oficjalny format standardu Khro­
nos dla danych 3D, w świeżym 
rozszerzeniu dla splatów gaus­
sowskich. Zaleta: glTF jest rozpo­
wszechniony we wszystkich du­
żych silnikach 3D (Babylon.js, 
Three.js, Unity, Unreal). Wada: 
rozszerzenie jest w 2026 jeszcze 
w stadium draftu, wiele viewerów 
jeszcze go nie potrafi. Sensowne 
przede wszystkim, gdy integru­
jesz dane splat z istniejącym po­
tokiem glTF lub piszesz viewer, 
który już jest zdolny do glTF.
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E6 — Splat (.splat)

G DZ I E

Pasek menu → Export → 3D Formats → 
Export .splat… Tryb początkujący: karta formatu 
„.splat„. Rozmiar: dokładnie 32 bajty na gaussia
na. Zgodny z: gsplat.js, viewery webowe (referen
cja antimatter15), większość przeglądarkowych dem 
3DGS.

T E C H N I C Z N I E

Format .splat  antimatter15 — 32 bajty na gaus
siana, brak nagłówka, brak indyrekcji. Układ na 
wpis: 3 × float32 pozycja (współrzędne świata), 
3 × float32 skala (po transformacji exp z prze
strzeni log wewnętrznego bufora), 4 × uint8 ko
lor RGBA (współczynnik SH DC skalowany przez 
SH_C0 = 0.282...  i ograniczony do [0,255]), 4 × 

uint8 kwaternion (w,x,y,z, znormalizowany i zakodo
wany w zakresie bajtu jako 128 + 128*q ). Tylko SH 
DC jest zapisywane — wyższe pasma SH są odrzu
cane. To czyni format niezwykle zwartym, ale kosz
tuje zmiany koloru zależne od widoku, które wystę
pują przy odbiciach lub spekularnych refleksach. 
Kolejność zapisu to dokładnie kolejność indeksów 
chmury (bez sortowania przestrzennego), viewery 
webowe takie jak gsplat.js  renderują od tego 
punktu wyjścia.

P R O S T Y M I  S ŁOWA M I

Format z wyboru, gdy chcesz 
prezentować splat w wła­
snym viewerze webowym z 
gsplat.js . Bardzo zwarty (32 

bajty/gaussian), ale brak wyższe­
go stopnia SH — czyli brak 
błyszczących odbić ani drobnych 
zmian koloru zależnych od kąta 
widzenia. Dla większości zasto­
sowań webowych żaden problem, 
ponieważ kolor DC całkowicie 
wystarcza, a brak zależności od 
widoku ledwo rzuca się w oczy.
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Rysunek 31:  Web Viewer otwarty w Firefoxie — splat bukietu Bjoerna renderowany z otacza
jącymi sferami znaczników kamer, pasek kart przeglądarki widoczny u góry, brak konfiguracji 
CDN/serwera. Samodzielny flowers-01.html  otwarty bezpośrednio z Findera podwój
nym kliknięciem w domyślnej przeglądarce — osadzony program WebGL2 renderuje chmurę 
gaussianów natychmiast, bez sieci ani serwera. Czarne znaczniki wokół bukietu to kamery 

treningowe, opcjonalnie wyświetlane. Przeciągnięcie myszką obraca, scroll zoomuje.
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E7 — Web Viewer (.html)

G DZ I E

Pasek menu → Export → Media → Export Web 
Viewer… Tryb początkujący: karta formatu „Web 
Viewer„. Rozmiar: dane splat kodowane base64 (≈ 
4/3 narzutu) + ok. 5 KB powłoki HTML/JS. Zgod­
ny z: każda nowoczesna przeglądarka z WebGL2 
(wszystkie desktopy, iOS 15+, Android 5+).

T E C H N I C Z N I E

Pakuje chmurę gaussianów wraz z w pełni inli
ne zapisanym renderem WebGL2 w pojedynczy 
plik .html . Nie ma zależności od CDN, nie ma 
WASM, nie ma drugiego pliku. Chmura jest we
wnętrznie najpierw kodowana jako binarna .splat  
(ta sama logika 32 bajtów jak E6), potem osadza
na w base64, potem dekodowana w przeglądarce 
przez atob . Wbudowany renderer wykonuje wła
sne sortowanie WebGL2, sterowanie orbitą myszy i 
sortowanie CPU na ramkę; cały kod JS (shadery, 
matematyka, pętla) jest widoczny w wyjściowym 
HTML. Konwencja osi na granicy zapis-do-rende
rera jest dokładnie taka sama jak w E5: pozycja 
(x, -y, -z) , kwaternion (w, x, -y, -z) . Opcjo

nalnie może być wyświetlany branding overlay 
(przełącznik Free Tier). Ponieważ wszystko jest inli
ne, plik działa również bezpośrednio z protokołu 
file:/​/​ — brak lokalnego serwera WWW potrzeb
nego do testowania.

P R O S T Y M I  S ŁOWA M I

Pojedynczy plik HTML, który mo­
żesz komuś przesłać mailem lub 
osadzić na stronie interneto­
wej. Podwójne kliknięcie w Fin­
derze i przeglądarka pokazuje 
twoją scenę z obracaniem mysz­
ką. Brak konieczności wysyłania 
do chmury, brak drugiego pliku, 
brak serwera. Idealne do prezen­
tacji klientom, portfolio, załącz­
ników mailowych. Wada: plik jest 
dzięki kodowaniu base64 około 
jedną trzecią większy niż czysty 
.splat  — dla bardzo dużych 

scen opłaca się więc osobne ho­
stowanie pliku .splat  razem 
ze standardowym viewerem.
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Rysunek 32:  Pojedyncza klatka wyekstrahowana z flowers-01.mp4 — bukiet Bjoerna w 
renderze profilowym, biała platforma ze znacznikami kamer widoczna, czarne tło (domyślne 
tło widoku, zmienne w Ustawieniach). Kamera okrąża scenę po parametrycznym torze (Ele
vation + Dystans stałe, Yaw obraca), czas trwania typowo 6–10 sekund przy 30 lub 60 fps. 

Rozdzielczość klatki skalowalna od 480p do 8K przez VideoPreset.
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E8 — Orbit Video (.mp4/.mov)

G DZ I E

Pasek menu → Viewport → Record Turntable Video 
LUB pasek menu → Export → Media → Export Orbit 
Video… Tryb początkujący: karta formatu „Orbit Vi
deo„ z suwakiem czasu trwania 3–30 s. Rozmiar: 
zależnie od czasu trwania, rozdzielczości, bitrate. 
Zgodny z: wszystkie platformy (H.264 i HEVC to 
standard Apple).

T E C H N I C Z N I E

Renderuje chmurę gaussianów wzdłuż parametrycz
nej orbitalnej ścieżki kamery i koduje każdą klatkę 
przez AVAssetWriter do pliku MP4 lub MOV. Kon
figuracja orbity steruje liczbą obrotów (obroty), 
dystansem, elewacją, FOV, czasem trwania i współ
czynnikiem Ease-In/Out. Eksport wideo orbitalnego 
przechodzi przez WŁASNY ForwardPass Radiance
Kit z pełną ewaluacją SH — pikselowo identyczny 
z viewportem w aplikacji (WYSIWYG). Na klatkę 
macierz dopasowania świata (obliczana przez ren
derer, aby obrócić wewnętrzne współrzędne do or
bitalnego świata Y-up) jest mnożona przez kamerę, 
następnie stosowane jest odbicie konwencji kame
ry (camFlip: orbitalne Y-up → COLMAP Y-down). 
Cel renderingu offscreen jest przez IOSurface przy
ciągany do CVPixelBuffera dla enkodera. Enkoder 
wspiera H.264 i HEVC, konfigurowalny bitrate i roz
dzielczość od 480p do 8K. Przed pierwszą klatką 
renderer czeka 200 ms, aby początkowe sortowanie 
splatów zostało ukończone. Ten eksport jest GPU-
-bound — przy 8K i milionach gaussianów czas ren
derowania na klatkę leży na poziomie kilku sekund, 
czyli całkowite czasy renderowania 10–30 minut dla 
6 s wideo są możliwe.

P R O S T Y M I  S ŁOWA M I

Gotowy plik MP4 z obrotem wokół 
twojej sceny. Idealny do social 
media, marketingu, prezentacji. 
Możesz ustawić czas trwania (3–
30 sekund), kierunek obrotu i 
prędkość. Plik można osadzać 
bezpośrednio na YouTube, Insta­
gramie, w PowerPoincie i wszę­
dzie indziej. Idzie częściowo wol­
no, ponieważ aplikacja musi ren­
derować każdą klatkę kompletnie 
— dla wideo 8K możesz planować 
pięć do trzydziestu minut, zależ­
nie od liczby gaussianów.
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E9 — Transforms SfM (transforms.json)

G DZ I E

Pasek menu → Export → Photogrammetry → Export 
SfM (transforms.json)… Rozmiar: typowo 1–10 KB 
(tylko pozy + intrinsics, brak obrazów, brak gaus
sianów). Zgodny z: nerfstudio, Brush, gsplat, Open
Splat, Meshroom, wszystkie nowoczesne trenery 
3DGS feed-forward.

T E C H N I C Z N I E

Zapisuje format nerfstudio transforms.json  z li
stą póz kamer plus dzielonymi intrinsics. Na kame
rę macierz widoku (wewnętrznie w RadianceKit: 
World-to-Camera w konwencji COLMAP) jest od
wracana, następnie kameralne wektory bazowe Y i 
Z są odbijane lustrzanie, aby przejść do konwen
cji nerfstudio (styl OpenGL, kamera patrzy wzdłuż 
-Z , +Y  jest w górze). Finalna macierz 4×4 lą

duje jako row-major zagnieżdżona tablica double 
w polu transform_matrix  każdej klatki. Intrinsics 
są zapisywane na poziomie top-level (ogniskowa x/
y, punkt główny x/y, szerokość/wysokość obrazu, 
camera_​model = "OPENCV", plus współczynniki dys

torsji 
k1, k2, p1,

p2 ) — chyba że eksporter wykryje 
kilka różnych zestawów intrinsics, wtedy są zapisy
wane na klatkę. Ścieżki obrazów są zapisywane jako 
images/​<filename> względem pliku JSON; użytkow
nik musi utworzyć siostrzany folder images/​ z foto
grafiami treningowymi.

P R O S T Y M I  S ŁOWA M I

Ten plik JSON opisuje dla każ­
dego zdjęcia, gdzie stała kame­
ra i dokąd patrzyła. Sam plik 
jest mały i bezużyteczny — uży­
wany jest razem z oryginalnymi 
obrazami w folderze. Nerfstudio, 
Brush i kilka innych trenerów 
czyta dokładnie ten format, a ty 
możesz przekazać swoje wyniki 
SfM z RadianceKit do innego na­
rzędzia bez konieczności ponow­
nego liczenia rekonstrukcji ka­
mer tam. Przy dużych scenach 
oszczędza godziny.
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E10 — Workspace COLMAP (sparse/0/)

G DZ I E

Pasek menu → Export → Photogrammetry → Export 
SfM (COLMAP Workspace)… Rozmiar: trzy pliki bi
narne razem typowo 4–8 MB — points3D.bin  
dominuje (jedna linia na punkt 3D chmury sparse), 
images.bin  i cameras.bin  są każdy znacznie po

niżej 100 KB. Zgodny z: sam COLMAP, Nerfstudio, 
Postshot, Meshroom, wszystkie narzędzia oczekują
ce katalogu sparse/​ COLMAP.

T E C H N I C Z N I E

Zapisuje standardowy układ sparse/​0/​ COL
MAP z trzema plikami binarnymi: cameras.bin , 
images.bin , points3D.bin . Referencja formatu 

to oficjalna dokumentacja COLMAP. cameras.bin  
zawiera zdeduplikowaną listę intrinsics (kamery z 
identycznymi intrinsics + rozmiarem obrazu są 
scalane do pojedynczego wpisu); używany model 
kamery to OPENCV  (Model 4), z fx/fy/cx/cy plus 
czterema współczynnikami dystorsji k1/k2/p1/p2. 
images.bin  listuje na obraz pozę jako kwaternion 
wxyz  plus translację, za nimi ID kamery i nazwa 

pliku; nie są zapisywane korespondencje 2D-3D. 
points3D.bin  zawiera chmurę punktów SfM z po

zycją, kolorem (RGB 0-255) i wartościami domyśl
nymi dla reprojekcji i długości ścieżki. Wszystko 
zapisywane w Little-Endian. Re-import do Radian
ceKit działa przez menu File → „Import COLMAP/
Metashape Workspace…„ (zobacz Q3 w rozdziale o 
backendach SfM).

P R O S T Y M I  S ŁOWA M I

Oficjalny format COLMAP. Je­
śli chcesz kontynuować trening 
w Postshot, Nerfstudio lub in­
nym oprogramowaniu zdolnym 
do COLMAP, to jest droga. Trzy 
małe pliki plus twoje oryginalne 
obrazy, a program docelowy ak­
ceptuje to, jakby sam COLMAP 
był programem źródłowym. Wię­
cej programów to rozumie niż 
format transforms.json (E9), jed­
nocześnie nieco mniej poręczne, 
ponieważ binarne zamiast tek­
stowych.
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Który format kiedy?

Cel Format

Viewer webowy na własnej stronie E7 Web Viewer (.html)

Viewer webowy z gsplat.js E6 Splat (.splat)

Reuse potoku w Postshot / Nerfstu
dio

E9 transforms.json + E10 Workspace COLMAP

Edycja w SuperSplat E1 PLY lub E2 Compressed PLY

Niantic Scaniverse / Spatial Fields E3 SPZ

Maksymalna kompresja E4 SOG (wymagane cwebp)

Wideo marketingowe/społecznościo
we

E8 Orbit Video
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Szybkie porównanie

Format Rozszerzenie Sandbox Rozmiar (1M Gauss) Najlepsze 
użycie

E1 PLY .ply tak ~250 MB Archiwum, 
najwyższa 
zgodność

E2 Com
pressed 

PLY

.ply tak ~40 MB Web + Su
perSplat

E3 SPZ .spz tak (spawn 
gzip)

~40 MB Niantic + 
Mobile

E4 SOG .sog warun
kowo 

(cwebp)

~20 MB Maksymalna 
kompresja

E5 glTF .glb tak ~250 MB Potok Khro
nos

E6 Splat .splat tak ~32 MB Viewer 
webowy 
gsplat.js

E7 Web 
Viewer

.html tak ~45 MB Samodziel
ny plik prze

glądarki

E8 Orbit 
Video

.mp4 / .mov tak zmienny Social/Mar
keting

E9 SfM 
Trans
forms

.json tak ~5 KB Przekazanie 
póz

E10 
Work
space 

COLMAP

Katalog tak ~4–8 MB Przekazanie 
póz binarne

Kolumna rozmiarów to przybliżone wartości referencyjne dla 1 mln gaussianów ze stop
niem SH 3. Rzeczywiste wartości zmieniają się zależnie od kompresowalności sceny; 
stopień SH 0 redukuje PLY/glTF o współczynnik 4.
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R O Z D Z I A Ł

Rozdział 9 — Backendy SfM

Rysunek 33:  Tryb Eksperta z selektorem Camera Alignment w Inspectorze (Apple Photo
grammetry / Native (Beta))

Rysunek 34:  Inspector z aktywnym Native (Beta) — w selektorze Camera Alignment wybra
na druga opcja, wszystkie pozostałe parametry konfiguracji treningu bez zmian

CO WIDAĆ NA OBRAZIE  Selektor Camera Alignment w Inspectorze to kontrolka segmento
wa z dwoma opcjami — Apple Photogrammetry (domyślne w buildach App Store, w 
pełni zgodne z sandboxem) oraz Native (Beta) (własny backend RadianceKit oparty na 
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potoku FAST+BRIEF+GLOMAP, opracowany w Fazie 3.8/3.9, stan na 2026-05). Native 
(Beta) jest zwalidowane tylko dla scen orbitalnych i szybsze przy ≥1 000 klatkach niż 
Apple Photogrammetry, ale nie spełnia jeszcze bramki jakości §5 Fazy 3 (finalLoss ≤ 
0.0115) — stąd oznaczenie Beta. Zewnętrzne wyniki SfM z Metashape, COLMAP lub 
innego oprogramowania fotogrametrycznego można dodatkowo zaimportować przez 
menu File (Q3 format tekstowy COLMAP, Q6 import workspace) — selektor się nie 
zmienia, ale zaimportowane pozy zastępują wynik SfM.

SfM oznacza Structure from Motion. Z zestawu nakładających się zdjęć oprogramo
wanie rekonstruuje dla każdego obrazu pozycję i kierunek patrzenia kamery we wspól
nym układzie współrzędnych 3D. Przy tej okazji powstaje zgrubna chmura punktów 3D, 
która inicjalizuje trening Gaussian Splatting. Wynik SfM jest wejściem dla właściwego 
treningu i decyduje w znaczącym stopniu o późniejszej jakości obrazu.

RadianceKit oferuje pięć dróg SfM: dwa wbudowane backendy (Q1 Apple Photogram
metry, Q4/Q5 Native), dwie ścieżki importu z zewnętrznych narzędzi (Q3 format teksto
wy COLMAP, Q6 binarny import workspace) oraz Q2 COLMAP-Binary, dostępne tylko 
w buildach deweloperskich poza App Store. Który jest właściwy, zależy od typu sceny 
(orbita wokół obiektu, wnętrze, lot dronem) oraz od tego, czy zewnętrzne oprogramo
wanie już dostarcza rekonstrukcję.

Q1 — Apple Photogrammetry

G DZ I E

Expert View → Inspector → Konfiguracja treningu → 
selektor Camera Alignment, pozycja „Apple Photo
grammetry„.

T E C H N I C Z N I E

Opakowuje wbudowany framework Photogramme
try firmy Apple, pierwotnie opracowany dla Object 
Capture. Apple wewnętrznie ekstrahuje cechy za 
pomocą zastrzeżonego potoku (kroki nie są publicz
nie udokumentowane), weryfikuje je przez dopaso
wywanie wielowidokowe i rozwiązuje Bundle Adju
stment na Apple Silicon Neural Engine + GPU. 
Backend jest w pełni zgodny z App Store (brak 
zewnętrznego pliku wykonywalnego, Sandbox=true, 
on-device), ale dostarcza tylko pozy kamer plus 
zgrubną chmurę punktów — bez metryk diagno
stycznych takich jak długość ścieżki czy błąd re
projekcji. Skaluje się zgodnie z zaleceniami Apple 
do kilkuset zdjęć. Przy ponad ~500 klatkach w 
liniowych lotach dronem lub dużych scenach plene
rowych obserwowano powtarzalne crashe lub ciche 
odrzucanie pojedynczych kamer.

P R O S T Y M I  S ŁOWA M I

To najprostsza droga. Wrzucasz 
zdjęcia, aplikacja liczy. Działa 
bardzo dobrze przy klasycznych 
skanach obiektów — gdy obcho­
dzisz mebel lub rzeźbę i robisz 
50–200 zdjęć. Przy lotach dro­
nem nad krajobrazem lub przy 
bardzo wielu zdjęciach (powy­
żej 500) procedura Apple chęt­
nie staje się jednak niestabilna. 
W takich scenach przetestuj bac­
kend Native (Q4/Q5) lub policz 
kamery w Metashape i wczytaj je 
przez import workspace (Q6).
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P OW E R - U S E R

Q2 COLMAP-Binary — uruchamia zewnętrzny program COLMAP jako podproces i 
dlatego w wersji App Store (sandbox) nie jest dostępny. Działa tylko w buildach 
deweloperskich poza App Store. Dla jakości, jaką dostarcza COLMAP, w wersji App 
Store jest dostępny import workspace (Q3 lub Q6): policz SfM w COLMAP-ie lub 
Metashape na zewnątrz i wczytaj wynik.

Q3 — format tekstowy COLMAP (Metashape / ETH3D)

G DZ I E

Menu „File → Import COLMAP / Metashape Work
space…„ (Cmd+⇧+I) LUB przeciągnięcie folderu z 
sparse/​0/​cameras.txt.

T E C H N I C Z N I E

Czyta standardowy eksport tekstowy COLMAP — 
trzy pliki tekstowe cameras.txt , images.txt , 
points3D.txt  w podfolderze sparse/​0/​ — i kon

wertuje do wewnętrznego modelu wyniku SfM. 
Ta sama definicja formatu co binarny eksport 
COLMAP, tylko jako ASCII zamiast formatu binar
nego. Jest tak właśnie wysyłany przez Agisoft 
Metashape, RealityCapture, PolyCam oraz bench
mark ETH3D. Parser dzieli rozpoznawanie mode
lu kamery z parserem binarnym (wszystkie typo
we modele: SIMPLE_PINHOLE, PINHOLE, OPENCV, 
OPENCV_FISHEYE, FULL_OPENCV). Odporny na li
nie komentarzy i puste linie. W testach skaluje się 
do ~1 400 kamer (ETH3D Tunnel) bez problemów.

P R O S T Y M I  S ŁOWA M I

Jeśli już pracowałeś z Meta­
shape, RealityCapture lub innym 
komercyjnym oprogramowaniem 
foto-3D i wyeksportowałeś wy­
nik — ten eksport możesz wczy­
tać do RadianceKit bezpośrednio, 
bez ponownego liczenia w apli­
kacji. To oszczędza godziny cze­
kania. Po prostu wczytaj cały fol­
der przez menu File lub przecią­
gnij go do okna.
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Q4 — Native SfM (inkrementalne)

G DZ I E

Expert View → Inspector → Konfiguracja treningu → 
selektor Camera Alignment, pozycja „Native (Beta)
„. Tryb inkrementalny jest domyślnym trybem tego 
backendu — w Inspectorze nie ma osobnego se
lektora mappera. Przez CLI tryb można jawnie usta
wić za pomocą --native-sfm  lub --sfm-mapper 
incremental.

T E C H N I C Z N I E

Własna implementacja całego potoku SfM 
przyspieszona przez GPU: cechy FAST+BRIEF 
LUB SuperPoint+LightGlue przez CoreML (z 
--coreml-features ), następnie Hamming-KNN 

matching, RANSAC z macierzą fundamentalną, bu
dowanie ścieżek, wybór pary początkowej, two-view 
bootstrap (F→E plus DLT), zachłanny inkremental
ny mapper z rejestracją PnP i triangulacją wielo
widokową oraz końcowy Bundle Adjustment przez 
Schur-zredukowany Levenberg-Marquardt z funkcją 
straty Hubera i analitycznymi jakobianami przez 
Cholesky-Solve. W pełni zgodny z App Store: brak 
zewnętrznego pliku wykonywalnego, Sandbox=true. 
Z wysłanym w Fazie 3.10 detektorem R2-Collapse: 
jeśli aplikacja zarejestruje mniej niż 60% klatek 
wejściowych lub współczynnik punktów na kamerę 
spadnie poniżej 13, automatycznie przełącza się na 
mapper globalny (Q5). Empirycznie czyste na sce
nach orbitalnych/obrotowych; na bardziej ogólnych 
ruchach (lot dronem, wnętrza ze złożoną geome
trią) wskaźnik powodzenia jest niższy — detektor 
wychwytuje jednak te przypadki. Skaluje się nieza
wodnie do ~200 kamer, wyżej z istotnie dłuższym 
czasem działania.

P R O S T Y M I  S ŁOWA M I

Mocne strony Apple (zgodność 
z App Store, szybkość dla or­
bit) z dodatkowymi wartościami 
diagnostycznymi. Działa szcze­
gólnie dobrze, gdy jak przy Ob­
ject Capture obchodzisz motyw. 
Przy bardziej skomplikowanych 
ujęciach (lot dronem lub salon) 
RadianceKit automatycznie wy­
krywa, że nic z tego nie wyj­
dzie, i przeskakuje na procedurę 
globalną. Oznaczone „Beta„, po­
nieważ wciąż w testach — stan­
dardowa rekomendacja to nadal 
Apple Photogrammetry dla pro­
stych skanów obiektów i import 
workspace (Q3 lub Q6) dla wyma­
gających zestawów plenerowych.
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Q5 — Native SfM (globalne)

G DZ I E

Wywoływane automatycznie, gdy inkrementalny 
mapper (Q4) wyzwoli detektor kolapsu (zarejestro
wane mniej niż 60% klatek wejściowych lub współ
czynnik punktów na kamerę poniżej 13). Ręczne 
wymuszenie tylko przez CLI --sfm-mapper global. 
W Inspectorze procedura globalna nie jest dostępna 
przez osobny selektor — aplikacja sama decyduje, 
kiedy się przełączyć.

T E C H N I C Z N I E

Globalna odmiana potoku natywnego. Najpierw eks
trakcja cech + matching jak w Q4, potem oszacowa
nie pozy względnej dla wszystkich zweryfikowanych 
par, następnie Rotation Averaging (synchronizuje 
wszystkie obroty kamer w układzie współrzędnych 
świata) i Translation Averaging (LSQR oparte na 
bezmacierzowym sformułowaniu sparse, aby unik
nąć przepełnienia liczb całkowitych przy dużych 
zbiorach kamer). Skaluje się w zasadzie do ~5 
000 kamer, w praktyce z pogorszoną jakością po
wyżej kilkuset kamer — pomiar bramki akceptacji §5 
Fazy 3.8 na K-1351 dał finalLoss 0.07 zamiast do
celowych 0.0115. Traktowane jako „tier zapasowy„: 
wchodzi do akcji, gdy mapper inkrementalny dege
neruje, ale sam nie jest ponownie sprawdzany pod 
kątem jakości.

P R O S T Y M I  S ŁOWA M I

Ścieżka planu B dla silnika na­
tywnego. Wywoływana automa­
tycznie, gdy szybsza ścieżka in­
krementalna zawodzi. Dostarcza 
użytecznego wyniku, ale w bar­
dzo dużych lub trudnych sce­
nach zwykle nie jest tak pre­
cyzyjna jak to, co otrzymujesz 
z Metashape lub zewnętrznej 
instalacji COLMAP. Jeśli Nati­
ve stanie się twoim standardo­
wym przepływem pracy, w takich 
przypadkach opłaca się obejście 
przez import workspace (Q3 lub 
Q6).
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Q6 — Import workspace Metashape / COLMAP-Text (Faza Q7)

G DZ I E

Menu File → „Import COLMAP / Metashape 
Workspace…„ (Cmd+⇧+I). Przeciągnięcie folderu z 
sparse/​0/​cameras.{bin,txt} oraz images/​.

T E C H N I C Z N I E

Automatycznie rozpoznaje, czy folder wybrany 
przez przeciągnięcie lub Open-Panel odpowiada 
jednemu z trzech układów workspace COLMAP 
(sparse/​0/​, sparse/​ lub root) oraz czy rekonstrukcja 
jest w formie binarnej ( cameras.bin ) czy teksto
wej ( cameras.txt ). Ścieżka binarna używa parsera 
binarnego COLMAP, ścieżka tekstowa — loadera 
ETH3D — oba produkują ten sam model wyniku 
SfM i reszta potoku (import obrazów, start treningu 
MCMC) jest agnostyczna wobec źródła. Obrazy są 
otwierane przez system zakładek sandboxa aplikacji 
w trybie security-scoped, dzięki czemu import dzia
ła również w wersji App Store. Specjalnie dla przy
padku „eksport Metashape bez ponownego liczenia 
rekonstrukcji„. Rozpoznawanie wspomniane w pozy
cji menu File ostrzega w logu aplikacji, jeśli wybrany 
folder nie jest rozpoznawalnym workspace.

P R O S T Y M I  S ŁOWA M I

Specjalnie funkcja dla użytkow­
ników Metashape. Jeśli masz li­
cencję na Metashape lub Reality­
Capture i tam wykonałeś rekon­
strukcję kamer, możesz po pro­
stu wciągnąć folder eksportu tu­
taj i od razu rozpocząć trening. 
Przy dużych scenach oszczędza 
to wiele godzin czasu obliczenio­
wego, ponieważ RadianceKit nie 
wykonuje wtedy SfM samodziel­
nie.

Który backend kiedy?

Scenariusz Zalecany backend

Skan obiektu, 50–200 
zdjęć

Q1 Apple Photogrammetry

Duży plener / dron / >500 
zdjęć

Q6 Workspace-Import (policz w Metashape lub COLMAP, 
potem wczytaj)

Istnieje eksport Metasha
pe/RealityCapture

Q6 Import (SfM niepotrzebne)

ETH3D / akademicki ze
staw COLMAP-Text

Q3 COLMAP-Text-Import

Ściśle zgodne z App Store 
+ scena orbitalna

Q4 Native inkrementalne

Q4 zawodzi Q5 Native globalne (automatycznie)

Dane benchmarku ETH3D Q3 (autotest precomputed)
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Szybkie porównanie

Bac­
kend

App Store Sand­
box

Zewnętrzny plik 
wykonywalny

Najlep­
sze uży­

cie

Maks ~ka­
mer

Q1 Apple 
PG

✅ ✅ — Orbit-Ob
ject

~300

Q2 COL
MAP Bi

nary

❌ (tylko bu
ild dev.)

— colmap/glomap Duży ple
ner

~5 000

Q3 COL
MAP-

-Text-Im
port

✅ ✅ — Stano
wiska 

benchm.

~1 500

Q4 Nati
ve incre
mental

✅ ✅ — Orbit-Ob
ject

~200

Q5 Nati
ve global

✅ ✅ — Fallback 
Q4

~1 351

Q6 
Work
space-
-Import

✅ ✅ — Reuse Me
tashape

zależnie od 
źródła
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R O Z D Z I A Ł

Rozdział 10 — Tryb początkujący

Der Einsteiger-Modus (engl. Simple Mode, Cmd+1) ist der geführte Workflow für alle, 
die zum ersten Mal eine 3D-Gaussian-Splatting-Szene rekonstruieren. Statt eine Side
bar voller Inspector-Felder anzuzeigen, führt die App durch vier Schritte: zuerst Bilder 
oder ein Video importieren und ein Qualitäts-Preset wählen, dann läuft die Verarbeitung 
(SfM + Training), anschließend kann die fertige Szene in einer 3D-Vorschau begutachtet 
werden, und zum Schluss wird in das gewünschte Format exportiert. Eine schmale Fort
schrittsleiste am oberen Fensterrand zeigt jederzeit an, in welchem Schritt du gerade 
bist.

Im Vergleich zum Expert-Modus (Cmd+2), der alle Bedienfelder gleichzeitig zeigt, blen
det der Einsteiger-Modus ungenutzte Optionen aus, gibt Validierungs-Warnungen bei 
zu wenigen oder schlechten Bildern und bietet auf jedem Schritt nur die Buttons an, 
die im aktuellen Zustand sinnvoll sind. Du kannst jederzeit zwischen Einsteiger- und 
Expert-Modus wechseln (Cmd+1 / Cmd+2), der gesamte Zustand — importierte Bilder, 
gewähltes Preset, gerade laufendes Training, fertige Punktwolke — bleibt erhalten und 
ist im jeweils anderen Modus sofort verfügbar.

Z1 — Import (Bilder & Preset wählen)

Rysunek 35:  Simple-Mode Schritt 1 — leere Drop-Zone vor Bild-Import, Crumb-Trail oben 
(Import → Frame Quality → Cameras → Training → Preview → Export), Format-Pills JPG/PNG/

TIFF/HEIC/MP4/MOV/PLY/SPZ/SPLAT/SCENE/COLMAP
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WAS IM BILD ZU SEHEN IST  Crumb-Trail (Import aktiv) zeigt den vierschrittigen Workflow. 
Linke Drop-Zone mit drei CTAs: „Browse Files„ (NSOpenPanel), „Try Sample Sce
ne” (bundled Demo), „Download Sample Photos (~427 MB)„ (Mip-NeRF360 flowers 
Subset). Format-Pills darunter listen alle akzeptierten Dateitypen. Rechts „Imported 
Files” mit Counter „0 images„ und Empty-State „No files imported yet”. Unten Quality-
-Picker (Default: Preview) und „Start Processing„ (deaktiviert solang keine Bilder da 
sind).

Der erste Schritt besteht darin, der App Bildmaterial zu geben. Per Drag-and-Drop in 
das große, gestrichelte Feld in der Mitte, per „Browse Files„-Button oder per Klick auf 
die mitgelieferte Sample-Szene. Rechts erscheint eine Liste aller importierten Bilder mit 
Auflösung und Dateigröße; unten in der schwebenden Werkzeugleiste wählst du das 
Qualitäts-Preset und startest mit „Start Processing” die Pipeline. Validierungs-Warnun
gen (rot bei < 3 oder < 10 Bildern, orange bei 10–19) zeigen an, ob die App eine 
sinnvolle Rekonstruktion erwartet oder nicht.

C-01 ProgressIndicator (Schritt-Anzeige)

G DZ I E

Oben über dem Workflow, immer sichtbar.

T E C H N I C Z N I E

Zeigt eine horizontale Fortschrittsleiste über die ge
samte Pipeline (Frame-Quality → SfM → Training) 
mit Stage-Allocation: Frame-Quality belegt 0–5 % 
(Phase 3.11, sehr kurz), SfM belegt 0–30 % der Bar, 
Training 30–100 %. Daneben Status-Text und pha
sen-benannte Prozent-Anzeige („SfM 41 %„, „Tra
ining 12 500/20 000”), damit Anwender nicht den 
scheinbaren Rückschritt „41 % SfM → 25 % Tra
ining„ als Fehler lesen — die Bar zeigt den gesamten 
Pipeline-Fortschritt, nicht die Sub-Stage. ETA-Be
rechnung beginnt, sobald genug Trainings-Tempo 
gemessen ist (typischerweise nach den ersten 100 
Iterationen). Dieselbe Anzeige wird auch im Expert-
-Modus oberhalb des Inspectors verwendet.

P R O S T Y M I  S ŁOWA M I

Die schmale Leiste ganz oben 
ist deine Karte durch den Work­
flow. Sie sagt dir nicht nur, was 
die App gerade macht (Kame­
ras ausrichten, Training läuft, …), 
sondern auch, wie weit sie ins­
gesamt schon ist. Die Aufteilung 
ist absichtlich so, dass die Kame­
ra-Berechnung das erste Drittel 
der Leiste belegt und das eigen­
tliche Training die hinteren zwei 
Drittel — sonst würde es wirken, 
als wäre der Fortschritt nach SfM 
plötzlich zurück bei null. Du kan­
nst dich also entspannt zurüc­
klehnen, ein Blick auf die Leiste 
genügt, um die grobe Etappe zu 
sehen. Der Text daneben sagt dir, 
ob du gerade in der SfM-Stufe (z. 
B. „SfM 41 %„) oder im Training 
(z. B. „Training 12 500/20 000”) 
steckst, damit die Zahlen nicht 
verwirrend wirken. Wenn du die 
ETA nicht angezeigt bekommst, 
ist das Training einfach noch zu 
jung — die App schätzt erst, so­
bald sie genug Tempo gemessen 
hat.
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C-03 DropZoneView (Drag-and-Drop-Bereich)

G DZ I E

Linke Seite des Import-Schritts, großes gestrichel
tes Rechteck mit Symbol. Wird im Einsteiger-Modus 
mit dem Label „Drop photos or a video here„ ange
zeigt.

T E C H N I C Z N I E

Drop-Bereich, der das Symbol kurz hüpfen lässt 
und den Hintergrund einfärbt, sobald Drag-Items 
über dem Feld schweben. Akzeptiert JPG, PNG, 
TIFF, HEIC, MP4, MOV, PLY, SPZ, .splat, .radian
cescene-Bundles und Verzeichnisse. Drop-Routing 
nach Typ: Bilder werden gesammelt und sortiert 
übergeben, Videos triggern den Frame-Sampling-
-Pfad, Splat-Dateien öffnen direkt die Vorschau, 
Scene-Bundles werden eingelesen. Verzeichnisse 
werden enumeriert und alle enthaltenen Bilder im
portiert. Security-scoped Bookmarks für sandbox-
-konformen Zugriff werden korrekt aufgenommen 
und freigegeben. Nicht-unterstützte Endungen wer
den als Warnbanner für 5 Sekunden angezeigt.

P R O S T Y M I  S ŁOWA M I

Das große gestrichelte Feld ist 
die Hauptbedienung des ersten 
Schritts. Zieh einfach Fotos oder 
ein Video hinein, oder einen gan­
zen Ordner — die App nimmt 
alles, was sie kennt, und ignoriert 
den Rest. Wenn das Feld blau 
wird und das Symbol kurz hüpft, 
hat die App den Drag erkannt. 
Lass los, und der Import star­
tet sofort: Bilder wandern in die 
Liste rechts, Videos triggern au­
tomatisch den Frame-Sampling-
-Schritt, und bereits trainier­
te .ply / .spz / .splat  Da­
teien öffnen direkt die Vorschau. 
Falls ein Format gar nicht passt 
(etwa PDF oder BMP), erscheint 
ein kurzer Hinweis am oberen 
Rand — die App schluckt unbe­
kanntes Material nicht stumm.

C-05 Browse Files Button

G DZ I E

Innerhalb der Drop-Zone, prominenter Button.

T E C H N I C Z N I E

Button, der den macOS-Datei-Dialog mit Mehrfach-
-Auswahl und den Dateitypen JPG, PNG, TIFF, MP4, 
MOV, Ordner sowie dem App-eigenen Scene-For
mat öffnet. Ergebnis-URLs sind security-scoped 
und werden über dieselben Import-Pfade weiterge
leitet wie Drag-and-Drop. Wenn der Benutzer einen 
Ordner auswählt, wird er rekursiv nach Bildern enu
meriert.

P R O S T Y M I  S ŁOWA M I

Wenn dir Drag-and-Drop unbe­
quem ist, klick einfach diesen 
Button und navigiere im macOS-
-Datei-Dialog zu deinen Fotos. 
Du kannst mehrere Dateien gle­
ichzeitig wählen (Cmd-Klick auf 
die einzelnen Bilder) oder einen 
ganzen Ordner auswählen — die 
App durchsucht den Ordner dann 
rekursiv nach allen unterstütz­
ten Bildtypen. Das ist besonders 
praktisch, wenn deine Aufnah­
men verschachtelt in Unterord­
nern liegen (z. B. „shoot-day1/„, 
„shoot-day2/”) — ein Klick auf 
den Hauptordner reicht. Funktio­
nal macht der Button exakt das, 
was auch Drag-and-Drop macht; 
wähl einfach den Weg, der dir be­
quemer ist.
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C-06 Try Sample Scene Button

G DZ I E

Innerhalb der Drop-Zone, nur sichtbar wenn das 
App-Bundle die Sample-Scene enthält und noch ke
ine Bilder/Splats importiert sind.

T E C H N I C Z N I E

Erscheint nur, wenn (a) eine sample-scene.splat , 
.spz  oder .ply  im App-Bundle vorhanden ist 

UND (b) noch keine Bilder/Videos importiert und 
noch keine Punktwolke vorhanden ist. Bei Klick lädt 
die fertige Punktwolke (bevorzugt das kleinste For
mat — .splat  ~3 MB, .spz  ~1.4 MB, Fallback 
.ply ) und setzt nach 400 ms hartkodierte Kame

ra-Werte aus dem Original-Metadaten der Blumen-
-Szene für eine ästhetisch sinnvolle Eingangs-Per
spektive.

P R O S T Y M I  S ŁOWA M I

Wenn du die App zum ersten Mal 
startest und einfach mal sehen 
willst, was am Ende rauskommt 
— klick hier. Das öffnet eine fer­
tig trainierte Blumen-Szene, die 
du sofort drehen und exportieren 
kannst, ohne dass die App rech­
nen muss. Die Kamera ist vorein­
gestellt auf eine ästhetisch sin­
nvolle Eingangsperspektive, so­
dass du gleich was Schönes 
siehst. Perfekt, um die 3D-Steu­
erung und den Export-Schritt ri­
sikolos auszuprobieren, bevor du 
auf eigene Aufnahmen losgehst. 
Sobald du eigene Bilder impor­
tierst, verschwindet der Button 
automatisch — er wird nur ange­
zeigt, solange das Projekt kom­
plett leer ist.

C-07 Download Sample Photos Button

G DZ I E

Innerhalb der Drop-Zone, neben „Try Sample Sce
ne„; gleiche Sichtbarkeits-Bedingungen.

T E C H N I C Z N I E

Triggert einen Download (Repo github.com/​
bkindler/​radiancekit-sample-photos), der ca. 427 
MB an 960 Vollauflösungs-Frames lädt und in die 
App speist. Während des Downloads wird der But
ton deaktiviert. Der Fortschritt erscheint in der obe
ren Progress-Bar als „Downloading X %„ in einer 
eigenen Stage, weil diese Stage ihre eigene 0–100 
%-Skala behält und der spätere SfM-Stage nicht 
überlappt.

P R O S T Y M I  S ŁOWA M I

Genau wie die Sample-Scene, nur 
mit den Ausgangs-Fotos statt mit 
dem fertigen Ergebnis. So kannst 
du die gesamte Pipeline einmal 
selbst durchlaufen lassen und 
sehen, wie lange SfM und Tra­
ining auf deinem Mac wirklich 
dauern. Der Download ist groß 
(etwa eine halbe DVD = 427 MB), 
passiert aber nur einmal — da­
nach sind die Fotos lokal und du 
kannst die Pipeline beliebig oft 
mit verschiedenen Presets neu 
starten. Während der Download 
läuft, zeigt die obere Fortschrit­
tsleiste den aktuellen Download-
-Stand in Prozent, sodass du 
abschätzen kannst, wann es los­
geht. Tipp: nimm dazu am besten 
ein schnelles WLAN oder Kabel-
-Netz — die 427 MB ziehen sich 
sonst.
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C-09 Quality Presets Picker

G DZ I E

Schwebende untere Werkzeugleiste des Import-
-Overlays, links neben dem Start-Button.

T E C H N I C Z N I E

Bedienelement mit Label „Quality„ gruppiert die ver
fügbaren Presets nach Kategorie (Classic / MCMC / 
Custom). Built-in Presets werden nach Kategorie 
gruppiert; die Abschnitts-Header sind hartkodiert. 
Custom-Presets nur sichtbar wenn welche existie
ren. Locked-State: Presets, die nicht in der Free-

-Liste (Quick + Preview) liegen, bekommen ein „🔒”-
-Suffix am Namen, wenn der User nicht gekauft hat; 
bei Auswahl springt der Picker auf Preview zurück 
und öffnet automatisch das Purchase-Sheet. Bei 
Wahl wird das Preset angewendet, was die gesamte 
Trainings-Konfiguration ersetzt.

P R O S T Y M I  S ŁOWA M I

Hier wählst du, wie genau und 
wie lange die App rechnen soll. 
„Quick„ und „Preview” sind ohne 
Kauf nutzbar und liefern in we­
nigen Minuten ein erstes Ergeb­
nis — ideal, um zu testen, ob 
deine Bilder überhaupt sinnvoll 
sind. „Balanced„ und „Quality” 
brauchen die Vollversion und lie­
fern deutlich saubere Modelle, 
dauern dafür aber Stunden statt 
Minuten. MCMC ist eine andere 
Strategie, die mit weniger Gauss-
-Splats auskommt — gut, wenn 
du das Modell später kompakt 
exportieren oder ins Web stellen 
willst. Premium-Presets erkennst 
du am kleinen Schloss-Symbol 
am Namen; tippst du eines ohne 
Lizenz an, springt der Picker zu­
rück auf Preview und das Kauf-
-Sheet öffnet sich automatisch. 
Faustregel: starte immer mit Pre­
view, schau dir das Ergebnis an, 
und entscheide dann, ob sich ein 
längerer Lauf lohnt.

C-10 Start Processing Button

G DZ I E

Schwebende untere Werkzeugleiste des Import-
-Overlays, rechts neben dem Preset-Picker.

T E C H N I C Z N I E

Button, der grau bleibt, solange weder Bilder noch 
ein Video importiert sind. Bei Klick startet die Pipe
line und schaltet die Stage-Maschine in die Reihen
folge Frame-Quality → SfM → Training um. Der But
ton selbst hat keinen weiteren Status; eine laufende 
Verarbeitung erscheint stattdessen als separater 
Verarbeitungsbildschirm.

P R O S T Y M I  S ŁOWA M I

Der „Loslegen„-Knopf. Solange 
er grau ist, fehlen noch Eingabe-
-Bilder oder ein Video. Sobald du 
Fotos hereingezogen hast, wird 
er aktiv und du klickst ihn an, um 
SfM und Training nacheinander 
zu starten. Ab da übernimmt die 
App den gesamten Ablauf und 
du landest automatisch auf dem 
Verarbeitungsbildschirm (Z2). Du 
musst nichts weiter klicken — 
erst nach Trainings-Ende we­
chselt die App wieder in die Vor­
schau (Z3). Wenn du es dir noch­
mal anders überlegst, kannst du 
auch danach noch jederzeit per 
Cancel abbrechen.
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C-11 Video Sampling Slider

G DZ I E

Rechte Bilderliste, sichtbar nur wenn ein Video 
(statt Bildern) importiert wurde.

T E C H N I C Z N I E

Schieberegler 0.5 fps – 30 fps in 0.5er-Schritten. 
Bei Änderung wird die Frame-Dichte aktualisiert 
und zusätzlich die Anzahl der Zielframes (minde
stens 10) aus Dichte und Videolänge berechnet. Der 
Schieberegler liegt außerhalb der Bilderliste, weil 
Listen-Elemente Maus-Events von Schiebereglern 
blockieren würden. Unter dem Schieberegler ste
hen die berechneten Zielframes („247 frames„) und 
die Videolänge („1m23s video”). Tooltip warnt: „Do
ubling the density doubles the number of frames 
and increases SfM time by ~100%.„

P R O S T Y M I  S ŁOWA M I

Wenn du statt Fotos ein Video 
importiert hast, entscheidet die­
ser Schieberegler, wie viele Ein­
zelbilder die App aus dem Video 
herausziehen soll. Mehr Bilder 
= bessere Qualität, aber linear 
mehr Rechenzeit. Für ein 30-Se­
kunden-Orbit-Video sind 5 fps 
(150 Bilder) ein guter Anfang; bei 
1-minütigen Aufnahmen reicht 
oft 3 fps völlig. Unter dem Regler 
zeigt die App live an, wie viele 
Frames bei der aktuellen Einstel­
lung herauskommen — so siehst 
du sofort, ob du in den sinnvol­
len Bereich von etwa 100–300 
Bildern triffst. Wenn das Ergeb­
nis schlecht wird, zieh den Regler 
nach rechts und probier es noch­
mal; die Verdopplung der Frame-
-Rate verdoppelt aber auch grob 
die SfM-Dauer.

C-12 Clear All Button

G DZ I E

Rechte Bilderliste, unten rechts; sichtbar nur wenn 
Bilder importiert wurden.

T E C H N I C Z N I E

Roter Button. Klick öffnet einen Bestätigungs-Dialog 
mit Titel „Clear all imported files?„ und Message „N 
images will be removed.”. Bestätigung leert alle im
portierten Bilder/Videos, Staging-Verzeichnisse, die 
Punktwolke, den Trainings-Status, das SfM-Ergeb
nis und alle Caches; die Stage springt zurück auf 
Import. Auf Cancel bleibt alles erhalten. Der Dialog 
ist als zerstörungsfreier Default-Pfad konfiguriert 
(zerstörender Button rot markiert).

P R O S T Y M I  S ŁOWA M I

Wenn du komplett neu anfan­
gen willst, klick hier. Die Be­
stätigungs-Frage erscheint, weil 
das Löschen alle aktuellen Im­
porte samt ggf. bereits berech­
neten Kameras und Trainings-
-Resultaten verwirft — du kan­
nst es nicht rückgängig machen. 
Sinnvoll, wenn du das gewähl­
te Bildmaterial komplett austau­
schen willst oder ein altes Pro­
jekt loswerden möchtest, bevor 
du ein neues startest. Beachte: 
ein einzelnes Bild rauszunehmen 
geht über die Liste rechts (sie­
he nächster Punkt), nicht über 
diesen Button. Deine Dateien 
auf der Festplatte werden dabei 
nicht gelöscht — die App ver­
gisst nur ihre Referenzen.
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C-13 File List ForEach (Einzel-Image-Entfernen)

G DZ I E

Rechte Bilderliste, jeder Eintrag.

T E C H N I C Z N I E

Liste über die importierten Bilder mit Swipe-zum-
-Löschen. Pro Bild eine Zeile mit Icon, Dateiname, 
Auflösung („1920 × 1080″) und Dateigröße (forma
tiert KB/MB). Auflösung kommt aus einem Metada
ten-Cache, der asynchron aus den Bild-Headern 
befüllt wird, damit die Oberfläche nicht blockiert. 
Die Löschen-Aktion bietet macOS-typisches Swipe-
-Delete (Trackpad-Swipe links auf einer Zeile) sowie 
Tastatur-Delete bei selektierter Zeile. Hinweis: Der 
erweiterte Image-Delete-Pfad mit explizitem Minus-
-Button, Backspace und Cmd-Z zum Rückgängig
machen wurde nur im Expert-Modus im Project Na
vigator ergänzt — im Einsteiger-Modus bleibt es bei 
Swipe-Delete.

P R O S T Y M I  S ŁOWA M I

Die Liste rechts zeigt jedes im­
portierte Bild mit Auflösung und 
Dateigröße — praktisch, um auf 
einen Blick zu sehen, ob du gemi­
scht hochauflösendes mit niedri­
gauflösendem Material zusam­
mengewürfelt hast. Um ein ein­
zelnes Bild rauszunehmen, wisch 
es mit zwei Fingern nach links 
auf dem Trackpad — wie in iOS 
Mail — oder wähle es an und 
drücke Delete. Die App löscht 
die Datei selbst nicht; sie nimmt 
sie nur aus dem aktuellen Pro­
jekt. Falls du eine richtige Minus-
-Schaltfläche oder Cmd-Z-Rück­
gängig brauchst, wechsle in den 
Expert-Modus (Cmd+2), dort gibt 
es das im Project Navigator. 
Im Einsteiger-Modus bleibt es 
bewusst beim einfachen Swipe-
-Pattern.
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C-15 Validation Warnings (3-Stufen-Tier)

G DZ I E

Unter der Bilderliste, oberhalb des Clear-All-But
tons.

T E C H N I C Z N I E

Drei aufeinander folgende Schwellen basierend auf 
der Anzahl importierter Bilder (nur aktiv wenn Bilder 
vorhanden und kein Video): - < 3 Bilder: rotes 
Banner (red octagon), Text „At least 3 images are 
required. Camera alignment cannot be computed 
from fewer images.„ - 3–9 Bilder: rotes Banner, Text 
„With fewer than 10 images, SfM often fails and the 
trained scene tends to overfit […]. 15–20 images 
minimum recommended; 30+ for object captures.” - 
10–19 Bilder: orangefarbenes Banner (warning trian
gle), Text „Workable, but quality usually improves 
with 20+ images and good coverage around the 
scene.„

Ab 20 Bildern verschwindet das Banner. Schwellen
werte sind hartkodiert und basieren auf empirischen 
560+-Trainings-Experimenten.

P R O S T Y M I  S ŁOWA M I

Die App schaut sich an, wie vie­
le Bilder du importiert hast, und 
gibt dir eine farbige Einschät­
zung. Rot heißt: das wird mit ho­
her Wahrscheinlichkeit nichts — 
entweder kann SfM keine Kame­
ras berechnen oder das Training 
überfittet auf zu wenig Material. 
Orange heißt: könnte klappen, 
aber rechne nicht mit Top-Qu­
alität, weil der Algorithmus zwi­
schen den Bildern wenig Über­
lapp findet. Kein Banner heißt: 
gute Voraussetzungen, du hast 
genug Material. Wenn du wirklich 
saubere Modelle willst, peile min­
destens 30–50 gleichmäßig ver­
teilte Aufnahmen rund um dein 
Motiv an — gerne auch deutlich 
mehr bei Außenszenen oder gro­
ßen Räumen. Du kannst trotz 
Warnung starten, aber sei nicht 
überrascht, wenn SfM kommen­
tarlos abbricht oder das Modell 
löchrig aussieht.
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C-16 COLMAP Workspace Detection

G DZ I E

Beim Drop eines Ordners — keine sichtbare Schalt
fläche, sondern Erkennungs-Logik.

T E C H N I C Z N I E

Beim Drop eines Verzeichnisses wird geprüft, 
ob darin eine der drei kanonischen Workspace-
-Layouts vorliegt: sparse/​0/​cameras.bin, sparse/​
cameras.bin oder direkt cameras.bin  im Root. 
Trifft das zu, wird die Standard-Bild-Enumeration 
abgebrochen und stattdessen ein modaler Alert 
geöffnet, der den User fragt, ob die bestehende 
Rekonstruktion verwendet oder die Bilder neu durch 
Apple Photogrammetry geschickt werden sollen. 
Gleicher Pfad auch für Text-Format-Workspaces 
(cameras.txt) und ETH3D-Exporte. Siehe Kapitel 9 
Backend Q6 für Details. Wirkt im Einsteiger-Modus 
genauso wie im Expert-Modus.

P R O S T Y M I  S ŁOWA M I

Wenn du schon einmal mit Meta­
shape, RealityCapture oder COL­
MAP gearbeitet hast und dort 
die Kamera-Berechnung schon 
laufen ließest, kannst du den 
Export-Ordner einfach hier re­
inziehen. RadianceKit erkennt 
am Inhalt automatisch, dass es 
sich um ein COLMAP-Workspace 
handelt (es prüft auf sparse/​
0/​, cameras.bin  und Co.), 
und fragt dich, ob es die 
fertige Rechnung übernehmen 
oder selbst neu rechnen soll. 
Übernehmen spart bei großen 
Szenen Stunden Wartezeit, we­
il SfM komplett übersprungen 
wird — das Training startet so­
fort. Auch Text-Format-Workspa­
ces (cameras.txt) und ETH3D-
-Exporte werden erkannt. Diese 
Funktion ist im Einsteiger-Modus 
genauso wie im Expert-Modus 
verfügbar; mehr Details stehen 
in Kapitel 9 unter Backend Q6.

Wann zur nächsten Stufe?

Du kannst Start Processing klicken, sobald (a) mindestens ein Bild oder ein Video 
importiert ist und (b) das Validation-Banner orange oder verschwunden ist. Bei rotem 
Banner lässt die App dich zwar trotzdem starten, du kannst aber mit hoher Wahrsche
inlichkeit die Verarbeitung gleich wieder abbrechen. Empfohlen: mindestens 20 Bilder, 
scharf, mit deutlichem Überlapp zwischen aufeinander folgenden Aufnahmen, alle aus 
etwa der gleichen Distanz zum Motiv. Wähle vor dem Start ein Preset, das zu deinem 
Zeitbudget passt — bei 30 Bildern und Quick-Preset bist du in wenigen Minuten durch, 
bei Quality dauert es eher 1–2 Stunden.
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Z2 — Verarbeitung (SfM + Training)

Rysunek 36:  Z2 SfM-Phase — Stage-Icon „Structure from Motion„ mit 41 % im großen 
Kreis, oberer Statusbalken bei „SfM 25 %”, Cancel-Button unten rechts

SfM-Phase (Kameras werden ausgerichtet): Großer Fortschrittskreis zeigt Sub-Sta
ge-Progress (hier 41 % der laufenden Apple-Photogrammetry-Session). Status-Text 
„Aligning cameras…„ oben links. Crumb-Trail markiert „Cameras” als aktive Stufe. Obe
rer Statusbalken zeigt Pipeline-Gesamtprogress (25 %) — SfM belegt die erste Hälfte 
des Balkens. Schwebende Wireframe-Kameras im Hintergrund deuten an, dass Posen 
geschätzt werden.

Rysunek 37:  Z2 Training-Phase — Stage-Icon „Training Gaussians„ mit 6 %, Live-Metriken 
oben (Training: 400/5000 — Loss: 0.1642 — 138.7 it/s), ETA 33s, Pause/Cancel unten

Training-Phase (Gaussians werden optimiert): Sub-Stage-Icon wechselt zu „Training 
Gaussians„, Prozent zählt Iterationen vom gewählten Preset (hier 400 / 5 000 für 
Preview-Preset = 8 % der Stage). Live-Metrik-Zeile zeigt Loss-Wert (0.1642), Iteratio
nen-pro-Sekunde (138.7 it/s) und ETA (33 s). Pipeline-Gesamtprogress klettert von 50 
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% bis 100 % während dieser Phase. Pause-Button (statt Cancel-Only in SfM-Phase) 
erlaubt Resume später; Cancel verwirft das Training-Ergebnis und kehrt zurück nach Z1.

Sobald die Pipeline läuft, blendet die App das Import-Overlay aus und zeigt einen voll
flächigen Verarbeitungsbildschirm. Mittig läuft ein großer Fortschrittskreis (220 × 220 
Pixel) mit Stage-Icon, Status-Text und Prozent-Zahl; im Hintergrund visualisiert eine 
dezente Splat-Animation symbolisch die laufende Berechnung. Oben links lässt sich ein 
Info-Panel einblenden, das Live-Metriken aus Training und SfM zeigt. Unten gibt es 
Pause/Resume, Cancel und im Fehlerfall einen Retry-Button.

C-18 SplatTrainingView (Hintergrund-Animation)

G DZ I E

Vollflächiger Hintergrund hinter dem Progress-Kre
is, ausgeblendet bei Abbruch oder Fehler.

T E C H N I C Z N I E

Dekorative Animation, die je nach Pipeline-Fort
schritt (0…1) eine zunehmende Anzahl kleiner ani
mierter Splat-Partikel rendert. Die Quelle ist ein be
rechneter Fortschrittswert, der SfM-Phasen auf 0–
0.2 abbildet und Training auf 0.2–1.0 (Frame-Quality 
auf 0–0.05). Damit „bauen„ sich die Splats sichtbar 
auf, während das Training läuft. Ausschließlich de
korativ — die Anzeige zeigt keine echten Zwische
nergebnisse des aktuellen Trainings (das wäre Live-
-Preview im Expert-Modus). Bei Cancel oder Failure 
wird sie ausgeblendet und nur der Status-Kreis ble
ibt sichtbar.

P R O S T Y M I  S ŁOWA M I

Im Hintergrund läuft eine kleine 
Animation aus tanzenden Punk­
ten, damit der Bildschirm nicht 
so leer wirkt während der Be­
rechnung. Das ist nicht dein 
echtes 3D-Modell — das siehst 
du erst nach dem Training in 
Schritt Z3. Die Animation hat 
aber dieselbe Tonalität, sodass 
du am ungefähren Verdichtungs­
grad ablesen kannst, wie weit 
das Training fortgeschritten ist. 
Anfangs sind nur wenige Punkte 
sichtbar, gegen Ende füllt sich 
der Hintergrund deutlich dichter 
— ein hübscher visueller Indika­
tor zusätzlich zur Prozent-Anze­
ige im Kreis. Wenn dich die Ani­
mation stört (z. B. weil du im Hin­
tergrund nebenher arbeiten wil­
lst), kannst du in den Expert-Mo­
dus wechseln, wo sie wegfällt.
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C-19 Großer Progress-Kreis

G DZ I E

Mittig auf dem Verarbeitungsbildschirm, 220 × 220 
Pixel.

T E C H N I C Z N I E

Zwei übereinander gerenderte Ringe: außen ein 
gedämpfter Track-Ring, innen ein gefüllter Fort
schritts-Ring mit Akzent- oder Rot-Stroke (rot 
bei Fehler). Innerhalb des Kreises ein Stage-Icon 
(Gehirn für Training, Kamera für SfM, Film für Vi
deo-Frame-Extraktion, Sparkles für Frame-Quality), 
Stage-Titel und die live animierte Prozent-Zahl in 
32-Punkt-Rounded-Font. Das Icon pulsiert sanft, 
solange die Verarbeitung aktiv ist. Die Anzeige in
terpoliert auf einem 30-Hz-Timer sanft in Richtung 
des aktuellen echten Fortschritts — mit Constant-
-Creep (0.0003/Frame) plus Proportional-Anteil (4 
% des Gaps) und einem Soft-Ceiling, das auf 80 % 
des nächsten erwarteten Milestone setzt (für SfM 
aus einer hartkodierten Milestone-Tabelle). So wirkt 
der Fortschritt flüssig, selbst wenn die echten SfM-
-Updates nur alle paar Sekunden eintreffen.

P R O S T Y M I  S ŁOWA M I

Der große Kreis in der Mitte 
ist deine Haupt-Anzeige während 
die App rechnet. Er füllt sich 
sanft, auch wenn die echten Be­
rechnungs-Updates nur alle paar 
Sekunden kommen — das gibt 
dir das Gefühl, dass etwas pas­
siert, statt minutenlang auf ein 
eingefrorenes Prozent zu star­
ren. Das Symbol in der Mitte 
wechselt, je nachdem ob ge­
rade Frames extrahiert werden 
(Film-Icon), Kameras ausgerich­
tet werden (Kamera-Icon), oder 
Gaussians trainiert werden (Ge­
hirn-Icon). Die Prozent-Zahl bez­
ieht sich auf den aktuellen Te­
ilschritt — die Gesamt-Pipeline 
siehst du in der schmalen Le­
iste ganz oben. Bei einem Fehler 
färbt sich der Ring rot statt blau, 
und das Icon pulsiert nicht mehr, 
sodass du sofort merkst, dass 
etwas schiefgelaufen ist.

C-22 Info Button (Metriken einblenden)

G DZ I E

Oben links auf dem Verarbeitungsbildschirm, 32 × 
32 Pixel.

T E C H N I C Z N I E

Schlichter Button mit Material-Hintergrund. Schaltet 
das Info-Panel ein oder aus. Icon wechselt zwischen 
Info-Kreis-Outline und Info-Kreis-Gefüllt, wenn ak
tiv. Sanfte Einblend-Animation. Im Tooltip „Show de
tailed processing metrics„.

P R O S T Y M I  S ŁOWA M I

Standardmäßig ist der Bild­
schirm bewusst aufgeräumt — 
nur der große Fortschrittskreis, 
mehr siehst du erstmal nicht. 
Wenn du als technisch interes­
sierter Nutzer genauer wissen 
willst, was passiert (welche Ite­
ration, wie hoch der Loss, wie 
viele Gaussians), klick auf das i-
-Symbol oben links. Ein kleines 
Panel klappt unten auf und ze­
igt alle Live-Werte. Ein erneuter 
Klick blendet es wieder aus. Die 
Einstellung ist nicht persistent — 
bei jedem neuen Trainingslauf ist 
das Panel zunächst wieder aus­
geblendet, was bewusst so ge­
wählt ist, um Einsteiger nicht zu 
erschrecken.
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C-23 Info Panel (Live-Metriken)

G DZ I E

Unten links auf dem Verarbeitungsbildschirm, sicht
bar nur wenn showProcessingInfo == true.

T E C H N I C Z N I E

Zwei-spaltiges Panel mit Ultra-Thin-Material-Back
ground. Linke Spalte: stage-spezifische Info-Zeilen 
— für SfM Status-Text und Prozent; für Tra
ining Iteration, kombinierter Loss, L1-Loss, D-SSIM-
-Loss, Gaussian-Count (orange gefärbt), Speed (it/
s), Elapsed-Time, berechnete ETA, SH-Degree und 
Learning-Rate. Rechte Spalte: Status-Text, Time-
-Info-String, inline Loss-Chart (siehe C-28) und 
ein Discoverability-Nudge (siehe C-32). Alle Werte 
werden aus dem Trainings-Status gelesen, der bei 
jedem Trainings-Tick aktualisiert wird.

P R O S T Y M I  S ŁOWA M I

Das Info-Panel zeigt alle Live-
-Werte, die im Expert-Modus 
dauerhaft in der Inspector-Side­
bar stehen würden: aktuelle Ite­
ration, Loss-Wert (kleiner = bes­
ser), Anzahl der Gaussians, Ge­
schwindigkeit, geschätzte Rest­
zeit, SH-Degree und Learning-
-Rate. Auf der rechten Seite läuft 
zusätzlich eine winzige Loss-Ku­
rve mit, die dir auf einen Blick 
verrät, ob das Training in die 
richtige Richtung läuft. Wenn das 
Training zäh wirkt, hilft ein Blick 
hier — ein Loss, der nicht mehr 
fällt, oder eine ETA, die nicht 
mehr sinkt, deuten auf Probleme 
hin. Wenn der Loss explodiert 
(plötzlich riesig wird) oder NaN 
anzeigt, ist das Training instabil 
geworden und ein Cancel + Re­
try oder Wechsel auf ein anderes 
Preset ist sinnvoll.

C-25 Pause/Resume Button

G DZ I E

Untere Navigationsleiste, sichtbar nur während der 
Trainings-Stage (NICHT während SfM) und solange 
die Verarbeitung läuft.

T E C H N I C Z N I E

Bordered Button. Ruft je nach Status Pause oder 
Resume auf. Label wechselt zwischen „Pause„ (mit 
Pause-Icon) und „Resume” (Play-Icon). Während 
des SfM-Schritts wird der Button nicht gezeigt, 
weil Apple Photogrammetry keine Pause-Semantik 
kennt. Der Pause-Zustand erhält Iteration, Gaus
sian-Status und Optimizer-Momentum komplett — 
Resume macht da weiter, wo zuvor angehalten wur
de.

P R O S T Y M I  S ŁOWA M I

Während das Training läuft, kan­
nst du es jederzeit anhalten und 
später fortsetzen. Sinnvoll, wenn 
du zwischendurch etwas ande­
res auf dem Mac machen willst, 
das viel GPU braucht — z. B. 
Videoschnitt, Spieletest oder ein 
Render-Export aus einer ande­
ren App. Klick Pause, mach dein 
Ding, klick Resume, das Training 
läuft genau dort weiter, wo es 
war. Iterations-Zähler, Gaussian-
-Anzahl und Optimizer-Momen­
tum bleiben dabei vollständig er­
halten, der Pause-State kostet 
dich nichts an Qualität. Während 
der SfM-Phase ist Pause nicht 
verfügbar — Apple Photogram­
metry kennt keine Anhalte-Funk­
tion, da musst du im Notfall mit 
Cancel arbeiten.
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C-26 Cancel Button

G DZ I E

Untere Navigationsleiste, sichtbar während die Ve
rarbeitung läuft (SfM oder Training).

T E C H N I C Z N I E

Roter Bordered-Button. Öffnet einen Bestätigungs-
-Dialog mit Titel „Stop and discard progress?„, 
Buttons „Discard Progress” (zerstörend) und „Keep 
Running„ (Cancel). Auf Bestätigung wird das Can
cel-Flag gesetzt, der Trainings-Task beendet, der 
SfM-Subprozess wenn nötig beendet und eine Sum
mary-Zeile mit Abbruch-Status in das JSONL-Log 
geschrieben. Im Gegensatz zu Pause werden Tra
inings-Buffer und Status verworfen.

P R O S T Y M I  S ŁOWA M I

Der Abbruch-Knopf. Im Gegen­
satz zu Pause ist das endgül­
tig — wenn du danach neu 
starten willst, läuft die Verarbe­
itung von vorne, sämtliche be­
reits trainierten Iterationen sind 
verloren. Sinnvoll, wenn du dich 
beim Preset vertan hast, das 
Training viel zu langsam läuft, 
oder die App offensichtlich Müll-
-Ergebnisse produziert und du 
nicht warten willst. Vor dem tat­
sächlichen Abbruch fragt die App 
über einen Bestätigungs-Dialog 
nochmal nach, damit du nicht 
aus Versehen Stunden Rechen­
zeit verlierst. Falls du nur kurz 
unterbrechen willst, nimm lieber 
Pause.

C-27 Retry Button

G DZ I E

Untere Navigationsleiste, sichtbar wenn die Pipeline 
fehlgeschlagen ist (SfM-Status startet mit „SfM fa
iled„ oder Training ist im Fehler-Zustand).

T E C H N I C Z N I E

Akzent-Button. Startet die gesamte Pipeline neu. 
Vor dem Start wird geprüft, ob noch importierte Bil
der/Videos vorhanden sind. Vorherige Fehler-Logs 
bleiben im JSONL-Verzeichnis erhalten; ein neuer 
Run schreibt eine neue Logdatei mit aktuellem Ti
mestamp.

P R O S T Y M I  S ŁOWA M I

Falls SfM oder Training mit 
einer Fehlermeldung abbricht, 
kannst du es hier neu versu­
chen. Manchmal hilft das, we­
il viele Schritte (RANSAC, Den­
sification) Zufallsanteile haben 
und ein zweiter Anlauf erfol­
greich sein kann, wo der erste 
gescheitert ist. Die gesamte Pi­
peline läuft dann erneut von 
vorne durch — SfM und Tra­
ining, in einer frischen JSONL-
-Log-Datei. Wenn auch der zwe­
ite Versuch fehlschlägt, sind me­
istens die Eingangsbilder das 
Problem (zu wenige, zu wenig 
Überlapp, Bewegungsunschärfe, 
schlechtes Licht); geh dann zu­
rück mit Back und tausch dein 
Material aus. Tipp: schau paral­
lel in die Training-Logs (Help → 
Open Training Logs), dort steht 
detaillierter, an welcher Stelle es 
konkret hakte.

219 / 233



R A D I A N C E K I T Rozdział 10 — Tryb początkujący

C-28 Inline Loss Chart

G DZ I E

Im Info-Panel, rechte Spalte, sichtbar nur während 
Training mit nicht-leerer Verlaufs-Historie.

T E C H N I C Z N I E

Kompakter Zeichen-Bereich (40 Pixel hoch), zeich
net die Loss-History als 1-Pixel-Linie in Akzent-Far
be. Daten werden auf finite Werte gefiltert (NaN-
-Schutz für unstabile Trainings). Min/Max werden 
über die gesamte History berechnet — der Chart 
auto-zoomt also auf den Wertebereich. Der letzte 
Loss-Wert steht rechts oben über dem Chart. Die 
History selbst wird im App-Zustand bei jedem Tra
inings-Tick aufgebaut (typisch alle 100 Iterationen).

P R O S T Y M I  S ŁOWA M I

Eine winzige Loss-Kurve, die dir 
auf einen Blick zeigt, ob das 
Training „konvergiert„ (Linie fällt 
nach rechts) oder ob es fe­
ststeckt oder explodiert (Linie 
flach oder steigt). Bei einem ge­
sunden Training fällt die Linie 
zu Beginn steil und flacht dann 
ab — das ist der erwartete Ver­
lauf, ähnlich einer Halbierung­
skurve. Der Chart zoomt automa­
tisch auf den aktuellen Wertebe­
reich, sodass auch kleine Verbes­
serungen am Ende des Trainings 
sichtbar bleiben. Wenn die Linie 
plötzlich nach oben schießt oder 
einfriert, ist das ein gutes Si­
gnal, dass etwas schiefläuft — 
entweder das Material ist proble­
matisch oder ein anderes Preset 
wäre besser geeignet. Den Chart 
findest du im Info-Panel, das du 
oben links mit dem i-Symbol ein­
blendest.
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C-32 Discoverability Nudge (Expert-Mode-Hinweis)

G DZ I E

Im Info-Panel, rechte Spalte unten, sichtbar nur 
während Training UND im Einsteiger-Modus.

T E C H N I C Z N I E

Kleine Zeile mit Augen-Icon und Caption-Text 
„Switch to Expert Mode (⌘2) for live splat preview„, 
in zurückhaltender Tönung und 10-Punkt-Schrift. 
Kein interaktives Element, nur Hinweis. Reagiert 
nicht auf Klick — der User muss tatsächlich Cmd+2 
drücken oder das Menü Mode → Expert Mode an
klicken.

P R O S T Y M I  S ŁOWA M I

Ein dezenter Hinweis, dass im 
Expert-Modus während des Tra­
inings die aktuelle Zwischenver­
sion deines 3D-Modells live im 
Viewport zu sehen ist. Im Einste­
iger-Modus wird das absichtlich 
ausgeblendet, um die Oberfläche 
ruhig zu halten — aber viele 
User wissen gar nicht, dass es 
diese Funktion gibt, also weisen 
wir hier sanft darauf hin. Drücke 
Cmd+2 und das Training läuft im 
Hintergrund weiter, während du 
dabei zuschauen kannst, wie sich 
dein Modell vor deinen Augen zu­
sammensetzt. Das ist auch ein 
gutes Werkzeug, um schon nach 
wenigen tausend Iterationen ab­
zuschätzen, ob das Ergebnis was 
wird, oder ob du lieber abbrichst 
und neu anfängst. Cmd+1 bringt 
dich jederzeit wieder zurück in 
die Einsteiger-Ansicht.

Wann zur nächsten Stufe?

Die App wechselt automatisch in Z3 (Vorschau), sobald das Training erfolgreich abge
schlossen ist — du musst nichts klicken. Die untere Navigationsleiste wechselt dann 
von Pause/Cancel auf einen Back-Button (zurück zu Import) und einen Export-Button 
(vorwärts zu Export). Im Fehlerfall (rote Fehlermeldung, Stage-Icon ist X) erscheint 
stattdessen Retry, und du musst entscheiden, ob du nochmal startest oder mit Back 
zum Import zurückgehst, um Bildmaterial zu ändern.
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Z3 — Vorschau (3D-Modell drehen)

Rysunek 38:  Simple-Modus Preview-Schritt mit 3D-Viewer

Rysunek 39:  Z3 Preview nach Training-Abschluss — Bjoerns Blender-Bouquet rekonstruiert, 
Header zeigt „Training complete — 3,022 Gaussians in 13s„, Back- und Export-Buttons unten

WAS IM BILD ZU SEHEN IST  Crumb-Trail markiert „Preview„ als aktive Stufe. Vollflächiger 
3D-Viewport rendert die fertig trainierte Bouquet-Szene (synthetisches Blender-Test-
-Set von Bjoern, 60-Frame-Subset aus 960 hemisphärischen Cams). Header-Statusbal
ken: „Training complete — 3 022 Gaussians in 13 s” — gibt finale Gaussian-Anzahl 
und Trainingszeit. Drag im Viewport rotiert die Kamera (Yaw/Pitch); Scroll-Wheel zoomt 
entlang der View-Direction. „Back„-Button (unten links) kehrt zurück zu Z2 für Resume 
oder Re-Run; „Export”-Button (unten rechts, primary) navigiert weiter zu Z4.

Nach Abschluss des Trainings landet die App automatisch in der Vorschau. Hier siehst 
du dein fertiges Gaussian-Splatting-Modell in einer Fullscreen-Metal-Ansicht und kan
nst es mit Maus und Trackpad drehen, zoomen und schwenken. Auf der Oberseite des 
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Viewports liegt ein kleines Overlay mit Kamerasteuerung und Info — Auto-Rotation, Tra
inings-Statistik, Reset-Knopf. Vor dem nächsten Schritt (Export) bietet es sich an, das 
Modell aus verschiedenen Winkeln zu prüfen, um sicherzugehen, dass die Rekonstruk
tion sauber ist.

C-36 SplatViewportView (3D-Hauptansicht)

G DZ I E

Fullscreen-Hintergrund des Vorschau-Schritts.

T E C H N I C Z N I E

Metal-basierter 3D-Viewport, der die fertige Punk
twolke rendert. Renderer to WŁASNY rasteryzator 
ForwardPass RadianceKit — ten sam, który rende
ruje splaty już podczas treningu — więc jest to 
prawdziwe WYSIWYG (to, co zostaje wytrenowane, 
jest pokazywane i eksportowane dokładnie tak sa
mo). Tile-basierte Rendering-Pipeline mit Order-In
dependent Transparency. Wenn der Renderer nicht 
initialisiert werden kann (z. B. weil Metal auf dem 
System nicht verfügbar ist), erscheint stattdessen 
ein schwarzer Hintergrund mit „Metal not available„-
-Text. Die Ansicht ignoriert die Safe-Area, sodass 
das Modell bis an die Fensterkante reicht.

P R O S T Y M I  S ŁOWA M I

Der Hauptviewport. Hier siehst 
du dein fertiges 3D-Modell aus 
deinen Fotos rekonstruiert, ge­
rendert auf der GPU in Echt­
zeit. Klick und zieh mit der 
linken Maustaste, um zu dre­
hen. Scrollrad oder Trackpad-
-Geste mit zwei Fingern, um 
zu zoomen. Rechte Maustaste 
oder Cmd+Drag zum Schwenken. 
Das Modell besteht aus zigtau­
senden semi-transparenten 3D-
-Ellipsoiden („Gaussians„), die 
deine Szene fotorealistisch re­
konstruieren — jedes einzelne 
hat eine Position, Ausrichtung, 
Form und Farbe, die das Tra­
ining gelernt hat. Im seltenen 
Fall, dass dein Mac kein Me­
tal unterstützt, siehst du statt­
dessen einen schwarzen Hinter­
grund mit einer Hinweismeldung 
— RadianceKit braucht zwingend 
eine Metal-fähige GPU.
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C-37 CameraControlsOverlay (Steuerungs-Overlay)

G DZ I E

Über dem Viewport, schwebend.

T E C H N I C Z N I E

Kompaktes UI-Overlay mit Buttons für Auto-Ro
tation (Turntable), Reset-Camera, Hintergrund-Au
swahl (Gray/Black/White), Save-Screenshot, Toggle-
-Info-Panel. Bindet an die Kamera-Parameter (Di
stanz, Azimut, Elevation, Target, FOV) und steuert 
das Auto-Turntable. Während des Trainings (wenn 
der User im Expert-Modus den Viewport mit-laufen 
sehen will) zeigt das Overlay zusätzlich eine kom
pakte Trainings-Status-Zeile.

P R O S T Y M I  S ŁOWA M I

Die kleine Schwebeleiste über 
dem Modell. Hier startest du die 
Auto-Rotation (das Modell dreht 
sich von alleine, gut für Screen­
shots und kurze Demos), setzt 
die Kamera per Reset zurück 
auf die Anfangsposition (falls du 
dich verirrt hast), wechselst den 
Hintergrund (Grau für neutral, 
Schwarz für maximalen Kontrast, 
Weiß für helle Modelle), und 
machst direkt Screenshots, die 
unter  /Pictures gespeichert wer­
den. Praktisch, wenn du ein be­
stimmtes Detail aus einem ganz 
bestimmten Winkel zeigen wil­
lst, ohne extra das ganze Modell 
zu exportieren. Die Auto-Rota­
tion ist auch ein guter Test, ob 
das Modell von allen Seiten gle­
ich gut aussieht oder ob es eine 
„Schmuddelseite„ gibt, die durch 
fehlende Aufnahmen entstanden 
ist.

224 / 233



R A D I A N C E K I T Rozdział 10 — Tryb początkujący

C-38 Export Button (Navigationsleiste)

G DZ I E

Untere Navigationsleiste in Z3.

T E C H N I C Z N I E

Akzent-Button mit Label „Export„ und Share-Icon. 
Klick triggert den Wechsel zu Z4. Vorher prüft die 
übergeordnete Ansicht, ob die Vollversion freige
schaltet ist — wenn nicht, wird statt der Export-
-Bühne die Sperr-Ansicht gezeigt (siehe U-06).

P R O S T Y M I  S ŁOWA M I

Wenn du mit dem Ergebnis zu­
frieden bist, klick Export und du 
landest im letzten Schritt, wo 
du das Format auswählst und 
speicherst. Ohne gekaufte Vol­
lversion landest du stattdessen 
auf einer Bildschirmsperre mit 
Unlock-Hinweis und Kauf-Button 
— die App will dir keine Vol­
lversion in die Schuhe schieben, 
aber der Export ist eines der Pre­
mium-Features. Sobald du den 
Kauf abgeschlossen hast, läuft 
die App direkt im freigeschalte­
ten Zustand weiter und du lan­
dest in der gewohnten Export-
-Bühne. Wenn du es dir doch an­
ders überlegst, kommst du über 
den Back-Button wieder in die 
Vorschau und kannst weiter am 
Modell drehen.

Wann zur nächsten Stufe?

Bevor du exportierst, dreh das Modell einmal komplett herum und prüfe: Sind alle Bere
iche, die du in deinen Eingangsbildern abgedeckt hast, vorhanden? Gibt es schwebende 
„Floater„ (frei in der Luft schwebende Gauss-Splat-Wolken)? Wirkt der Hintergrund/
Himmel sauber oder verschmiert? Schwerwiegende Probleme lassen sich nur durch 
Neu-Training fixieren — entweder mit mehr Bildern, anderem Preset, oder im Expert-
-Modus mit Floater-Reduction-Settings.
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Z4 — Export (Format wählen & speichern)

Rysunek 40:  Simple-Modus Export-Schritt mit Format-Karten

Rysunek 41:  Z4 Export-Karten — 6 Formate (PLY 742 KB ausgewählt, SPZ 74 KB, glTF 
708 KB, .splat 96 KB, Orbit Video, Web Viewer 133 KB), Export-History-Sidebar rechts mit 

bereits exportiertem PLY

WAS IM BILD ZU SEHEN IST  Crumb-Trail markiert „Export„ als aktive Stufe. Linkes Karten-
-Grid „Choose Export Format” mit allen sechs Optionen: PLY (Standard-3DGS, 742 
KB, mit vollen SH-Koeffizienten — hier vorausgewählt mit blauem Häkchen), SPZ 
(komprimiertes 3DGS-Format, ~90 % kleiner als PLY, 74 KB), glTF (mit KHR_​gaussian_​
splatting-Extension, 708 KB), .splat (Web-Viewer-kompatibel via antimatter15, 96 KB), 
Orbit Video (360°-MP4 der Szene, Live-Größenberechnung), Web Viewer (eigenständi
ges HTML mit eingebettetem 3D-Viewer, 133 KB). Größenangaben werden live aus 
dem aktuellen Gaussian-Count und Format-Overhead berechnet. Rechts „Export Histo
ry„ listet bereits abgeschlossene Exporte mit Format-Pill, Dateiname und Zeitstempel 
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— Click reveals im Finder. Primary-CTA unten links: „Export PLY (3DGS Standard)” mit 
Gaussian-Subtitle „2,991 Gaussians · SH degree 3″.

Im letzten Schritt wählst du aus 6 Export-Formaten (PLY, SPZ, glTF, .splat, Orbit-Video, 
Web-Viewer) per 2-spaltiges Karten-Grid, klickst Export und wählst Speicherort im ma
cOS-Dialog. Rechts läuft eine History aller bisherigen Exports — bei der Karten-Auswahl 
wird unter jeder Karte sofort der geschätzte Dateigröße angezeigt, sodass du z. B. SPZ 
bevorzugst, wenn du ins Web willst (klein), und PLY, wenn du in eine andere Software 
(SuperSplat, Postshot, Blender via Plugin) importieren willst (groß und vollständig).

C-39 2-Column Format Grid

G DZ I E

Linke Hauptseite des Export-Schritts.

T E C H N I C Z N I E

Karten-Raster mit zwei flexiblen Spalten und 12 
Punkt Abstand. Iteriert über die im Einsteiger-
-Modus angebotenen Formate — eine gefilterte 
Teilmenge der vollen Formatliste, die nur die 6 wich
tigsten Formate enthält: PLY, SPZ, glTF, .splat, Or
bit-Video, Web-Viewer. Compressed-PLY und SOG 
werden NUR im Expert-Modus angeboten.

P R O S T Y M I  S ŁOWA M I

Ein Karten-Raster mit den 6 For­
maten, die im Einsteiger-Modus 
relevant sind: PLY (Standardfor­
mat für andere 3D-Tools), SPZ 
(komprimierte Variante für Web), 
glTF (offizieller Web3D-Stan­
dard), .splat (für antimatter15-
-Web-Viewer), Orbit-Video (fer­
tiges MP4 zum Vorzeigen), 
und Web Viewer (eigenständige 
HTML-Datei mit eingebettetem 
3D-Player). Damit deckst du 90 
% der Anwendungsfälle ab. Wenn 
du eines der weniger gängi­
gen Formate brauchst (Compres­
sed-PLY oder SOG für extreme 
Komprimierung), wechsle in den 
Expert-Modus, dort sind alle 8 
Formate verfügbar. Die kompakte 
Auswahl hier ist bewusst, damit 
Einsteiger nicht von der Vielfalt 
überfordert werden.
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C-40 Format Card Button

G DZ I E

Jede Karte im Grid.

T E C H N I C Z N I E

Schlichter Button mit Karten-Layout: Icon (z. B. 
Dokument-Zipper für PLY, Archivbox für SPZ, Vi
deo-Icon für Orbit-Video) oben, Format-Name als 
Headline, Beschreibungs-Caption (2-zeilig gekürzt), 
darunter die geschätzte Dateigröße (live aus For
mat, Gaussian-Count und SH-Degree berechnet 
und als KB/MB formatiert). Bei Klick wird das For
mat ausgewählt. Selektierte Karte bekommt Akzent-
-Hintergrund, Akzent-Border und ein Häkchen-Icon 
rechts oben. Tooltip ist die Format-Beschreibung.

P R O S T Y M I  S ŁOWA M I

Eine Karte pro Format. Klick eine 
an, sie wird mit Akzent-Farbe und 
einem Häkchen hervorgehoben, 
und der Export-Button darunter 
passt seinen Text an („Export 
PLY„, „Export SPZ”, etc.). Je­
de Karte zeigt ein passendes 
Symbol, den Namen, eine zwe­
izeilige Kurz-Erklärung und die 
geschätzte Dateigröße bei de­
inem aktuellen Trainings-Ergeb­
nis. Die Größe hilft dir, sinnvoll 
zu wählen — wenn du das Er­
gebnis per Email schicken willst, 
nimm die kleinste Variante (me­
ist SPZ oder .splat); wenn du in 
einer anderen 3D-Software we­
iterarbeiten willst, nimm die mit 
der besten Kompatibilität (typi­
scherweise PLY). Beim Hovern 
über einer Karte zeigt der Tool­
tip eine ausführlichere Beschre­
ibung, falls du die Unterschiede 
zwischen den Formaten unklar 
findest.

C-41 Video Duration Slider

G DZ I E

Unter dem Format-Grid, sichtbar nur wenn ein 
Video-Format gewählt ist (Orbit-Video oder Social-
-Video).

T E C H N I C Z N I E

Schieberegler 3–30 Sekunden in 1-Sekunden-
-Schritten, bindet an die Video-Länge im App-
-Zustand. Maximal-Breite 300 Pixel. Wird nur einge
blendet, wenn ein Video-Format ausgewählt ist. Bei 
nicht-Video-Formaten wird der Schieberegler kom
plett aus der Ansicht entfernt — kein toter Platz.

P R O S T Y M I  S ŁOWA M I

Wenn du ein Orbit-Video als 
Export wählst, kannst du hier 
die Länge bestimmen. 3 Sekun­
den = sehr schnelle Drehung, 
30 Sekunden = langsame, ruhige 
Drehung um dein Modell. Für So­
cial-Media-Reels (Instagram, Tik­
Tok) ist meistens 6–10 Sekunden 
ideal — lang genug, um das Mo­
dell zu zeigen, kurz genug, dass 
die Zuschauer nicht abspringen. 
Bei Präsentationen oder Portfo­
lio-Videos darfst du gerne 15–
20 Sekunden nehmen. Der Slider 
taucht nur auf, wenn ein Video-
-Format ausgewählt ist; bei Da­
tei-Formaten wie PLY oder SPZ 
wäre er sinnlos und ist ausge­
blendet.

228 / 233



R A D I A N C E K I T Rozdział 10 — Tryb początkujący

C-42 Export Button

G DZ I E

Unter dem Format-Grid (und unter dem Duration-
-Slider, falls Video gewählt).

T E C H N I C Z N I E

Großer Akzent-Button. Label: „Export {Format-Na
me}„, Share-Icon. Bei Klick wird der macOS-Spe
ichern-Dialog mit Format-passender Endung und 
Default-Filename „scene.{ext}” geöffnet; bei Be
stätigung wird der Export an die gewählte URL ge
schrieben. Deaktiviert, wenn kein Trainings-Ergeb
nis vorhanden ist oder ein Export bereits läuft.

P R O S T Y M I  S ŁOWA M I

Klick, wähle Speicherort im ma­
cOS-Dialog, fertig — die App 
schreibt die Datei im gewählten 
Format an die ausgewählte Stel­
le. Default-Name ist „scene.{En­
dung}„ (z. B. „scene.ply” oder 
„scene.spz„), den kannst du im 
Dialog beliebig ändern, bevor du 
speicherst. Der Button ist grau, 
solange noch kein Training-Er­
gebnis vorhanden ist (sollte hier 
nie passieren, weil du sonst gar 
nicht im Export-Schritt wärst) 
oder ein anderer Export bereits 
läuft. Sobald der Export läuft, er­
scheint darunter eine Fortschrit­
tsanzeige; die App bleibt bedien­
bar, du kannst also schon den 
nächsten Export vorbereiten.

C-43 Export Progress Bar

G DZ I E

Unter dem Export-Button, sichtbar nur während ein 
Export läuft.

T E C H N I C Z N I E

Fortschrittsanzeige mit Max-Breite 300 Pixel, da
runter Caption „Exporting… N %„. Der Wert läuft 
von 0 bis 1 und wird während des Schreibens aktu
alisiert — bei PLY in Chunks von 10 000 Gaussians, 
bei SPZ einmalig nach Quantisierung, bei Orbit-
-Video in Frame-Intervallen.

P R O S T Y M I  S ŁOWA M I

Während der Export läuft, siehst 
du hier den Fortschritt als 
schmalen Balken plus Prozent-
-Anzeige. PLY ist meistens bin­
nen Sekunden fertig, weil die 
Datei einfach binär weggeschrie­
ben wird. SPZ braucht etwas län­
ger, weil die Daten dabei quan­
tisiert und komprimiert werden. 
Orbit-Video ist der zeitaufwen­
digste Export — hier wird jedes 
einzelne Frame neu gerendert; je 
nach Auflösung und Länge kann 
das eine Minute oder länger dau­
ern. Während des Exports bleibt 
die App bedienbar, du kannst 
also schon das nächste Format 
vorbereiten oder im Viewport we­
iterklicken.
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C-44 Export Error Display

G DZ I E

Unter der Progress-Bar, sichtbar nur wenn beim 
letzten Export ein Fehler aufgetreten ist.

T E C H N I C Z N I E

Rote Zeile mit Warning-Icon und Fehlertext. Rote 
8 %-Hintergrund-Opacity, abgerundete Ecken. Max-
-Breite 400 Pixel. Häufige Fehlerursachen: SOG 
erwartet cwebp  im System-PATH (nicht App-Store-
-konform); Schreibfehler bei vollem Plattenspeicher; 
Sandbox-Fehler bei Speicherzielen außerhalb des 
erlaubten Bereichs.

P R O S T Y M I  S ŁOWA M I

Wenn der Export schiefgeht, er­
scheint hier in Rot eine kurze 
Klartext-Beschreibung des Pro­
blems. Meistens ist die Ursache 
offensichtlich — kein Platz auf 
der Platte, keine Schreibrechte 
für den Zielordner, oder ein Zie­
lort außerhalb der Sandbox-er­
laubten Bereiche. Speziell beim 
SOG-Format kommt es vor, dass 
cwebp  im System fehlt; in die­

sem Fall ist SOG nicht nutzbar 
und du musst auf SPZ auswe­
ichen. Wenn die Fehlermeldung 
unklar ist, schau in das Log-Ve­
rzeichnis (Help → Open Training 
Logs), dort steht ausführlicher, 
was schiefgegangen ist. Im Zwe­
ifel hilft es, einfach einen ande­
ren Speicherort zu wählen — z. 
B. den Schreibtisch.

C-46 Export History List

G DZ I E

Rechte Seite des Export-Schritts.

T E C H N I C Z N I E

Liste über die Export-Historie (persistent als JSON 
in den UserDefaults gespeichert, nach jedem erfol
greichen Export gepflegt). Jede Zeile zeigt Format-
-Badge (klein, akzentfarbig), Timestamp (HH:mm), 
Dateiname (1 Zeile gekürzt) und formatierte Date
igröße. Klick auf eine Zeile öffnet Finder mit selek
tierter Datei. Empty-State: „No exports yet„.

P R O S T Y M I  S ŁOWA M I

Eine Liste deiner bisherigen 
Exports — Format, Uhrzeit, Date­
iname, Größe, in chronologischer 
Reihenfolge. Klick eine Zeile an 
und die Datei wird im Finder 
hervorgehoben angezeigt, ohne 
dass du selber durch Ordner na­
vigieren musst. Praktisch, wenn 
du eine Stunde später nochmal 
den letzten Export brauchst und 
nicht mehr weißt, wo du ihn hin­
gespeichert hast — die History 
merkt sich das. Wenn du noch 
nie etwas exportiert hast, steht 
hier ein freundlicher Hinweis „No 
exports yet„. Die Liste übersteht 
Neustarts der App, weil sie in den 
UserDefaults gespeichert ist.
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C-48 History Context Menu (Rechtsklick)

G DZ I E

Rechtsklick auf eine History-Zeile.

T E C H N I C Z N I E

Kontextmenü auf jedem Listen-Eintrag mit zwei 
Aktionen: „Reveal in Finder„ (öffnet Finder mit se
lektierter Datei, wie der Einfach-Klick) und „Copy 
Path” (legt den vollen Dateipfad als Text in die Zwi
schenablage). Letzteres ist nützlich für Drag-and-
-Drop in andere Apps oder zur Übergabe an die 
Kommandozeile.

P R O S T Y M I  S ŁOWA M I

Rechtsklick auf einen History-
-Eintrag öffnet ein kleines Menü 
mit zwei Aktionen. „Reveal in 
Finder„ macht dasselbe wie ein 
normaler Klick — öffnet den Fin­
der mit selektierter Datei, sodass 
du sie sofort siehst. „Copy Path” 
legt den kompletten Dateipfad in 
die Zwischenablage, sodass du 
ihn z. B. in Terminal-Befehlen, 
in andere Apps oder in eine No­
tiz einfügen kannst. Besonders 
praktisch, wenn du den Export 
an jemanden weitergeben willst 
oder ihn in einem anderen Pro­
gramm öffnen möchtest, das per 
Pfad-Eingabe arbeitet. Funktio­
nal ein kleines, aber hilfreiches 
Detail, das auf Mac-typische Be­
dienungs-Patterns setzt.

Wann ist der Workflow abgeschlossen?

Nach einem erfolgreichen Export hast du dein 3D-Modell als Datei auf der Platte und 
die History zeigt einen neuen Eintrag. Es gibt keinen „Done„-Button — du kannst 
beliebig viele Exports in unterschiedlichen Formaten anhängen, ohne neu zu trainieren. 
Wenn du zurück zur Vorschau willst (z. B. um nochmal eine Kameraperspektive zu 
prüfen), nutze den Back-Button in der unteren Navigationsleiste. Wenn du eine komplett 
neue Szene anfangen willst, gehe via Back bis Z1 und nutze dort Clear All, oder File → 
New Project (Cmd+⇧+N).

Wechsel zu Expert-Modus

Drücke jederzeit Cmd+2 oder wähle Mode → Expert Mode ( M8 ). Der gesamte 
Zustand bleibt erhalten: importierte Bilder, gewähltes Preset, laufendes oder fertiges 
Training, fertige Punktwolke, Export-History, sogar die aktuelle Stage. Im Expert-Modus 
wird statt der vier-Schritt-Bühne das volle Inspector-Sidebar gezeigt mit allen ~150 
Bedienfeldern. Insbesondere: der Project Navigator (siehe Kapitel 2) bietet die erweiter
ten Bild-Operationen (Minus-Button, Backspace-Delete, Cmd-Z-Undo, Quick-Look-Vor
schau), die Live-Preview im Viewport während des Trainings, sowie alle Loss-, MCMC-, 
Densification- und Mip-Splatting-Parameter. Cmd+1 schaltet zurück in den Einsteiger-
-Modus — auch das verliert keinen Zustand.

231 / 233



R A D I A N C E K I T Rozdział 10 — Tryb początkujący

Häufige Fragen

Warum bleibt mein Start-Processing-Button grau?

Du hast noch keine Bilder oder kein Video importiert. Zieh mindestens eine Datei in 
die Drop-Zone oder benutze „Browse Files„. Sobald die Bilder-Liste rechts mindestens 
einen Eintrag enthält, wird der Button aktiv. (Bei nur 1–2 Bildern startet er zwar, aber 
SfM bricht direkt mit Fehler ab — siehe das rote Validation-Banner.)

Warum ist mein Export-Button gesperrt?

Im Einsteiger-Modus gibt es zwei Stufen: (a) Wenn die Trainings-Pipeline noch nicht 
fertig ist und du keine hast, ist der Button deaktiviert — du musst erst Z2 abschließen. 
(b) Wenn du die Vollversion noch nicht gekauft hast (PurchaseManager.hasAccess == 
false), siehst du statt der Export-Bühne eine Sperr-Ansicht mit Schloss-Icon und 
„Unlock Full Version„-Button, der das Purchase-Sheet öffnet. Quick- und Preview-Pre
sets erlauben Training kostenlos, aber Export ist Premium.

Warum kann ich kein Preset auswählen?

Du kannst es auswählen — aber wenn du ein Premium-Preset (Balanced, Quality, 
MCMC-Varianten) ohne gekaufte Vollversion antippst, springt der Picker automatisch 
zurück auf Preview und das Purchase-Sheet öffnet sich. Quick und Preview sind die 
einzigen kostenlos benutzbaren Presets.

Warum ist meine Drop-Zone leer und gestrichelt-grau, obwohl ich Bilder reinzie­
he?

Wahrscheinlich ein UTI-Typ-Mismatch. Die App akzeptiert JPG, PNG, TIFF, HEIC, MP4, 
MOV plus die App-eigenen Splat-Formate. Andere Bildformate (BMP, GIF, WebP, RAW-
-Formate) werden NICHT erkannt. Wenn du sicher bist, dass dein Bildtyp dabei sein 
müsste, prüfe die Dateinamens-Endung — die App geht primär nach Extension, nicht 
nach Datei-Inhalt.

Warum dauert SfM so lange, obwohl ich nur 30 Bilder habe?

Apple Photogrammetry skaliert nicht linear — bei manchen Bild-Konstellationen (Innen
räume mit komplexen Texturen, Bewegungsunschärfe, schlechtes Licht) braucht es 
deutlich länger als das Bild-Count vermuten lässt. Wenn SfM nach 10+ Minuten bei 30 
Bildern noch hängt, breche ab und versuche es nochmal mit besserem Material, oder 
wechsle in den Expert-Modus und probiere COLMAP/Native-SfM (Cmd+2 → Inspector 
→ Camera Alignment).

Wo finde ich meine Training-Logs?

Help → Open Training Logs (Cmd+⇧+L). Das öffnet ~/​Documents/​RadianceKit/​Logs/​
. Jede Trainings-Session schreibt eine eigene JSONL-Datei mit Timestamp im Dateina
men — erste Zeile ist die Konfiguration, danach folgt eine Progress-Zeile alle 100 
Iterationen, letzte Zeile ist die Summary mit Final-Loss und Success-Flag.
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